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EKTRON, INC. SOFTWARE LICENSE AGREEMENT
** READ THIS BEFORE LOADING SOFTWARE**
YOUR RIGHT TO USE THE PRODUCT DELIVERED IS SUBJECT TO THE TERMS AND CONDITIONS SET OUT IN THIS LICENSE
AGREEMENT. USING THIS PRODUCT SIGNIFIES YOUR AGREEMENT TO THESE TERMS. IF YOU DO NOT AGREE TO THIS SOFTWARE
LICENSE AGREEMENT, DO NOT DOWNLOAD.
CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein (the “Software”).
Downloading and/or using the Software or copying the Software onto CUSTOMER’S computer hard drive indicates CUSTOMER’S acceptance of
these terms and conditions. If CUSTOMER does not agree with the terms of this agreement, CUSTOMER should not download.
Ektron, Inc. (“Ektron”) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on the following
terms and conditions:
1. Right to use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only on a single URL.
Each license is valid for the number of seats listed below (the “Basic Package”). Any use of the Software beyond the number of authorized seats
contained in the Basic Package without paying additional license fees as provided herein shall cause this license to terminate. Should
CUSTOMER wish to add seats beyond the seats licensed in the Basic Package, the CUSTOMER may add seats on a block basis at the then
current price for additional seats (see product pages for current price). The Basic Packages are as follows:
Ektron CMS400.NET — Licensed for ten seats (10 named users) per URL.
Ektron eWebEditPro — Licensed for ten seats (10 named users) per URL.
Ektron eWebEditPro+XML — Licensed for ten seats (10 named users) per URL.
For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software.
The CUSTOMER may not modify, alter, reverse engineer, disassemble, or decompile the Software. This software product is licensed, not sold.
2. Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should CUSTOMER breach
any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License upon notification and demand by Ektron.
3. Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated into the Software)
as well as any accompanying written materials (the “Documentation”) is owned by Ektron or its suppliers, is protected by United States copyright
laws and international treaties, and contains confidential information and trade secrets. CUSTOMER agrees to protect the confidentiality of the
Software and Documentation. CUSTOMER agrees that it will not provide a copy of this Software or Documentation nor divulge any proprietary
information of Ektron to any person, other than its employees, without the prior consent of Ektron; CUSTOMER shall use its best efforts to see that
any user of the Software licensed hereunder complies with this license.
4. Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in material and
workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt. Ektron does not warrant the use
of the Software will be uninterrupted or error free, nor that program errors will be corrected. This limited warranty shall not apply to any error or
failure resulting from (i) machine error, (ii) Customer's failure to follow operating instructions, (iii) negligence or accident, or (iv) modifications to the
Software by any person or entity other than Company. In the event of a breach of warranty, Customer’s sole and exclusive remedy, is repair of all
or any portion of the Software. If such remedy fails of its essential purpose, Customer’s sole remedy and Ektron’s maximum liability shall be a
refund of the paid purchase price for the defective Products only. This limited warranty is only valid if Ektron receives written notice of breach of
warranty within thirty days after the warranty period expires.
5. Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD “AS IS” AND WITHOUT ANY WARRANTIES AS
TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. NO WARRANTY OF FITNESS FOR A
PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL WARRANTIES EXPRESS AND IMPLIED ARE HEREBY
DISCLAIMED.
NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR GOODWILL, LOSS
OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER,
CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE,
EVEN IF COMPANY OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.
6. Additional Terms and Conditions apply
When using the CMS400 map control, Subject to the terms and conditions of the Map provider (Microsoft Virtual Earth or Google maps)
Microsoft Virtual Earth
http://www.microsoft.com/virtualearth/product/terms.html

If you have any questions would like to find out more about a MWS/VE Agreement, please contact maplic@microsoft.com for information.
Google Maps
http://code.google.com/apis/maps/terms.html
7. Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way transferred
without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the relationship between the parties
contemplated herein shall be governed by, construed and enforced in accordance with the laws of the State of New Hampshire without regard to
conflict of laws principles thereof. The parties agree that any action brought in connection with this Agreement shall be maintained only in a court
of competent subject matter jurisdiction located in the State of New Hampshire or in any court to which appeal therefrom may be taken. The parties
hereby consent to the exclusive personal jurisdiction of such courts in the State of New Hampshire for all such purposes.. The United Nations
Convention on Contracts for the International Sale of Goods is specifically excluded from governing this License. If any provision of this License is
to be held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce any provision of this
Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce such provision. If you fail to comply with any
term of this License, YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License represents the entire understanding between the parties
with respect to its subject matter.
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND
THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE SOFTWARE, OR BY PLACING OR
COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS AGREEMENT’S TERMS AND
CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN EKTRON AND YOU, THIS
AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES.
Copyright 1999 - 2008 Ektron, Inc. All rights reserved.
LA10031, Revision 2.0
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What’s New in the 7.5 Release

• The Document Management feature has been fundamentally
improved. The way you create, edit, and perform all other
functions with assets has been changed. For example, Internet
Explorer users no longer need to deal with a client installation
file.
Another new feature is the ability to drag and drop assets into a
mapped network folder. Users of this method do not need to
install Ektron CMS400.NET client software nor learn how to use
it. For full details of the enhanced feature, see ”Using the
Document Management System” on page 222.

• After signing into the Ektron CMS400.NET Web Site or the
Workarea and clicking the triangle (circled below), any content
has a drop-down menu of actions that can be performed on it.

The options change according to several criteria, such as the
content type, status, and your permissions for its folder. See
Also: ”Content Dropdown Menu” on page 35

- New for 7.5.1 - After signing into an Ektron CMS400.NET
Web site or the Workarea, many server controls have a
menu of actions that can be performed.
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To display the menu, click the small gray circle in the upper left
corner.

• The Community Platform in Ektron CMS400.NET is a group of
features that allow users to network socially on the site. Access
to the community platform is available from the Web site or the
Workarea. As a User, you can access the your Community
information from the Workarea via the My Workspace folder
tab. See ”My Workspace” on page 377.

• New for 7.5.2 - The eWebEdit400 editor, an alternative to
eWebEditPro+XML, is available. Its main advantage is that
users are not required to install an ActiveX control file on their
computer. For more information, see ”Introduction to
eWebEdit400” on page 488.
Administrators who want to learn how validation is handled with
this editor should read the Ektron CMS400.NET Administrator
Manual section “Validating with eWebEdit400.”
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• New for 7.5.2 - The View Content Difference feature has been
enhanced. It no longer requires you to install a file on your
computer, and its display changed. For more information, see
”Comparing Versions of Content” on page 98.

• New for 7.5.2 - The options for working with checked out
content have changed slightly. In 7.5.2, if you are not the user
who checked out the content,

- if you are a member of Administrators user group, you can
either force a check-in or request one. If you request,
Ektron CMS400.NET emails the user who checked out

content, asking him to check it in.

- if you are not a member of Administrators user group but
have edit permission for the content’s folder, you can
request a check-in

- if you are a not a member of Administrators user group and
lack edit permission for the content’s folder, you can only
view the content

• For 7.5.2 - Entering start and end times for a calendar event is
now optional. If the user does not select them, they are set to
12:00 a.m. and 11:55 p.m.

• New for 7.5.3 - The search finds metadata along with other
content. Previously, you had to precede the search text with an
at sign (@) followed by the name of the metadata field. See
Also: ”Searching for Metadata” on page 117

• New for 7.5.3 - The Document Management Toolbar has been
removed. It was no longer needed since it has become easier
to edit Microsoft Office documents within Ektron CMS400.NET.
Alternatively, users can launch Office, edit a file, and save it to
into Ektron CMS400.NET via a mapped network folder without
signing into the Workarea. This feature is described in ”Adding
Documents to a Mapped Network Folder” on page 238.
The Ektron Explorer has also been removed. It’s no longer
necessary, since users can drag and drop files into a mapped
network folder without signing into the Workarea.
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Securing Ektron
CMS400.NET
Security Checklist
The following is a checklist of things an Administrator must do to
secure Ektron CMS400.NET.

Change Admin user password
Change builtin user password
IMPORTANT!

If you changed the builtin user password during the site setup, you do not need to
change it again. See ”Editing Builtin” on page ii for additional information.

Remove Sample Users and Sample
Membership Users
IMPORTANT!

Some users in this list might not appear in your User list. This depends on which
version of the software you have installed.

CMS400.NET Users

Membership Users

jedit

jmember

tbrown

member@example.com

jsmith

north

vs

supermember
west
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Additional Information
You do not need to make these changes if you are using the
CMS400.NET for demonstration or evaluation purposes. These
changes should be completed once the decision is made to
purchase the product and go live with your site.
IMPORTANT!

Ektron recommends creating your own Administrator user and deleting the Admin
user.

IMPORTANT!

Ektron recommends deleting any users from the CMS400.NET that are not
needed on the system.

The Everyone Group
By default, the root folder in Workarea provides the Everyone
Group with all permissions except Overwrite Library. Ektron Inc.
recommends reviewing the permission needs of the Everyone
Group when you add a folder. For information on Permissions, see
the Administrator Manual section “Managing User and
Permissions” > “Setting Permissions.”

Editing Builtin
IMPORTANT!

The “builtin” user does not appear in the Users list. This user appears on the
application setup screen.

To change the builtin account information, follow these steps.
1. In the Workarea, click Settings > Configuration > Setup.
2. Click the Edit button (

).

3. Locate the Built In User field.
4. Edit the built in user information by changing the username and
password.
5. Click the Update button (
NOTE

).

If you cannot sign in to Ektron CMS400.NET because the builtin user
password was changed and you don’t know the new password, use the
BuiltinAccountReset.exe utility. This resets your Ektron CMS400.NET user \
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password to Builtin \ Builtin. This utility is located in C:\Program
Files\Ektron\CMS400versionnumber\Utilities.

ServerControlWS.asmx
Best Practice
For improved security, Ektron recommends renaming or removing the
Web services file when you move it to your production server. After
installation, this file is named ServerControlWS.asmx and resides in the
webroot/siteroot/Workarea folder.

ServerControlWS.asmx is the Web service that lets the server controls talk to
Ektron CMS400.NET. The path is coded in the web.config file. This is how it
appears:
<!-- Web Service URL for Server Controls design time --> <add key="WSPath" value="http://
localhost/CMS400Developer/Workarea/ServerControlWS.asmx" />

You will need to edit this line if you change the location or name of the
ServerControlWS.asmx file.

Ektron CMS40 0.NET Deve lope r Re fe re nce Manua l, Version 7.5, Rev 7

iii

Securing Ektron CMS400.NET

Ektron CMS40 0.NET Deve lope r Re fe re nce Manua l, Version 7.5, Rev 7

iv

Table of Contents

What’s New in the 7.5 Release ............................................i
Securing Ektron CMS400.NET ............................................i
Security Checklist......................................................................... i
Additional Information ................................................................ ii

Introduction to Ektron CMS400.NET................ 1
What is a Content Block? ........................................................... 1
Working with Content from your Web Site ................................ 2
Types of Content.......................................................................... 7
Workflow in Ektron CMS400.NET ............................................... 8
Editing Content ............................................................................ 9
The Lifecycle of Content ........................................................... 10

Logging In and Out ...........................................................11
Prerequisites .............................................................................. 11
Logging into the Sample Web Site........................................... 11
Site Preview................................................................................ 13
Logging Out of the Sample Site ............................................... 14

The Workarea and Smart Desktop .................. 15
Accessing the Workarea ........................................................... 15
Understanding the Smart Desktop........................................... 17
Navigating Within the Smart Desktop...................................... 20
Sending Instant Email ............................................................... 25

Working with Folders and Content ................. 28
Viewing a Folder................................................................30
New Menu ................................................................................... 32
View Menu .................................................................................. 33
Delete Menu................................................................................ 34
Action Menu ............................................................................... 35

Ektron CMS40 0.NET User Manua l, Version 7.5

i

Content Dropdown Menu .......................................................... 35

Adding a Subfolder ...........................................................40
Deleting a Folder ...............................................................40
Viewing Content ................................................................40
Viewing Content from a Web Page........................................... 40
Expanding the Content Area..................................................... 46

Adding HTML Content ......................................................48
Editing HTML Content.......................................................52
Deleting Content ...............................................................57
Workarea Toolbar Buttons ...............................................60
Scheduling Content to Begin and End............................65
Setting a Start Date.................................................................... 66
Setting an End Date on Content ............................................... 68
Setting Archive Options ............................................................ 69

Adding a Content Summary .............................................73
Automatic Creation of a Summary ........................................... 74
Creating a Summary for New Content ..................................... 74
Creating a Summary for Existing Content............................... 75
Editing a Summary .................................................................... 76

Adding or Editing Metadata..............................................77
Entering Custom Metadata ....................................................... 78
Entering Title and Keywords .................................................... 85

Approving/Declining Content...........................................87
Approve/Decline One Content Item.......................................... 89
Approve/Decline Several Content Items.................................. 90
Example of an Approval Chain ................................................. 91

Comparing Versions of Content ......................................98
Ektron CMS40 0.NET User Manua l, Version 7.5

ii

The View Content Difference Screen ....................................... 98
The View Content Difference Feature .................................... 100

Viewing and Restoring Previous Content.....................108
Accessing Content History ..................................................... 108
The Content History Window.................................................. 109
Restoring a Previous Version ................................................. 111
Comparing Historical Versions............................................... 112
Removing Applied XSLT ......................................................... 112

Searching the Workarea .................................................114
Accessing the Search Content Folder Screen ...................... 114
The Search Published Tab ...................................................... 115
The Advanced Search Tab ...................................................... 119
Result Display Options ........................................................... 127
Information on the Advanced Search Results Screen ......... 128

Content Workflow Reports .............................................130

Library Folder .................................................. 131
Terms Used in this Chapter .................................................... 131
Accessing The Library ............................................................ 132
Library Folder Properties ........................................................ 134
Searching the Library.............................................................. 136
Files........................................................................................... 140
Hyperlinks ................................................................................ 150
Images ...................................................................................... 151
Quicklinks and Forms ............................................................. 153

Working with HTML Forms ............................. 156
Overview of Form Processing ................................................ 158
The Structure of Form Data .................................................... 158
Creating a New Form............................................................... 159
Creating a Form’s Content...................................................... 166
Form Validation........................................................................ 172
Form Fields .............................................................................. 173
Implementing a Form on a Web Page .................................... 194
Assigning a Task to a Form .................................................... 195
Viewing Form Reports............................................................. 197
Viewing Form Information....................................................... 204
Ektron CMS40 0.NET User Manua l, Version 7.5

iii

Editing a Form.......................................................................... 210
Deleting a Form........................................................................ 212
View Form Toolbar................................................................... 212
Creating Polls and Surveys .................................................... 214

Using the Document Management System... 222
Supported Types of Assets..................................................... 223
Security..................................................................................... 224
Software Requirements........................................................... 224
Working with Microsoft Office Documents............................ 227
Importing Office Documents................................................... 230
Working with Managed Files................................................... 253
Asset Workflow ........................................................................ 258
Asset Reports........................................................................... 259

Working with Calendars.................................. 261
Understanding Calendars ....................................................... 263
Accessing the View Calendar Screen .................................... 264
Viewing a Calendar .................................................................. 269
Tips on Viewing a Calendar .................................................... 271
Adding a Calendar Event ........................................................ 273
Viewing a Calendar Event ....................................................... 280
Editing Calendar Events.......................................................... 282
Deleting Calendar Events........................................................ 284

Managing Tasks............................................... 286
Creating a Task via the Task Folder ....................................... 287
Creating a Task from the Web Site......................................... 299
Creating a Task via the Content Folder ................................. 299
Viewing a Task ......................................................................... 300
Editing a Task........................................................................... 305
Adding Comments to Tasks.................................................... 306
Deleting a Task......................................................................... 309
Viewing a Task’s History ......................................................... 310
Task Module Toolbar ............................................................... 311

Blogs................................................................. 312
Adding a Blog .......................................................................... 316

Ektron CMS40 0.NET User Manua l, Version 7.5

iv

Blog Properties ........................................................................ 318
Language Support ................................................................... 336
Deleting a Blog......................................................................... 336
Searching Blogs ...................................................................... 337
Subscribing/Unsubscribing to a Blog.................................... 337
Blog Posts ................................................................................ 341
Blog Comments ....................................................................... 350
Adding or Editing Blog posts with Windows Live Writer..... 358

Personalizing a Web Page .............................. 363
Layout of a Personalization Page .......................................... 364
Personalizing a Web Page ...................................................... 365
The Page Catalog..................................................................... 375

My Workspace ................................................. 377
Documents ............................................................................... 379
Messaging ................................................................................ 390
Message Board ........................................................................ 397
Colleagues................................................................................ 400
Community Groups ................................................................. 412
Favorites................................................................................... 415
Photos....................................................................................... 417

Web Site Navigation Aids ............................... 424
Working with Collections ...............................................424
Finding Collections ................................................................. 425
Viewing a Collection ................................................................ 428
Creating a Collection............................................................... 430
Editing Content in a Collection .............................................. 438
Reordering Collections List .................................................... 439
Editing Collection Information ............................................... 439
Deleting a Collection ............................................................... 440
Working with Collections in a Multi-Language System ....... 440
Comparison of Collections, Menus, Taxonomy, and the List
Summary Features .................................................................. 442

Working with Menus .......................................................444
The Structure of Menus and Menu Items............................... 446
Ektron CMS40 0.NET User Manua l, Version 7.5

v

Access to the Menus Feature ................................................. 446
Managing Menus...................................................................... 447

Ektron CMS400.NET System Management ... 477
Updating Your User Profile.............................................477
Online Help ......................................................................483
Accessing Online Help............................................................ 483
Accessing Online Manuals ..................................................... 484

Introduction to Ektron CMS400.NET Editors 486
Setting the Editor for Ektron CMS400.NET Users................. 487

Introduction to eWebEdit400.......................... 488
Toolbar Buttons.................................................................... 490
Copying from Other Applications....................................... 497
Finding and Replacing Text ................................................ 498
Checking Spelling ................................................................ 503
Working with Images ........................................................... 506
Inserting an Image ................................................................... 506
Inserting an Image Thumbnail ................................................ 508
Editing an Image’s Properties ................................................ 508
Deleting an Image from Content ............................................ 516

Using Bookmarks................................................................. 517
Creating a Bookmark............................................................... 517

Using Hyperlinks.................................................................. 521
Creating a Hyperlink................................................................ 521
Testing a Hyperlink .................................................................. 523
Creating a Hyperlink to a Location Within a Web Page ....... 524
Editing a Hyperlink .................................................................. 525
Removing a Hyperlink ............................................................. 525
Preventing a URL from Becoming a Hyperlink ..................... 526

Inserting email Links ........................................................... 527
Working with HTML.............................................................. 529
Working with Tables ............................................................ 531
Creating a Table ....................................................................... 531
Modifying Table Properties ..................................................... 535

Ektron CMS40 0.NET User Manua l, Version 7.5

vi

Deleting a Table ....................................................................... 537
Inserting a Table within a Table .............................................. 537
Choosing the Number of Rows and Columns....................... 538
Specifying Table Width............................................................ 540
Specifying Horizontal Alignment............................................ 544
Table Backgrounds.................................................................. 546
Setting Table Borders.............................................................. 551

Working with Table Cells ..................................................... 556
Selecting Cells to Modify ........................................................ 556
Specifying the Height and Width of a Cell ............................. 558
Deleting a Cell .......................................................................... 559
Specifying a Cell’s Background Color ................................... 560
Specifying a Background Image for a Cell ............................ 561
Spanning Rows or Columns ................................................... 562
Aligning Text Within a Cell...................................................... 564
Splitting a Cell .......................................................................... 565
Merging Two Cells ................................................................... 566
Word Wrap................................................................................ 567
Setting Cell Padding and Spacing.......................................... 568
Section 508 Tables................................................................... 570

Working with HTML Forms.................................................. 574
Overview of Form Processing ................................................ 576
The Structure of Form Data .................................................... 576
Creating a New Form............................................................... 576
Creating a Form’s Content...................................................... 585
Form Validation........................................................................ 590
Form Fields .............................................................................. 590
Inserting or Editing Buttons on the Form.............................. 612
Implementing a Form on a Web Page .................................... 615
Assigning a Task to a Form .................................................... 615
Viewing Form Reports............................................................. 618
Viewing Form Information....................................................... 618
Editing a Form.......................................................................... 618
Deleting a Form........................................................................ 618
View Form Toolbar................................................................... 618
Creating Polls and Surveys .................................................... 618

Introduction to eWebEditPro+XML ................ 626
Creating a Simple Web Page..........................................628
Creating a Sample Web Page ................................................. 629

Ektron CMS40 0.NET User Manua l, Version 7.5

vii

Toolbar Buttons...............................................................632
Customizing Your Toolbar ..............................................645
Removing Or Adding Menus .................................................. 646
Removing or Adding Menu Items........................................... 647
Restoring Toolbars .................................................................. 650
Rearranging the Menus on a Toolbar..................................... 650
Creating a New Menu .............................................................. 650
Moving a Menu Off the Toolbar .............................................. 652
Changing the Menu’s Orientation........................................... 653

The Context Sensitive Menu ..........................................654
Using eWebEditPro+XML’s Advanced Features ..........657
Copying from Other Applications....................................... 658
Finding and Replacing Text ................................................ 659
Checking Spelling ................................................................ 663
Editing in Microsoft Word.................................................... 668
Inserting Images................................................................... 671
Editing Images...................................................................... 687
Specifying Color Depth ........................................................... 718

Introduction to Tables.......................................................... 719
Table Dialog Boxes and Menus .......................................... 723
Manipulating Your Table’s Format ...................................... 730
Choosing the Number of Rows and Columns....................... 730
Specifying Table Width............................................................ 732
Specifying Horizontal Alignment............................................ 737
Table Backgrounds.................................................................. 738
Setting Table Borders.............................................................. 742

Working with Table Cells ..................................................... 746
Specifying the Width of a Cell ................................................ 746
Inserting a Cell ......................................................................... 747
Deleting a Cell .......................................................................... 748
Setting a Cell’s Border Color .................................................. 749
Specifying a Cell’s Background Color ................................... 750
Specifying a Background Image for a Cell ............................ 752
Spanning Rows or Columns ................................................... 754
Aligning Text Within a Cell...................................................... 756
Splitting a Cell .......................................................................... 759
Merging Two Cells ................................................................... 760
Word Wrap................................................................................ 761
Setting Cell Padding and Spacing.......................................... 762
Ektron CMS40 0.NET User Manua l, Version 7.5

viii

Using Bookmarks................................................................. 764
Using Hyperlinks.................................................................. 768
Working with HTML.............................................................. 774
Using Ektron CMS400.NET’s Wiki Feature ........................ 778
Creating a Wiki......................................................................... 778

Section 508 Compliance...................................................... 784
Moving the Cursor into eWebEditPro+XML........................... 784
Using eWebEditPro+XML without a Mouse........................... 785
Section 508 Tables................................................................... 787

Inserting Comments within Content................................... 794

Appendix A: Content Statuses....................... 798
Approved Content ................................................................... 799
Checked-In Content ................................................................. 800
Checked Out Content .............................................................. 802
Submitted Content................................................................... 803
Marked for Deletion Content................................................... 804
Pending Start Date Content .................................................... 805
Staged Content ........................................................................ 806

Ektron CMS40 0.NET User Manua l, Version 7.5

ix

Ektron CMS40 0.NET User Manua l, Version 7.5

x

Introduction to Ektron CMS400.NET

Introduction to Ektron
CMS400.NET

Using Ektron CMS400.NET to manage Web content is easy once
you know the basics of setting up and maintaining your site. This
documentation explains how to maintain an Ektron CMS400.NET
site from a user’s point of view. By reading this documentation, you
will gain an understanding of how Ektron CMS400.NET works.
This section introduces basic concepts that you should understand
when beginning to work with Ektron CMS400.NET through the
following subtopics.

• ”What is a Content Block?” on page 1
• ”Control Menu Options” on page 3
• ”Types of Content” on page 7
• ”Workflow in Ektron CMS400.NET” on page 8
• ”Editing Content” on page 9
• ”The Lifecycle of Content” on page 10

What is a Content Block?
A Web site consists of several pages. Each page is made up of
one or more blocks of content. For example, the home page from
one of Ektron CMS400.NET’s sample sites is below.
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You can work with content from the Web site or after logging into
the Ektron CMS400.NET Workarea. See Also:

• ”Working with Content from your Web Site” on page 2
• ”The Workarea and Smart Desktop” on page 15

Working with Content from your Web Site
After signing in to Ektron CMS400.NET, you can do your work from
two types of dropdown menus.

• Content menu - lets you work on content when it appears on a
list. See Also: ”Content Dropdown Menu” on page 35

• Control menu - lets you work on any of the various Ektron
CMS400.NET controls that appear on a Web page. A control

can display content, a list of content items, etc. See Also: ”The
Control Menu” on page 2

The Control Menu
After you sign in, notice that most areas of the Web page are
surrounded by a border or display a gray circle in the top left
corner. The border might only appear as you move the cursor over
it.
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You can perform Ektron CMS400.NET tasks from the control
menus. The options can vary depending on what is on that area of
the page and your permissions. For example, one area might have
a content item and another a list of related content items. Your
system administrator controls the design of each page.
The advantage of this feature is that you can see how Web page
will appear to site visitors. Continue editing until you are satisfied
with the content.
See Also:

• ”Control Menu Options” on page 3
• ”Hiding and Showing the Content Border” on page 5
• ”Appendix A: Content Statuses” on page 798 explains the
meaning of the border’s color

Control Menu Options
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The following table describes the menu options that may appear.
Button

Name

Description

More Information

Add

Appears if you selected a language
and the content is not available in that
language. Use this button to copy
existing content into new content and
translate it to the new language.

Approve

Approve or decline a request to
publish or delete content

”Approving/Declining Content”
on page 87

Assign Task

Assign a task to a user

”Managing Tasks” on page 286

Delete

Open View Content page. From it,
you can delete the content.

”Viewing Content” on page 40

Edit

Check out content for editing

”Editing HTML Content” on
page 52

Hide Border

Hide the colored border around
content when a user is logged in

”Hiding and Showing the
Content Border” on page 5

Important! When you hide the border,
the Add and Edit buttons for menus
are also hidden.
Logout

Log out of Ek tr on CMS 400 .NET
view of Web site

”Logging Out of the Sample
Site” on page 14

New Poll

Create new poll or survey

”Creating Polls and Surveys” on
page 214

Preview

Preview content before it is published

”Site Preview” on page 13

Properties

Open content’s View Content page

”Viewing Content” on page 40
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Button

Name

Description

More Information

Show
Border

Show a colored border around
content when you are logged in

”Hiding and Showing the
Content Border” on page 5

Important! When you hide the border,
the Add and Edit buttons for menus
are also hidden.
View
Content
Difference

Display differences between a
previous and the currently published
version of content

”Comparing Versions of
Content” on page 98

View History

Open View History screen, where you
can view previous versions of content

”Viewing and Restoring
Previous Content” on page 108

Workarea

Open Workarea. From here, you can
perform all Ek tron CM S40 0.NET
tasks.

”The Workarea and Smart
Desktop” on page 15

Hiding and Showing the Content Border
IMPORTANT!

When changing the border to hidden, the Add and Edit buttons for menus are
also hidden. This displays the page as it appears when you are not logged in. For
information on menus, see ”Working with Menus” on page 444.

You can hide the border that may surround content when you are
logged into Ektron CMS400.NET. This lets you view the page as it
appears when not logged in.
When the border is hidden and you hover over a content area,
there is no indication that it is CMS400 content. However, you can
still right click to access the menu.
TECHNICAL NOTE

Information about whether a border is hidden is stored in a cookie on a user’s
system. This preserves the information between sessions.

Hiding the Border
To hide the content border, right click a content block while logged
in. Next, select Hide Borders. The page refreshes, and no border
appears.
This image shows the content with a border and menu.
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This image shows the same content without the border.

Showing the Border
To show the border, right click a content block while logged into
Ektron CMS400.NET. Next, select Show Borders. The page
refreshes, and the border appears.
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Types of Content
Every piece of content in Ektron CMS400.NET is one of the
following types. The table below summarizes all types.

Type

Description

For more information, see

HTML content

Content designed to be published on the
World Wide Web

E ktron CM S40 0. NET ’s editor,

For information on using
see ”Introduction to
eWebEditPro+XML” on
page 626.

XML Smart Forms

Online forms, polls, or surveys designed to
collect information from site visitors and save
it in an XML format

E ktron CM S40 0. NET

HTML form/survey

Online forms, polls, or surveys designed to
collect information from site visitors and save
it in an HTML format

”Working with HTML Forms” on
page 156

DMS Documents,
which consist of Office
documents, managed
files, and multimedia
files

See details below

Office documents

Files normally created and edited using
Microsoft Office

”Working with Microsoft Office
Documents” on page 227

Managed files

Files created outside of E kt ro n
C M S 4 0 0 . N E T , such as PDFs and .jpeg files.
You cannot create or edit these files within
Ek tron CM S40 0.NET - you can only store
them.

”Working with Managed Files”
on page 253

Multimedia

Files that run in a media player, such as
sound and movie files

E ktron CM S40 0. NET

Administrator Manual Section
“Managing Content Folders” >
“Smart Forms”

Administrator Manual section
“Managing Assets“> “Managing
Multimedia Assets'”

When creating new content, you must assign a type.
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As you can see, the New menu lists all types of content you can
work with.

Workflow in Ektron CMS400.NET
Organizations typically want a Web site that is updated frequently
with the latest information. They also want to decentralize the
update process, so that non-technical users from any department
can make changes. Further, organizations want oversight over
those changes to ensure the accuracy of the information, that the
content adheres to corporate guidelines, etc.
Ektron CMS400.NET manages the lifecycle of content, from

creation through approval and publication. It helps your
organization set up a process for overseeing changes to a Web
site, indicate content’s status within that lifecycle, and inform the
next approver that it is their turn to review the content.
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Editing Content
Finding Content
Much of your work involves editing existing content or creating new
content. Ektron CMS400.NET provides three methods for finding
content to be updated. You can use whichever method is easiest.

• Navigate through your Web site to the content you want to edit
• Find the content through the Workarea, which resembles
Windows Explorer and helps you find content by navigating
through a folder tree. See Also: ”The Workarea and Smart
Desktop” on page 15

• Use the Search button (

), which appears on many screens.
When clicked, a screen prompts you to enter keywords and
then finds content containing the keywords.

The Editing Process
After you find content, click the Edit button ( ) or menu option to
open it in an editor. Below is an example of content within the
editor.

The editor resembles popular word processing software. You can
enter text, then select it and click a button to change its display
properties. For example, you can make text bold, change the color,
or copy and paste it. You can also insert images, tables, links to
other Web pages, and check spelling. See Also: ”Introduction to
Ektron CMS400.NET Editors” on page 486
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The Lifecycle of Content
After you edit content, you typically submit it for approval to one or
more individuals who oversee changes to your Web site. These
people can review, edit and approve the change. When the last
approver signs off, the new content becomes available on the Web
site.
In some cases, you are one of the content approvers. In this case,
you receive an email notifying you that content needs approval.
You look it over, change it as needed, then pass it on to the next
approver. If you do not agree with the changes, you can decline the
request. In this case, the user who made the edits is informed that
the change is not approved.
The following graphic illustrates the content approval cycle.

To help track content’s position in this workflow, Ektron
CMS400.NET assigns a status to each content item. The status
determines what you can do with it, and indicates what must occur
in order for it to get published to the Web site. For more
information, see ”Appendix A: Content Statuses” on page 798.
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Logging In and Out

This section explains how to log in and out of Ektron CMS400.NET,
and to use the site preview feature through the following subtopics.

• ”Prerequisites” on page 11
• ”Logging into the Sample Web Site” on page 11
• ”Site Preview” on page 13
• ”Logging Out of the Sample Site” on page 14

Prerequisites
Once your Webmaster or administrator installs Ektron
CMS400.NET, you need the following items before you can use it.

• URL (Web address) of Ektron CMS400.NET Web site
• Username and password
Once you acquire both, you can log into Ektron CMS400.NET and
begin managing Web site content.

Logging into the Sample Web Site
To access the Ektron CMS400.NET sample site, follow these
steps.
1. In your Web browser, navigate to the URL of your Ektron
CMS400.NET Web site. Your system administrator provides
this.
2. Click the Login button on the screen.
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3. The Login dialog box appears.

4. Enter your username and password.
If you are using one of Ektron’s sample sites, you can use any of
three standard users that demonstrate Ektron’s flexible userpermissions model. The table below lists the username and
password needed to log in as each user type, as well as the
permissions assigned to each user.

User Type

Username

Password

Permissions

Administrator

admin

admin

All

Standard user

jedit

jedit

Basic (for example, add/edit content,
manage library files, etc.)

Membership user

jmember

jmember

Read-only permission to private content

5. Click the Login button.
6. The Web page appears.
You can navigate around your Web site as you could before
signing in. But now, the content is surrounded by a colored box
when you move the cursor over it (illustrated below).
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Site Preview
While logged into Ektron CMS400.NET, you can preview the Web
site as it would appear to visitors, or view it in regular view.
Button
Appearance

Status

Description

Preview
Mode

Content appears as last edited. The advantage of this mode is
that you can see a Web page as it will appear when published
to your site. Continue editing until you are satisfied with its
appearance.
In Preview mode, click the Preview button to switch to regular
mode.

Regular View

The most recently published version of content appears.
In this mode, colored borders surround content when you
move the cursor over it.
In regular view, click the Preview button to switch to preview
mode.

Toggling Site Preview
To toggle site preview on and off, follow these steps.
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1. Navigate to a page that includes the login/logout button.
2. Click the Preview button.

3. The Web site is now in preview mode.

4. To turn preview mode off, click the (
login screen.

) button on the

Logging Out of the Sample Site
To log out of Ektron CMS400.NET, follow these steps.
1. Click the Logout button (

) in the content’s floating toolbar,

or click the Logout button (

) on the Web page.

2. The Logout confirmation box appears.

3. Click the Logout button.
4. You return to the Web page from which you logged out.
However, it is in standard view, not Ektron CMS400.NET view.
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The Workarea and Smart
Desktop

The Workarea is a central screen from which you perform all
Ektron CMS400.NET activities. From it, you can

• access the Smart Desktop
• view the system’s top level folders
• navigate through the folder structure
• perform actions on content
This chapter describes using the Workarea and Smart Desktop
through the following subtopics.

• ”Accessing the Workarea” on page 15
• ”Understanding the Smart Desktop” on page 17
• ”Navigating Within the Smart Desktop” on page 20
• ”Sending Instant Email” on page 25

Accessing the Workarea
To access your Workarea, follow these steps.
1. Click the Workarea button at the bottom of the screen
(
) or the Workarea button (
floating toolbar.

) in the content’s

2. The Workarea appears.
3. The following illustrates one of several screens that may
appear in the Workarea. Your system administrator determines
which screen appears for you.
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Closing the Workarea
To close the Workarea, click
in the upper right corner of the
window. When you close the Workarea, you return to the Ektron
Ektron CMS40 0.NET User Manua l, Version 7.5
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CMS400.NET view of your Web site. You do not exit Ektron
CMS400.NET.

Understanding the Smart Desktop
The Smart Desktop is one of Ektron CMS400.NET’s main screens.
To access it from wherever you are working in Ektron CMS400.NET,
click the button in the top left corner (circled below).

The Smart Desktop consists of three sections, illustrated below.
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• The right frame displays
- Content awaiting approval - content you need to approve
before it proceeds to the next approver or is published if
you are the final approver.See Also: The Ektron
CMS400.NET Administrator Manual > “Content Reports” >
“Approvals Reports”

- Content currently checked out - all content in a checkedout status. This content cannot be edited by other users
until the user who checked it out or the system
administrator checks it in.See Also: The Ektron
CMS400.NET Administrator Manual > “Content Reports” >
“Checked Out Report”
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- A list of tasks assigned to you See Also: ”Managing Tasks”
on page 286

- Any form submission tasks assigned to you See Also:
”Assigning a Task to a Form” on page 195

- The Content to Expire Report -See Also: The Ektron
CMS400.NET Administrator Manual > “Content Reports” >

“Content to Expire Report”

- Forum Post - A list of Forum Posts that are awaiting
approval. Posts need approval when Forums are using the
Moderate Comments feature. See Also: The Ektron
CMS400.NET Administrator Manual > “Discussion Boards” >
“Implementing Discussion Boards” > “Working with Posts”
> “Approving a Post”

- Content Review - A list of Content Reviews awaiting
approval. Content Reviews need approval when the
ContentReview server control’s Moderate property is set to
True. See Also: The Ektron CMS400.NET Administrator
Manual > “Managing HTML Content” > “Content Rating” >
“Viewing the Content Rating Report” > “Moderating
Reviews” > “Moderating Reviews From the Smart Desktop”

- Content Flags - Content flagged by a site visitor for review.
See Also: Ektron CMS400.NET Administrator Manual
section “Community Management” > “Flagging”
NOTE

The number to the right of each category lists the quantity of content items in that
category for you. When you click an item, up to five content items in a category
appear. To perform tasks on that content, and to view additional content in that
category, click the category.

If you select a folder from the left frame, the right frame
displays content in that folder. If you select content from the list,
information about it fills the right frame.

• The top left frame displays the folder tree for the Smart
Desktop folder, which has three subfolders

- Tasks (See ”Managing Tasks” on page 286)
- Content Reports (see “Content Reports” in the Ektron
CMS400.NET Administrator Manual )

- Community Messaging (see ”Messaging” on page 390)
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• The bottom left frame displays the top-level folders in Ektron
CMS400.NET. Your display may be different depending on

whether you are an administrator.

- Content folder (see ”Working with Folders and Content” on
page 28)

- Forms folder (see ”Working with HTML Forms” on page 156)
- ”Library Folder” on page 131
- Modules (see “Membership Users and Groups” and
“Business Rules” sections of the Ektron CMS400.NET
Administrator Manual)

- Settings folder, which includes ”Updating Your User Profile”
on page 477 and ”Accessing Online Help” on page 483

Navigating Within the Smart Desktop
Ektron CMS400.NET’s top level folders appear in the lower left

corner of the Smart Desktop. Use them to access all other folders.
To open any top level folder, click it. When you do, it appears in the
frame above. Typically, you would a click top-level folder to see its
subfolders, then click a subfolder to see its content.
The following graphic illustrates the location of Ektron
CMS400.NET’s major features from the Smart Desktop.
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From the Smart Desktop, you can also:

• ”Modify the Display of Top Level Folders” on page 21
• ”Hide the Left Panel of the Workarea” on page 23

Modify the Display of Top Level Folders
The display of top level folders can appear in two formats.
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Format

Illustration

A full button with an icon and text

An icon on the bottom of the left frame

The full display is easier to see, but the icon format allows more
space for the folder structure. You can decide which option best
suits your needs.

Switching Between Full Buttons and Icons
By default, top-level folders appear as full buttons. To switch the
display of all folders to icons, double click the down arrow circled
below.

To switch back to full buttons, double click the up arrow circled
above.
You can also switch the display of folders one at a time by clicking
the up or down arrow.
As an alternative method of switching the display, you can
1. Place the cursor on the bar above the display of top-level
folders. (The bar has several dots in the middle.)
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2. When the cursor turns to a double headed arrow, drag it to the
bottom bar.
To return the display to full buttons, drag the same bar above.

Hide the Left Panel of the Workarea
You can hide the left frame of the Workarea to provide more space
for working in the right frame. Below is an example of the
Workarea with a minimized left frame. Note that you cannot see
the folder display in the left frame.

To minimize the left frame, click the white X near the top of the left
frame.
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The left frame remains minimized until you move the cursor to the
left of the bar circled below.

Using Autohide
The Workarea screen also provides an autohide feature, which
quickly switches between full right frame view and combination
right-left frame view.
When autohide is turned on, the left frame is minimized unless you
place the cursor to the left of the bar circled above. If you place the
cursor there, the left frame appears. As soon as you move the
cursor back to the right frame, the left frame disappears.
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To turn on the autohide feature, click the push pin icon near the top
of the left frame.

When you do, the push pin turns 90 degrees to indicate autohide is
on.

To turn off autohide, move the cursor to the left frame and click the
push pin icon. When you do, the push pin returns to its original
position.

Sending Instant Email
Ektron CMS400.NET lets you send email instantly to a user or user

group from many screens available from the Smart Desktop. Your
ability to send instant mail is indicated by a small mail icon next to
a user or group name (indicated in red below).

When you click a user/group name or email icon, the email screen
appears, as shown below. Once you complete the screen and click
Send, an email is sent to designated users.
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Conditions for Instant eMail
• You must have a valid email address set up in the user profile.
If not, email icons do not appear in Ektron CMS400.NET. See
Also: ”Updating Your User Profile” on page 477

• Your system administrator must enable the feature.

Where Instant email is Available
Instant email is available from several screens that display users
and user groups. Typically, you click a user name or the email icon
to launch an email. Screens in the following Ektron CMS400.NET
features support instant email.

• Smart Desktop
• Tasks
• Approvals
• Reports
• User and user group setup
Wherever instant email is available, one of the email icons
appears.
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Modifying Instant eMail
When the email screen appears, the following information is
copied from Ektron CMS400.NET into the email.
Field

Source of Default Information

Editable?

To

User you selected to receive the email. If the user does
not have valid email address, an error message appears
on the screen (see below). If you then insert a valid
email address, the email is sent.

Yes.
If desired, you
can add
recipients by
typing them
into this field.

If you specify a group to receive the message, as long
as one group member has a valid email address, all
group members with valid addresses receive the email.
From

You

No

Subject

If the email message is linked to content, its title
appears.

Yes

Body of
message

If the email message is linked to content, a link to the
content appears.

Yes
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Working with Folders and
Content

Every content item resides in the Content folder or one of its
subfolders. So, to work with existing content or create a new
content, you must first navigate to its folder.
A typical content folder screen appears below. It consists of three
sections:

• The top left frame shows the folder structure. You can click any
folder to display its content in the right frame, while its
subfolders appear below it.

• The right frame shows content in the currently selected folder.
Above is a set of menus that let you perform tasks on the
content.

• The lower left frame shows Ektron CMS400.NET’s top level
folders
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In this chapter, you learn about adding, editing, publishing, and
deleting content through the following subtopics. (Permissions and
Approvals are explained in the Ektron CMS400.NET Administrator
manual .)

• ”Viewing a Folder” on page 30
• ”Workarea Toolbar Buttons” on page 60
• ”Deleting a Folder” on page 40
• ”Viewing Content” on page 40
• ”Expanding the Content Area” on page 46
• ”Adding HTML Content” on page 48
• ”Editing HTML Content” on page 52
• ”Deleting Content” on page 57
• ”Workarea Toolbar Buttons” on page 60
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Viewing a Folder
To view any folder under the content folder, follow these steps.
1. Access the Workarea, as described in ”Site Preview” on
page 13.
2. Click Content from the left lower side of the Workarea.

3. All content in the root folder and the selected language appear
in the right frame. Subfolders appear in the upper left frame.
NOTE

The View menu option lets you filter content by type. For example, you can set it
to view only HTML content. Therefore, you may only see content of a selected
type in the folder. See Also: ”View Menu” on page 33

4. To work with any folder or its content, click the folder. When you
do, its content appears in the right frame.
NOTE

You can only view folders for which your system administrator has granted
permission.

5. If your system supports more than one language, you can
select content for a particular language or all languages using
the View > Language menu option (illustrated below).
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Each folder lists the following information about its content.
Field

Description

Title

The name of the content.

Language

The language of the content.

ID

The number assigned to the content by Ektron
CMS400.NET. It is used to retrieve the content from a
database.

Status

The status of the content. See Also: ”Appendix A:
Content Statuses” on page 798

Date
Modified

The most recent date the content was added, edited, or
published.
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Field

Description

Last Editor

The last user who accessed the content.

The following menus and button appear across the top of the View
Contents of Folder screen.

NOTE

Depending on your permissions, you may not see all menu options.

• ”New Menu” on page 32
• ”View Menu” on page 33
• ”Delete Menu” on page 34
• ”Action Menu” on page 35
• Add Asset button (

) See ”Adding Documents Using Drag
and Drop” on page 235

• ”Content Dropdown Menu” on page 35

New Menu
Menu Option

Lets you create or upload
this new item into folder

For more information, see

Folder

Folder

”Workarea Toolbar Buttons” on page 60

Blog

Blog

”Blogs” on page 312

Discussion Board

Discussion Board

E ktron CM S40 0. NET Administrator

Manual Section “Discussion Boards”
”Discussion Boards” on page 471
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Menu Option

Lets you create or upload
this new item into folder

For more information, see

Community Folder

Folder whose content can be
updated by membership as well
as regular users

E ktron CM S40 0. NET Administrator

HTML Content

HTML content

”Adding HTML Content” on page 48

HTML Form/Survey

HTML Form, Poll, or Survey

”Working with HTML Forms” on page 156

Smart Form

Smart Form

E ktron CM S40 0. NET Administrator

Manual Section “Managing Content
Folders” > “Community Folders”

Manual Section “Managing Content
Folders” > “Smart Forms”
DMS Document

•
•
•

Office Document

•

Managed file, any supported type

”Working with Microsoft Office Documents” on page 227

•

”Working with Managed Files” on
page 253

Multimedia file, any supported type

Multiple DMS
Documents

Several Office documents,
managed files, multimedia files

”Adding Documents Using the Multiple
DMS Documents Option” on page 233

Collection

Collection

”Working with Collections” on page 424

Menu

Menu

”Working with Menus” on page 444

View Menu
The View Menu provides the following functions.

Menu Option

Function

All types

Displays all content types of selected
language.

Ektron CMS40 0.NET User Manua l, Version 7.5

For more information, see

33

Viewing a Folder

Menu Option

Function

•

HTML content

•
•

HTML Form/Survey

Limits folder display to selected content
type. For example, choose View > DMS
Document and see only managed
assets in the folder -- other content types
are suppressed.

DMS Document,
which includes Office
Documents, Managed Files, Multimedia, Open Office

For more information, see

This is especially helpful if the folder has
a lot of items, and you are looking for
only one type of content.
Note that the icon for the selected type
appears to the left of View, as illustrated
below.

Language

Limits display of content within folder to
one language. Also, sets language of
new items you create or upload into the
folder.

Menus

Lets user view and work with menus
assigned to this folder

”Working with Menus” on
page 444

Collections

Lets user view and work with Collections
assigned to this folder

”Working with Collections” on
page 424

Archived Content

Lets user view and work with content that
passed its scheduled End Date and
whose archive option is either Archive
and remove from site or Archive and
remain on Site.

”Setting Archive Options” on
page 69

Folder Properties

Only system administrators see this
option. It lets you assign folder
properties, such as which users can edit
a folder’s content.

The Ek tr on CMS 400 .NET
Administrator Manual section
“Managing Content“ >
“Managing Content Folders” >
“Folder Properties”

Delete Menu
This menu lets you perform the following functions.
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Menu option

Lets you

For more information, see

Delete this
folder

Delete current folder and all of its content

”Deleting a Folder” on page 40

Note: You cannot delete the Root folder.
Delete content

Delete one or more content items in
folder

”Deleting Content” on page 57

Action Menu
This menu lets you perform the following functions.

Menu option

Lets you

More Information

Export for
translation

Prepare content for translation by a
translation agency

E ktron CM S40 0. NET Administrator

Search

Search content in the Workarea

”Searching the Workarea” on page 114

Manual section “Multi-Language
Support” > “Using the Language Export
Feature”

Content Dropdown Menu
The View Contents of Folder screen features a context-sensitive,
dropdown menu of options you can perform for a content item.
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The options depend on several factors, such as

• your folder permissions
• your position in the approval chain (if any)
• the content’s status
• whether the item is a Microsoft Office document
To see the dropdown menu options for any content item, follow
these steps.
1. After signing in, navigate to a Web page or the folder that
contains the content.
2. Hover the cursor over the content item. It is surrounded by a
blue rectangle, and a triangle appears to the right of the title.

3. Hover the cursor over the triangle (
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4. A menu of options available for that content item appears. For
example, if you have permission to edit it, Edit appears on the
dropdown menu.

Dropdown Menu Options

Option

Allows you to...

For more information, see

Approve

Approve content that has been submitted for
publishing

”Approving/Declining Content”
on page 87

Check in

Change status of selected content to checked in.
Might use if you checked out and saved a
document then it became lost or corrupted.

”Checked-In Content” on
page 800

This option changes original document’s status to
checked in. However, it does not replace the
version of the file in E ktron CM S40 0. NET . To
replace content that was checked out and edited,
drag and drop it into Ek tr on CMS 40 0.NET . See
Also: ”Checking Out, Saving, and Replacing an
Office Document” on page 247
Note: Previous Ek tron CM S40 0.NET releases
included a Work Offline option, whose Check In
function replaced the version of the file in E kt r o n
C M S 4 0 0 . N E T . In contrast, this release’s Check In
function only changes the content’s status.
Check out
and Save As

Change a content item’s status to checked out and
save it to your local computer. When you finish
editing the item, drag and drop it into E k t r o n
CMS400.NET.
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Option

Allows you to...

For more information, see

Decline

Decline an approval request submitted to you.
This option reject the changes and keeps the
current version live on Web site. You are prompted
to enter a reason for the decline.

”Approving/Declining Content”
on page 87

After you decline

•

The author who made the change is notified
by email

•

The content is removed from the Approval
Chain

If the author updated content then submitted it for
approval, the updated content remains in the file. If
you do not want it to remain, choose the Edit
option.
You may be asked to decline both a content
change and a request to delete content.
Delete

Edit

Submit content for deletion.

•

HTML, HTML form, or XML Smart Form content - edit content within an Ek tr on
C M S 4 0 0 . N E T editor

•

Asset - First, use Check out and Save As or
Save As to save asset to your computer and
edit it. Then, use Edit to replace version in
Ek tron CM S40 0.NET .

•

”Deleting a Single Content
Item” on page 57

•

”Deleting an Office Document” on page 246

•

”Deleting a Managed File”
on page 257

•

”Editing HTML Content” on
page 52

•

”Editing a Form” on
page 210

•

”Editing a Managed File” on
page 256

Edit in
Microsoft
Office

Edit Office document within Ek tr on
C M S 4 0 0 . N E T , which launches Office

”Editing an Office Document” on
page 244

Edit
Properties

Edit item’s Ek tr on CMS 400 .NET information,
such as Summary, Metadata, Schedule, and
Taxonomy.

”After you select the content,
you have the following options.”
on page 43

After you complete the edit screen, you proceed to
the View Content screen. From here, you can
perform additional content activities, such as
move/copy, delete, and view history.
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Option

Allows you to...

Force Check
In

Only appears if user is a member of the
Administrator group and content is checked out.

For more information, see

Allows an admin to check in content even though
he is not the one who checked it out.
Publish

Accept changes to content and publish it to the
site.

Request
Check In

Allows either admin user or non-admin user with
edit permission for the content’s folder to email the
user who checked out content. The email asks the
check-out user to check it in.

Save As

Save Office document or asset to your computer.

”Saving an Office Document” on
page 249

Submit

Submit current version of content for publishing.
When you do this, the next person in the Approval
Chain is notified that your content is ready for
review.

”Asset Workflow” on page 258

View

View item’s E k t r o n C M S 4 0 0 . N E T information,
such as Summary, Metadata, Schedule, and
Taxonomy. After viewing, you can also edit that
information if you have permission.

”After you select the content,
you have the following options.”
on page 43

Next, you proceed to the View Content screen.
From here, you can perform additional content
activities, such as move/copy, delete, and view its
history.
View in
Microsoft
Office

View Office document within Office application.
Cannot change.

View
Properties

View Office document’s E k t r o n C M S 4 0 0 . N E T
information, such as Summary, Metadata,
Schedule, and Taxonomy. After viewing, you can
also edit that information if you have permission.

”After you select the content,
you have the following options.”
on page 43

After you complete the edit screen, you proceed to
the View Content screen. From here, you can
perform additional content activities, such as
move/copy, delete, and view its history.
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Adding a Subfolder
Since the procedure for adding new folders is usually only granted
to administrators, it is documented in the Ektron CMS400.NET
Administrator manual section “Managing Content Folders” >
“Adding Subfolders.”

Deleting a Folder
Since the procedure for adding new folders is usually only granted
to administrators, it is documented in the Ektron CMS400.NET
Administrator manual section “Managing Content Folders” >
“Deleting Subfolders.”

Viewing Content
You can view all content in your Ektron CMS400.NET Web site.
Viewing content allows you to see the content, metadata,
summaries, and other information.

Viewing Content from a Web Page
To view content from a Web page, follow these steps.
1. Sign in.
2. Browse to the content you want to view.
3. Right click the mouse.
4. Click Properties.
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5. Continue reading from ”The View Content screen appears.” on
page 43.

Viewing Content from the Workarea
1. Navigate to the folder that contains the content, as explained in
”Viewing a Folder” on page 30.
2. The icon to the left of View indicates the type of content being
displayed. Icons are described below.

Icon

Content Type
All types

HTML

HTML form or survey

DMS document

To change the type of content being displayed, click View then
select a type.
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3. If your system supports more than one language, you can view
only content in any language via the View > Language menu
option (illustrated below).

4. Hover the cursor over the content, click the triangle (
select View from the dropdown menu.
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Alternatively, click the content’s title.
5. The View Content screen appears.

NOTE

You can also click the content title to access the View screen.

After you select the content, you have the following options.
Your options depend on your permissions and the status of the
content.

Button or
Tab

Name

Description

For more information, see

Properties
tab

Content
Properties

View the content’s properties

”Properties” on page 45

Content tab

View Content

Displays content

Summary
tab

Edit Summary

Edit content’s summary
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Button or
Tab

Name

Description

For more information, see

Metadata tab

Edit Metadata

Edit content’s metadata

”Adding or Editing Metadata” on
page 77

Comment
tab

View Comment

View comments on changes
made when editing content.
This comment also appears on
the View Content and Content
History screens. Use it to help
distinguish one version from
another.

Tasks tab

Add/edit tasks

Add or edit tasks for this content

”Managing Tasks” on page 286

Web Alerts
tab

Add/edit Web
Alerts

Add or edit Web Alerts for this
content

E ktron CM S40 0. NET

Templates
tab

Add/edit
Templates

The template currently assigned
to the content.

The Ek tr on CMS 400 .NET
Administrator Manual section
“Managing HTML Content” >
“Creating/Updating Templates”

Category tab

Add/edit
Taxonomy
Category

Any taxonomy categories
currently assigned to the
content.

The Ek tr on CMS 400 .NET
Administrator Manual section
“Taxonomy”

Edit Content

Open content for editing

”Editing HTML Content” on
page 52

View History

View older versions of content;
restore older version

”Viewing and Restoring
Previous Content” on page 108

View Staged

Displays staged content

”Staged Content” on page 806

View Difference

Compares current and earlier
versions of content

”Comparing Versions of
Content” on page 98

Delete

Delete content

”Deleting Content” on page 57

Check for
content linked to
this content

Identify all content with
Quicklinks to this content

”Checking for Broken
Quicklinks” on page 59
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Button or
Tab

Name

Description

For more information, see

Add Task

Attach a task to content

”Task Module Toolbar” on
page 311

Return

Go back to previous menu

View
(language)

View

If you can view content in more
than one language, select a
language from the drop down
list.

Add

Add

-select
language-

-select
language-

Lets you copy current content
into a new item and translate it
to selected language.

”Translating Content to Another
Language” on page 55

Properties
The content properties screen contains information about the
content.
Field

Description

Content Title

The title assigned to the content

Content ID

The ID number assigned to the content. The ID number is used to retrieve
content from a database.

Content language

The content’s language

Status

The current status of the content
See Also: ”Appendix A: Content Statuses” on page 798

Last User to Edit

The last user to edit this content

Last Edit Date

When the content was last edited

Start Date

When the content will go live on the Web site

End Date

When the content will be removed from the Web site
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Field

Description

Action on End Date

What happens to the content when its end date and time are reached. See
Also: ”Setting Archive Options” on page 69

Date Created

When the content was created

Approval Method

Whether all approvers must sign off on content before it is published;
managed by your system administrator.

Approvals

The users in the approval chain for this content. See Also: ”Approving/
Declining Content” on page 87

Smart Form
Configuration

The Smart Form applied to the content. This is typically managed by your
system administrator. See Also: E kt r o n C M S 4 0 0 . N E T Administrator Manual
Section “Managing Content Folders” > “Smart Forms”

Template

The template currently assigned to the content. This is typically managed by
your system administrator. See Also: The E kt r o n C M S 4 0 0. NE T
Administrator Manual section “Managing HTML Content” > “Creating/
Updating Templates”

Path

The folder path to the content’s folder. A slash (\) represents the Content
folder.

Rating

E k t r o n C M S 4 0 0 . N E T provides a Content Rating feature that lets site visitors

rate any content item on a scale of 1 to 10. If this feature is enabled for the
content item, the average numerical rating appears. See Also: E kt r o n
C M S 4 0 0 . N E T Administrator Manual section “Managing Content” > “Content
Rating”
Content Searchable

True appears if the content can be found when someone searches your Web
site.
However, even if content is not searchable, the Workarea Advanced search
still finds it. See Also: ”The Advanced Search Tab” on page 119

Expanding the Content Area
You can vertically expand the content area of the screen. This
gives you more space to work on content. To expand the content
portion of the Workarea, click the up arrow (
), highlighted
below.
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Once the content area is expanded, the top row of buttons and title
are not visible.

Click the down arrow (
) to return the content area to normal
size. The top row of buttons and title return.
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Adding HTML Content
You can only add content to a folder if you have permission to do
so. The following flowchart illustrates a typical sequence of events
when working with content.

After you create content, you or your system administrator typically
make it available on the site. For example, you can add a hyperlink
to it from another page, or place it in a collection or menu. Your
administrator can add it to a list summary or content list.
NOTE

Only users with Add permission for a folder can add content to it. See Also:
Ektron CMS400.NET Administrator Manual chapter “Setting Permissions”

NOTE

This section only explains how to create HTML content. The procedure for
creating/uploading other types content are listed in the table below.

To add HTML content, follow these steps.
1. Browse to the folder where you want to create the new content.
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2. Click View > Language and select a language from the list.

3. Click New > HTML Content.

4. The Edit Content window opens.
5. Create content in the editor using the following table.

Ektron CMS40 0.NET User Manua l, Version 7.5

49

Adding HTML Content

Responding to the Fields on the Add Content Screen

Field

Description

Title

Enter a title for the content.

Add to Quicklinks Table

Note: This checkbox only appears if you are a member of the
Administrators User Group.
Check if you want to create a Quicklink to this content. If you do,
users can insert links to this content from within other E kt ro n
C M S 4 0 0 . N E T content items
See Also: ”A quicklink is a special kind of hyperlink that jumps to
another content item on your Web site. (A regular hyperlink jumps to
a Web page on the internet.)” on page 132

Content Searchable

Note: This checkbox only appears if you are a member of the
Administrators User Group.
Check this box if the content should be found when someone
searches your Web site. However, even if content is not
searchdisplay‘

•
•

the Workarea Advanced search still finds it. See Also: ”The
Advanced Search Tab” on page 119
it can appear among Suggested Results. See Also: E kt r o n
C M S 4 0 0 . N E T Administrator Manual section “Searching Your

Web Site” > “Suggested Results”

After you respond to the above fields, the following buttons are
available.

Buttons on the Add Content Screen

Button

Name

Description

Submit

Submit the content into the approval chain. This action also returns the
new or updated content to the database and exits the editor.
See Also: ”Approving/Declining Content” on page 87
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Button

Name

Description

Publish

Publish the content to the Web site.
Note: Only the last approver in the approval chain sees this button. If no
approval chain is assigned to the content’s folder, every authorized user
sees this button.
See Also: ”Approving/Declining Content” on page 87
This action also returns the changed content to the database and exits
the editor.

Check In

Save and check-in the document. This action returns the changed
content to the database and exits the editor. It does not submit the
content into the approval chain. Rather, it allows you and other users to
continue changing it.

Save

Save the content without leaving the editor. It is a good idea to save your
work frequently.

Cancel

Close the editor without saving changes.

Tabs on the Edit Content Screen

Tab

Description

Content

Insert content. For more information about using E k t r o n C M S 4 0 0 . N E T ’s
editors, see ”Introduction to Ektron CMS400.NET Editors” on page 486.

Summary

Enter or edit the content summary.
See Also: ”Adding a Content Summary” on page 73

Metadata

Enter or edit the content metadata.
Note: All required metadata must be added before content can be checked in
or submitted into the approval chain.
See Also: ”Adding or Editing Metadata” on page 77
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Tab

Description

Comment

Briefly describe the content, or comment on changes made when editing
content.
The history comment appears on the View Content and Content History
screens.

Schedule

Use this tab to set a future publication date/time. In order to be published, this
content must be approved and reach its publication date/time.
See Also: ”Scheduling Content to Begin and End” on page 65
If appropriate, enter a date when the content will no longer be viewable on the
Web site.
See Also: ”Setting an End Date on Content” on page 68

Web Alerts

See the Ek tron CM S40 0.NET Administrator Manual chapter “Web Alert
Feature”

Templates

This content’s folder must have a default template. It can also have additional
templates assigned.
When content is created, the default template is automatically assigned to it. If
you want to change the template assigned to this content, click this tab and
choose a template from the dropdown list.
See Also: Ek tr on CMS 400 .NET Administrator Manual section “Managing
HTML Content” > “Creating/Updating Templates”

Category

Assign taxonomy categories to this content. See Also: Ek tron CM S40 0. NET
Administrator Manual chapter “Taxonomy.”

Editing HTML Content
Ektron CMS400.NET HTML content can be in any of several
statuses, as described in ”Appendix A: Content Statuses” on
page 798. You can only edit content for which you have permission
and in one of the following statuses:

• published
• checked in
• checked out by you
• submitted for your approval
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NOTE

If you check content out, you or a member of the Administrators group must check
it in before other users can edit it.

NOTE

The ability to edit content is a privilege granted by the system administrator. If you
do not see an Edit option on the dropdown menu, you do not have permission to
do so.

See Also:

• ”Editing a Form” on page 210
• ”Translating Content to Another Language” on page 55
• ”Editing an Office Document” on page 244
• ”Editing a Managed File” on page 256

Steps in Editing HTML Content
There are two ways to edit content:

• from a web page after you log in
• from the Ektron CMS400.NET Workarea
Each is now explained.

Accessing the Edit Content Screen from a Web Page
To access the Edit Content screen from a Web page, follow these
steps.
1. Browse to the content you want to edit.
2. Click Edit from the menu options.
3. The Edit Content in Folder screen appears. From here, you can

•edit content
•create or edit a summary
•specify metadata for the content
•enter or update a comment
•enter or update start and end dates
•review and update Web Alert information (To learn more, see
the Ektron CMS400.NET Administrator manual chapter “Web
Alert Feature”)
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•if manual aliasing is enabled, an Alias tab appears (To learn
more, see the Ektron CMS400.NET Administrator Manual
section “URL Aliasing” > “Manual Aliasing” )

•assign or change available templates (To learn more, see the
Ektron CMS400.NET Administrator Manual section “Managing

HTML Content” > “Creating/Updating Templates” )

•assign taxonomy categories (To learn more, see the Ektron
CMS400.NET Administrator Manual section “Taxonomy”)
•save changes
•check in content
•submit content for approval
•publish content to the Web site
•access the library
4. Edit the content. See Also: ”Table of Toolbar Buttons and DropDown Lists” on page 633
Or, you can choose a toolbar option or tab from the top of the
Edit Content window. These options are described in ”Buttons
on the Add Content Screen” on page 50 and ”Tabs on the Edit
Content Screen” on page 51.

Accessing the Edit Content Screen from the Workarea
To access the Edit Content screen from the Workarea, follow these
steps.
1. Access the View Content screen for the folder that contains the
content you want to edit, as described in ”Viewing Content” on
page 40.
2. Select View > Language then the language whose content
you want to view.
3. Hover the cursor over the triangle (

) and click.

4. Select Edit from the menu.
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5. The editor opens with the content block inserted.
6. From the Edit Content window, you can

• edit content
• create or edit a summary
• specify metadata for the content
• enter or update a comment
• enter or update start and end dates
• review and update Web Alert information (To learn more,
see the Ektron CMS400.NET Administrator manual chapter
“Web Alert Feature”)

• review and update templates (To learn more, see the
Ektron CMS400.NET Administrator Manual section “Managing

HTML Content” > “Creating/Updating Templates” )

• review and update categories (To learn more, see the
Ektron CMS400.NET Administrator manual chapter “Taxonomy”)

• save changes
• check in content
• submit content for approval
• publish content to the Web site
• access the library
7. Make the necessary edits to the content.
Or, you can choose a toolbar option or tab from the top of the
Edit Content window. These options are described in ”Buttons
on the Add Content Screen” on page 50 and ”Tabs on the Edit
Content Screen” on page 51.

Translating Content to Another Language
NOTE

The following procedure only works with HTML or XML content. You cannot
translate other file types as described below.

Use this procedure when you want to initialize a new foreign
language content item with content from a source language. This
copying should facilitate the translation.
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For example, an editor is translating content from French to
German. The editor copies the French edition to new content
whose language is German. As the editor translates the French
edition into German, he deletes the French content. Any images in
the content would usually remain, and all formatting (tables,
bullets, etc.) is retained.
NOTE

Ektron CMS400.NET also has a Language Export feature copies content into
XLIFF files for submission to a translation agency. For more information, see the
Ektron CMS400.NET Administrator Manual section “Multi-Language Support” >
“Using the Language Export Feature.”

To copy content into new content block of a different language,
follow these steps.
1. Go to the View Content screen for the content you want to
translate. See Also: ”Viewing Content” on page 40
2. Use the Add: dropdown list in the upper right corner to select
the language into which you want to translate the content.

3. The Edit Content screen appears with original language
content.
4. Translate into the new language then delete the original
content.
If desired, you can click the Translate button (
). If you do, a
new screen prompts you to identify the original language, new
language, and a glossary. Then, the content is translated. If
you like the translation, click Paste Content, and the translated
content replaces the original.
Once the translated content is inserted into the editor, you can
edit it as needed.
5. When you save the content, it is saved as the edition of that
content in the selected language. It has the same content ID
number as the original content but a different language
identifier.
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NOTE

The ability to delete content is a privilege granted by the system administrator. If
you do not see a Delete option on the View Contents of Folder screen, you do not
have permission to do so.

NOTE

It is good practice to check for broken quicklinks before deleting content. See
”Checking for Broken Quicklinks” on page 59.

The Delete command lets you permanently delete obsolete
content from your Web site.
There are two ways to delete content.

• A folder-level Delete option (

) removes several
content items from the current folder. This option only deletes
Approved content. For more information, see ”Deleting Several
Content Items in a Folder” on page 59.

• Depending on the content’s status and your permissions, you
may be able to delete one item at a time. The options for doing
so are

- a Delete option when viewing content from a Web page
- a Delete menu option that appears after selecting content
on the View Contents of Folder screen
For more information, see ”Deleting a Single Content Item” on
page 57.
Like publishing, deleted content must proceed through the
approval chain before it is removed. If you are the last approver in
the approval chain, the content is deleted immediately. See Also:
”Approving/Declining Content” on page 87

Deleting a Single Content Item
To delete one content item, follow these steps.

Deleting One Content Item from a Web Page
To delete content from a Web page, follow these steps.
1. Sign in.
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2. Browse to the content you want to delete.
3. Click the Delete menu option.
4. The View Content screen for the selected content appears.
(See ”Viewing Content” on page 40.)
5. Click the Delete button (

).

6. The following message appears.

7. Click OK to delete the content.

Deleting One Content Item from the Workarea
1. Access the View Contents of Folder screen for the content you
want to delete, as described in ”Viewing Content” on page 40.
2. Hover the cursor over the triangle (

).

3. Select Delete from the dropdown menu.

NOTE

If you do not see Delete, either you lack permission to delete the content, or its
status makes it ineligible for deleting.
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4. The following message appears.

5. Click OK to delete the content.

Deleting Several Content Items in a Folder
On the View Contents of Folder screen, you can delete several
Approved content items at once. To do so, follow these steps.
1. Navigate to the folder that contains the Approved content you
want to delete.
2. Hover the cursor over the Delete menu (

).

3. Select Content from the dropdown menu.

4. Check boxes next to Approved content items you want to
delete.
NOTE

Check the box in the header cell to select all or deselect all.

5. Click the Delete Content button (

).

6. A confirmation message appears.
7. Click OK to continue.

Checking for Broken Quicklinks
The Link Search button (
) locates all content that includes a
Quicklink to the displayed content. This feature is useful before
deleting content, because it informs you of every content item that
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will include a “dead” link if you delete a content item. You should
then edit that content and remove or change the obsolete
Quicklinks.
To use the link checker, follow these steps.
1. Access the View Content page for the content whose links you
want to check, as described in ”Viewing Content” on page 40.
2. Click the Link Search button (

).

3. A page lists each content item that links to the current content.
4. Click the title to access the View Content page for the selected
content.
5. Remove or change the Quicklink.

Workarea To olbar Buttons

Many Workarea screens feature a toolbar that contains buttons for
performing actions. This section explains the buttons’ functions.
Button

Name

Description

Add

Adds items in several places.

Add Calendar Event

Accesses the add calendar event screen in the Workarea.

Add Content

In a content folder, opens the editor and allows you to create
new content.
See Also: ”Adding HTML Content” on page 48

Add Content Folder

In a content folder, allows you to create a subfolder to further
organize your content.
See Also: ”Workarea Toolbar Buttons” on page 60
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Button

Name

Description

Add Library Item

In the library folder, allows you to upload an image or file, or add
a hyperlink or Quicklink to use in content.
See Also: ”Library Folder” on page 131

Add Task

Assign task to a user. See Also: ”Managing Tasks” on page 286

Approvals

View approval chain for folder or content.
See Also: ”Approving/Declining Content” on page 87

Approve

Approve content that awaits your approval.

Approve All

In the approvals folder, approves all content awaiting your
approval with one click.

Archived Content

If current content is being displayed, switch to display archived
content.
If archived content is being displayed, switch to display current
content. See Also: ”Setting Archive Options” on page 69

Back

Calendar

Return to previous screen.

Lets you choose when content will go live.
See Also: ”Working with Calendars” on page 261

Cancel

Cancels action you are performing without saving the
information.

Check-in

Saves and checks in content you are working on.
See Also: ”Approved Content” on page 799

Collection

Accesses the collection area for content; lets you create, edit,
and delete collections. See Also: ”Working with Collections” on
page 424
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Button

Name

Description

Decline

Declines an approval request submitted to you. Clicking this
button rejects changes and keeps the current version of content
live on Web site. You are prompted to enter a reason for the
decline.
After you decline

•
•

The author who made the change is notified by email
The content is removed from the Approval Chain

If the author edited content then submitted it for approval, the
updated content remains in the file. If you do not want it to
remain, choose the Edit option.
You may be asked to decline both a content change and a
request to delete content.
Delete

Deletes selected item. See Also: ”Deleting Content” on page 57

Delete Content

Deletes multiple content items at once. See Also: ”Deleting
Content” on page 57

Delete Folder

Deletes current content folder.

Do Not Apply XSLT

Removes XSLT applied to XML content viewed in the content
history area. See Also: ”Removing Applied XSLT” on page 112

Edit

Edits content or specific criteria in the Workarea.

Insert Library Item

Inserts selected library item into content.
See Also: ”Library Folder” on page 131

Link Check

Identifies content with a hyperlink to the current content. You
would typically use this feature to remove the links before
deleting content.
If you do not remove the links, they are inoperative after the
content is deleted.

Overwrite

Replaces an image or file with a newer version.
See Also: ”Overwriting Images” on page 152

Preview

Previews item that was or will be added.

Ektron CMS40 0.NET User Manua l, Version 7.5

62

Workarea Toolbar Buttons

Button

Name

Description

Publish

Save and publish the content.

Remove

Removes items from folders and lists in the Workarea.

Reorder

Changes the sequence of links in a collection.
See Also: ”Working with Collections” on page 424

Restore

Restores previously published content.
See Also: ”Viewing and Restoring Previous Content” on
page 108

Save

Saves content that was modified.

Search

Searches content and library folder screens.
See Also: ”Searching the Library” on page 136

Show Calendar

Displays the calendar in the Workarea. See Also: ”Working with
Calendars” on page 261

Submit

Saves and submits content to next approver in the approval
chain.

Update

Changes are saved and content is updated.

View Date

View all calendar events for a selected day.

View Difference

Opens the View Content Difference feature.
See Also: ”Comparing Versions of Content” on page 98

View History

View history of selected content.
See Also: ”Viewing and Restoring Previous Content” on
page 108

View Published

Displays currently published version of content.
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Button

Name

Description

View Staged

Displays staged content.
See Also: ”Staged Content” on page 806
Selects the language of the content being displayed.

Select
language
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Sc h e d u l i n g C o n ten t to B eg in a nd
End

Scheduling lets you control when a version of content becomes
visible on the Web site. Similarly, you can remove content on a
predetermined date and time. When used together, a start and end
date can relieve you of much work by managing how long a
version of content is viewable on your Web site.
You can also set options for what happens to a content version
upon reaching its end date.

How Does It Work?
When you create or modify content, you can select a “go-live” date
and time. If you do, and the content makes it through the approval
chain, Ektron CMS400.NET publishes the content to the live site at
that time.
For example, your company is having a sale of the century in a
month, and everything is ready except the announcement. You
decide to update your Web site to let the public know about the
sale. With this feature, you create the Web content now and set it
to go live a week before the sale.
The Ektron Windows Service manages these changes to your site.
See Also: Ektron CMS400.NET Administrator Manual section
“Managing your CMS400 System” > “Ektron Windows Service.”
This topic is explained through the following subtopics:

• ”Setting a Start Date” on page 66
• ”Setting an End Date on Content” on page 68
• ”Setting Archive Options” on page 69
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Setting a Start Date
To set a start date, follow these steps.
1. Access the editor by adding new content or editing existing
content.
2. If adding new content, enter a title and the content.
3. Click the Schedule tab.

4. Click the calendar button next to the Start Date field.

5. A calendar pops up.
6. Select the date and time when this version of the content will
become visible on the Web site.
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7. Click the Done button.
8. The date and time appear in the Start Date field.
NOTE

When you select a time for content to go live, that time depends on the server’s
system clock. If the clock is incorrect, the content will not go live at the intended
time.

What Happens After I Set a Start Date?
After you save the content, it appears on the Content Pending Start
Date report, which helps you keep track of content with a future
start date. See Also: Ektron CMS400.NET Administrator Manual >
“Content Reports” > “Content Pending Start Date Report”
After you set a go-live date and the content completes the approval
chain, two scenarios may occur:

• The content is new
• The content already exists, and you are publishing a new
version
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Each scenario is now explained.

Setting the Go-Live Date on New Content
When you set a go-live date on new content, it becomes viewable
on the specified date and time as long as it completes the approval
chain. If a site visitor accesses the page that contains the content
before then, he sees only the template.
If a logged-in CMS user browses your Web site, he sees a grey
border around the content until the date specified. If he clicks
within the grey border, he can use the Preview option to see the
new content.

Setting the Go-live Date on Existing Content
When you set a go-live date for changes to existing content, and it
completes the approval chain, a logged-in CMS user sees a grey
border around the content until the date specified.
When you view content on the Web site, you see the previously
published version. When the go-live date occurs, the new content
replaces the previous version, and its status changes to Active.

Setting an End Date on Content
To set an end date for content, follow these steps.
1. Edit content. See ”Editing HTML Content” on page 52.
2. Click the Schedule tab.
3. Click the calendar icon next to the End Date field.

4. A calendar pops up.
5. Select the date and time you want the content to be removed
from the Web site.
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6. Click the Done button.
7. The date and time appear in the End Date field
NOTE

When you select a time for content to go live, that time depends on the server’s
system clock. If the clock is incorrect, the content will not be removed at the
intended time.

What Happens After I Set an End Date?
You have three choices for what to do with content when it reaches
its end date. These are explained in ”Setting Archive Options” on
page 69.
If your choice means the content will not appear on the Web site,
Ektron recommends having another content item ready to replace
it. If not, and a site visitor visits the page containing the content, he
sees the template without the content.

Appearance on Content Reports
After content reaches its end date, it appears on the Expired
Content report, which helps you track expired content.See Also:
Ektron CMS400.NET Administrator Manual > “Content Reports” >
“Expired Content Report”
The report lists all content whose end date will occur within a
number of days that you specify.

Setting Archive Options
Use content’s archive options to determine what happens upon
reaching its end date/time. To be eligible for any option, the content
must reach its end date/time, progress through its approval chain,
and be published. Until those events occur, the content remains
visible both within its content folder and on the site.
The archive options (illustrated below) appear below the Start
Date and End Date fields on the content’s Schedule screen.
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Each option is explained below.

Archive Options

Option

Can site visitors view content
upon expiration?

Can users view and edit
content within Ektron
CMS400.NET upon
expiration?

Archive and remove from
site (expire)

No

Yes, within its folder by clicking
the View > Archive Content
option.
Archived content can be found via
the Workarea Advanced search (if
the Archived check box is
checked).
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Option

Can site visitors view content
upon expiration?

Can users view and edit
content within Ektron
CMS400.NET upon
expiration?

Archive and remain on Site

•

Yes, within its folder by clicking
the View > Archive Content
option.

•

Content appears in a List Summary if the ListSummary control’s contentype property is set
to Archive_Content.
If content is an HTML form, the
response page option appears.
For example, if the form displays
a message after the user completes it, that message appears.

Also, can be found via Basic
Search and Advanced search (if
the Archived check box is
checked).

See Also: ”A new screen lets you
determine what happens after the site
visitor completes the form. The
choices are:” on page 160

•

Content is found by the search
(Workarea and site)

•

Content is visible within its taxonomy display

•

Content is visible if site visitor
enters exact path, such as
http://localhost/
CMS400Developer/
dynamic.aspx?id=1014&__taxo
nomyid=14

Add to CMS Refresh Report

Yes

Yes, in the active area of its folder
and on the Refresh Report.
See Also: Ek tr on CMS 400 .NET
Administrator Manual section
“Content Reports” > “Refresh
Reminder Report”

Restoring Content from Archived to Active State
To restore content from archived state to active, follow these steps.
1. Navigate to its folder.
2. Click View > Archived Content. (See ”Setting Archive
Options” on page 69).
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3. Hover the cursor over the content, click the triangle (
select Edit from the dropdown menu.

), and

4. The Edit Content in Folder screen appears.
5. Click the Schedule tab.
6. Remove the End Date or change it to a future date.
7. Submit the content for publishing. When the content is
published, it will no longer be archived.
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Adding a Content Summary

A summary provides a short description of content to supplement
the title when a list of content items appear on a Web page. You
create a summary when creating or editing content. Then, your
Web site developer can create Web pages that display just the title
and summary to attract readers to the full story.
A good example is a news Web site, which lists titles and
summaries of top stories (illustrated below)

TOP STORIES
Ektron Named a Rising Star (08-15-2003)
August 15, 2003, Amherst, New Hampshire, USA —
Ektron, Inc., an innovator in Web content
management and authoring, has been named
a Rising Star as part of the prestigious
New England Technology Fast 50 Program.
Ektron Launches International Distribution Program (0808-2003)
August 8, 2003, Amherst, New Hampshire, USA —
Ektron, Inc., an innovator in dynamic Web
content authoring and management with
over 350,000 users, today announced the
launch of its international distribution
program.

Like content, summaries can include images as well as different
font styles and sizes. This chapter explains how to create
summaries and how they can help navigation on your site. Your
system administrator determines how and where to display
summaries on your site.
See Also:
Ektron CMS40 0.NET User Manua l, Version 7.5

73

Adding a Content Summary

• ”Automatic Creation of a Summary” on page 74
• ”Creating a Summary for New Content” on page 74
• ”Creating a Summary for Existing Content” on page 75
• ”Editing a Summary” on page 76

Automatic Creation of a Summary
Ektron CMS400.NET automatically generates a summary for new

content if none exists. To do this, it checks the summary when new
content is published. If the summary is blank, Ektron CMS400.NET
copies the first 40 words of the content to the summary.
After the content is published, you can update or delete the
summary. If it is deleted, the summary remains blank and is never
again automatically generated for that content item.

Creating a Summary for New Content
1. Navigate to the folder in which you want to create the content.
2. Click New then pick the content type from the dropdown menu.
3. The Add Content screen appears.
4. Insert a Title and content. See Also: ”Adding HTML Content”
on page 48
5. Click the Summary tab.
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6. Enter summary information for the content. The summary can
include images, files, and hyperlinks. Its length can be
restricted by your system administrator in the configuration
setup file.
7. When done, click the appropriate button.

Creating a Summary for Existing Content
1. Navigate to the folder that contains the content.
2. Hover the cursor over the content, click the triangle ( ), and
select Edit or Edit Properties from the dropdown menu.
3. The View Content screen appears.
4. Click the Summary tab to enter or edit summary information
for the content. The summary can include images, files, and
hyperlinks. Its length can be restricted by your system
administrator in the configuration setup screen.
5. When done, click the appropriate button.
6. The View Content page reappears.
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NOTE

When you enter or edit existing content’s summary, its status changes to checked
out. After you create the summary, click the Check-In button to check the content
in. From that point, you need to submit or publish it.

Editing a Summary
NOTE

You can only edit the summary of content that is published, checked in, or
checked out by you.

To edit a content’s summary, follow these steps.
1. Access the View Content page for the content whose summary
you want to edit, as described in ”Viewing Content” on page 40.
2. Click the Summary tab.

3. The Edit Summary window opens.
4. Click the Edit button. The summary opens within the editor.
5. Make the necessary changes.
6. When done, click the appropriate button.
7. The View Content page reappears.
NOTE

When you edit an existing content summary, it goes into a checked out state. After
creating the summary, check the content back in. From that point, you must
submit it or publish it.
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Adding or Editing Metadata

You can add several kinds of metadata to Ektron CMS400.NET
content.

• Metadata that can be found by your Web site search. It helps
site visitors find content on your Web site. This kind of
metadata can also be found using the Workarea’s Search
screen. For more information, see ”Entering Custom Metadata”
on page 78.

• Metadata that resides in the source code of a Web page.
Examples include the title and meta tags. This data makes it
easier for search engines to find your Web page (illustrated
below).

For more information, see ”Entering Title and Keywords” on
page 85.

• Metadata that identifies related Ektron CMS400.NET information
(for example, another content item, a collection, or a
ListSummary). Then, your Web site can display the related
content whenever the source content item appears.
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For example, your Web site sells motorcycle helmets. On a
page that shows a particular helmet, the left column lists a
collection of motorcycle drivers who use that helmet.

• Image data - this standard metadata field is available to every
content item. It identifies an image that can be retrieved by
Ektron Markup Language’s (EKML) [$Image] and
[$ImageThumbnail] variables. (EKML is described in the Ektron
CMS400.NET Developer’s Guide.)
An example of using Image data is a list summary that includes
a photo of every item on the list. For example, your site
promotes a soccer team. The list summary shows every player
on the team. To the left of each player’s name is a thumbnail of
his image.
Metadata is more fully explained through the following topics.

• ”Entering Custom Metadata” on page 78
• ”Entering Title and Keywords” on page 85

Entering Custom Metadata
Your system administrator defines the metadata that can be added
to content. The metadata being collected can be customized for
each folder. When you create or update content, you can define
metadata using fields that the administrator specified.
NOTE

In order to add metadata to content, an administrator must have created
definitions for it in the language of the content.

For example, each document stored in the Document
Management functionality has a unique part number. Your system
administrator adds a custom search field called Part Number, and
specifies that only numbers can be inserted into the field.
When you add a document to Ektron CMS400.NET, you access the
content’s metadata and insert the correct part number for the
document (illustrated below).
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Then, anyone visiting your Web site can find that document by its
part number using your Web site’s search screen.
NOTE

When your system administrator sets up metadata, he determines whether or not
is it “publicly viewable.”
If it is, the search field appears on the search screen that site visitors use along
with the search screen in the Ektron CMS400.NET Workarea. If the data is not
publicly viewable, it only appears on the Workarea search screen.

Entering or Editing Metadata
To enter or edit content’s metadata, follow these steps.
WARNING!

You may only edit metadata of content that is published, checked in, or checked
out by you.

Ektron CMS40 0.NET User Manua l, Version 7.5

79

Adding or Editing Metadata

1. Access the Edit Content screen for the content whose
metadata you want to enter or edit, as described in ”Editing
HTML Content” on page 52.
2. Click the Metadata tab.

3. The Edit Metadata screen opens with the current metadata
displayed. In order to add metadata to content, an
administrator must have created definitions for it in the
language of the content.
NOTE

Your system administrator determines the appearance of the Metadata screen.
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4. Edit the metadata. Note that

• Required field labels are red and marked with an asterisk (*).
You must place at least one response in such fields before you
can save the metadata.

• Your system administrator may prevent you from editing a field.
In this case, the field has a gray background, and you cannot
place the cursor there.
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• Fields may appear in two columns. In this case, the system
administrator provides a list of terms that you can apply to the
content. You can select terms from the list or enter free text.
One column is labeled Not Included and the other Included.
Move terms between lists by clicking the Add and Remove
buttons.

• You may see a list of terms in one box, and a field labeled Text
to its right.

With such a list, you can

- add a new term by typing it into the Text field and clicking
Add

- remove any term by selecting it and clicking Remove
- modify any term by selecting it. It appears within the Text
field, where you can change it. Then, press the Change
button.

- restore the terms to their default settings by pressing the
Default button

- change the sequence of terms by selecting one then
pressing the up and down arrows (

)

• If related content metadata is available for the content, its
name appears followed by None Selected (ID) Change Clear.
Click Change to display a window of choices. For example, if
the related content type is a collection, all collections appear in
the popup. Select the appropriate data for this content.
Selected items appear in the bottom of the screen. You can
reorder them by selecting an item then clicking the up and
down arrows. To remove items from the bottom of the screen,
select them and click the delete (
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If the related content type is either content item or library
image, hyperlink, or file, the following window appears when
you click Change.
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Use this screen to identify the related content. To do this,

- Select a folder from the left frame
- Double click the related-content item from the top right
frame

- The item appears in the lower right frame
- When all items are in the lower right frame, click the Save
button (

) directly below Select Metadata

• If default metadata is defined for a specific data type, you can
click the Default button at the bottom of each field to restore it.

• Below each field is a Characters Left field, which counts the
number of metadata characters. You cannot exceed the
maximum (500 characters).
5. Click the Save button (

).

6. The View Content screen reappears.
The content is now in a checked out state to you. For the changes
to take effect on the Web site, check in the content and submit it to
the approval chain.
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See Also: ”Approving/Declining Content” on page 87

Entering Title and Keywords
After you create or update content, it is typically published.
Programs that search the Web look at a page’s title and keywords
to determine if they should return your Web page. To improve
search results, Ektron CMS400.NET provides two fields within
Metadata by default.
NOTE

Your system administrator may enable or disable these fields for each folder.

• Title - appears on the search results screen to further define
your Web page

• Keywords - are searched by leading search programs, along
with the page’s title
After content is published, you can view the page source to see its
metadata. Below is an example.
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On this Web page, notice the keywords are included in the meta
tag, and the title is in HTML tags. These appear according to how
the administrator sets up the metadata definitions.
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Approving/Declining Content

Your site administrator establishes an approval chain for each
folder, or even specific content items. The approval chain is a list of
people or groups who must approve new or edited content before it
is published to the Web site. If a user group is part of an approval
chain, any member of the group can approve the content.
The administrator also determines the sequence of approvers in
the chain.
When a new or edited content is submitted to the approval chain, it
is reviewed by users who may

• change it
• approve or decline it
• publish it to the Internet (it is published when the last user
approves it)
The chart below illustrates the approval process.
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You can approve or decline all content submitted to you from the
approval folder.
Ektron CMS400.NET can automatically send email notification,

informing users that content workflow events have either taken
place or are requested of them. For example, a content contributor
receives an email that his content has been published to the Web
site. The list of automatic emails and directions for customizing
their content are described in the Setup manual section
“Customizing Ektron CMS400.NET email.”
The following topics guide you through the approval or decline of
this content.

• ”Approve/Decline One Content Item” on page 89
• ”Approve/Decline Several Content Items” on page 90
• ”Example of an Approval Chain” on page 91
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Approve/Decline One Content Item
1. Click the Smart Desktop button (circled in red below).

2. Click Reports.
3. Click Approvals.
4. Click the content you want to approve or decline.
To select all displayed content, click Select All at the top of the
screen.

5. The content appears. You can view the content, summary,
metadata, etc.
A toolbar at the top of the screen lists tasks you can perform on
the content.
Button

Name

Result of Clicking

Publish

Accept changes to the content and publish it to the site.
Note: If there is another approver in the content’s approval chain, this is
replaced by a SUBMIT button.
If you click Publish but the content item has an incomplete task assigned
to another user, the content cannot be published. Instead, the following
error message appears.

The user to whom the task is assigned must complete it before you can
publish the content.
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Button

Name

Result of Clicking

Decline

Reject changes and keep current version of content live on Web site. You
are prompted to enter a comment that provides a reason for the decline.
The author who made the change is notified by email of the decline.
The content inserted by the last editor remains in the file. If you do not
want it to remain, choose the Edit option.

Edit

Check out content and change it if desired.

View
Published/
Staged

Toggle between published and submitted versions of content. This can
help you compare versions. See Also: ”Staged Content” on page 806

View Diff

View differences between the version awaiting approval and the
published content.
See Also: ”Comparing Versions of Content” on page 98

Back

Return to previous screen.

Approve/Decline Several Content Items
To approve several submitted content items without reviewing
them, follow these steps.
1. Select the submitted content you want to approve, as
described in ”Approve/Decline One Content Item” on page 89.
2. Click the Approve All button (

).

3. The following message appears.
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4. To continue, click OK.
5. The approved content is either submitted to the next publisher,
published immediately to the Web site, or deleted, depending
on the approval chain set for the content.

Example of an Approval Chain
The approval chain begins when a content contributor submits a
new or edited content. If email is enabled, an email is sent to the
next approver in the approval chain.
The following example follows a typical content block from creation
to publication. Three users make up this approval chain.

• Sports Writer - creates sports content
• Sports Editor - edits and publishes all sports articles
• Editor In Chief - edits and publishes all articles
Each user has different permissions that correspond to their roles.
The example uses the following topics to explain a typical approval
chain.

• ”Creating Content” on page 91
• ”First Approver” on page 93
• ”Second Approver” on page 94

Creating Content
The first step is to create content. To create new content, follow
these steps.
1. Log in to Ektron CMS400.NET as a SportsWriter.
2. Create content, as described in ”Adding HTML Content” on
page 48.
3. Click the Submit button (
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4. The content is placed into the approval chain. The next user in
the chain receives an email saying the content is ready for
approval.

NOTE

Emails are only sent if your Administrator enables them.

The content contributor, Sports Writer, has completed his role in
the approval chain but continues to receive emails notifying him of
changes in the content’s status.
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First Approver
After Sports Writer submits the content, the first user in the
approval chain, Sports Editor, receives an email stating content
needs his approval. He can change and approve the content or
decline it.
Sports Editor logs into Ektron CMS400.NET, navigates to his
desktop, where he sees a link Content Awaiting Approval.

He clicks the link and sees all content awaiting his approval.
The approvals folder window displays information such as title,
who submitted it, go live date, etc. The Sports editor clicks the
submitted content.
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The View Content Awaiting Approvals window appears listing all
information necessary to decide whether to approve or decline the
content.
At the approval window, the Sports Editor has these options.
Button
Approve

Decline

Edit

Result
Send content to next approver in approval chain.

1.

Send email to creator, notifying him/her that content was
declined.

2.

Remove content from approval chain.

Invokes the editor. From here, the approver can change the content.

For demonstration purposes, we‘ll choose Approve.

Second Approver
After the content is approved, the next approver in the approval
chain receives an email saying that the content is ready for
approval.
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EditorInChief logs in to Ektron CMS400.NET and accesses his
Workarea. The Workarea has an Approval folder with the content
awaiting his approval. EditorInChief navigates through the
Approval folder until he finds the content Red Sox win World
Series.
From this window, EditorInChief can view information about the
content, including title, go live date, user who created it, etc. He
then clicks the content he wants to approve.
This window is similar to the previous approver’s but includes a
Publish button at the top of the screen. The EditorInChief has a
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publish button (instead of a submit button) because he is the last
approver in the approval chain. When he approves the content, it is
published to the Web site.
Like the Sports editor, the EditorInChief has the following options.

Button

Description
Publish the content.

Publish
1.

Sends an email to the creator, notifying him/her that content was
declined.

2.

Removes content from the approval chain.

Decline

Invokes the editor. The approver changes the content.
Edit

After reviewing the content, the EditorInChief decides it is great
and publishes it. At this point, the content becomes live on the Web
site, and the approval chain is complete.
The user who created the content receives an email notifying him
that it was published.
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Comparing Versions of Content

There are two versions of this procedure. You may need to consult
your system administrator to determine the correct procedure for
you.

If the Ektron
CMS400.NET
server is

And your
client is

See

32 bit

32 bit

”The View Content Difference Screen” on page 98

64 bit

32 bit

”The View Content Difference Feature” on page 100
Note: This procedure was the only one prior to 7.5.2. It
downloads an ActiveX control to your computer.

64 bit

64 bit

The View Content Difference feature is not available

The View Content Difference Screen
NOTE

Use this procedure if both your computer and the Ektron CMS400.NET server are
32 bit.

The View Content Difference screen highlights changes to
selected content. Below is an example of the View Content
Difference screen, showing the default tab, Difference.
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Each tab is explained below.

Tab

Shows this content

Difference

Both versions:

•

content that only appears in the version on the This Content tab is highlighted in yellow

•
•

content that only appears in the currently published version is red
unchanged content is black

Last
Published

Currently-published.

This
Content

The version you are comparing the currently-published content against.

IMPORTANT!

If there is no difference between the versions, you see Content is Identical.

The View Content Difference feature is explained through the
following topics.
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• ”When Can I Compare Content?” on page 100
• ”Accessing the View Content Difference Feature” on page 100

When Can I Compare Content?
The View Content Difference feature is available when

• you are viewing a version of content
• a staged version of that content is available (See Also: ”Staged
Content” on page 806)

Learn About Accessing the View Content Difference Feature

Accessing the View Content Difference Feature
To Access the View Content Difference feature, follow these steps.
1. Navigate to the content whose versions you want to compare.
2. Click View Properties.
3. Click the History button ( ). The View Content History screen
appears. See Also: ”Comparing Historical Versions” on
page 112
4. Click a version that you want to compare with the most recently
published version.
5. Click the View Content Difference toolbar button (

).

The View Content Difference Feature
NOTE

Use this procedure if your computer is 32 bit, and the Ektron CMS400.NET server
is 64 bit.

The View Content Difference feature highlights changes that were
made to selected content. Below is an example of the View
Content Difference screen, showing two versions of content. The
changes are indicated by

• redlining deleted content
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• highlighting in yellow added content

Within the View Content Difference feature, you can perform
several tasks, as well as view different versions of the content
separately, or compared.
The View Content Difference feature is explained through the
following topics:

• ”When Can I Compare Content?” on page 100
• ”The Compare Content Window” on page 102
• ”First Use of the View Content Difference Feature” on page 107

When Can I Compare Content?
The View Content Difference feature is only available when

• you are viewing an historical version of content
• a staged version of the content is available (See Also: ”Staged
Content” on page 691)
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The following table explains when you can use the feature, and
which versions are compared.
Content Status

Compares current published
version with

Published

Historical version stored in the content
history area

Checked-In

Most recently checked-in version

Submitted

Submitted version

Pending Start Date

Scheduled version pending start date

Checked Out

Not available

If content can be compared with another version, the View
Difference button (
Web page view.

) appears in the content history area or the

The Compare Content Window
NOTE

The first time the View Content Difference feature is opened, a simple installation
program runs. See Also: ”First Use of the View Content Difference Feature” on
page 107.

The Compare Content window consists of the following:

• ”Toolbar” on page 103
• ”Content Area” on page 106
• ”View Tabs” on page 106
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Each area is explained below.

Toolbar
The content comparison toolbar has five buttons, explained below.
Button

Name

Description

Print

Sends content to local or network printer.
Note: This option prints the currently displayed content, whether it is
the compared, published, or staged content.

Save

Saves a copy in HTML format on your local machine or network.
When saved as a physical file, the HTML may be edited. However,
the changes are not saved to the Web Server.
Note: The save option saves the version of the content you are
viewing.
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Button

Name

Description

Setup

Opens setup dialog box to configure the settings. Typically, only an
administrator would use this.
For more information, see ”Setup” on page 104.

Help

Displays additional information about the compare feature.

Exit

Closes the window.

Setup
Click the Setup button (
) to open the setup dialog box.
Typically, a system administrator would edit these settings.

You can change the setup options to better suit your needs. The
following table explains each option.
Option

Description

Compare Options
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Option

Description

Compare visual
aspect

Compares content as it would appear on a
Web page.

Compare source
code

Displays compared content as source HTML.

Whitespace Options
Ignore All

Blank (whitespace) characters are ignored.

Smart Detect

One or more consecutive whitespace
characters are treated as a single separation
sequence. That is, multiple whitespace
characters are ignored.

Detect All

Blank (whitespace) characters are treated as
any other character.

Other Options
Ignore Case

Determines whether comparison is case
sensitive. For example, if you check this box,
the strings “Bob” and “BOB” are not
highlighted because their only difference is
the case of the characters.

Ignore Format
Attributes

Determines whether comparison ignores
changes in text-formatting attributes (HTML
Visual Analysis only).

After updating setup information, click OK to save changes.
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Content Area
The content area displays the content comparison.

The following table describes the change indicators.

Symbol

Example

Content state

Plain black text

Unchanged

Yellow highlighted text

Added

Red, struck-through text

Deleted

View Tabs
When viewing content in the View Content Difference feature,
there are three view modes, explained below.

View

Description

Diff

Compares published version of content to staged
version
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View

Description

Published

Displays currently published version

Staged

Displays the staged version of content. See Also:
”Staged Content” on page 691

To switch between views, click the corresponding View tab.

First Use of the View Content Difference Feature
The first time the View Content Difference screen is used on a
client machine, a simple installation program is performed.
Click Yes when the following screen appears.

When the installation program completes, close and reopen the
View Content Difference feature.
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Viewing and Restoring Previous
Content

Past versions of published content are available unless your
system administrator purged them. Your ability to view a content
item’s history is determined by your user privileges.
After viewing a previous versions of content, you can replace the
current version with any previous version.
NOTE

This section explains how to view and possibly restore older versions of content.
To see a change-by-change comparison of two content items, use the View
Content Difference feature, explained in ”Comparing Versions of Content” on
page 98.

NOTE

The Purge History feature deletes historical versions of content according to userdefined criteria. Therefore, some previous versions may be unavailable. See Also:
Ektron CMS400.NET Administrator manual > “Managing Content Folders” >
“Folder Properties” >”Purge History”

The View and Restore features are explained through the following
subtopics.

• ”Accessing Content History” on page 108
• ”The Content History Window” on page 109
• ”Restoring a Previous Version” on page 111
• ”Comparing Historical Versions” on page 112
• ”Removing Applied XSLT” on page 112

Accessing Content History
By default, all users can view the history of Ektron CMS400.NET
content. You can access content history from two places:

• The Workarea’s View Content page
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• A Web page
Once you access the history, the functionality is identical.
The following sections explains how to access the content history
from both places.

Accessing the Content History from the Workarea
To access the history from the Workarea, follow these steps.
1. Navigate to the View Content page for the content whose
history you want to view.
2. Click the item whose history you want to view.
3. The View Content Screen appears.
4. Click the View History button (

).

Accessing the Content History from a Web Page
To access the history for content from a Web page, follow these
steps.
1. Sign in.
2. Browse to the content whose history you want to view.
3. Click the View History menu option (

).

4. The Content History window opens.

The Content History Window
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The View Content History window lists every version of the content
available in Ektron CMS400.NET. The window displays the following
information for each version.

• version number See Also: ”The Content Version Number” on
page 110

• a green circle indicates a version that was published. Versions
without a green circle indicate content that was checked-in but
not published.

• date and time when a version was checked in or published
• title of content
• last user who edited content
• comments entered by user to describe nature of changes
made
To view any version, click its title. When you do, the Content
History window appears for that content.

The Content Version Number
Ektron CMS400.NET assigns a unique number to each saved

version of a content block. The number is increased by one tenth if
the content is checked in but not published. If the content is
published, the next whole number is assigned.
For example, if the current version is 1.0 and you check in that
content, the new version is 1.1. If the next editor publishes it, the
new version is 2.0.
If the content is purged, the numbering scheme restarts with the
remaining content.

The Detail History Window
After viewing the View Content History window, you can click any
version to see the detail for it. The detailed History window has two
sides:

• The left side redisplays the information in the content history
window. See Also: ”The Content History Window” on page 109
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• The right side displays the selected version of the content.
After viewing a version of content, you can perform these
actions on it.
Action

Button

Description

More Information

Restore

Restore historical version of
content

”Restoring a Previous
Version” on page 111

View Difference

Compare historical version to
current version

”Comparing Historical
Versions” on page 112

View History
Report

View summary list of all versions

”The Content History
Window” on page 109

Remove XSLT

Remove XSLT applied to XML
content

”Removing Applied XSLT” on
page 112

XML Content Only

Actions are explained below.

Restoring a Previous Version
NOTE

The ability to restore content is a privilege granted by the system administrator. If
you do not see a Restore button (
do not have permission to do so.

) on the View Content History screen, you

1. Open the content folder that contains the content.
2. Click the content item.
3. Click the History toolbar button (

).

4. Select an historical version of the content that you want to
restore.
5. Click the Restore button (

).

6. The content history window closes, and you return to the View
Content page or the Web page, with the content in a checked
in status.
7. If desired, check out the content to make additional changes.
8. Select the workflow to perform on the content.
9. When the historical version is placed in the approval chain and
approved, it is published to the Web site.
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Comparing Historical Versions
After you select an historical version of content, you can view the
differences between it and the current version. To compare an
historical version, follow these steps.
NOTE

You can only View Differences if there are two or more published versions of the
content.

1. Open the content folder that contains the content.
2. Click the content item.
3. Click the History toolbar button (

).

4. Select an historical version of the content.
5. Click the View Differences button (

).

The historical and the current versions are compared. To learn
more about the comparison, see ”Comparing Versions of Content”
on page 98.

Removing Applied XSLT
You can only remove an applied XSLT when viewing historical
versions of XML content. If you remove the applied XSLT, you can
view the content without the irrelevant XML tags.
The following table compares the views.
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With XSLT

Without XSLT
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Searching the Workarea

You can search any folder to quickly locate content within Ektron
CMS400.NET. The following sections explains how to use the
content search through the following subtopics.

• ”Accessing the Search Content Folder Screen” on page 114
• ”The Search Published Tab” on page 115
• ”The Advanced Search Tab” on page 119
• ”Result Display Options” on page 127
• ”Information on the Advanced Search Results Screen” on
page 128

Accessing the Search Content Folder Screen
To access the Search Content Folder screen, follow these steps.
1. Navigate to the folder from which you want to begin the search.
NOTE

To search your entire site, start with the top-level (Root) folder. If you want to limit
the search to a folder (and its subfolders), select it then choose search criteria.

2. Click Action > Search.
3. The Search Content Folder screen appears.
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The Workarea search has two tabs:

• the left tab, Search Published, is like the Site Search. See
”The Search Published Tab” on page 115.

• the right tab, Advanced Search, lets you search by internal
properties, such as title, status, and comments. See ”The
Advanced Search Tab” on page 119.

The Search Published Tab
The Search Published tab within the Workarea finds content that
satisfies these criteria.

• status is published
• active (archived content is ignored; however, the Advanced
Search finds archived content. See ”The Advanced Search
Tab” on page 119)

• you have read-only or greater permission for the content’s
folder

• content is public. However, private content is available to those
with permission to view it, such as membership users after
logging in. (See Also: “Private Content & Memberships” section
of the “Managing Users & User Groups” chapter of the Ektron
CMS400.NET Administrator Manual)

• matches selected language, if site is multi-lingual. See Also:
Ektron CMS400.NET Administrator Manual section ”Working

with Multi-Language Content”

• the content’s Content Searchable check box is checked
• is not a non-image file added to the library. Images are
searchable, while other files added to the library are not. So, to
make files searchable, add them as assets, not library files.

• content resides in the folder you selected before launching the
search or one of its subfolders. To search the entire Web site,
begin the search at the root folder.

• satisfies text and/or query entered in the search box (no value
returns nothing). The text inserted in the search field can
appear in the content, summary, or metadata. See Also:
Ektron CMS400.NET Administrator Manual section “Searching
Your Web Site” > “Query Language.”
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• satisfies content type criterion, if chosen (see below). These
are described in ”Search Screen Options” on page 116.

Search Screen Options

Search Screen
Option

Finds submitted text in these content types

Site

Content from all options listed below.

HTML

•
•

HTML
Smart Form (XML)

Note: Finds field values but not field labels. This has not
changed since prior releases.

•
•

HTML Form
Blog entries (not comments)
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Search Screen
Option

Finds submitted text in these content types

Documents

•

MS Office document (includes Powerpoint, Excel)

Note: The search finds text within Visio documents if the
Visio IFilter has been installed on the server. See “Installing
the Visio IFilter” in the Ek tr on CMS 400 .NET Administrator
Manual.

•
•

PDF file
.txt file

Images added as
assets or through the
library

.gif, .jpeg, etc.

Multi Media

Flash, .mp3, etc.

Forums

Forum posts and topics

NOTE

The search cannot find calendar events.

Searching for Metadata
• Searchable type metadata values are returned like regular
content.

• It can take up to 30 minutes for newly-added metadata to be
available to the search.

• Searchable metadata field names must not include a space. If
they do, the search cannot find the metadata.

• To find content with searchable metadata whose style is yes or
no, enter

true

or

false.

Display of Published Search Results
Below is an example of the Search Published results screen.
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As you can see, content on the search results screen begins with
the title and last edited date/time. Following them is either an
abstract or the summary of the content. This is determined by your
web developer in the Web Search server control.
Following the abstract is additional information, such as content ID
number, size, last author, etc.

Search Result Ranking
Each content item found by a catalog search is given a numerical
rank between 0 and 1000. Search results can be sorted by rank.
Criteria used to calculate rank include the

• number of occurrences of the search term
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• proximity of search term to beginning of file
• proximity of search term to other occurrences of the term
• whether the term is in the title

The Advanced Search Tab
The Advanced Search within the Workarea finds content that
satisfies these criteria.
IMPORTANT!

The Advanced search finds content whether or not it is marked Searchable.

• user must have read-only or greater permission for content’s
folder

• matches selected language, if site is multi-lingual
• satisfies criteria entered on the screen (see below)
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The Advanced Search Tab helps you find Ektron CMS400.NET
content by specifying the following criteria. All fields are optional.
However, the search only finds content that satisfies all criteria.

• the kind of content you want to search (for example, HTML
content, forms, assets)

• a search word or words. Unlike the Search Published tab, you
cannot use a query.

• how the search words must match the content in order for a
document to be found

• whether the title is searched
• whether the comments are searched
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• a range of created or modified dates
• the editor who updated the content most recently
• the content’s status
• any searchable metadata assigned to the folder
See Also:

• ”Using the Advanced Search” on page 121
• ”Specifying the Kind of Content to Search” on page 122
• ”Specifying a Search Word or Phrase” on page 122
• ”The Noise File” on page 123
• ”Specifying Match Criteria” on page 123
• ”Additional Search Criteria” on page 125
• ”Custom Fields” on page 126
Each feature is explained below.
NOTE

To help track search activity, the Search Phrase Report provides a count of all
words and phrases searched within a date range. In Ektron CMS400.NET, this
report is available from the Smart Desktop > Reports. For documentation of this
report, see Ektron CMS400.NET Administrator Manual > “Content Reports”
“Search Phrase Report.”

Using the Advanced Search
When performing a search, enter one or more words into the text
box, select search preferences, then click the Search button.
You can use an asterisk as a wildcard character, in other words, to
stand for any character. For example, the phrase CMS*00 returns
topics that include the following text: CMS400, CMS300, CMS200
and CMS100.
Your system administrator can add custom search fields that only
appear if a user is logged in. For more information, seethe
“Metadata” section of the Ektron CMS400.NET Administrator
Manual .
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Specifying the Kind of Content to Search
Near the top of the screen, check boxes let you determine the
kinds of content to search.

NOTE

Assets only appears if your organization has implemented Ektron’s Document
Management feature.

Check this box

To search

Content

HTML content, blogs entries, and XML Smart
Form field values

Forms

HTML forms

Assets

Content that is neither HTML nor XML, such as
Office documents and managed files. See Also:
”Using the Document Management System” on
page 222

Include Archived

Content, forms and assets that have been
archived. See Also: ”Setting Archive Options” on
page 69

Specifying a Search Word or Phrase
In the Search Text field, enter one or more words that you want to
find within content, forms, and assets. The search returns content
that includes these words.
Entering text here is optional. That is, you can use fields on the
lower portion of the screen to find content without entering words
contained in the content. For example, you can find every piece of
HTML content that was modified by a certain user within the last 30
days.
If you check off HTML and Form content, you can enter no search
criteria and get a list of all HTML and Form content on your site.
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However, if you enter search text, the search only finds items that
include the search text and satisfy other criteria on the screen.

The Noise File
Ektron CMS400.NET has a noise file that screens from the search

every single letter of the alphabet as well as common words.
Examples of common words are about, after, all, and also. Avoid
entering such words into the Search Text field, because the
search ignores them.
For information on managing the noise files, see the Ektron
CMS400.NET Administrator Manual section “Searching Your Web
Site” > “Query Language” > “Rules for Formulating Queries.”

Specifying Match Criteria
NOTE

This field is only applicable if you entered one or more words in the Search Text
field.

From this dropdown list, select criteria for how the search word or
words must appear within the content of the files being searched.

Your choices are described below.

Choice

A search returns content that has

For more information,
see

All the words

all words in the search field

”All the Words” on
page 124

Any of the words

any word in the search field

”Any of the Words” on
page 124
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Choice

A search returns content that has

For more information,
see

Exact Phrase

all words in the order specified in the search field

”Exact Phrase” on
page 124

Content ID

has the submitted ID number

”Content ID” on page 125

Match Criteria Examples
The examples below assume you entered these words into the
Search Text field.

• partners
• content
• Monday
• employee
• green
All the Words
All Words is an “and” function. The search returns only content
that has the words partners and content and Monday and
employee and green. The words can be in any order within the file.

Any of the Words
Any Word is almost the opposite of All of the Words. It is an “or”
function.
When you select this option, the search returns all files that have at
least one of the words entered in the search text field. In other
words, it returns files with the word partners or content or Monday
or employee or green.

Exact Phrase
Exact Phrase returns content that have all five words in the order
specified in the search text field.
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A better example would be to search for a phrase, such as Content
Management Solution. The search yields only content with that
exact phrase.

Content ID
You can find content by its ID number. To do so, select Content ID
from the drop down box below the Search Text field. Then, enter
the ID number in the Search Text field and click Search.

Additional Search Criteria
The next section of the Advanced Search Tab lets you choose one
or more customized search criteria. Note that if you enter more
than one criterion, only content satisfying all criteria appears on the
search results screen.

Fields that Apply to Content, Forms and Assets
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Search criterion

Description

Title

The title of the content. You can enter a partial word. For example, entering
Part yields the following results.

•
•

Multi-Hospital Nurse Executive Participation
Ektron Partners and Customers

You can enter more than one word or phrase as long as they are in the correct
sequence.
Comments

The content’s comments, which can be inserted via the Comment tab.

Date Created

The file’s creation date. You can enter a single date or a range of dates.
The search returns all content with that creation date that satisfy the other
criteria.

Date Modified

The last date when the file was modified. You can enter a single date or a
range of dates.
The search returns all items with that edit date that satisfy the other criteria.

Last Editor’s Last Name

The last name (surname) of the user who most recently changed the content.
This is taken from the Last Name field on the User Information screen.
The search returns all items last edited by that user that satisfy the other
criteria.

Status

The content status. See Also: ”Appendix A: Content Statuses” on page 798
Note: Although you can search for content by any status, the search results
display only the most recently published version. If a version has never been
approved, nothing appears.

Custom Fields
Custom fields are defined by your system administrator and
applied to content by its author or editor. They are custom-defined,
so would be different for every site.
The custom search fields appear below the Status field.
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Result Display Options
At the top of the Advanced Search Tab, a pull-down list lets you
choose the how to display the search results.

View
option

Description

Example

Graphical

If the item is content or a form,
display a thumbnail of it.

Sample HTML content

If the item is an asset, display a
generic icon that indicates asset
type.
In both cases, to the right are
the item’s

•
•
•

title
summary
last edited user, date and
time

You can click the title to display
the item inside the View
Contents screen. From there,
you can perform all available
functions on the item.

Sample Microsoft Word document

Note: Graphical search results
require the Internet Explorer
browser, version 6 or greater.
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View
option

Description

Text

Display item’s title in the left
column. To the right, display the

•
•
•
•
•
•

Example

last edit date/time
folder name
size (assets only)
DMS rank (assets only)
language
status

Information on the Advanced Search Results
Screen
The following column headers describe the information displayed
for all content items that satisfy the search criteria.

Column

Description

Header
Content Title

The title of the content item

Last Edit Date

The most recent date on which content was edited. If it was never
edited, its creation date.

Folder name

The folder that contains the content

Size

The size of the content item in kilobytes

DMS Rank

An indication of how well a content item page matches the search
criteria, using a range of 0 to 1000. The higher the rank, the more
relevant content is to the search criteria.
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Column

Description

Header
Language

The locale id value of the content’s language.
For a reference list of these values, see the E ktron CM S40 0. NET
Administrator manual section “Appendix C: List of Supported
Languages””Appendix C: List of Supported Languages” on
page 1015

Status

A one-character abbreviation of the content item’s status. See Also:
”Appendix A: Content Statuses” on page 798

NOTE

If you install Ektron CMS400.NET then later select a different database to
search, you must run C:\Program Files\
Ektron\releasenumber\utilities\software\searchconfig\SearchConfig.e
xe against the new database. This program gets all required data from the new

database.
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Content Workflow Reports

The Reports folder contains various content reports. For
information about them, see the Content Reports section of the
Ektron CMS400.NET Administrator Manual.
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The library folder stores images, files, quicklinks, and hyperlinks
that can be inserted into editor content. Before you can insert them
into content, you must copy them from your computer to a larger,
file server computer that everyone editing your site can access.
This chapter explains how to copy such files and insert them into
Web content through the following topics.

• ”Terms Used in this Chapter” on page 131
• ”Accessing The Library” on page 132
• ”Library Folder Properties” on page 134
• ”Searching the Library” on page 136
• ”Files” on page 140
• ”Hyperlinks” on page 150
• ”Images” on page 151
• ”Quicklinks and Forms” on page 153

Terms Used in this Chapter
• An image is any graphic file, which can include illustrations and
photos. Common image file extensions are .gif., .jpg, .tiff, etc.

• A file is type of computer file that can be launched from a
browser, such as Internet Explorer. Examples include a
Microsoft Word document and a .PDF file.

• A hyperlink is a commonly used or hard to remember Web
address (also known as a URL). After you add hyperlinks to the
library, users can easily apply them to editor content.
So for example, if the editor content is “Contact Ektron,” the
user can select the text, click the library button, select
hyperlinks to find the Ektron hyperlink, and apply that
hyperlink to the text.
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Once the page is published, a person reading it can click the
text to “jump” to the Web address www.ektron.com.

• A quicklink is a special kind of hyperlink that jumps to another
content item on your Web site. (A regular hyperlink jumps to a
Web page on the internet.)
Whenever content is created, if the Add to Quicklinks table
box is checked, a quicklink is created for it.

• A form is a quicklink to HTML form content. Whenever content
is created, a form link is automatically created for it.

Accessing The Library
1. Click the Workarea button (

) or icon (

).

2. Click the Library folder in the lower left corner of the Workarea.
3. The Library folder appears.
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4. The sub-folders appear in the left frame. Files in the root folder
(library) appear in the right frame.

You can use the dropdown list (circled above) to change the type of
library files that appear.
To work with any library file, click it. When you do, the View Library
screen appears, providing additional information about the item.
From here, you can

• edit its title, file name, or description
• overwrite it
• find content linked to it
• delete it
For more information, see ”Viewing Files” on page 143.
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The following table explains the toolbar buttons on the library
screen.
NOTE

Button

Your system administrator determines which library folders you can access, and
which functions you can perform on library items within the folders.

Description

For more information, see

Search library

”Searching the Library” on page 136

View the library’s properties
screen

”Library Folder Properties” on page 134

Add an image, file, quicklink, or
hyperlink to the library

”Copying Files to the Library” on
page 141

Select the type of Library file to
work with

Library Folder Properties
To view the library folder’s properties, follow these steps.
1. Click the Properties button (

).

2. The Library Management screen appears.
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3. The screen displays the following settings.

Field

Description

Image Extensions

File extensions of images that can be copied to the library
folder. For example, .gif and .jpg.

Image Upload path/
Physical Path

The folder to which library images are moved when you
insert them into E k t r o n C M S 4 0 0 . N E T .

File Extensions

Extensions of files that can be copied to this library folder.
For example, .doc and .pdf.

FIle Upload path/
Physical Path

The folder to which library files are moved when you insert
them into Ek tr on CMS 400 .NET .

Your system administrator controls these settings.
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Searching the Library
You can search the library to find items when you only know some
information about them. For example, you know that an image’s
name includes Ektron but don’t know its filename or folder.
To search the library, first select the folder in which you want to
begin the search. The search only considers files in that folder and
its child folders. To search the entire library, begin by selecting the
Library (root) folder.
Next, click the Search button ( ) from the library toolbar. When
you do, a search screen appears with two tabs (shown below).

The left tab, Search Published, works the same as the regular
search tab of that name. See ”The Search Published Tab” on
page 115.
The right tab, Advanced Search, provides several fields that let
you narrow your search.
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The fields are described below.
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Field

Description

Enter Keyword(s)

Specify one or more keywords that the search will use. The search
looks for keywords in the file’s title. (The title is assigned by the user
when the file is added to the library.) If a file’s title matches the
keywords, the file appears on the search results screen.
The search also uses keywords to search through the file’s

•

internal name (for example, airplane.gif) if the Filename Search
checkbox is checked

•

description if the Description search checkbox is checked

A keyword can be a complete or partial word. But, you can only enter
a partial term for one word. For example, you can enter Adv and
have the search return the content titled “Adverse Drug Reactions.”
But if you enter Adv Drug, the search returns nothing.
You can enter several complete search terms but they must be in the
correct sequence. For example, to find the topic titled “Adverse Drug
Reactions,” you can enter Adverse Reactions but cannot enter
Reactions Adverse.
To find all files in a selected library folder, enter nothing in this field.
Or, to find all files in a selected library folder of a type (for example,
images), select the type and enter nothing in this field.
All Types

The search considers all library asset types.

Images only

The search only considers images.

Quicklinks Only

The search only considers quicklinks.

Forms Only

The search only considers forms.

Files Only

The search only considers files.

Hyperlinks Only

The search only considers hyperlinks.

Description Search

If you check this box, the search considers the library item’s
description when returning search results. Otherwise, the search
ignores the description.
For example, if you enter Ektron into the keyword field, the search
returns all library files that include that string.
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Field

Description

Filename Search

If you check this box, the search considers the file name when
returning search results. Otherwise, the file name is not considered
by the search.
For example, if you enter ppt into the keyword field, the search
returns all files that include that string (such as all Powerpoint
presentations).

Only search items
last edited by myself

The search only considers library assets that were last modified by
you.

One or more of the search criteria set by your system administrator in the Metadata
Definitions screen.

NOTE

Some search field check boxes are circles while others are squares. If the box is a
circle, you can only choose one option. If it is a square, you can choose as many
as you want.

The search displays library items that meet the search criteria on
the search results screen. You can click any item to view its
properties (such as Library ID number, Last Edit Date and
Description).

Displaying Search Results
Search results appear in this order.

• images
• files
• hyperlinks
• quicklinks
• form links
Result Display Options
At the top of the library search screen, a pull-down list lets you
choose the how to display the results.
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View
option

Description

Example

Mixed

If the item is an
image, display the
image in the left
column. If not,
display its title.
To the right,
display the item’s
Description.
Note: Mixed
search results
require the
Internet Explorer
browser, version 6
or greater.

Text

Display item’s title
in the left column.
To the right,
display the file
type and folder
name.

Files
This section explains how to work with library files through the
following subtopics:
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• ”Copying Files to the Library” on page 141
• ”Viewing Files” on page 143
• ”Editing a File” on page 145
• ”Overwriting Files” on page 145
• ”Library Link Searching” on page 147
• ”Adding a Library File to Content” on page 148
For a definition of the term “files,” see ”Terms Used in this Chapter”
on page 131.

Copying Files to the Library
Files must be copied to the Ektron CMS400.NET library before
users can insert them into content. To copy a file to the library,
follow these steps.
WARNING!

Ektron recommends using the Document Management system to add files. Unlike
library files, DMS files can be part of an approval chain, maintain a history, are
searchable, and can have a summary, schedule, metadata, taxonomy categories,
etc.

TECHNICAL NOTE

Microsoft lets users upload files of any name. However, Internet Explorer security
blocks files whose name contains an ampersand (&), colon (:), or percentage sign
(%). Source: http://support.microsoft.com/kb/826437/en-us
To allow these characters, add the following registry key to your Web server then
reset IIS.
Reg Key: DWORD HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ASP.NET
VerificationCompatibility = 1.

1. In the Workarea, browse the library folder and select a folder to
which you want to copy a file.
NOTE

When you copy a file to a folder, only users with permissions to that folder can
insert the file into content.

2. A list of files in that folder appears.
3. Click the Add Library button (

).

4. The Add File screen appears.
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5. Enter the necessary information according to the following
table.

Field

Description

Title

Enter a title for the file to be copied.

Filename

Enter the path to the file to be copied. You can use the
Browse button to find it.

Description

You can enter a full text description to help other users
identify this file.
The Description appears on the View File screen.
It also accompanies the file on the Search Results
screen if the user selects Mixed when viewing results.
See Also: ”Displaying Search Results” on page 139

After you enter the necessary information and click the Save
button, the file is copied. Now, users with permissions to the
selected folder can insert the file into their content.
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Viewing Files
Once a file is copied to the library, you may preview it. To preview a
copied file, follow these steps.
1. Navigate to the library folder to which the file was copied.
2. Click the file you want to preview.
3. The View File screen appears.

The table below describes each field on the screen.

Field

Description

Title

Title assigned by user who copied or edited it.

Filename

Filename and location on the server.

Library ID

ID number assigned by Ektron CMS400.NET when file was originally
copied.

Ektron CMS40 0.NET User Manua l, Version 7.5

143

Library Folder

Field

Description

Parent Folder

File’s parent folder. Users need permissions to this folder to insert the file
into content.

Last User to Edit

Last user who changed file.

Last Edit Date

When file was last edited.

Date Created

When file was originally copied to library.

Description

Optional, full-text description of file.

If the file can be displayed in your browser, a preview of it appears
at the bottom of the screen. If it cannot display in the browser, a
link to preview it in its host application appears instead.
NOTE

You may need to download some files before you can be view them (for example,
.mdb, .mp3, .zip, etc.).

The following table describes the buttons on the View Library Item
screen.

Button

Description

For more information, see

Edit the items title and description

”Editing a File” on page 145

Overwrite the library item

”Overwriting Files” on page 145

Find content linked to the library item

”Library Link Searching” on page 147

Delete library item

”Deleting Library Items” on page 148

Return to previous screen
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Editing a File
You can edit the title, filename and description of any file that was
copied to the library. To do so, follow these steps.
1. Access the View File screen, as described in ”Viewing Files” on
page 143.
2. Click the Edit button (

).

3. The Edit File screen appears.

4. Change the title, file name, and/or description of the file.
5. Click the Update button (

).

Overwriting Files
If a library file becomes out of date or the wrong version was
copied, you may replace it with a new version. Overwriting files lets
you minimize disk space and the number of library files.
NOTE

The ability to overwrite a library file is a privilege granted by the system

) on the View Library
administrator. If you do not see an Overwrite button (
Item in Folder screen, you do not have permission to overwrite.
NOTE

You can only overwrite images and files. The new image or file must have the
same file extension as the file being replaced.

Before You Overwrite an Image
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When overwriting an image, the new image uses the same size
dimensions and file extension as the older image. Be sure that the
two images have the same file extension and size or make the
adjustments at each occurrence of the image.

Before You Overwrite a File
Remember, all links that point to the overwritten file now point to
the new file.

Overwriting Library Assets
To overwrite a library file, follow these steps.
1. Navigate to the View File screen for the file you want to
overwrite, as described in ”Viewing Files” on page 143.
2. Click the Overwrite button (

).

3. The Overwrite File screen appears.
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4. Click the Browse button.
5. A window lets you navigate to the new file.
6. Click the file, then click the Open button.
7. You return to the Overwrite File screen with the path to the new
file in the Filename field.

8. If desired, enter a Description for the new file.
9. To overwrite the current version of the file with this version,
click the Update button (

).

10. The following message appears.

11. To overwrite the file, click OK.

Library Link Searching
Link searching indicates all content that includes a library link. It is
useful when you want to delete a library item. With the click of a
button, you see all content that you need to update to reflect the
change you are making.

Performing a Library Item Link Search
To perform a library item link search, follow these steps.
1. Access the View Library Item for any type of library item, as
described in ”Viewing Files” on page 143.
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2. Click the Link Search button (

).

3. A list of all content that references the library item is displayed.
You should edit that content before deleting the item.

Deleting Library Items
You can delete obsolete items from the library. By deleting an item,
you prevent users from adding it to their content. A deleted
hyperlink, quicklink or form quicklink remains on your Web server,
so any existing links to them are not broken.
On the other hand, if an item is a file or image, the delete window
displays an additional prompt, Remove from the server, that lets
you remove the item from the server. This feature is available to
help reduce disk space taken up by these files. Before removing an
image or file from your server, you should review all content with
links to it and remove or update the link. To delete an item from the
library, follow these steps.
1. Access the View Library Item for any type of library item, as
described in ”Viewing Files” on page 143.
2. Click the Delete button (

).

3. The Delete Library Item screen is displayed.
4. If appropriate, check the box next to Remove from the server
(see above).
5. Click the Delete button (

).

Adding a Library File to Content
After a file is copied to the library, users can add it to content. (See
”Adding a Library File to Content” on page 149)
You can also insert an item into the library while adding it to
content. (See ”Adding a File to the Library and Inserting it into
Content” on page 150)
If you insert an image file, it appears within the content. If you add
any other type of file, the file name appears as a hyperlink within
the content. When a site visitor viewing that page clicks the
hyperlink, the inserted file is launched.
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Adding a Library File to Content
1. Invoke the editor by adding or editing content in Ektron
CMS400.NET.
2. Place the cursor within the content where you want the library
file to appear.
3. Click the library button (

).

4. The library opens.
5. Navigate to the folder that contains the file you want to insert.

6. From the file types dropdown list, select the kind of file you
want to insert.
7. All library files of that type in the selected folder appear on the
screen.
8. Click the file you want to insert.
NOTE

You can preview the file by clicking the preview button (

9. Click the insert button (
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10. A hyperlink to the file appears in your content.

You can click the link to open the file.

Adding a File to the Library and Inserting it into Content
Use this procedure to insert an image into content that has not yet
been copied to the library. This procedure inserts the item into the
library then into the content.
1. Invoke the editor by adding or editing content in Ektron
CMS400.NET.
2. Click the library button (

).

3. The library opens.
4. Navigate to the folder that will contain the file after you insert it.
5. From the File types dropdown, select the type of file you want
to insert.
6. Click the Add Library button (

).

7. A new screen appears. Browse to the file you want to insert.
Or you can click the search button (
insert.

) to search for a file to

8. Enter a Description for the file.
9. If metadata is required for the library item, you must complete
it. Metadata fields may appear in the lower section of the
screen.
10. Click the Add Library button (

).

11. The file is inserted into the selected library folder and the
content.

Hyperlinks
For a definition of the term hyperlinks, see ”Terms Used in this
Chapter” on page 131.
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Adding Hyperlinks
You must copy hyperlinks to the library before content creators can
insert them into content. To copy a hyperlink to the library, follow
the procedure described in ”Copying Files to the Library” on
page 141. The only difference is that you insert a hyperlink instead
of a file.

Viewing Hyperlinks
To view a hyperlink, follow the procedure described in ”Viewing
Files” on page 143. The only difference is that you view a hyperlink
instead of a file.

Editing Hyperlinks
To edit a hyperlink, follow the procedure described in ”Editing a
File” on page 145. The only difference is that you edit a hyperlink
title instead of a file title. You can also edit the URL.

Adding Hyperlinks to Your Content
Once a hyperlink is added to the library, users can add the
hyperlink to their content.
To add a hyperlink to content, follow the procedure described in
”Adding a Library File to Content” on page 148. The only difference
is that you add a hyperlink instead of a file.

Images
For a definition of the term images, see ”Terms Used in this
Chapter” on page 131.

Uploading Images
You must copy images to the library before content creators can
insert them into content. To copy an image to the library, follow the
procedure described in ”Copying Files to the Library” on page 141.
The only difference is that you add an image instead of a file.
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Viewing Images
To view an image, follow the procedure described in ”Viewing
Files” on page 143. The only difference is that you view an image
instead of a file.

Editing Image Titles
To edit an image’s title, follow the procedure described in ”Editing a
File” on page 145. The only difference is that you edit an image’s
title instead of a file title.

Overwriting Images
When an image in the library becomes out of date, or if the wrong
version of an image was copied, you may overwrite that image with
a new or correct version. Overwriting images minimizes disk space
and the number of copied library images.
NOTE

Overwriting images is a permission that your system administrator may or may
not assign to you.

To overwrite an image, follow the procedure described in
”Overwriting Files” on page 145. The only difference is that you
overwrite an image instead of a file.
NOTE

You can only overwrite an image with another image of the same extension. (that
is, .gif > .gif, not .jpg > .gif)

Adding Images to Your Content
Once an image is added to the library, users can add it to content.
To add an image to content, follow the procedure described in
”Adding a Library File to Content” on page 148. The only difference
is that you add an image instead of a file.
The image is placed into the picture properties dialog box, where
you can change it before inserting it. For information about the
picture properties dialog box, see ”Using the First Picture
Properties Dialog Box” on page 673.
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Quicklinks and Forms
For a definition of the terms quicklinks and forms, see ”Terms Used
in this Chapter” on page 131.

Adding a Quicklink or Form to Content
After new content is created, if the Add to Quicklinks table
checkbox was checked for it, users can insert a quicklink to it into
any other content. To do so, follow the procedure described in
”Adding a Library File to Content” on page 148. The only difference
is that you add a quicklink or form instead of a file.
Be sure to place the cursor where you want the quicklink or form to
appear before inserting it. When the quicklink or form is inserted,
the title of the “jumped to” content appears in the content. To test
the quicklink or form, select the newly-inserted title and double
click it.
When the page is published, a reader can click the link to jump to
the quicklink or form page.

Viewing Quicklinks or Forms
To view a quicklink or form, follow the procedure described in
”Viewing Files” on page 143. The only difference is that you view a
quicklink or form instead of a file.
The table below describes each field on the quicklinks display.

Field

Description

Title

Title given to the hyperlink or form by the user who added it, or last edited it.

URL Link

URL link for the quicklink or form.

Library ID

ID number assigned automatically by Ektron CMS400.NET when the
quicklink or form was originally added.

Parent Folder

Parent folder that the quicklink or form belongs to. Users need permissions
to this folder to be able to access the quicklink or form.
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Field

Description

Last User to Edit

Last user that made changes to the quicklink or form.

Last Edit Date

The date the quicklink or form was last edited.

Date Created

The date and time the quicklink or form was originally added to the Ektron
CMS400.NET library.

To preview a quicklink or form, click the link at the bottom of the
page.

Updating Default Template for Multiple Quicklinks
WARNING!

NOTE

This procedure is only necessary if Link Management is set to false in your web.
config file. If if Link Management is set to true, Ektron CMS400.NET
automatically updates the template within the quicklink when content is moved.
See your system administrator for help with the web.config file.
This action can only be performed on quicklinks.

When content is moved in Ektron CMS400.NET, its quicklink does
not get changed. After it is moved, you need to update the default
template called in the content’s quicklink.
To update the default template for one or more quicklinks, follow
these steps.
1. In the library, access the quicklinks folder containing quicklinks
you want to update.
2. Click the Update Quicklinks button (

).

3. The Update URL Link Template Quicklinks screen is displayed.
4. Check the quicklinks you want to update.
NOTE

Check the box in the table header to select or deselect all.

5. In the To: text field, enter the name of the template you want to
apply to the selected quicklinks.
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6. Click the Update Quicklinks button (
changes.

) to update the

A confirmation message is displayed.
7. Click OK to continue.
The selected quicklinks are updated to use the specified template.
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IMPORTANT!

This section describes creating forms with eWebEditPro+XML. If you are using
the eWebEdit400 editor, see ”Working with HTML Forms” on page 574.

Ektron CMS400.NET provides powerful online form capabilities,

allowing you to create an online dialog with visitors. Now anyone in
your organization – not just a developer or Webmaster– can create
and deploy Web forms to capture visitor information. Support
marketing strategies by getting feedback on their needs. Follow up
on their interest in your products and services. Register people for
events.
Form capabilities include

• Creating a form and its postback message
• Creating polls and surveys for a Web site
• Adding validation criteria to form fields
• Automatically assigning tasks for follow-up activities to form
submissions

• Reporting on form information
• Exporting results to Microsoft Excel
A sample form appears below.
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This chapter explains how to perform all form actions through the
following topics.

• ”Overview of Form Processing” on page 158
• ”The Structure of Form Data” on page 158
• ”Creating a New Form” on page 159
• ”Creating a Form’s Content” on page 166
• ”Form Validation” on page 172
• ”Form Fields” on page 173
• ”Implementing a Form on a Web Page” on page 194
• ”Assigning a Task to a Form” on page 195
• ”Viewing Form Reports” on page 197
• ”Exporting a Form’s Raw Data” on page 203
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• ”Viewing Form Information” on page 204
• ”Editing a Form” on page 210
• ”Mailto or Database Form” on page 211
• ”Deleting a Form” on page 212
• ”View Form Toolbar” on page 212
• ”Creating Polls and Surveys” on page 214

Overview of Form Processing
Step

For more information, see

1.

Create a form

”Creating a New Form” on page 159

2.

Assign it to a Web page

”Implementing a Form on a Web Page” on page 194

3.

Site visitor goes to your Web site
and completes form. Form is mailed
to an email address, saved to a
database, or both.

4.

View submitted form data and
download it to a spreadsheet.

”Viewing Form Reports” on page 197

The Structure of Form Data
Forms reside within the root folder or one of its subfolders. A form
has the following components.

• Form (title, ID number, whether the form data is sent as email,
and/or saved to a database, etc.)

• Content information (title, start and/or end date, status,
postback message, etc.)

• Form fields (plain text field, password field, text area, hidden
text, choices, checkbox, select list, calendar, submit button,
etc.)
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Creating a New Form
The screen you use to create a new form has five simple steps.
After you complete the steps, you have a new form that’s ready to
collect the information you need. To make the task even easier,
Ektron CMS400.NET provides sample forms that you can start with
then customize.
As explained in ”Mailto or Database Form” on page 211, form data
can be emailed and/or saved to a database. Forms created using
the procedure described below are saved to a database by default,
but not emailed. To change either setting, use the Edit Properties
screen. See ”Viewing and Editing a Form’s Properties” on
page 205.
To create a new form, follow these steps.
NOTE

You can also create a new edition of a form in another language by copying an
existing form and translating it. For more information, see ”Translating Content”
on page 818.

NOTE

For the steps to create a new poll, see ”Working With Polls” on page 215. For the
steps to create a new survey, see ”Creating a Survey” on page 220.

1. Choose a content folder.
2. From the View menu, click Language, and select the language
in which to create the form.
3. Click the New menu > HTML Form/Survey.
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4. The New Form screen appears.

NOTE

When you choose Standard Poll or Blank Survey, the number of steps in the
Forms Wizard changes from five to four. This happens because the Assign Tasks
step is removed. See Also: ”Working With Polls” on page 215 and ”Creating a
Survey” on page 220.

5. Choose the form that you want to begin with. You can click the
preview icon ( ) next to any sample form to preview it before
choosing it.
Select a sample that most closely matches the form you want
to create. After you create it, you can add fields, remove fields,
modify possible responses, etc.
6. Click Next.
7. Enter or edit the form’s Title and Description.

•Title - used to reference the form within the Workarea
(required)

•Description - an extended description of the form
8. The next screen lets you assign a task to a user or user group.
If you do, a task will be created every time a site visitor submits
this form. See Also: ”Assigning a Task to a Form” on page 195
9. A new screen lets you determine what happens after the site
visitor completes the form. The choices are:
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•Display a message - See ”Composing the Postback
Message” on page 161

•Redirect to a file or page - Identify a file or a page on your
Web site that is launched when the visitor completes the
form

- An example of a file is a white paper (a common file
format is .PDF) that the visitor requested

- An example of a page is one that lets the visitor
download your product

•Redirect to an action page and forward form data - See
”Redirect to an Action Page and Forwarding Form Data” on
page 162

•Report on the form - See ”Making Form Results Available to
Site Users” on page 163
10. Now that you have completed information about the form, you
can enter the form’s content. This procedure is described in
”Creating a Form’s Content” on page 166.

Composing the Postback Message
The postback message can contain text or graphics, just like any
other HTML content. Typically, it acknowledges the site visitor’s
completion of the form.
For most sample forms provided, sample text appears in the editor.
Modify it as you wish, using Ektron CMS400.NET’s editor to change
the font size, style, color, insert library items, etc.

Inserting Fields into the Postback Message
You can also insert fields that retrieve form information upon its
submission. Use the Insert Fields pull-down to do this (illustrated
below).
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All form fields appear on the list. In addition, the following fields can
be used to insert form information into the postback message,
although they’re not completed by the person submitting the form.

• Form title
• Form description
• Date form was submitted by site visitor
For example, your postback message may be
Thank you «Full Name» for completing the «[Form Title]».

When the postback message appears, it looks like this.
Thank you Jay Kohler for completing the breakroom survey.

Redirect to an Action Page and Forwarding Form Data
The following section of the Ektron CMS400.NET Administrator
Manual explains how your administrator sets up the action page:
“Working with HTML Forms“> “Redirecting Submitted Form Data”.
After your administrator follows that procedure, he identifies a
folder and hyperlink that you use to select an action page.
WARNING!

You must obtain from your administrator the name of the custom action page and
its folder to complete this procedure.

To redirect submitted form data to an action page, follow these
steps.
1. Go to the page on which you determine the form’s response. If
this is a new form, it is page 4 of the Forms Wizard.
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To modify an existing form, select the form’s folder, then the
form. Next, select Edit and click the Post Back Message tab.
2. Select Redirect to an action page and forward form data.

3. Click the icon next to File or page.
4. The Hyperlink manager dialog appears.
5. In the URL field, enter the path to the custom action page. For
example, /site root folder/customaction.aspx. Do not get a
quicklink from the library.
6. Press OK.

Making Form Results Available to Site Users
When you create polls and surveys, you can choose to display the
results after site users submit data. The results can be displayed in
the same window or output to a new window. In addition, you can
choose how to chart the data. For a description of chart types, see
”Chart Types” on page 165.
To show site visitors the results, follow these steps:
1. Go to the page on which you determine the form’s response. If
this is a new form, it is page 4 of the Forms Wizard.
To modify an existing form, select the form’s folder, then the
form. Next, select Edit and click the Post Back Message tab.
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2. Select Report on the form.

3. Choose whether you want the results to appear in the Same
Window or a New Window.
4. Choose the style of the report.
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Chart Types
The following table describes the types of charts available.
Chart Type

Description

Data Table

The poll or survey
answers are
displayed with the
percentage of users
who responded to
each item.

Bar Chart

The poll or survey
answers are
displayed with a bar
graph. Use this chart
type when you want
a quick visual
representation of the
responses.

Pie Chart

Displays a standard
pie chart. Poll or
survey answers are
color coded, and the
percentage of
people who chose
each answer is
shown.

Sample
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Chart Type

Description

Combined

Combines the Data
Table and the Bar
Chart.

IMPORTANT!

Sample

You cannot chart data that is entered into a text box. For example, if one of the
choices in a poll is Other, and the survey has a text box for site users to enter
additional information, the text in the box is not charted. However, the fact that the
a user chose Other is charted.

Creating a Form’s Content
Here is an example of form content that you can create.
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Note that some fields are required, and some provide a dropdown
list of choices. You can learn how to create such a screen by
following the directions below.
The following topics explain how to create a form.

• ”The Form Toolbar Options” on page 168
• ”Inserting Form Fields” on page 169
• ”Form Validation” on page 172
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The Form Toolbar Options
Creating form content is similar to creating a standard content
item. (See ”Adding HTML Content” on page 74). The big difference
is a special toolbar (illustrated below) to make it easier to insert
form elements.

All toolbar options except the Select Button pull-down also appear
on a vertical toolbar to the left of the editor. You can use whichever
toolbar you prefer -- all options are the same.

Adding a Field to the Screen
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The major difference between the toolbars is how you add a field to
the screen. If you are using the horizontal toolbar, place the cursor
where you want field, and click the toolbar button.
When using the vertical toolbar, drag a button to the desired
screen location.
Note that a context-sensitive menu, available by right clicking the
mouse, is also available to perform these actions. You can right
click the mouse then select Insert Field to display a contextsensitive menu of all commands.

Inserting Form Fields
The final screen of the Forms setup lets you arrange the screen so
that it collects exactly the information you want. To create the
screen, you insert fields that prompt a site visitor to enter
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information. Then, add buttons that let the user submit the data on
the screen.
If you chose a sample form at the beginning, the screen includes
fields. If you did not, the screen has only a Submit button.
NOTE

In addition to inserting fields, you can add explanatory text, lines, images, etc.
onto the form screen. If you want to place fields in columns, insert a table and
place the fields within table cells.

The table below explains each field type you can enter.

Button

Inserts this
kind of field

Description

For more information, see

Checkbox

User’s response is either checked or
unchecked

”Inserting a Checkbox Field” on
page 173

Hidden Text
Field

Information a site visitor doesn’t
need to know about

”Inserting a Hidden Text Field” on
page 175

Text Field

Free text field; user cannot format
text

”Inserting a Text Field” on page 176

Password

A password field

”Inserting a Password Field” on
page 180

Text Area

Same as Text Field except field
scrolls vertically to accept more text

”Inserting a Text Area Field” on
page 182

Choices

Several choices appear on screen.
User checks any number of
appropriate boxes.

”Inserting a Choices Field” on
page 185

Select

Same as Choices except options
appear in a drop-down box, and site
visitor can only select one choice

”Inserting a Select List Field” on
page 189

Calendar

Lets user insert a date by clicking a
calendar

”Inserting a Calendar Field” on
page 192
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After you complete the form, you have the following options.
Button or Tab

Description

Postback Message

See ”Composing the Postback Message” on page 161

Metadata

Edit the metadata for the content. See Also: ”Adding or Editing
Metadata” on page 77

Schedule

Assign start or end dates, or both, for when content is published to
Web site See Also: ”Scheduling Content to Begin and End” on
page 65

Comment

Enter history comment to indicate changes made to content

Web Alerts

Assign or update Web Alert information for the form. See the
Ek tron CM S40 0.NET Administrator Manual chapter “Web Alert
Feature””Web Alert Feature” on page 931.
Submit content into approval process.

Submit
Publish content to Web site.
Publish

Note: If the content has any active tasks, a comments window
pops up. You can insert comments to describe how approving or
declining the content affects the task.
Note: Only the last approver in the approval chain sees this button.

Check In

Save and check-in content. This button does not submit the
content into the approval process, but rather lets other users
change it.
Save the content without submitting it into the approval process.

Save

Decline

If a user clicks save and then closes the editor, other users cannot
edit the content.
This buttons appears if you are the next approver in the approval
list. Click it to decline the changes made to the content.
Note: If content has any active tasks, a comments window pops
up. You can insert comments to describe how approving or
declining the content affects the task.

Ektron CMS40 0.NET User Manua l, Version 7.5

171

Working with HTML Forms

Button or Tab

Description
Close the editor without saving changes.

Cancel

Next, click the Save and Submit or Publish button (
only appears on your Web site after it is published.

). The form

After you complete and save the form, it may need to go through
the approval process. When that is complete, add it to the site by
assigning it to a page template. See ”Implementing a Form on a
Web Page” on page 194.

Form Validation
You can apply validation rules while creating or editing the
following field types:

• text
• password
• textarea
• calendar
Validation rules ensure that the form information entered by site
visitors meets your criteria. For example, a validation rule can
specify that a site visitor’s response to the Telephone field
conforms to a standard format (for example, 7 or 10 digits). If the
response does not conform, an error message informs the site
visitor of the problem. The input must conform before the form can
be submitted.
For a list of validation rule types, see ”Validation Options” on
page 178.

When Validation Rules are Applied
Validation rules are applied when a site visitor submits an entire
form, not as soon as the input is entered. If invalid input is found,
the error message that you define appears.
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The site visitor must change his response to conform to the
validation rule. When he does, the next field is checked and, if that
is invalid, its error message appears, etc.
TIP!

If you apply validation rules to more than one field, include the field name in the
error message. For example, enter The name field only allows text. This is
good practice because error messages only appear after the form is submitted
and, if the message does not identify the field, the user may not know which field
needs correction.

Form Fields
Inserting a Checkbox Field
A Checkbox field is only one character wide and accepts one of
two possible values: checked or unchecked. For example

To insert a checkbox field, follow these steps.
1. Place a checkbox type field
onto the screen. See Also:
”Adding a Field to the Screen” on page 168
2. The following dialog appears.
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Fields on the Checkbox Dialog

Field

Description

Descriptive
Name

Enter a description of the field.

Field Name

Enter a name for this field. This text identifies the field in
the database and in email if the form is mailed.

This text describes the field on form reports. See
”Viewing Form Reports” on page 197.

Note: You cannot enter spaces nor most special
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If
you do, they are replaced by underscores.
Tool Tip Text

Enter text that appears when a site visitor hovers the
cursor over this field (circled in red below).
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Field

Description

Default
value

If you want this field to be checked when the screen first
appears, click True.
Otherwise, click False.
Regardless of the default value, the site visitor can
change it while completing the screen.

Inserting a Hidden Text Field
When the form is submitted, this field can pass information that the
site visitor doesn’t need to know about, such as a tracking number.
This is typically data to be stored in the database and/or emailed
along with the rest of the data.
To insert a hidden text field, follow these steps.
1. Place a hidden text field
onto the screen. See Also:
”Adding a Field to the Screen” on page 168
2. The following dialog appears.

Fields on the Hidden Text Field Dialog
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Field

Description

Descriptive
Name

Enter a description of the field.

Field Name

Enter a name for this field. This text identifies the field in
the database and in email if the form is mailed.

This text describes the field on form reports. See
”Viewing Form Reports” on page 197.

Note: You cannot enter spaces nor most special
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If
you do, they are replaced by underscores.
Tool Tip Text

Enter text that appears when a site visitor hovers the
cursor over this field (circled in red below).

Value

Enter the value that will be saved with this field when the
form is submitted.

Inserting a Text Field
Use a plain text field when you want the user to enter an
unformatted, free text response.
To insert a plain text field, follow these steps.
1. Place a plain text field
onto the screen. See Also: ”Adding
a Field to the Screen” on page 168
2. The following dialog appears.
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Fields on the Plain Text Field Dialog

Field

Description

Descriptive
Name

Enter a description of the field.

Field Name

Enter a name for this field. This text identifies the field in
the database and in email if the form is mailed.

This text describes the field on form reports. See
”Viewing Form Reports” on page 197.

Note: You cannot enter spaces nor most special
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If
you do, they are replaced by underscores.
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Field

Description

Tool Tip Text

Enter text that appears when a site visitor hovers the
cursor over this field (circled in red below).

Default
value

If you want to set a default value for this field, enter it
here. For example, if this field collects a city, and most
users enter New York, enter New York as the value.
Regardless of the default value, the site visitor can
change it while completing the screen.

Validation

Select the kind of validation to apply to this field. See
”Validation Options” on page 178
If you assign to this field any value other than No
validation, the field is initially surrounded by red dashes
in Data Entry mode. If the user’s response does not
meet the validation criterion, the field remains
surrounded by red dashes. The system administrator
determines whether or not the user can save an invalid
document.

Error
Message

Enter text that appears on the screen if the site visitor‘s
response to this field does not satisfy the validation
criterion.
For example, if the validation criterion is telephone
number, the error message could be Please enter 7 or
10 digits. It would appear if the user entered, for
example, S061882.
By default, the error message is the same as the
validation criterion you choose. You can use this field to
customize its text.
Note: You can only enter double-byte characters if your
Windows settings include that language. If you enter
characters that are not in a language defined in your
Windows settings, question marks (?) appear instead of
the characters.

Validation Options
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NOTE

Your Web developer can customize validation options. For details, see the
Ektron CMS400.NET Developer’s Guide section “Customizing Validation.”

Option

Characteristics of Valid Response

No validation

Response is not checked.

Cannot be blank

Response is required. The format of the response is not checked.

Non-negative whole number or
blank

A positive whole number or no response.

Non-negative whole number
(required)

A positive whole number.

Decimal number or blank

A decimal number (for example, 12.345 or 12) or blank . A leading
minus sign “-” is allowed. The decimal point must be a period (.),
even in locales that normally use a comma (,).
Decimal numbers include whole numbers because the decimal point
is implied. That is, 12 is 12.0000.

Decimal number required

A decimal number (it cannot be blank) of none, one, or two decimal
places.
A leading minus sign “-” is allowed. The decimal point must be period
(.), even in locales that normally use a comma (,).
Decimal numbers include whole numbers because the decimal point
is implied. That is, 12 is 12.0000.

Percent: (0-100) required

A whole number from 0 to 100.

email address

a@a.a, where a is one or more characters.

email address list

Several email addresses. Each address’s format is a@a.a, where a
is one or more characters. The user must separate each address
with a semicolon (;).

Zip code (US)

5 (nnnnn) or 9 digits separated by a dash after the fifth (nnnnn-nnnn).

Zip code (US) required

5 (nnnnn) or 9 digits separated by a dash after the fifth (nnnnn-nnnn).
A response is required.

Social Security (US) required

Nine digits in this pattern: nnn-nn-nnnn. A response is required.
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Option

Characteristics of Valid Response

Postal Code (Canada)

ana nan, where a is an alphabetic character and n is numeric.

Postal Code (Canada) (required)

ana nan, where a is an alphabetic character and n is numeric. A
response is required.

Social Insurance Number
(Canada)

A nine digit number in the format: nnnnnnnnn.

Social Insurance Number
(Canada) Required

A nine digit number in the format: nnnnnnnnn. A response is
required.

Telephone number (US and
Canada)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.

Telephone number (US and
Canada) (required)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.

The site visitor can insert separator characters, such as dashes (-),
between numbers.

The site visitor can insert separator characters, such as dashes (-),
between numbers.
A response is required.

Inserting a Password Field
Use a password field when you want the user to enter a password.
A password is like a text field but the user’s entry appears as dots
instead of characters. This prevents an onlooker from seeing the
password. A user’s password entry cannot exceed 18 characters.
To insert a password field, follow these steps.
1. Place a plain text field
onto the screen. See Also: ”Adding
a Field to the Screen” on page 168
2. The following dialog appears.
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Fields on the Password Dialog

Field

Description

Descriptive Name

Enter a description of the field.
This text describes the field on form reports. See ”Viewing Form
Reports” on page 197.

Field Name

Enter a name for this field. This text identifies the field in the
database and in email if the form is mailed.
Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are
replaced by underscores.
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Field

Description

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this
field (circled in red below).

Default value

If you want to set a default value for this field, enter it here.
Regardless of the default value, the site visitor can change it while
completing the screen.

Validation

Select the kind of validation to apply to this field. The choices are:

•
•

No validation - response is not checked

•

Minimum of 8 characters with at least one digit - Site visitor’s
entry must be at least 8 characters and include one digit.

Cannot be blank - Response is required. The format of the
response is not checked.

If you assign to this field any value other than No validation, the
field is surrounded by red dashes when it appears on your Web site.
Error Message

Enter text that appears on the screen if the site visitor‘s response to
this field does not satisfy the validation criterion.
For example, if the validation criterion is Minimum of 8 characters
with at least one digit, the error message could be Please enter at
8 or more characters with at least one digit.
By default, the error message is the same as the validation criterion
you choose. You can use this field to customize its text.
Note: You can only enter double-byte characters if your Windows
settings include that language. If you enter characters that are not in
a language defined in your Windows settings, question marks (?)
appear instead of the characters.

Inserting a Text Area Field
Use a text area field when you want the site visitor to enter an
unformatted, free text response. A text area field is similar to a Text
Field except it scrolls vertically to accept more text.
To insert a text area field, follow these steps.
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1. Place a text area field
onto the screen. See Also: ”Adding a
Field to the Screen” on page 168
2. The following dialog appears.

Fields on the Textarea Dialog

Field

Description

Descriptive
Name

Enter a description of the field.
This text describes the field on form reports. See ”Viewing Form Reports” on
page 197.
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Field

Description

Field Name

Enter a name for this field. This text identifies the field in the database and in
email if the form is mailed.
Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are replaced by
underscores.

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this field
(circled in red below).

Default
value

If you want to set a default value for this field, enter it here. For example, if this
field collects a city, and most users enter New York, enter New York as the
value.
Regardless of the default value, the site visitor can change it while completing
the screen.

Validation

Select the kind of validation to apply to this field. The choices are:

•
•

No validation - response is not checked

•

Allow maximum of 1000 characters - Site visitor’s entry cannot exceed
1000 characters.

Cannot be blank - Response is required. The format of the response is
not checked.

If you assign to this field any value other than No validation, the field is
surrounded by red dashes when it appears on your Web site.
Error
Message

Enter text that appears on the screen if the site visitor‘s response to this field
does not satisfy the validation criterion.
For example, if the validation criterion is Cannot be blank, the error message
could be Please enter a response.
By default, the error message is the same as the validation criterion you
choose. You can use this field to customize its text.
Note: You can only enter double-byte characters if your Windows settings
include that language. If you enter characters that are not in a language
defined in your Windows settings, question marks (?) appear instead of the
characters.
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Inserting a Choices Field
Use a Choices field when you want the site visitor to select from a
predetermined list of choices. You can allow the site visitor to
select only one or more than one choice. You can also determine
the list of choices and the appearance of the list.
To insert a choices field, follow these steps.
onto the screen. See Also: ”Adding a
1. Place a choices field
Field to the Screen” on page 168
2. The following dialog appears.
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Fields on the Choices Dialog
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Field

Description

Descriptive
Name

Enter a description of the field.

Field Name

Enter a name for this field. This text identifies the field in the database and in
email if the form is mailed.

This text describes the field on form reports. See ”Viewing Form Reports” on
page 197.

Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are replaced by
underscores.
Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this field
(circled in red below).

List

Custom - You create your own set of choices. Use the Item and Item List
fields to do this.
Note: If, after seeing the following predefined choices, you want to customize
the choices available to site visitors, return to this field, replace the value with
Custom, then define the ranges you want in the Item field.
Age Ranges - Use the predefined choices for age ranges. You can see the
ranges on the screen after you choose this option.
Numeric Ranges -Use the predefined choices for numeric ranges. You can
see the ranges on the screen after you choose this option.
Gender -Use the predefined choices for gender. You can see the values on
the screen after you choose this option.
Marital Status - Use the predefined choices for marital status. You can see
the values on the screen after you choose this option

Allow
Selection

Click More than one to allow the site visitor to select more than one item on
the data entry screen. Otherwise, click Only one.
For example, if you click More than one, and the choices are: music, art,
sports, the user could select all three choices.
If you click Only one, the user could only select one choice.
A selection is required - Check this box if the user must select at least one
item in the list.
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Field

Description

Appearance

Click Vertical List to arrange the choices vertically.

Click Horizontal List to arrange the choices horizontally.

Click List Box to display all choices in a box. The box lengthens to display all
entries.

Item:

Enter the value that is collected when the data entry user selects this item.

Value

For example, if Interests appears in the Name field, and you want music to be
collected when the data entry user selects this item and saves the page, enter
music here.

Item:

Enter text to describe this item on the data entry screen.

Text

After you insert this field onto the screen, you can use eWeb Ed it Pr o+X ML ’s
formatting capabilities to modify its size, font, color, and other attributes.

Item List

This section of the screen displays the items that you enter in the Value and
Text fields.
Buttons near the bottom of the screen let you remove items from this list as
well as rearrange them.

Place a check in the box of any item to be checked by default on the data
entry screen. If you do, the user can accept the default or uncheck the item by
clicking in the checkbox. Note that if Only One is selected under Allow
selection (above), only one item can be selected.
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Inserting a Select List Field
Use a Select List field when you want the site visitor to select from
a predetermined list of choices. Although similar to the choices
field, when you insert a Select List field, the site visitor only sees
the first option in a drop down box.

He must click the down arrow to see the remaining values and
select one.

So, the Select List field occupies less room on the screen than a
choices field. Also, the site visitor can only choose on item on the
list. In contrast, you can allow a visitor to select several choices if
you use a choices field.
To insert a Select List field, follow these steps.
1. Place a Select List field
onto the screen. See Also:
”Adding a Field to the Screen” on page 168
2. The following dialog appears.
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Fields on the Select List Field Dialog

Field

Description

Descriptive
Name

Enter a description of the field.
This text describes the field on form reports. See ”Viewing Form Reports” on
page 197.
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Field

Description

Field Name

Enter a name for this field. This text identifies the field in the database and in
email if the form is mailed.
Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are replaced by
underscores.

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this field
(circled in red below).

List

Custom - You create your own set of choices. Use the Item and Item List
fields to do this.
See Also: ”Customizing a Standard List” on page 192
Languages - list of languages supported by Windows
Countries - list of all countries in the world
U.S States and Territories - list of all states and territories that make up the
U.S.
Canadian Provinces - list of all Canadian provinces
Age Ranges - Use the predefined choices for age ranges. You can see the
ranges on the screen after you choose this option.
Numeric Ranges -Use the predefined choices for numeric ranges. You can
see the ranges on the screen after you choose this option.
Years - list of calendar years, ranging from 2004 to 2014

Item:

Enter the value that is collected when the data entry user selects this item.

Value

For example, if Interests appears in the Name field, and you want music to be
collected when the data entry user selects this item and saves the page, enter
music here.

Item:

Enter text to describe this item on the data entry screen.

Text

After you insert this field onto the screen, you can use eWeb Ed it Pr o+X ML ’s
formatting capabilities to modify its size, font, color, and other attributes.
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Field

Description

Item List

This section of the screen displays the items that you enter in the Value and
Text fields.
Buttons near the bottom of the screen let you remove items from this list as
well as rearrange them.

Place a check in the box of any item to be checked by default on the data
entry screen. If you do, the user can accept the default or uncheck the item by
clicking in the checkbox.
First item is
not a Valid
Selection

Check here if the first item on the list is not a valid value but instead text that
prompts the user to respond to the field. An example of such text for a list of
states would be Select a state.
If you check this box and the user selects the first value on the list (most likely
by default), an error message appears when he tries to save the screen.

Customizing a Standard List
You can customize any list of predefined choices. For example,
you can change the calendar years so they begin in 1995 and run
through 2020.
To do this, follow these steps.
1. Choose the standard list that you want to customize.
2. Change the value of the List field to Custom.
3. All of the predefined choices appear in the Item List box.
4. To

•add new items, use the Item Value and Text fields
•delete an existing list item, select it and click Remove
•rearrange the list, use the Move Up and Move Down buttons
•edit a list item, select it and press the Change button

Inserting a Calendar Field
To insert a field that lets a site visitor select a date, use a Calendar
Field. To do that, follow these steps.
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1. Place a Calendar field (
) onto the screen. See Also:
”Adding a Field to the Screen” on page 168
2. The following dialog appears.

Fields on the Calendar Field Dialog

Field

Description

Descriptive
Name

Enter a description of the field.

Field Name

Enter a name for this field. This text identifies the field in the database and in
email if the form is mailed.

This text describes the field on form reports. See ”Viewing Form Reports” on
page 197.

Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are replaced by
underscores.
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Field

Description

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this field
(circled in red below).

Default
value

If you want to set a default value for this field, enter it here. For example, if this
field collects a city, and most users enter New York, enter New York as the
value.
Regardless of the default value, the site visitor can change it while completing
the screen.

Validation

Select the kind of validation to apply to this field. The choices are:

•
•

No validation - response is not checked
Cannot be blank - Response is required. The format of the response is
not checked.

If you assign Cannot be blank, the field is surrounded by red dashes when it
appears on your Web site.
Error
Message

Enter text that appears on the screen if the site visitor‘s response to this field
does not satisfy the validation criterion.
For example, if the validation criterion is Cannot be blank, the error message
could be Please enter a response.
By default, the error message is the same as the validation criterion you
choose. You can use this field to customize its text.
Note: You can only enter double-byte characters if your Windows settings
include that language. If you enter characters that are not in a language
defined in your Windows settings, question marks (?) appear instead of the
characters.

Implementing a Form on a Web Page
After you create the form, you need to link it to another page on
your Web site. You would insert the link as you would any form link.
See ”Adding a Library File to Content” on page 148.
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Next, open your Web Site, navigate to the host page, and click the
hyperlink to access the form. Now, you can test the form and make
sure it works as you expected. If needed, you can return to edit
mode, change the form, and test it again until you are happy with it.

Assigning a Task to a Form
While tasks typically help Ektron CMS400.NET users track content
activities, you can also assign a task to users or user groups
whenever a form is submitted.
For example, your Web site offers a free product demonstration to
anyone who completes a form. Whenever a site visitor submits the
form, a task is assigned to your sales department’s administrative
assistant. He uses the information on the form to schedule a
demonstration. The sales manager can review the task history to
audit sales leads and ensure demonstration requests are being
handled in a timely manner.
To set up a task that it is assigned to users or groups whenever a
site visitor completes the form, follow these steps.
Note

You should be familiar with tasks before beginning this procedure. See Also:
”Managing Tasks” on page 286

1. If you are creating a new form, assign the task at Step 3 of the
Forms Wizard.
If you are editing a form, assign the task on the form’s Edit
Properties screen.
In both cases, you identify only users and groups to whom the
task will be assigned whenever a site visitor completes the
form. Ektron CMS400.NET assigns the remaining task
information.
2. You complete the form and make it available on your Web site.
3. A visitor to your site fills out and submits the form.
4. A task is created and assigned to users and groups you
identified in Step 1.
5. Any Ektron CMS400.NET user can view all tasks created via
form submission in the Smart Desktop. See illustration below.
See Also: ”Understanding the Smart Desktop” on page 17
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Ektron CMS400.NET users and administrators can also view and

update tasks assigned to them via the Task screens on the Smart
Desktop. See ”Viewing a Task” on page 300 and ”Viewing a Task’s
History” on page 310.

Task Information
The task created upon form submission has the following
information.

Field

Value

Title

Form title, as entered by the author

Assigned to

As set up by the user who created or edited the form

Assigned by

User who created or last edited form

Priority

Normal
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Field

Value

Task
Category

Form Submission Task Category

Task type

Form Submission Task

Created by

User who created or last edited form

State

Not started

Due date

Not specified

Start date

Not specified

Description

Data from form “form name” was received on date time.
form description
Name of every field on the form: value submitted by
user into that field

email Automatically Generated Upon Form Submission
An email is automatically sent to every user named in Step 1 above
who has a valid email address in the User Information Screen. The
email’s subject line is the form name. The body of the email
contains the following information for each field on the form.

• name
• value submitted by user

Viewing Form Reports
If a form is set to store data in the database, you can run a report
that displays the submitted data. To view a form report, follow
these steps.
1. Navigate to the folder for which you want to view the report.
The View Contents of Folder screen appears.
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2. Click the form you want to view. (If you do not see your form in
the folder, make sure the Content Type drop-down box is set to
All Types or Forms.)
3. Click the View Reports button (

).

4. The View Forms Report screen appears.
5. Enter report criteria using the following table as a reference.
Field

Description

Start Date

If desired, specify a start date. The report displays
only forms that were submitted on or after the start
date.

End Date

If desired, specify an end date. The report displays
only forms that were submitted on or before the
end date.

Report Display

Specify the format to display the report.

Select Legacy
Report

Specify the version of the form or poll for which to
get a report. Using this option allows you to see
the results from previous polls and forms.

6. Click the Get Result button to display the report.

Display Formats
The submitted form data can be viewed in any of these formats.

• ”Table with Totals” on page 198
• ”Bar Chart” on page 165
• ”Summary of Selected Choices” on page 199
• ”Table of Values” on page 200
• ”List of Submitted Values” on page 201
• ”Submitted Data as XML” on page 202
Table with Totals
The table of values shows the following information for each
completed form.
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• a checkbox that lets you delete the response
• an internal identification number of the response
• the name of the user who submitted the form, if he signed in to
Ektron CMS400.NET beforehand. If the user did not sign in,

anonymous appears.

• date response was submitted
• The name of each field on the survey
- under each field name is the submitted response for the
each user

• the bottom line sums the numerical and percentage totals for
each response
Sample of Table with Totals Format

Summary of Selected Choices
This format totals, for choice and select type fields, the number of
times each choice was selected. Only choices that were selected
at least once appear.
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Sample Summary of Selected Choices Format

Table of Values
The table of values shows the following information for each
completed form.
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• a checkbox that lets you delete the response
• an internal identification number of the response
• the name of the user who submitted the form, if he signed in to
Ektron CMS400.NET beforehand. If the user did not sign in,

anonymous appears.

• date response was submitted
• descriptive name of each form field appears in the column
header

- the value entered for each field appears below the header
Sample of Table of Values Format

List of Submitted Values
The List of Submitted Values format provides the same information
as the Table of Values, but is formatted vertically rather than
horizontally. See Also: ”Table of Values” on page 200
Sample List of Submitted Values Format
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Submitted Data as XML
Displays the results of the form in an XML format. The following
information is included:

• <Title> - title of the form block
IMPORTANT!

With polls you can create a new poll question to replace an existing poll question.
By default the poll still has the same Title, ID, and other properties. You can
change the title of a new poll question when you are editing the poll.
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• <Description> - description of the form
• <SubmittedData> - information that was submitted
Sample of Submitted Data as XML

Exporting a Form’s Raw Data
After you run a report, you can export its data to a Microsoft Excel
spreadsheet file (.xls) for further analysis. If a form uses an XML
structure, each XML tag becomes a column header in the
spreadsheet.
To export form data, follow these steps.
1. Access the View Form Reports screen for the report you want
to export, as described in ”Viewing Form Reports” on
page 197.
2. Click the Export Reports button (

).

3. A File Download dialog box is displayed. Choose the option
that best suits your needs.
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4. After the data is exported, you can analyze and modify the .xls
file.

Viewing Form Information
You can view

• information about a form
• information about a form’s properties

Viewing a Form’s Information
After a form is created, you can view its information in the Forms
folder. To view a form, follow these steps.
1. Access the folder that contains the form you want to view.
2. Click the form you want to view.
3. The View Form screen displays.
4. Click the Form Properties tab.
5. The following table explains the information on the screen.

Field

Description

Form Title

Title used to reference the form

FormID

ID number automatically assigned to form

Status

The form’s current status

Description

Extended description for the form

Form Data

The type of form data: Mail or Database. See Also: ”The
Structure of Form Data” on page 158

Form Submissions

The maximum number of times a user can submit the form.
This is typically used with polls and surveys to limit one
user’s influence over the results.
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Field

Description

Assign Task to

Users and groups to whom a task will be automatically
assigned whenever a site visitor completes the form. See
Also: ”Assigning a Task to a Form” on page 195

Content Properties

Displays the properties of the form’s content

Content Title

Title of content associated with form
Note: The content name is the same as the Form name.

Content ID

Content ID number assigned to content

Status

The status of the content

Last Editor

Last user to edit the content

Start Date

Date and time when content will go live on Web site (if set
for future date)

End Date

Date and time when content will be removed from Web site
(if set for future date)

Date Created

Date and time when content was created

The View Form screen also contains several buttons to perform
actions. To learn about the buttons, see ”View Form Toolbar” on
page 212.

Viewing and Editing a Form’s Properties
To see and update additional form information that does not
appear on the View Form screen, view its properties. To do so,
follow these steps.
1. Navigate to the form’s View Form screen, as described in
”Viewing a Form’s Information” on page 204.
2. Click the Form Properties button (

).

3. The Form Properties screen displays a subset of form
information.

Ektron CMS40 0.NET User Manua l, Version 7.5

205

Working with HTML Forms

• Title and Description
• Database or Mail - if form data is emailed whenever a site
visitor submits it, enter mail property information below. See
”Mail Properties” on page 206

• Autofill form values - checked by default, this allows the form’s
fields to fill automatically when a logged-in site visitor has
previously completed the form.

• Limit Submission - when checked, you can enter the number of
times a user can submit a form in the Number of
Submissions text field

• Assign task to - see ”Assigning a Task to a Form” on page 195
• Form block’s ID number
• Mail Properties
Mail Properties

Field

Description

To

Email address to which the form is sent when submitted.
See Also: ”Retrieving email Address from the Submitted
Form” on page 207

From

Text that appears in the email’s From field. See Also:
”Retrieving email Address from the Submitted Form” on
page 207

CC

Text that appears in the email’s CC field. See Also:
”Retrieving email Address from the Submitted Form” on
page 207

Subject

Text that appears in the email’s subject field. See Also:
”Retrieving Form Data Into the Subject and Preamble
Fields” on page 209

Preamble

Beginning text of the email. See Also: ”Retrieving Form
Data Into the Subject and Preamble Fields” on page 209
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Field

Description

Send data in XML
Format

A green check means email data will be in a structured XML
packet.
A red X means the email data will be in a standard mailto
format.
For more information, see “Sending Data as XML” in the
Ektron CMS400.NET Administrator Manual Forms chapter.

Retrieving email Address from the Submitted Form
In the Mail Properties section of the Edit Form screen, you can
select email addresses submitted on the form to be inserted into
these Mail Property fields:

• To
• From
• CC
So, instead of entering a static email address, it can be
dynamically retrieved from the user’s form submission. For
example, you want to retrieve the “from” field of an email from the
information a user enters when completing the form.
To do this, use the OR to addresses in field dropdown lists circled
below. These lists contain fields that dynamically retrieve data from
the submitted form.
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Note that the To and CC fields can accept fields whose validation
type is email address or email address list. On the other hand,
the From field can only accept fields whose validation type is
email address (that is, a single email address).
To set this up, follow these steps.
1. Add a form field whose Validation type is Email address or
Email address list . The field prompts the user completing the
form to enter his email address. Label the field something like
Enter your email address.
TIP!

If the field allows more than one address, add on-screen instructions to separate
each address with a semicolon (;).
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2. Go to the Edit Form screen > Mail Properties section.
3. Move to the field labeled From:.
4. At the dropdown list following OR to addresses in field, select
the field you created in Step 1.
Now, when a user completes the form, the value he enters in the
field created in Step 1 is used for the email’s From address.

Retrieving Form Data Into the Subject and Preamble Fields
You can retrieve data from a submitted form directly to the form’s
Subject and Preamble fields. (The subject is a standard mail field,
and the preamble is text that appears at the beginning of the
email.)
For example, the form may provide a list of your products. While
the user is completing the form, he selects a product that he is
interested in. The product then becomes the subject line of the
email.
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NOTE

Since a Textarea field can span multiple lines, it can only be used with the
preamble. However, a plain text field can be used with both the subject and
preamble.

To retrieve data dynamically from a form field into the email’s
subject line or preamble, follow these steps.
1. Add a form field that collects the information you want to insert
into the email’s subject line or preamble. See Also: ”Inserting
Form Fields” on page 169
2. Go to the Edit Form screen > Mail Properties section. See
Also: ”Editing a Form” on page 210
3. Move to the field labeled Subject or Preamble.
4. At the dropdown list following OR use text in field, select the
field you created in Step 1.

Editing a Form
After you create a form, it can easily be edited if information needs
to be changed. You can update the following information by
following the procedure below.

• the form fields
• post back message
• metadata
• schedule
• comments
• Web Alerts
However to edit a form’s Title, Description, form data, or task
values, use the Edit Properties screen.
To edit a form, follow these steps.
1. Access the View Form screen for the form you want to edit, as
described in ”Viewing and Editing a Form’s Properties” on
page 205.
2. Click the Edit button (
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3. The Edit Form screen is displayed. The screen is the same as
the Add New Form screen. For documentation of individual
fields, see ”Creating a New Form” on page 159.
4. Make the necessary changes to the form.
5. Click the Save button (

).

See Also: ”Working with HTML Forms” on page 156

Editing a Form’s Content
You can edit the content associated with the form by a variety of
methods, including:

• Accessing the content by the floating toolbar on the Web page
• Editing the content by the View Form screen
• Accessing the content by the View Form content properties
screen
This section explains how to edit a form’s content from the View
Form screen. To edit a form’s content, follow these steps.
1. Access the View Form screen for the content, as described in
”Viewing a Form’s Information” on page 204.
2. Click the Edit Content button (

).

3. The Edit Content screen appears.
4. Make the necessary changes to the form’s content.
5. If needed, click the Postback Message, Metadata, Schedule,
Comment or Web Alerts tab to edit that information.
6. Click a workflow button (Submit for Publication or Publish).

Editing a Form’s Properties
See ”Viewing and Editing a Form’s Properties” on page 205

Mailto or Database Form
The Forms feature lets you create a mailto or a database form to
use on your Web site. When creating or editing a form, you must
specify the type of form you are creating. The options are:
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• Send it via email
• Store it in a database
• Send it via email and store in a database
See ”Viewing and Editing a Form’s Properties” on page 205 for
information about toggling this option on and off.

Advantages of a Mailto Form
By creating a mailto form, any email generation is done on the
server-side, not on the client. This means that site visitors can
submit email whether or not the client has email software.

Storing Form Data in a Database
By storing form data in the Ektron CMS400.NET database, you
can keep information submitted by site visitors and view reports on
that information. You can also export the form data to a
spreadsheet.

Deleting a Form
You can easily delete forms that are no longer needed.
NOTE

Deleting a form also deletes its associated content and information.

To delete a form, follow these steps.
1. Access the View Form screen for the form you want to delete.
2. Click the Delete Form button (

).

3. A confirmation message is displayed.
4. Click OK.

View Form Toolbar
Several toolbar buttons and tabs help you work with forms.
To learn about toolbar buttons available when creating or editing a
form, see “Inserting Form Fields” on page 169.
Ektron CMS40 0.NET User Manua l, Version 7.5

212

Working with HTML Forms

Button or
Tab

Name

Description

More Information

Edit Content

Edit the form’s content, which
contains the form fields

”Editing a Form’s
Content” on page 211

View Staged/
Published Content

Click View Staged button to view
content that has not yet been
published.
Click View Published button to view
content that is live on the Web site.

View History

View (and possibly restore) older
versions of a content block

”Accessing Content
History” on page 108

View Difference

Compare two versions of content

”Comparing Versions of
Content” on page 98

Edit Form Properties

Edit Form properties not available
via the Edit Content button

”Viewing and Editing a
Form’s Properties” on
page 205

Delete Form

Delete a form

”Deleting a Form” on
page 212

Check Links

Check for other content that contains
a link to this form.
You would typically use this feature
to remove the links before deleting
content. If you do not remove the
links, they are inoperative after the
content is deleted.

Add Task

Add a task

View Task

View task information

Add Form

Add a new form

”Creating a New Form”
on page 159

Export Raw Data

Download form data to a Microsoft
Excel spreadsheet

”Exporting a Form’s Raw
Data” on page 203
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Button or
Tab

Name

Description

More Information

View Reports

View submitted form data; can select
range of dates

”Viewing Form Reports”
on page 197

View Content
Properties

Access view properties for the
content

”Viewing and Editing a
Form’s Properties” on
page 205

View
(language)

View

If you can view forms in more than
one language, select a language
from the drop down list

Add

Add

-select
language-

-select language-

Lets you copy current form into new
block and translate it to selected
language

or Form
Properties

”Translating Content” on
page 818

Creating Polls and Surveys
Polls and surveys are a type of form. All of the same functionality is
available and applies.
WARNING!

For complete understanding of Forms, polls, and surveys, you should read the
entire chapter ”Working with HTML Forms” on page 156.

• A poll is generally one question and appears on a site for a
very short time, an hour or a day.

• A survey is usually multiple questions and appears on your site
for a longer time than a poll.
NOTE

For information on scheduling when your polls and surveys appear on the site,
see ”Scheduling Content to Begin and End” on page 65.

With polls and surveys, you can show ongoing results to site
visitors after they submit their answers.
The following sections provide information about creating a poll or
survey beyond the normal form information.

• ”Working With Polls” on page 215
• ”Creating a Survey” on page 220
• ”Making Form Results Available to Site Users” on page 163
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• ”Viewing a Form’s Information” on page 204
• ”Viewing and Editing a Form’s Properties” on page 205
For information on how to display a poll or survey on a Web site,
see the Developer Reference Manual section “Introduction to
Ektron CMS400.NET Server Controls” > “Poll Server Control”.

Working With Polls
Below is an example of a poll. Note that when a site visitor hovers
over the poll, the question also appears as ToolTip text.

This subsection contains the following:

• ”Creating a New Poll in the Workarea” on page 215
• ”Replacing a Poll from the Web Site” on page 217
• ”Editing a Poll from the Web Site” on page 219
Creating a New Poll in the Workarea
To create a new poll, follow these steps.
NOTE

You can also create a new edition of a poll in another language by copying an
existing poll and translating it. For more information, see ”Translating Content” on
page 818.
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NOTE

For the steps to create a new form, see ”Creating a New Form” on page 159. For
the steps to create a new survey, see ”Creating a Survey” on page 220.

1. Choose a content folder.
2. From the View menu, click Language, and select the language
in which to create the poll.
3. Click New > HTML Form/Survey.
4. The New Form screen appears.

NOTE

If you choose Standard Poll or Blank Survey, the number of steps in the Forms
Wizard changes from five to four. This happens because the Assign Tasks step is
removed.

5. Choose Standard Poll. You can click the preview icon (
next to any sample form to preview it before choosing it.

)

6. Click the Next button.
7. Enter or edit the form’s Title and Description.

•Title - used to reference the poll within the Workarea
(required)

•Description - an extended description of the poll.
8. Click the Next button.
9. This screen lets you add a poll question and possible replies.
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NOTE

This screen allows you to add up to eight replies. If you have more than eight
replies, you can add them in the forms editor after clicking the Done button.

10. Click the Next button.
11. This screen indicates that you have entered the basic poll
information and should click the Done button to further edit and
view the form’s fields.
12. After clicking the Done button, the form editor launches so you
can edit existing fields and properties. In addition, you can set
post back and schedule information, add metadata and
comments, change the title, and submit the poll for publication.
NOTE

From this screen, you can add more replies to your poll by right clicking on the
choices field and clicking properties. See Also: ”Inserting a Choices Field” on
page 185.

Replacing a Poll from the Web Site
When logged into Ektron CMS400.NET, you can right click on a poll
and choose New Poll to replace the current one. The title of the
poll, its ID, and properties stay the same. Only the questions and
answers change.
To replace a poll, follow these steps.
1. Log into Ektron CMS400.NET.
2. Navigate to the Web page that hosts the poll.
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3. Right click the poll and choose New Poll.

4. The Workarea opens, indicating you are at step three of the
Poll Wizard.

5. Add a new question to the Question text box.
6. Add possible responses to the Choices text boxes.
7. Click Next.
8. Click Done.
9. The form editor launches, allowing you to edit the fields and
properties. In addition, you can set post back and schedule
information, add metadata and comments, change the title and
submit the poll for publication.
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10. Once published, the updated poll appears on the site.

Editing a Poll from the Web Site
To edit an poll on a Web site, follow these steps.
WARNING!

If you are logged into the site and create a new poll by right clicking on a poll
selecting New, the existing poll is replaced by the new one.

1. Log on to the Ektron CMS400.NET Web site.
2. Right click the poll you want to change and click Edit.

3. Make changes to the poll using the Forms editor.
4. Submit the poll to the Approval Process.
Ektron CMS40 0.NET User Manua l, Version 7.5

219

Working with HTML Forms

Creating a Survey
To create a new survey, follow these steps.
NOTE

You can also create a new edition of a survey in another language by copying an
existing form and translating it. For more information, see ”Translating Content”
on page 818.

NOTE

For the steps to create a new poll, see ”Working With Polls” on page 215. For the
steps to create a new form, see ”Creating a New Form” on page 159.

1. Choose a content folder.
2. From the View menu, click Language, and select the language
in which to create the form.
3. Click the New > HTML Form/Survey.
4. The New Form screen appears.
.

NOTE

When you choose Standard Poll or Blank Survey, the number of steps in the
Forms Wizard changes from five steps to four steps. This happens because the
Assign Tasks step is removed.

5. Choose Blank Survey. You can click the preview icon (
next to any sample form to preview it before choosing it.

)

6. Click the Next button.
7. Enter or edit the form’s Title and Description.
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•Title - used to reference the survey within the Workarea
(required)

•Description - an extended description of the survey.
8. Click the Next button.
9. This screen lets you determine what happens after the site
visitor completes the survey. The choices are:

•Display a message - See ”Composing the Postback
Message” on page 161

•Redirect to a file or page - Identify a file or a page on your
Web site that is launched when the visitor completes the
form

- An example of a file is a white paper (a common file
format is .PDF) that the visitor requested

- An example of a page is one that lets the visitor
download your product

•Redirect to an action page and forward form data - See
”Redirect to an Action Page and Forwarding Form Data” on
page 162

•Report on the form - See ”Making Form Results Available to
Site Users” on page 163
10. Click the Next button.
11. A screen indicates that you have entered basic information
about the survey and should click the Done button to enter the
survey’s content. This procedure is described in ”Creating a
Form’s Content” on page 166.
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The Document Management System (DMS) lets you import
Microsoft Office files along with other types of files into Ektron
CMS400.NET. (Non-Office files are known as managed files.)
Collectively, these files are known as assets.
After being saved to Ektron CMS400.NET, assets can be updated
and tracked like HTML and XML content. If you’re familiar with how
content is handled, most of what you know applies to assets. For
example, assets

• can be stored in folders with other content, or in separate
folders that you create just for them

• are assigned content ID numbers
• can have summary, metadata, comment, task, schedule, and
taxonomy information

• inherit permissions and approvals from their folder properties
• progress through the workflow (check out, check in, publish)
• retain a history so you can restore earlier versions
• can be searched
• support foreign language editions
• can have a task assigned to them
• appear on content reports
• update the Smart Desktop listing of files awaiting approval,
checked out, tasks, to expire
When an asset is imported to the CMS then saved, a copy of it is
saved to the Document Management server. Then, whenever a
user edits and saves the asset, a new copy is stored. In this way,
you can review and, if needed, restore a prior version.
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This chapter explains the Document Management Functionality
through the following topics.

• ”Supported Types of Assets” on page 223
• ”Security” on page 224
• ”Software Requirements” on page 224
• ”Working with Microsoft Office Documents” on page 227
• ”Working with Managed Files” on page 253
• ”Asset Workflow” on page 258
• ”Adding Assets to Collections and Menus” on page 259
• ”Asset Reports” on page 259

Supported Types of Assets
Ektron CMS400.NET can support all file types. By default, only the

following types are supported. However, your administrator can
add or remove any file type via the Asset Server Setup screen.
EXCEPTION!

Ektron CMS400.NET does not support double extensions, such as
filename.aspx.vb.

• Microsoft Office 2000 or later documents: Word, Excel,
Powerpoint, Project, Publisher, Visio, etc.

• Managed files: *.zip files, PDFs, *.txt files, graphic files such as
*.gif and *.jpeg, Open Office documents such as *.odf, *.odt

• Multimedia files such as *.swf, *.mp3, *.wav. *.avi
NOTE

The file types that can be uploaded are determined by your administrator. If you
try to upload the wrong type of file, the following error message appears.
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Security
For the purposes of security, assets are treated like other content.
Your system administrator applies security to each folder,
determining which user groups can perform which tasks on the
content in a folder. For more information, see the “Setting
Permissions” chapter of the Ektron CMS400.NET Administrator
Manual .

Software Requirements
Your production server must run Windows 2003 server or Windows
2000.
See Also:

• ”Browser Requirements” on page 224
• ”Installing FireFox Plug In” on page 225

Browser Requirements

Feature

Browser Requirements

For more information, see

Edit Microsoft Office
documents within

Internet Explorer. Option does not appear
with Firefox.

”Editing an Office Document” on
page 244

C MS 4 00 .NE T

Note: Firefox users can check an Office
document out to their computer, edit it
using Office, then drag and drop the file
back into C M S 4 0 0 . N E T . See ”Editing a
Managed File” on page 256.
Note: If your computer has Windows
Vista, you must turn off its User Account
Control to use this feature. For details,
see http://www.microsoft.com/technet/
technetmag/issues/2007/06/uac/
default.aspx

Multiple DMS Documents
Option

Internet Explorer. Option does not appear
with other browsers.
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Installing FireFox Plug In
If you want to use the Document Management’s drag and drop
feature with the Firefox browser, you need to install software to
enable it. You only need to do this the first time on a computer.
Afterwards, the features are available to you with no additional
effort.
Follow these steps to install the Firefox plug-in software.
1. Launch the FireFox browser.
2. In the Ektron CMS400.NET Workarea, open a content folder.
3. Click the Add Assets button (circled below).

4. The following box appears in the center of the screen.

5. Click the word here.
6. The following dialog appears.
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7. Click the down arrow next to Netscape (default) and select
Other.
8. Browse to C > Program Files > Mozilla Firefox > Firefox.exe.
9. Click Open.
10. Firefox.exe appears next to the Open with field.
11. Press OK.
12. The following dialog appears.
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13. Click Install Now.
14. Close then reopen the Firefox browser.
15. You can now drag and drop files into Ektron CMS400.NET.

Working with Microsoft Office Documents
This section explains how to work with Microsoft Office documents
through the following subtopics.

• ”MS Office Document Menu Options” on page 228
• ”Notes on Working with Microsoft Office Documents” on
page 228

• ”Importing Office Documents” on page 230
- ”How Imported Documents are Named” on page 231
- ”Adding Documents Using the DMS Document Option” on
page 232

- ”Adding Documents Using the Multiple DMS Documents
Option” on page 233

- ”Adding Documents Using Drag and Drop” on page 235
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- ”Adding Documents to a Mapped Network Folder” on
page 238

• ”Editing an Office Document” on page 244
• ”Deleting an Office Document” on page 246
• ”Checking Out, Saving, and Replacing an Office Document” on
page 247

• ”Saving an Office Document” on page 249
• ”Saving an Office Document in .html Format” on page 249

MS Office Document Menu Options
Depending on a document’s status, your role, and position in the
document’s approval chain, any of the following options may be
available when you display the dropdown menu for an Office
document.

See Also: ”Dropdown Menu Options” on page 37

Notes on Working with Microsoft Office Documents
• Prerequisites
- Your computer has MS Office
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- Internet Explorer to work with Office documents within
Ektron CMS400.NET.

NOTE

While you cannot edit within Ektron CMS400.NET using Firefox, you can save an
Office document to your computer, edit it, then drag and drop the updated version
to Ektron CMS400.NET.

• Verify the following settings for every Office document type that
you work with.

- Open Windows Explorer.
- Click Tools > Folder Options > File Types.
- Click an Office file type you work with (for example, DOC
Microsoft Word Document).

- Click the Advanced button.
- Change the checkboxes at the bottom of the screen so they
look like this.

- Click OK
• Problems can arise if you try to open a document created with
Office 2007 and your computer has an earlier version of Office.
The best solution is to upgrade your computer to Office 2007.
If you cannot do this, the next best option is to install Microsoft
Windows Compatibility Pack. See https://www.microsoft.com/
downloads/details.aspx?FamilyId=941B3470-3AE9-4AEE8F43-C6BB74CD1466&displaylang=en .
Once installed, you can successfully work with Microsoft Word
2007 documents even though you have Office 2003, Office XP,
or Office 2000. At this time, there is no Compatibility Pack that
lets you work with other Office documents, such as Excel or
Powerpoint.
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Importing Office Documents
DMS can store and help you manage Office documents. This
section explains how to import any document into Ektron’s
Document Management System.
Ektron CMS400.NET provides five ways to import Microsoft Office

documents. They are described below.
NOTE

Only users with Add permission for a folder can import documents into it. See
Also: Ektron CMS400.NET Administrator Manual chapter “Setting Permissions”

Method

Advantages

Disadvantages

For more
information, see

New > DMS
Document from View
Contents of Folders
screen

•

Can enter Summary, Metadata
information etc. for
each document

•

Slower when
importing several
Office documents

•

”Adding Documents
Using the Multiple DMS
Documents Option” on
page 233

•

Can create unique
title for each document

Cannot maintain
Windows folder
structure

•

You can check in or
submit document for
approval

•

Can upload several
files at once, so it’s
faster than New
DMS Document
option

•

Document title
taken from Windows
file name

•

Requires Internet
Explorer and MS
Office

New > Multiple DMS
Documents from View
Contents of Folders
screen

•

More efficient when
same summary,
metadata, schedule, etc., apply to
many documents

•

You can check in or
submit document for
approval
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Method

Advantages

Disadvantages

For more
information, see

Drag and drop into
CM S40 0.NET , from
View Contents of
Folders screen

•

Can upload several
files at once, so it’s
faster than New
DMS Document
option

•

Content is in
checked in status;
submitting it for publishing is a separate
step

”Adding Documents
Using Drag and Drop”
on page 235

•

Can drag/drop
folder structure;
CM S40 0.NET recreates it in
Workarea

•

Document title
taken from Windows
file name

•

More efficient when
same summary,
metadata, schedule, etc. apply to
many documents

•

User doesn’t need
to install or learn
CMS software

•

Document title
taken from Windows
file name

•

Can drag/drop
folder structure;
CM S40 0.NET creates it in Workarea

•

Content is in
checked in status;
submitting it for publishing is a separate
step

•

Cannot assign language to content or
work with content in
a language other
than your computer’s default language

Drag and drop into a
mapped network folder

”Adding Documents to a
Mapped Network
Folder” on page 238

How Imported Documents are Named
When you use the New > DMS Document file import option, you
enter an Ektron CMS400.NET title for the file.
When you import an Office document or managed file into Ektron
CMS400.NET using any other method, its name is the file name
without the extension. So, a file named mypicture.jpg becomes
mypicture in Ektron CMS400.NET.
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While it may appear that the file extension was removed, it is
retained and reappears for assets when you use the Edit option,
on the View Contents of Folder screen (circled below).

The original file extension also appears when you check out.

If you import a file of the same name but a different extension into
the folder, the new file’s name has the next available number
appended to it. For example, mypicture(2).

Adding Documents Using the DMS Document Option
To add a new Office document to Ektron CMS400.NET via the New
> DMS Document menu option, follow these steps.
1. From the Workarea, select the Content tab.
2. Select the folder in which you want to place the document. See
Also: ”Working with Folders and Content” on page 28
3. The default language icon appears next to the screen title. To
create a document for a different language, click View >
Language and select the language.
4. Click New > DMS Document.
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5. The following screen appears.

6. Click the Browse button and browse to the file you want to
import. Click OK.
7. Enter a Title.
NOTE

If you want to retain the original document name, insert the full filename into the
Title field. For example, you could enter mydocument.doc.

8. Use the Content Searchable checkbox to determine if the
content should be searchable. See Also: ”Content Searchable”
on page 46.
9.

If desired, add a summary, metadata, a schedule, and
comments. See Also:

•”Adding a Content Summary” on page 73
•”Adding or Editing Metadata” on page 77
•”Scheduling Content to Begin and End” on page 65
10. Check in or submit the content for publishing as you would
HTML content. See Also: ”Buttons on the Add Content Screen”
on page 50

Adding Documents Using the Multiple DMS Documents Option
To add Office documents to Ektron CMS400.NET via the New >
Multiple DMS Documents menu option, follow these steps.
NOTE

This option is only available if you are using Internet Explorer and Office is
installed on your computer.

Ektron CMS40 0.NET User Manua l, Version 7.5

233

Using the Document Management System

TIP!

If you will apply the same information (Summary, Metadata, Categories, etc.) to
several files, place those files in the same Windows folder before starting this
procedure.

1. From the Ektron CMS400.NET Workarea, select the Content
tab.
2. Select the Ektron CMS400.NET folder in which you want to
place the documents. See Also: ”Working with Folders and
Content” on page 28
3. The default language appears next to the screen title. To create
a document for a different language, click View > Language
and select the language.
4. Click New > Multiple DMS Documents.
5. The Edit Content in Folder screen appears. The lower portion
of the screen resembles Windows Explorer.

The left frame shows folders in your computer. The right frame
shows files in the selected folder.
6. In the left frame, select the folder that contains files you want to
upload.
7. In the right frame, check the box next to each file you want to
upload. To select all files in the folder, check the box in the
header (circled below).
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NOTE

You can only import files from one folder at a time.

8. If appropriate, enter the files’ summary, metadata, schedule,
tasks, comments, or category. Any information you enter is
applied to all selected files.
9. To check in the files, click the Check In button (
top left corner.

) from the

To submit the files into the approval chain, click the Submit
(

) or Approve (

) button.

Adding Documents Using Drag and Drop
When using drag and drop, you can choose individual files or a
folder. If you choose a folder, its structure is recreated in Ektron
CMS400.NET even if it is several levels deep.
1. From the Ektron CMS400.NET Workarea, select the Content
tab.
2. Select the Ektron CMS400.NET folder in which you want to
place the documents. See Also: ”Working with Folders and Content” on
page 28

NOTE

You cannot drag and drop a file into a folder for which XML Smart Forms are
required.

3. The default language appears next to the screen title. To create
the documents in a different language, click View > Language
and select the language.
4. Click the Add Assets button (circled below).
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5. The drag and drop window appears.

NOTE

If you are using Ektron CMS400.NET with the FireFox browser for the first time,
see ”Installing FireFox Plug In” on page 225.

6. Resize Ektron CMS400.NET so that it occupies the left half of
the screen.
7. Open Windows Explorer. Resize it so it occupies the right half
of the screen.
8. Find the folder or assets you want to upload.
9. From Windows Explorer, select then drag and drop the folder
or assets onto the drag and drop window.
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10. The following screen appears.
.

If any asset being uploaded is not supported, an error message
appears: An error occurred copying some or all of the selected
files. However, all supported files are uploaded. See Also:
”Supported Types of Assets” on page 223
11. If Ektron CMS400.NET requires you to apply metadata or a
taxonomy category to the content, the following screen
appears.
NOTE

Your system administrator creates the metadata screen. The image below is only
an example of what it might look like.
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12. Required metadata field labels are red and have an asterisk
(as title does above). Complete all required metadata. See
Also: ”Adding or Editing Metadata” on page 77
If the Category tab appears, apply at least one taxonomy category
to this asset. See Also: Ektron CMS400.NET Administrator Manual
section “Taxonomy.”The status of a dragged and dropped
document depends on the approval chain.

• If you are the last approver, or if there is no approval chain, its
status is Approved.

• If there is an approval chain and you are not the last approver,
its status is Checked In (I).

Adding Documents to a Mapped Network Folder
You can set up a mapped network folder then drag and drop
folders or assets into it. The advantage of this method is that you
can upload documents without installing or learning how to use
Ektron CMS400.NET.
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When using drag and drop, you can choose individual assets or a
folder. If you choose a folder, Ektron CMS400.NET recreates that
folder structure, even if it is several levels deep. After the assets
are uploaded, they are set to Checked In status.
You can also delete and move assets using the mapped network
folder.
This section explains these procedures.

• ”Language Restrictions on Content in a Mapped Network
Drive” on page 239

• ”Setting up a Mapped Network Drive” on page 239
• ”Dragging and Dropping Assets into a Mapped Network Drive”
on page 241

• ”Viewing Managed Files in a Mapped Network Drive” on
page 242

• ”Removing Mapped Network Drives” on page 243
Language Restrictions on Content in a Mapped Network Drive
You cannot choose a language for assets in a mapped network
folder-- they are automatically assigned the Ektron CMS400.NET
default language (set in the siteroot/web.config file at the
ek_DefaultContent Language element).
And, you cannot work with assets of a language other than your
computer’s default language. For example, if your computer’s
default language is English and your version of Ektron
CMS400.NET has Spanish content, you cannot edit that content in a
mapped network folder.

Setting up a Mapped Network Drive
Prerequisites:

• The path to your Ektron CMS400.NET Web site. It is something
like this: http://server23/CMS400. If you do not know the path,
ask your system administrator.

• an Ektron CMS400.NET user name and password
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1. Right click the Windows Start button.

2. Choose Explore. Windows Explorer opens.
3. Click Tools > Map Network Drive.

4. The Map Network Drive screen appears. Click Sign Up for
Online Storage or Connect to a Network Server.
5. A wizard screen appears. Click Next.
6. Another wizard screen appears. Click Choose another
network location. Click Next.
7. A third wizard screen appears. Enter the path to your Ektron
CMS400.NET site, followed by the ekdavroot folder. For
example, http://server23/CMS400/ekdavroot. Click Next.
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WARNING!

If your computer runs Microsoft Vista and you see this error message The folder
you entered does not appear to be valid. Please choose another, refer to this
Ektron KB article: http://dev.ektron.com/kb_article.aspx?id=15176.

8. A login screen appears (see below). Enter your Ektron
CMS400.NET username and password. Click OK.

9. Another wizard screen appears. Name the folder. You will use
this name to identify the folder when you want to drag and drop
assets to it. Click Next.
10. The Finish screen appears.

Dragging and Dropping Assets into a Mapped Network Drive
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Use Windows Explorer to drag and drop folders or assets into the
mapped network folder.
WARNING!

If a Windows folder has more than 1500 files, Windows Explorer may time out
while trying to open it. To remedy this problem, divide your files in that folder into
several child folders.

1. Open Windows Explorer. Resize it so it occupies the left half of
the screen.
2. Open the folder that contains the folders or assets you want to
upload to Ektron CMS400.NET.
3. Open a second instance of Windows Explorer. Resize it so it
occupies the right half of the screen.
4. In that window, open My Network Places. Under that, find the
mapped network folder you created in ”Setting up a Mapped
Network Drive” on page 239.
5. A login screen appears. Enter your Ektron CMS400.NET
username and password. Click OK.
6. Open the Ektron CMS400.NET folder into which you want to
upload assets or folders.
7. From the left window, drag and drop assets or folders into the
mapped network folder.
If any of the assets being uploaded is not supported, an error
message appears: An error occurred copying some or all of the
selected files. However, all supported assets are uploaded. See
Also: ”Supported Types of Assets” on page 223

Viewing Managed Files in a Mapped Network Drive
If you want to view individual managed files within a mapped
network drive folder, follow this procedure.
1. Open the site

root/web.config

file.

2. Go to this line:
<!--remove verb="GET,HEAD,POST" path="*"/-->

3. Remove the comment characters (in red above).
4. In the following lines, insert beginning and ending comment
characters as shown in red below.
<!--add verb="GET,POST" path="*.doc" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.docx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xls" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
<add verb="GET,POST" path="*.xlsx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
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<add
<add
<add
<add

verb="GET,POST"
verb="GET,POST"
verb="GET,POST"
verb="GET,POST"

path="*.ppt" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
path="*.pptx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
path="*.vsd" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/>
path="*.vsdx" type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/-->

<!-- Enable the line below and remove all office specific mappings above for Server 2003 with
private assets and enable remove verb command-->

5. Go to this line:
<!--add verb="GET,HEAD,POST" path="*"
type="Ektron.ASM.EkHttpDavHandler.EkDavHttpHandlerFactory"/-->

6. Remove the comment characters (in red above).
After you make this change, you can click to view any image file in
the ekdavroot folder.

Removing Mapped Network Drives
Ektron CMS400.NET’s DMS feature creates a mapped, ekdavroot
network drive for many functions. For example, if you sign on to
Ektron CMS400.NET and create a new folder, a new mapped,
ekdavroot network drive is created.

If you find that ekdavroot folders clutter up your My Network Places
folder, you can delete them. Deleting ekdavroot folders has no
impact on your ability to use Ektron CMS400.NET.
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Editing an Office Document
There are two ways to edit an Office document if you are using the
Internet Explorer browser and Office is installed on your computer.

• ”Edit in Microsoft Office” on page 244
• ”Edit Using a Mapped Network Folder” on page 245
NOTE

Firefox users can check an Office document out to their computer, edit it using
Office, then drag and drop the asset back into CMS400.NET.

Edit in Microsoft Office
Prerequisites

• Your computer has MS Office.
• The Internet Explorer browser. You cannot use Firefox.
To use this option, click the document from the Ektron CMS400.NET
folder and select Edit in Microsoft Office from the dropdown
menu.

The document opens within Office. Make your changes and save
it. When you do, the revised version is saved to Ektron
CMS400.NET.
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NOTE

If you want to edit the document’s Summary, Metadata, Schedule, Comment,
Task, or Taxonomy category information, click the asset from the Ektron
CMS400.NET folder, then select Edit Properties from the dropdown menu.

When you begin to edit the document, its status changes to
Checked Out (0). When you make your changes and save, it is
Approved.
See Also:

•”Adding a Content Summary” on page 73
•”Adding or Editing Metadata” on page 77
•”Managing Tasks” on page 286
•”Scheduling Content to Begin and End” on page 65
•Ektron CMS400.NET Administrator manual chapter “Web
Alert Feature” ”Web Alert Feature” on page 931

Edit Using a Mapped Network Folder
You can edit an Office document directly from a mapped network
folder. To do that, follow these steps.
1. Set up a mapped network folder, as described in ”Setting up a
Mapped Network Drive” on page 239.
2. Use Windows Explorer to open the folder.
NOTE

If any Windows folder has more than 1500 files, Windows Explorer may time out
while trying to open it. To remedy this problem, divide your files in that folder into
several child folders.

3. Open a document using Office, make changes, and save it.
You can also delete and move documents using the mapped
network folder.
The document is now in checked into Ektron CMS400.NET, and can
appear on your Web site when approved. Also, a history of every
saved version is retained so you can restore previous ones if
necessary. You cannot enter or change Ektron CMS400.NET
document information (Summary, Metadata, etc.) in the mapped
network folder -- someone must use Ektron CMS400.NET to do that.

Status of Document Saved to Mapped Network Folder
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The status of a document saved to a mapped network folder
depends on the approval chain and the user who signed in when
the mapped network folder was created.

• If you are the last approver, or if there is no approval chain, its
status is Approved.

• If there is an approval chain and you are not the last approver,
its status is Checked In (I).
Also, if the content’s folder requires metadata or a taxonomy
category which has not been entered, its status is Checked In (I).

Deleting an Office Document
NOTES

You must have delete permissions for the folder that contains the document.
(Permissions are explained in the Ektron CMS400.NET Administrator manual
It is good practice to check for broken quicklinks before deleting documents. See
”Checking for Broken Quicklinks” on page 59.

To delete an Office document, follow these steps.
1. Navigate to the Workarea’s Content folder.
2. Open the folder that contains the document.
3. Place the cursor over the document
4. Hover the cursor over the triangle ( ) on the right end of the
document and click. A dropdown menu appears.
5. Click Delete.
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NOTE

If you do not see Delete, either you lack permission to delete the content or its
status makes it ineligible for deleting.

6. The following message appears.

7. Click OK to delete the document.
Like publishing, deleted content must go through the approval
chain before it is removed. If you are the last approver in the
approval chain, the content is deleted immediately. See Also:
”Approving/Declining Content” on page 87

Checking Out, Saving, and Replacing an Office Document
If you check out and save an Office document to your computer,
you would typically edit it using Office. While it is checked out, only
you or a system administrator can check it back in. Other users
cannot edit it. You may use this feature to work on the document
on your computer, copy it to another computer, or even email it to
someone who does not have access to Ektron CMS400.NET.
You can also use the Check Out and Save As option to edit an
Office document if you use the Firefox browser. Firefox does not let
you edit Office documents within Ektron CMS400.NET, as you can
with Internet Explorer. To work around this limitation, check out the
Office document, save it to your computer, and edit it.
When all edits have been entered, drag and drop the document
back to Ektron CMS400.NET.
Follow these steps to copy an Office document to your computer,
edit it, then replace the version in Ektron CMS400.NET.
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IMPORTANT!

There are several ways to import a document into Ektron CMS400.NET. Some
methods retain the original file name while others let the user assign a name.
When you check out and save a document to your computer, it is saved under the
original file name, which may be different from its Ektron CMS400.NET name.
The original file name is on the screen that appears after you select Check out
and Save as (circled below).

Make note of the original file name, because you use it to identify the file after it is
saved to your computer.

1. In Ektron CMS400.NET, open the folder that contains the Office
document.
2. Hover the cursor over the triangle ( ) on the right end of the
document and select Check out and Save As.
3. You are prompted to open or save the document. Click Save.
4. Select a folder to which you want to save the document.
5. The document’s status changes to checked out (O).
6. Edit the document in Office.
NOTE

If you change your mind and do not change the document, but simply close
Office, the document remains Checked Out (O). Use the Check In menu option to
check it in.

7. Drag and drop the edited document. See ”Adding Documents
Using Drag and Drop” on page 235.
8. You are asked to confirm the file replace. Click Yes.
9. The document is submitted for approval.
10. The revised document is saved in Ektron CMS400.NET.
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Saving an Office Document
You would typically save an Office document to your computer in
order to distribute it to others, or if you want a personal copy. You
should not save a document to your computer if you plan to edit it
then replace the version in Ektron CMS400.NET -- doing this may
overwrite edits made by other users.
If you want to edit a document, use the Edit in MS Office or
Check out and Save As menu option. Both options set the
content to checked out status, which prevents non-administrator
users from editing it until you check it back in.
Follow these steps to save an Office document.
1. In Ektron CMS400.NET, open the folder that contains the Office
document.
2. Hover the cursor over the triangle (
document and click Save As.

) on the right end of the

3. You are asked if you want to open or save the document.
Choose Save.
4. Select a folder to which you want to save the document.

Saving an Office Document in .html Format
This feature converts Office documents to HTML format, which
means they are formatted to display within a browser. As a result,
anyone visiting your site can view the document, whether or not
Microsoft Office is installed on their computer.
WARNING!

Only Microsoft Word and Excel documents can be published as HTML. Ektron
CMS400.NET does not support saving Powerpoint or Visio documents as
HTML.

There are two ways to save an Office document in .html format.
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Method

Advantages

For details, see

1.

You don’t need to know the path
to your Web site’s root folder.

”Saving an Office
Document as .html from
Ektron CMS400.NET” on
page 251

You don’t need to drag and drop
document to C M S 4 0 0 . N E T

”Saving Office Document
as .html from Your
Computer” on page 252

Drag and drop Office document into
C MS 4 00 .NE T .

2.

Use Edit in MS Office option to
save it in html format.

1.

Open an Office document on your
computer.

2.

Save it in html format to the
ekdavroot folder in your Web root.

Warnings About Saving in .html Format
Regardless of how you save Office documents as HTML, be
careful to set up procedures that prevent HTML content from being
overwritten. For example:
1. You save a Word document as .html.
2. Someone edits the .html version.
3. You save the original Office Document as .html again.
In this scenario, the edits made in step 2 are overwritten by step 3.
It is important to establish procedures that avoid such problems.

Saving an Office Document as a Web Page
When saving a Word document, after you choose Save as from
Word’s File menu, there are two choices for saving as .html.
NOTE

When saving an Excel document, Save as Web Page (*.htm, *.html) is the only
option.

• save as Web Page
• save as Web Page Filtered
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NOTE

For a description of the differences between these options, see http://
office.microsoft.com/en-us/help/HP030852781033.aspx.

Ektron recommends save as Web Page, Filtered because the
resulting HTML is almost identical to the original document. The
save as Web Page is not a good option because its HTML content
does not match the original document and may cause problems
when being edited.

Handling Images Embedded within a Word Document
If you save an Office document that includes images, they appear
when anyone is editing the document as well as when it appears
on your Web site. In addition, the images are saved to the
corresponding Ektron CMS400.NET Library folder. In this way, other
Ektron CMS400.NET users can apply the images to HTML content
as needed.
See Also: ”Library Folder” on page 131

Saving an Office Document as .html from Ektron CMS400.NET
This procedure assumes the Office document has been saved to
Ektron CMS400.NET. Procedures for doing this are explained in
”Importing Office Documents” on page 230.
See Also: ”Warnings About Saving in .html Format” on page 250
1. Within the Ektron CMS400.NET Workarea, open the Content
area.
2. Open the folder that contains the Office document you want to
save as .html.
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3. Hover the cursor over the triangle (
document you want to save

) on the right end of the

4. Click Edit in Microsoft Office. The document opens within
Office.
5. From Office’s File menu, select Save as Web Page.
6. In the Save as Type field, select Web page, Filtered (*,htm,
*.html). See Also: ”Saving an Office Document as a Web
Page” on page 250

7. Click the Save button.
8. You may be warned about formatting features not supported in
HTML. Press Continue.
9. A dialog prompts you to enter your Ektron CMS400.NET user
name and password.
10. Ektron CMS400.NET’s folders appear in a Save as window. The
folder that contains the Word document is the default folder.
Select that or any other Ektron CMS400.NET folder and click
Save.
11. The Office document is saved as an .html file into Ektron
CMS400.NET.
12. Close the document and exit from Office.

Saving Office Document as .html from Your Computer
1. Open the Office Document.
2. Click File > Save as (*,htm, *.html).
3. Click My Network Places and navigate to ekdavroot folder on
the server that hosts Ektron CMS400.NET.
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4. Ektron CMS400.NET’s folders appear. The folder that contains
the Word document is the default folder. Select that or any
other Ektron CMS400.NET folder.
5. In the Save as Type field, select Web page (*.htm, *.html) or
Web Page, filtered (*.htm, *.html). See Also: ”Saving an
Office Document as a Web Page” on page 250.
6. Click the Save button.
7. You may be warned about formatting features not supported in
HTML. Press Continue.
8. A dialog prompts you to enter your Ektron CMS400.NET user
name and password.
9. The Office document is saved as an .html file into Ektron
CMS400.NET.
10. Close the document and exit from Office.
The status of the document depends on the approval chain and the
user who signed in when the mapped network folder was created.

• If you are the last approver, or if there is no approval chain, its
status is Approved.

• If there is an approval chain and you are not the last approver,
its status is Checked In (I).

Working with Managed Files
Ektron CMS400.NET can also track and manage any non-Office

type of file that runs on your computer (for example, .PDF, .gif and
.zip).
You use a host application to create the file. For example, you
might use Photoshop to create a .jpg file. Next, save it to Ektron
CMS400.NET using any method explained in ”Importing Office
Documents” on page 230. While importing, add supporting
information, such as summary, metadata, taxonomy category and
schedule. Use standard toolbar buttons to perform actions like
view history, submit for publishing, and delete.
If you want to edit a managed file, use the Check out and Save
As menu option to place a copy of it on your computer. Then, edit it
using the host application. When done, drag and drop the changed
file to Ektron CMS400.NET.
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This section explains how to work with managed files through the
following subtopics.

• ”Managed File Menu Options” on page 254
• ”Creating a New Managed File” on page 255
• ”Importing Managed Files” on page 255
• ”Editing a Managed File” on page 256
• ”Deleting a Managed File” on page 257

Managed File Menu Options
Depending on a managed file’s status, your role, and position in
the document’s approval chain, any of the following options may
be available when you display the dropdown menu for a managed
file. See Also: ”Content Dropdown Menu” on page 35

Menu
option

Description

For more information, see

View

View and edit managed file and its C MS 400 .N ET
information (Summary, Metadata, History, etc.).
Can also be used to replace file.

Save As

Save copy of managed file to your computer

”Saving an Office Document” on
page 249

Check Out
and Save As

Change a managed file’s status to checked out
and save a copy to your computer

”Checking Out, Saving, and
Replacing an Office Document” on
page 247

Note: These sections describe
working with Office documents.
Everything works the same with
managed files.
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Menu
option

Description

Edit

Overwrite a managed file in C MS4 00. NE T with a
version on your computer.

Note: These sections describe
working with Office documents.
Everything works the same with
managed files.

The file name can be different but its type must
match the file being edited. A file’s type appears
after you click Edit, on the Edit Content in Folder
screen (circled below).

Check In

For more information, see

”Checking Out, Saving, and
Replacing an Office Document” on
page 247

Change a checked-out managed file’s status to
checked in.
Useful if you checked out and saved a managed
file then it became lost or corrupted. This option
lets you change its status back to checked in.

Submit/
Publish

Submit managed file into approval chain

”Asset Workflow” on page 258

Delete

Delete managed file; deleted file cannot be
retrieved

”Deleting a Managed File” on
page 257

Creating a New Managed File
You cannot create a managed file within Ektron CMS400.NET.
Instead, create it on your computer using the host application then
import it into DM.

Importing Managed Files
WARNING!

You cannot import files whose name includes a percentage sign (%) or
ampersand (&).
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You import managed files into Ektron CMS400.NET using the same
methods you use to import MS Office documents. See ”Importing
Office Documents” on page 230.
If you do not see a file you uploaded, verify that the View Menu box
is displaying the type of file you are looking for. Files upload to the
correct type regardless of what is selected when you drag and
drop them.

Editing a Managed File
You do not edit a managed file within Ektron CMS400.NET. Instead,
you check it out, save it on your computer, edit it using the host
application, then check it back in to Ektron CMS400.NET. While it is
checked out, only you or a system administrator can edit the
managed file within Ektron CMS400.NET.
NOTE

Alternatively, you can edit within a mapped network folder. See ”Edit Using a
Mapped Network Folder” on page 245.

Follow these steps to edit a managed file.
1. From the Workarea, select the Content folder.
2. Select the managed file’s folder.
3. Select the managed file you want to edit.
4. Hover the cursor over the triangle (
file and click.

) on the right end of the

5. Click Check out and Save As from the dropdown menu.

6. Select a folder on your computer in which to save the file.
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7. Open the host application.
8. Edit and save the file.
9. Return to Ektron CMS400.NET and open the file’s folder.
10. Click the Add Assets button (circled below).

11. Drag the changed file to the Assets area in the middle of the
screen.

Deleting a Managed File
NOTES

You must have delete permissions for the folder that contains the document.
(Permissions are explained in the Ektron CMS400.NET Administrator manual
It is good practice to check for broken quicklinks before deleting documents. See
”Checking for Broken Quicklinks” on page 59.

1. From the Workarea, select the Content folder.
2. Select the managed file’s folder.
3. Find the managed file you want to delete.
4. Hover the cursor over the triangle (
file and click.

) on the right end of the

5. Click Delete from the dropdown menu.
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6. You are asked to confirm the deletion. Press OK.
7. The asset enters its approval chain.
Like publishing, deleted content must go through the approval
chain before it is removed. If you are the last approver in the
approval chain, the content is deleted immediately. See Also:
”Approving/Declining Content” on page 87

Asset Workflow
An asset proceeds through the same workflow as any other type of
content. A diagram is below.

Ektron CMS40 0.NET User Manua l, Version 7.5

258

Using the Document Management System

See Also:

• ”Approving Assets” on page 259
• ”Adding Assets to Collections and Menus” on page 259

Approving Assets
Assets are placed into the approval chain, like other types of
content. For more information, see ”Approving/Declining Content”
on page 87.

Adding Assets to Collections and Menus
You can add an asset to a collection or menu as you would any
other type of content. For more information, see ”Working with
Collections” on page 424 and ”Working with Menus” on page 444.

Asset Reports
Ektron CMS400.NET provides several reports that track assets by

status.
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Report

Displays assets in this status

For more information, see

Approvals

Requiring your approval

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “Approvals
Report”
Checked In Content

Checked in

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “Checked In
Report”
Checked Out Content

Checked out

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “Checked Out
Report”
New Content

Submitted Content

New (that is, created and saved
but never published)

C M S 4 0 0 . N E T Administrator Manual >

Submitted for publication

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “New Content
Report”

“Content Reports” > “Submitted
Report”
Pending Content

Approved and pending a start date

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “Content Pending
Start Date Report”
Refresh Reminder Report

End date has been reached

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “Refresh
Reminder Report”
Expired Content

Expired date has been reached

C M S 4 0 0 . N E T Administrator Manual >

“Content Reports” > “Expired Content
Report”
Content to Expire

Will expire within specified number
of days
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Working with Calendars

Calendars in Ektron CMS400.NET perform the same function as a
paper calendar: they keep one or more users informed about
upcoming events. They can be displayed to all visitors to your Web
site, and any authorized user can add events to a calendar.
Typical calendar events could include

• company meeting
• reserving a conference room for an interview
• company holidays
• deadlines
These are only a few uses of calendar events. Calendars are
versatile and can easily meet all of your needs. A sample calendar
appears below.
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The Calendar Feature is explained through the following topics.

• ”Understanding Calendars” on page 263
• ”Accessing the View Calendar Screen” on page 264
• ”Viewing a Calendar” on page 269
• ”Tips on Viewing a Calendar” on page 271
• ”Adding a Calendar Event” on page 273
• ”Understanding Event Types” on page 277
• ”Viewing a Calendar Event” on page 280
• ”Editing Calendar Events” on page 282
• ”Deleting Calendar Events” on page 284
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Understanding Calendars
Before working with calendars, you should understand the
following points.

• Ektron CMS400.NET supports several calendars at one time.
There might be a site-wide calendar, and other calendars for
special interests, such as an athletic events calendar.

• Each date can display several events.
• Only system administrators can create a calendar.
• Each calendar is assigned to a content folder (See Also:
”Working with Folders and Content” on page 28). Your ability to
view, add, edit, and remove calendar events is determined by
your permissions for that folder.

• The following illustrates the workflow of calendar tasks.
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Accessing the View Calendar Screen
The View Calendar screen collects general information about a
calendar, and provides toolbar buttons that let you perform
calendar-related activities.
To access the View Calendar screen, follow these steps.
1. Access the Modules folder from the lower left corner of the
Workarea.
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2. Click the Calendars folder.

3. The Calendar Modules screen appears. It lists all calendars in
Ektron CMS400.NET.

NOTE

Only system administrators can create a new calendar.

4. Click a calendar.
5. The View Calendar screen appears, showing information about
the calendar.
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The following table explains the fields on the View Calendar
screen.
Field

Description

Title

Title given to the calendar. The title identifies the calendar within the
Workarea.
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Field

Description

ID

ID number automatically assigned to calendar. This is used to
display the calendar on a Web page.

Description

Description given to the calendar.

Location Label

Label for the calendar’s location information. This label appears on
the calendar when a location is assigned to a calendar event.

Start Time Label

Label for the calendar’s start time. This appears on the calendar
when a start time is assigned to a calendar event.

End Time Label

Label for the calendar’s end time data. This appears on the calendar
when an end time is assigned to a calendar event.

Table Properties:
Display Weekends
Forward Only

A green check ( ) means the calendar displays every day of the
week. A red X ( ) means the calendar displays weekdays only.
If a green check ( ) appears next to Show only events that fall
after the viewing day, and the user viewing the calendar is not
logged in, the calendar only displays events from the viewing date
forward. No past events appear.
A logged-in user can view past calendar events.
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Field

Description

Event Type Label

Indicates if event types are assigned to this calendar.

See Also: ”Understanding Event Types” on page 277
One section of the Add Calendar Events screen displays available
event types and lets the user assign them to the event.

By default, this text is Event Type:. Your system administrator can
edit the text.
Event Types Available

A green check (

) means you can add event types to the calendar.

Event Types Required

A green check ( ) means that when entering a calendar event, you
must assign an event type to it.

Instructions

If this calendar uses event types, text appears at the bottom of the
screen that explains how to use the event type selection box. By
default, this text is Select Event Type to View:.

Your system administrator can change this text.
Show All Label

If this calendar uses event types, the list of event types appears at
the bottom of the screen. On top of the list is text indicating that all
event types will appear on the calendar. By default, this text is Show
All.

Your system administrator can change this text.
Long Description

Lets the user enter additional text while adding a calendar event.
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Field

Description

Folder Name

Name of content folder to which the calendar is assigned for
permission purposes.
You can only add, edit or delete events for calendars in folders to
which you have been granted permission.

Folder Path

Complete path to the calendar’s content folder.

The View Calendar screen may contain the following toolbar
buttons that let you perform other tasks.
Button

Name

Description

More Information

View
Calendar

Show calendar in the Workarea

”Viewing a Calendar” on
page 269

Back

Return to previous screen

Viewing a Calendar
NOTE

This section explains how to view a calendar and enter calendar events from the
Workarea. Once a calendar is available on your Web site, you can also perform
these actions by logging in and navigating to the calendar on your site.

To view a calendar, follow these steps.
1. Access the View Calendar screen for the calendar you want to
see, as described in ”Accessing the View Calendar Screen” on
page 264.
2. Click the View Calendar (

) button.

3. The calendar appears.
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See Also: ”Tips on Viewing a Calendar” on page 271.
4. If you want to view events of a certain type only, click the
Select Event Type to View drop-down list (illustrated below).
Then, choose an event type. See Also: ”Understanding Event
Types” on page 277

The page is refreshed, and the calendar displays events of that
type only.
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From the View Calendar screen, you can perform the following
tasks. Note that the Add and View buttons appear on each
calendar day, while the Return button is on the toolbar at the top of
the screen.
Click on

Event title within
calendar (sample
below)

Action

More Information

Add Calendar Event

”Adding a Calendar Event” on page 273

View Calendar Events

”Viewing a Calendar Event” on page 280

Return to Previous Screen

Return to previous screen

Jump to calendar event’s
Web page (if available)

See Also: ”Working with Calendars” on page 261

Tips on Viewing a Calendar
• The monthly calendar displays the current month. In the
intranet sample, today is highlighted in yellow (illustrated
below).
At the top of the calendar are the previous and next months.
Click them to view those months.
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• Where an event appears, move the cursor over it to see a
popup box with the event name, location, and start and end
times.
If a Web page is linked to the event, you can click the event
name to jump to that page.

• Click the number that represents any day to view detail for that
day (illustrated below).

• From the daily view, you can
- see all events and the hours they span
- proceed to the previous or next day (click a date in the upper
left or right corner)

- return to the month view by clicking on today’s date
- view detail about an event by clicking on it
• From the event view (illustrated below), you can view the
event’s location and start and end times. Click the date to
return to the daily view.

Ektron CMS40 0.NET User Manua l, Version 7.5

272

Working with Calendars

Adding a Calendar Event
NOTE

You can only add a calendar event if you have add or edit permission for the
calendar’s folder.

To add a calendar event, follow these steps.
1. Access the calendar to which you want to add an event, as
described in ”Viewing a Calendar” on page 269.
NOTE

You can also add a calendar event after viewing the View Events screen. See
Also: ”Viewing a Calendar Event” on page 280

2. Navigate to the month and day for which you want to add a
calendar event.
Your calendar display is determined by your system
administrator.

3. Click the Add Event (

) button.

4. The Add Calendar Event screen appears.
NOTE

Folder information appears at the bottom of the screen only if the folder has
subfolders or content under it.
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5. Respond to the fields using the following table as a reference.
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Field

Description

Event Title

Enter a title for the event.
Note: If you enter a Quicklink in the Hyperlink field, the Quicklink’s content
title replaces this title. You can then edit the new title if desired.

Event Location

If desired, enter a location for the event (for example, Conference Room 1 or
Cafeteria).

One Time/
Recurring

If you want to enter a one-time only event, continue reading.

Date

Click the calendar icon (

If you want to add a recurring event, see ”Adding a Recurring Event” on
page 277.
) to display a calendar. From it, select a start date.

Technical note: If you see a mix-up of the month and date of your entry (for
example, you select March 2 but see February 3), make sure the date format
specified in the Windows Control Panel Regional Settings dialog matches
your current language. Also, make sure the settings apply to the default user.

Start Time

End Time

If you want to enter a start time, click the clock icon (
From it, select a start time.

) to display a clock.

If you want to enter an end time, click the clock icon (
From it, select an ending time for the event.

) to display a clock.
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Field

Description

Display the times
for the event

Check this box if you want the calendar to display the event’s start and end
times (illustrated below).

The time also appears on the event detail if this box is checked.

Hyperlink

You can link a Web page to this calendar event. The Web page could contain
more information about the event, directions to it, etc.
If you insert a hyperlink, when this event appears on the calendar, the reader
can click the event to jump to that page.
To enter any page on the internet, enter its Web address. For example,
www.example.com.
To link to content on your Web site, click the library button (
). (This type of
link is known as a Quicklink.) The Quicklinks dialog appears, and you can
navigate to the content.
The last published version of linked content appears. If content has never
been published, nothing appears.
If you select a hyperlink, the title of the selected content replaces any text in
the Event Title field. You can edit the new title if desired.

Launch link in a
new browser

Check this box if you want the Web page or Quicklink specified in the
Hyperlink field to appear in a new browser window when someone clicks it.
If you do not check this box, the new Web page replaces the current one
when the link is clicked.
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Field
Event Type

Description
Note: This field only appears if your system administrator set up one or more
event types for this event.
See Also: ”Understanding Event Types” on page 277
To apply an event type to this event, click an Event Type from the right
column. Then, click the Right Arrow (
Selected column.

) to move the event type to the

Repeat for each event type you want to assign to the event.

6. Click Save (

).

Understanding Event Types
Your system administrator can set up types of calendar events. For
a personal or workgroup calendar, examples might be staff
meetings, employment interviews, conference calls. For an
educational institution, examples might be academic deadlines,
sporting events, and tuition due dates.
If you assign a type to an event while creating it, you can later
display only events of that type. This feature lets the viewer
temporarily suppress unwanted events. As a result, the calendar
display is cleaner, because it only shows relevant information.

Adding a Recurring Event
You can assign an event to occur multiple times on a calendar. To
do so, follow these steps.
1. Add a calendar event (as described in ”Adding a Calendar
Event” on page 273).
2. Click the Recurring tab to assign the event for more than one
day.
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3. Refer to the table below to complete to the Recurring fields.
Field

Description

Start Date

Click the calendar icon (

) to display a calendar. From it, select a start date.

Technical note: If you see a mix-up of the month and date of your entry (for
example, you select March 2 but see February 3), make sure the date format
specified in the Windows Control Panel Regional Settings dialog matches
your current language. Also, make sure the settings apply to the default user.
End Date

Click the calendar icon ( ) to display a calendar. From it, select an end date
for the series of recurring events.

Event will occur

Select the frequency of the event from among the choices.

Ektron CMS40 0.NET User Manua l, Version 7.5

278

Working with Calendars

4. Finish your edits.
For documentation of
Start Time

End Time

Display the times for the event

See
Click the clock icon (
time.

) to display a clock. From it, select a start

Click the clock icon (
time for the event.

) to display a clock. From it, select an ending

Check this box if you want the calendar to display the event’s start
and end times (illustrated below).

The time also appears on the event detail if this box is checked.

Hyperlink

You can link a Web page to this calendar event. The Web page could
contain more information about the event, directions to it, etc.
If you insert a hyperlink, when this event appears on the calendar,
the reader can click the event to jump to that page.
To enter any page on the internet, enter its Web address. For
example, www.example.com.
To link to content on your Web site, click the library button (
).
(This type of link is known as a Quicklink.) The Quicklinks dialog
appears, and you can navigate to the content.
The last published version of linked content appears. If content has
never been published, nothing appears.
If you select a hyperlink, the title of the selected content replaces any
text in the Event Title field. You can edit the new title if desired.
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For documentation of

See

Launch Link in New Browser

Check this box if you want the Web page or Quicklink specified in the
Hyperlink field to appear in a new browser window when someone
clicks it.
If you do not check this box, the new Web page replaces the current
one when the link is clicked.

Event Types

Note: This field only appears if your system administrator set up one
or more event types for this event.
See Also: ”Understanding Event Types” on page 277
To apply an event type to this event, click an Event Type from the
right column. Then, click the Right Arrow (
type to the Selected column.

) to move the event

Repeat for each event type you want to assign to the event.

5. Click the Save button (

).

Viewing a Calendar Event
Once events are added to a calendar, you can easily view them. To
view a calendar event, follow these steps.
1. Access the Show Calendar screen for the calendar that
contains the event you want to view, as described in ”Viewing a
Calendar” on page 269.
2. Place the cursor on the event you want to view.
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3. Click the View Events (

) button.

4. The View Events screen appears, listing all calendar events for
that date. If an event is part of a series of recurring events, the
following icon appears next to it:
From this screen, you can perform the following functions:

- Add a new event (See Also: ”Adding a Calendar Event” on
page 273)

- View, edit, and delete an existing event
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Editing Calendar Events
The section explains how to edit a single event or a recurring
series of events.
NOTE

You can only edit a calendar event if you have edit permission for the folder to
which the calendar is assigned.

See Also: ”Adding a Calendar Event” on page 273

Editing a Single Event
After a calendar event is added to a calendar, you may edit it to
change the title, location, times, etc. To edit a calendar event,
follow these steps.
1. Access the View Calendar Events screen for the date that
contains the event you want to edit, as described in ”Adding a
Calendar Event” on page 273.
2. Click the event you want to edit.
3. The Edit Calendar Event screen appears.
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4. Update the fields using the table described in ”Adding a
Calendar Event” on page 273 as a reference.
5. Click the Save button (

).

Editing Recurring Events
After a recurring series of events is added to a calendar, you may
edit it to change the title, location, hyperlink, and event type.
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NOTE

You cannot edit event dates or times. To change those, delete and re-enter the
series of events.

To edit a recurring series of events, follow the steps in ”Editing a
Single Event” on page 282. The only difference is the Update all

recurring events associated with this event box.
To apply the edits to only the instance of the event that you
selected, uncheck the box. To apply the changes to all instances,
check the box.

Deleting Calendar Events
The section explains how to delete a single event or a recurring
series of events.
NOTE

You can only delete a calendar event if you have add, edit, or delete permission
for the content folder to which the calendar is assigned.

Deleting a Single Occurrence Calendar Event
You can easily delete calendar events that are no longer needed,
or do not belong to the calendar they were added to. To delete a
calendar event, follow these steps.
1. Access the View Calendar Events screen for the date that
contains the event you want to delete, as described in ”Adding
a Calendar Event” on page 273.
2. Click the event you want to delete.
3. The Edit Calendar Event screen appears.
4. Click the Delete button (

).

5. A confirmation message appears.
6. Click OK.

Deleting a Recurring Calendar Event
You can delete a single event in a recurring series or all events in
the series.
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Deleting a Single Recurring Event
1. Access the View Calendar Events screen for the date that
contains the event you want to delete, as described in ”Adding
a Calendar Event” on page 273.
2. Click the event you want to delete.
3. The Edit Calendar Event screen appears.
4. Click the Delete Content button (

).

5. A confirmation message appears.
6. Click OK.

Deleting All Events in a Recurring Series
1. Access the View Calendar Events screen for any date that
contains an events in the series that you want to delete, as
described in ”Adding a Calendar Event” on page 273.
2. Click the event in the series that you want to delete.
3. The Edit Calendar Event screen appears.
4. Click the Delete This and Associated Recurring Events button
(

).

5. A confirmation message appears.
6. Click OK.
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Managing Ta sks

A task is a request from one user to another to perform an action
within Ektron CMS400.NET. Examples of a tasks include:

• updating content
• publishing content
• updating an image
• reordering a collection
The Tasks folder displays all tasks that are either assigned to you
or that you assigned to another user or user group. You can also
assign tasks to yourself.
A task may or may not be related to a specific piece of content. If it
is, you can access content then “attach” a task to it. This kind of
task is managed just like the other tasks, but you can also view and
update it via the attached content. For more information, see
”Viewing a Task” on page 300.
This chapter explains how to work with tasks through the following
topics.

• ”Creating a Task via the Task Folder” on page 287
• ”Adding a Task Category and Task Type” on page 294
• ”Creating a Task from the Web Site” on page 299
• ”Creating a Task via the Content Folder” on page 299
NOTE

Tasks can also be created automatically when forms are submitted. See Also:
”Assigning a Task to a Form” on page 195

• ”Viewing a Task” on page 300
• ”Editing a Task” on page 305
• ”Adding Comments to Tasks” on page 306
• ”Deleting a Task” on page 309
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• ”Viewing a Task’s History” on page 310
• ”Task Module Toolbar” on page 311

Creating a Task via the Task Folder
This topic consists of the following subtopics:

• ”Accessing the Tasks Folder” on page 287
• ”Creating a Task via the Task Folder” on page 288
• ”Adding a Task Category and Task Type” on page 294

Accessing the Tasks Folder
To access the Tasks folder, follow these steps.
1. Access your Smart Desktop, as explained in ”Understanding
the Smart Desktop” on page 17.
2. The Smart Desktop folders appear in the top left frame.

3. Click the Tasks folder. The following subfolders appear:

• Assigned To Me - tasks assigned to you
• Assigned By Me - tasks you assigned to someone else
• Created By Me - tasks you created
• Assigned To User - search for tasks assigned to a user
• Not Started - tasks whose state is set to not started
• Active - tasks whose state is set to Active
• Awaiting Data - tasks whose state is set to Awaiting Data
• On Hold - tasks whose state is set to On Hold
• Pending - tasks whose state is set to Pending

Ektron CMS40 0.NET User Manua l, Version 7.5

287

Managing Tasks

• Reopened - tasks whose state is set to Reopened
• Complete - tasks whose state is set to Complete
You can click any folder to view only tasks in that category.
Also, the View Tasks screen appears in the right frame, listing all
tasks assigned to you, or assigned by you.

From this page, you can view, sort, update, or add tasks. To learn
more about the View Tasks screen, see ”Viewing a Task” on
page 300.
To learn about sorting by Task Type, see ”Sorting Tasks By Task
Type” on page 304.

Creating a Task via the Task Folder
See Also: ”Task Module Toolbar” on page 311
To create a task, follow these steps.
1. Access your Tasks folder, as described in ”Accessing the Tasks
Folder” on page 287.
2. Click the Add button (
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IMPORTANT!

The Add button only appears if your system administrator has granted you
permission to add tasks. For more information, see the Ektron CMS400.NET
Administrator Manual > “Managing Tasks” > “Task Permissions.”

3. The Add Task screen appears.
Enter information for the task using the following table
Field

Description

Task Title

Enter a title for the task (for example, Update Content). The
title appears in the left column of the View Tasks screen.

Assigned To

Your user name appears.

•

If you do not have Redirect permissions, you cannot
assign tasks to other users.

•

If you have Redirect permissions, your user name
appears followed by Select User or Group. To assign
the task to yourself, proceed to the next field. To assign
the task to someone else, click Select User or Group
and choose a user or group. (The user to whom the task
is being assigned must have permission to edit the content.)

When you complete the screen, an email is sent to the
selected user or user group informing him of the assigned
task.
Note: email is only sent if email notification is enabled for
Ek tron CM S40 0.NET .
Language

Select the language of the user who will perform the task.

Content

If this task involves a piece of content, select it. When you
click Select, a new window appears. From this window, you
can navigate through folders to find the content.
You can only select a piece of content whose language
matches the user language selected above.

See Also: ”Selecting Content for the Task” on page 292
Priority

Select the priority of the task. Your choices are High, Normal
and Low.
The priority appears on the View Tasks screen. A user can
sort tasks on the screen by priority.
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Field

Description

Task Category

Select a category for the task. When a Task Category is
chosen, the Task Type drop down box is auto filled with task
types associated with that category. See Also: ”Adding a
Task Category and Task Type” on page 294.

Task Type

Select the Task Type for this task. You must specify a Task
Category before you assign a task type. See Also: ”Adding a
Task Category and Task Type” on page 294.

Add

By clicking the Add link, you can add Task Categories and
Task Types. See Also: ”Adding a Task Category and Task
Type” on page 294
Note: If you Add a Task Category or Task Type while adding a
task, the task information (Task Title, Assigned To, Language,
etc.) entered will be lost when the screen refreshes.

Edit

By clicking the Edit link, you can edit the Task Type chosen in
the Task Type drop down box. See Also: ”Editing a Task
Type” on page 296
Note: If you edit a Task Type while adding a task, the task
information (Task Title, Assigned To, Language, etc.) entered
will be lost when the screen refreshes.

State

Choose a status for the task. Your choices are:

•
•
•
•
•

Not Started
In Progress
Completed
Waiting on Someone else
Deferred

If the task is not linked to content, you can assign it to any
state. However, if you later link the task to content (via the
Content link above), the state switches to Not Started.
The state appears on the View Tasks screen. A user can sort
tasks on the screen by state.
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Field

Description

Start Date

Using the calendar button, choose a start date for the task.
The start date appears on the View Tasks screen. A user can
sort tasks on the screen by start date.

Technical note: If you see a mix-up of the month and date of
your entry (for example, you select March 2 but see February
3), make sure the date format specified in the Windows
Control Panel Regional Settings dialog matches your current
language. Also, make sure the settings apply to the default
user.

Due Date

Using the calendar button, choose the date by which the task
needs to be completed.
The due date appears on the View Tasks screen. A user can
sort tasks on the screen by due date.
Technical note: If you see a mix-up of the month and date of
your entry (for example, you select March 2 but see February
3), make sure the date format specified in the Windows
Control Panel Regional Settings dialog matches your current
language. Also, make sure the settings apply to the default
user.
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Field

Description

Description

Add additional information to describe the task. The
description appears on the View Task screen (circled below).

4. Click the Save button (

).

If email notification is enabled, an email is sent to the user/user
group to which the task was assigned.

Selecting Content for the Task
When you click Select Content from the Add Task screen, the
Select Content screen appears. It shows only content in the
selected language.
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You should only select a content folder for which you have
permissions.
To select a piece of content to assign to the task, follow these
steps.
1. Navigate to the content. (Click any folder to open it.)
2. Click the circle to the left of the content.

3. Press the Save button (
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Adding a Task Category and Task Type
Task Categories and Task Types let users and administrators sort
task by user defined categories and types.
By clicking the Add link, located next to the Task Type drop down
box, you can add Task Categories and Task Types. This allows you
to add categories and types without leaving the Add Task screen.
NOTE

Administrators can also add and edit Task Categories and Task Types from the
Workarea by clicking Settings > Configurations > Task Types. See Also: Ektron
CMS400.NET Administrator Manual > “Managing Tasks” > “Adding a Task
Category and Task Type”.

To add a Task Category and a Task Type, follow these steps.
1. Go to the Add Task screen, as described in ”Creating a Task
via the Task Folder” on page 288.
2. Click the Add link, next to the Task Type dropdown box.

3. The Add Task Type screen appears.
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From this screen you can perform the following:

• Add a task type to an existing task category
• Create a new task category
• Add a new task type
• Add a task type description
• Define task type availability
NOTE

As a user, if you set the Task type to Not Available, you cannot edit the Task Type
after that. To make the Task Type available, see your administrator. Task Type
availability is explained in the Ektron CMS400.NET Administrator Manual >
“Managing Tasks” > “Task Categories and Types” > “View Categorization
Screen“> “Task Type Availability”

4. Enter your information.
5. Click Save (

).

6. Your new Task Category and Task Type appear in the drop
down boxes.
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Task Type Availability
Task types can be hidden from users by clicking the Not Available
check box in the Add Task Type and Edit Task Type screens. By
making Task Types not available, you can make the Task Type
unavailable without deleting it.

Editing a Task Type
From the Add Task screen, you can edit a Task Type. This will
allow you to change the Task Type name, Task Type description,
and Task Type availability.
To edit a task type, follow these steps.
1. Go to the Add Task screen, as described in ”Creating a Task
via the Task Folder” on page 288.
2. Choose a Task Category and the Task Type to edit.
3. Click Edit, next to the Task Type dropdown box.
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4. The Edit Task Type screen appears.
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From this screen you can edit the following:

• Task Type
• Task Type Description
• Task Type Availability. See Also: ”Task Type Availability” on
page 296
NOTE

As a user, if you set the Task type to Not Available, you cannot edit the Task Type
after that. To make the Task Type available, see your administrator. Task Type
availability is explained in the Ektron CMS400.NET Administrator Manual >
“Managing Tasks” > “Task Categories and Types” > “View Categorization
Screen“> “Task Type Availability”

5. Edit the information.
6. Click Save (

).

7. The Task Type information is changed.
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Creating a Task from the Web Site
To create a task from a Web page, follow these steps.
1. Browse to the content for which you want to assign a task.
2. Right click the mouse to display a menu.
3. Click the Add Task button (
IMPORTANT!

).

The Add Task button only appears if your system administrator has granted you
permission to add tasks. For more information, see the Ektron CMS400.NET
Administrator Manual > “Managing Tasks” > “Task Permissions.”

4. The Add Task screen appears. The content you were viewing is
assigned to the task.
5. Follow the directions in ”Creating a Task via the Task Folder”
on page 288. The only differences are

• the content’s ID number and title appear on the screen
• the language of the content is the default language

Creating a Task via the Content Folder
The above section describes assigning tasks from the Tasks folder.
You can also assign task via the content folder, as illustrated
below.

Assigning a Task from the View Content Screen
To assign a task from the View Content screen, follow these steps.
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1. Access the View Content screen for the content to which you
want to “attach” in a task, as described in ”Viewing Content” on
page 40.
2. Click the Add Task button (
IMPORTANT!

).

The Add Task button only appears if your system administrator has granted you
permission to add tasks. For more information, seethe Ektron CMS400.NET
Administrator Manual > “Managing Tasks” > “Task Permissions.”

3. Follow the directions in ”Creating a Task via the Task Folder”
on page 288. The only differences are

• the content’s ID number and title appear on the screen
• the language of the content is the default language

Viewing a Task
Once a task is added, (with the exception of Administrators and
users given permission to create tasks) only the user who
assigned the task and those to whom the task was assigned can
view it.
To view a task, follow these steps.

Viewing a Task from the Content Folder
1. Access the Contents folder from the left side of your Workarea.
2. Open the folder that contains the content.
3. Click the content associated with the task.
4. Click the Tasks tab.
5. The page lists all tasks assigned to the content.
6. Select a task.
From the view task page, you can add a comment to the task. See
”Adding Comments to Tasks” on page 306 for more information.

Viewing a Task from the Tasks Folder
To view a task from the Tasks folder, follow these steps.
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1. From the Smart Desktop, select the Tasks folder. See Also:
”Understanding the Smart Desktop” on page 17
2. Click the task you want to view.
3. The View Task screen is displayed. From here, you can
perform these tasks.

• ”Editing a Task” on page 305
• ”Deleting a Task” on page 309
• ”Adding Comments to Tasks” on page 306
See Also: ”Task View Options” on page 301, ”Sorting Tasks By
Task Type” on page 304, ”Sorting Tasks By Column” on page 304;
”Managing Tasks” on page 286; ”emailing Tasks” on page 305

Task View Options
Beneath the main task module folder, several view screens display
all tasks filtered by specified categories. After viewing tasks in any
category, most screens let you perform an action on the tasks (the
actions are included in the table below). For example, you can
change a tasks state to another state. To select all tasks on a
screen, click the check box in the header row (illustrated below).

Folder

Displays these tasks

Action you can perform
from view screen

Tasks

All tasks assigned to you, that are in one
of the following states.

•
•
•
•

•
•
•
•
•
•

not started
active
awaiting data

Click on task to view it
Add a task
Sort tasks by Task Type
Sort tasks by column

on hold
reopened
pending
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Folder

Displays these tasks

Action you can perform
from view screen

Assigned To Me

All open tasks assigned to you

•
•
•

Click on task to view it

•
•
•

Click on task to view it

•
•
•

Click on task to view it

•

Select any user and view
all tasks assigned to that
user.

Assigned By Me

Created by Me

Assigned to User

All open tasks you assigned to yourself or
others

All open tasks you created

All open tasks assigned to a user you
select

Sort tasks by Task Type
Sort tasks by column

Sort tasks by Task Type
Sort tasks by column

Sort tasks by Task Type
Sort tasks by column

To do so, select new user
from Assign to User drop
down list and click Get
Tasks.

Not Started

All whose state is Not Started
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Click on task to view it

•

Change to the following
states: Awaiting Data, On
Hold

•
•
•

Click on the task to view it

Sort tasks by Task Type
Sort tasks by column

Sort tasks by Task Type
Sort tasks by column

302

Managing Tasks

Folder

Displays these tasks

Action you can perform
from view screen

Active

All whose state is Active

•

Change to the following
states: Awaiting Data, On
Hold

•
•
•

Click on the task to view it

•

Change to the following
states: Awaiting Data, On
Hold

•
•
•

Click on the task to view it

•

Change to the following
states: Awaiting Data, On
Hold

•
•
•

Click on the task to view it

•
•
•

Click on the task to view it

•
•
•

Click on the task to view it

•

Change to the following
state: Archive

•

Click on the task to view it

•
•

Sort tasks by Task Type

Awaiting Data

On Hold

Pending

Reopened

Completed

All whose state is Awaiting Data

All whose state is On Hold

All whose state is Pending

All whose state is Reopened

All whose state is Completed
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Sort tasks by Task Type
Sort tasks by column

Sort tasks by Task Type
Sort tasks by column

Sort tasks by Task Type
Sort tasks by column

Sort tasks by Task Type
Sort tasks by column
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Sorting Tasks By Task Type
On every View Task page, you can sort tasks by the Task Type
assigned to the task. You sort by Task Type using the Show Task
Type drop down box. It is located in the upper right corner of the
Workarea.
NOTE

Task Types only appear in the Show Task Type dropdown box when they have
been added to a task.

To sort by Task Type, click the drop down box and choose a Task
Type. Words in bold Italics are Task Categories. You cannot sort
by Task Categories.

Sorting Tasks By Column
On every View Tasks page, you can sort the information by most
columns. Information can be sorted by the following.
Column

Click to sort tasks

Title

Alphabetically by title of associated
content

CID

By content ID number

State

By task state, from first to last

Priority

By task priority. High appears first,
followed by Normal then Low
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Column

Click to sort tasks

Due Date

By due date, beginning with dates closest
to today

Assigned To

Alphabetically by user to whom the task
is assigned
Note: Once set, a task’s assigned-to user
does not change throughout the life of
the task.

Assigned By

Alphabetically by user who assigned the
task

Last Added Comment

Alphabetically by the most recently
created task comment

Create Date

By date task was created, beginning with
dates closest to today

emailing Tasks
You can email the contents of any Task screen. emailing tasks
works the same as emailing reports. See the Ektron CMS400.NET
Administrator Manual section “Content Reports” > “Common
Report Topics” > “emailing Reports.”

Editing a Task
You can change task information, such as

• Title
• Assigned to
• Language
• Content
• Priority
• Task Category
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• Task Type
• Status (State)
• Due Date
• Start Date
• Description
To edit a task, perform the following steps.
1. Access the View Task page for the task, as described in
”Viewing a Task from the Tasks Folder” on page 300.
NOTE

You cannot edit a task after viewing it from the Content folder.

2. Click the Edit button (

).

3. The Edit Task screen appears.
4. Edit the task.
5. Click the Update button (

) to save the changes.

Adding Comments to Tasks
You can add comments to an assigned task if you want to provide
additional information about its status. For example, if you update
a task’s status from In progress to Waiting on Someone Else, you
can use a comment to describe the status change, such as:
left voice mail with John with questions about
his changes to the home page
Comments appear at the bottom of the View Tasks screen
(illustrated below).
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Several comments can be added to a task to record its progress
from assignment to completion.
To add a comment to a task, follow these steps.
NOTE

When an approver approves/declines content from the Content Awaiting Approval
screen, if the content has an active task, the Add Comments to Task screen
appears. The screen lets the approver insert comments about the task associated
with the content.

1. Access the View Task screen for the task, as described in
”Viewing a Task” on page 300.
2. Click the Add Comment button (

).

3. The Comments window appears.
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4. Enter your comment in the editor. Note that you can format and
spell check the text using the toolbar buttons.
5. Click the

button.

6. The View Task screen reappears with the comment at the
bottom of the page.

Updating Comments
To update a comment, follow these steps.
1. Access the View Task screen that contains the comment you
want to update, as described in ”Viewing a Task” on page 300.
2. Click the comment’s Date/Time link (illustrated below).
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3. The Comments window opens with the comment displayed.
4. Update the comment.
5. Click the

button.

Deleting a Task
You can easily delete a task that is no longer needed. For example,
the user who assigned a task would typically delete it when it is
completed.
To delete a task, follow these steps.
1. Access the View Task screen for the task, as described in
”Viewing a Task” on page 300.
2. Click the Delete button (
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IMPORTANT!

The Delete button only appears if your system administrator has granted you
permission to delete tasks. For more information, see the Ektron CMS400.NET
Administrator Manual > “Managing Tasks” > “Task Permissions.”

3. A confirmation message appears.
4. Click OK.

Viewing a Task’s History
Ektron CMS400.NET maintains a history of all events in the life of a

task, as well as any comments entered. As examples, the task
history shows when and by whom the task was created, when it
changed to Active, when it was linked to content, when its state
changed, when it was approved, etc.
You can view the task’s history until the task is purged. To view a
task’s history, follow these steps.
1. Navigate to the View Task screen, as explained in ”Viewing a
Task” on page 300.
2. Click the History button (

).

3. The history of task events appears (example below).
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Task Module Toolbar
The following table explains the toolbar buttons available while
managing tasks.
Button

Name

Description

More Information

Add Comment

Add a comment to the task.

”Adding Comments to
Tasks” on page 306

Add Task

Access the Add Task screen from the
View Content page.

”Task Module Toolbar”
on page 311

Add Task

Access Add Task screen from task
module folder.

”Creating a Task via
the Task Folder” on
page 288

Back

Return to previous page.

Calendar

Select a date.

Delete Task

Delete a task.

”Deleting a Task” on
page 309

Edit Task

Edit a task.

”Editing a Task” on
page 305

Save

Save task information.

Update

Save task information.

View Task

View task information.
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Blogs (short for Web Logs) are a form of online information
sharing. A blog is often set up so a group of people can share their
thoughts on a subject. One person creates the main post and other
comment on post. In addition, blogs can be used to create an
online diary of everyday life.
In the Ektron CMS400.NET Workarea, blogs and blog posts have a
relationship similar to folders and content. The blog is the
equivalent of a folder, and blog posts are the equivalent of content
items. While blogs and blog posts have a few unique properties,
they mostly work the same as folders and content.
On your Web site, blogs are arranged so the latest post appears at
the top. This differs from paper diaries, because you are reading
the newest material first, instead of the oldest. Because blogs are
laid out this way, site visitors can quickly find the most recent
entries.
Blogs are made up of multiple elements. These elements allow site
visitors to view or create a blog post, add comments, and see a roll
call of associated blogs. In addition, if a blog calendar is present on
the blog site, visitors can see which days have blog posts.
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Blogs in the Workarea appear as a language bubble in the folder
structure. This distinguishes a blog folder from a content folder.

The following table lists elements commonly found in a blog.

Element

Description

Blog Title

The name of your blog as you want it to appear on the site.
For example, “My Life Story.”

Blog Post

The main entry for each topic. A blog post is made up of
several sub elements:

•
•
•

Headline - the title of the post

•

TrackBack URL - a URL visitors can use to notify you
when they are talking about the blog post on their site

•
•

PingBack - Pings back any URLs in the blog post

Commentary - the details of the post
Comment Link - links to a comments page, where site
visitors can view or add comments

Images - add images to a blog post. You add images to
a blog post the same way you add them to content.
See Also: ”Adding a Library File to Content” on
page 148
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Element

Description

Blog Comments

A Comments link appears at the end of the blog post. The
link includes a number in parentheses, for example (3).
This number denotes how many comments have been
made. Click this link to move to the comments page, where
you can read comments on the post and possibly enter your
own.

Blog Roll

Other blog sites that the blog’s creator wants site visitors to
view.

Blog Subjects

Subjects associated with the blog. If you click a subject,
links to all posts associated with the subject appear.

Calendar

Indicates when blog posts were made. This lets site visitors
navigate your blog by clicking a day that has blog posts.

Blog Workflow
The following table explains the workflow of a blog.
Workflow

Description

See Also

Phase 1

An administrator creates a blog in the
Workarea. During this phase, he assigns
blog subjects, creates a blog roll, and
decides how comments are handled.

”Adding a Blog” on
page 316

Phase 2

A developer adds the blog to a Web form
using the blog server control. He then
publishes the form.

The Developer Manual
section “Introduction to
Ektron CMS400.NET
Server Controls” > “Blog
Server Controls”

Phase 3

Ek tron CM S40 0.NET users can add

”Blog Posts” on page 341

blog posts, either from the Workarea or
the Web site.
Depending on the user’s permissions, the
post is either published immediately or
submitted to the blog’s approval chain.
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Workflow

Description

See Also

Phase 4

The blog post is published. Now, site
visitors can view it and possibly add
comments.

”Blog Comments” on
page 350

Depending on the blog’s comment
settings, they either appear immediately
or must be approved first.

The following sections explain using the blog feature in the
Workarea.

• ”Adding a Blog” on page 316
• ”Blog Properties” on page 318
• ”Blog Subjects” on page 322
• ”The Blog Roll” on page 327
• ”Language Support” on page 336
• ”Searching Blogs” on page 337
• ”Subscribing/Unsubscribing to a Blog” on page 337
• ”Deleting a Blog” on page 336
• ”Blog Posts” on page 341
• ”Blog Comments” on page 350
• ”Adding or Editing Blog posts with Windows Live Writer” on
page 358

Adding a Blog
NOTE

To be able to create a blog , you must have permission to Add Folders on the
blog’s Advanced Permissions screen.

To add a blog, follow these steps.
1. Go to the Workarea’s Content folder.
2. Click the folder in which the blog will reside.
3. Click New > Blog.
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4. The Add a Blog screen appears.

5. Fill out the Properties tab according to the table below.

Field

Description

Blog Name

The name of your blog as it appears in the content folder tree.

Blog Title

The title of your blog as it appears on the Web site.

Visibility

Choose whether the site is private or public.

Comments

Public

Any site visitor can view the blog.

Private

A site visitor must log in to view the blog. This
includes membership and Ek tron CM S40 0.NET
users.

Choose how to handle comments by checking the appropriate boxes. For
more information, see ”Controlling Blog Comments” on page 350.

6. On the Subjects tab, add subjects to the blog. For more
information on blog Subjects, see ”Blog Subjects” on page 322.
7. On the Blog Roll tab, add blog sites that you want blog readers
to visit. For more information on blog rolls, see ”The Blog Roll”
on page 327.
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IMPORTANT!

See ”Editing a Blog’s Properties vs. Adding a Blog” on page 318 for additional
properties that are only available when editing a blog’s properties.

Blog Properties
NOTE

To be able to edit blog properties, you must have permission to Edit Folders on
the blog’s Advanced Permissions screen.

By clicking the blog properties button ( ), you can change the
following groups of information about a blog.

• ”Editing a Blog’s Properties vs. Adding a Blog” on page 318
• ”Blog Folder Properties” on page 319
• ”Metadata” on page 321
• ”Blog Subjects” on page 322
• ”Web Alerts” on page 326
• ”The Blog Roll” on page 327
• ”Permissions and Approvals” on page 334
• ”Purge History” on page 336

Editing a Blog’s Properties vs. Adding a Blog
When you edit a blog’s properties and settings, more properties
and settings are available than when you created it. This is done to
save time when adding multiple blogs to a site.
The table below shows which properties or settings are available
when adding and editing a blog.

Blog Properties and Settings Availability
Property or Setting

Available When
Adding a Blog

Available When
Editing a Blog

Visibility

Blog Name
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Property or Setting

Available When
Adding a Blog

Available When
Editing a Blog

Blog Title

Tagline

# of Visible Posts

Comment Control

Update Service

Style sheet filename for this folder

Template filename for this folder

Smart Forms

Metadata

Subjects

Web Alerts

Blog Roll

Permissions

Approval Chain

Blog Folder Properties
The following table shows the fields on the Blog’s Properties tab.
To edit these properties
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- from the Workarea, navigate to the blog folder, click View >
Folder Properties, then the Edit Properties button (

).

- from the Web site, log in, navigate to the blog, right click the
mouse, and select Properties
When you are finished, click Save (

).

To learn about the other tabs on the Properties screen, see

• ”Metadata” on page 321
• ”Blog Subjects” on page 322
• ”Web Alerts” on page 326
• ”Smart Forms” on page 326
• ”The Blog Roll” on page 327
• Ektron CMS400.NET Administrator manual section “Managing
Content Folders” > “Breadcrumbs”

Field

Description

Visibility

Choose whether the site is a private blog or public.

Blog Name
Blog Title

Public

Anyone who visits the site is able to view the blog.

Private

A site visitor must log into the site to be able to
view the blog. This could include membership
users, CMS400 users or both.

The name of your blog as it appears in the content folder tree.
The title of your blog as it appears on the Web site blog. It only appears if the
ShowHeader blog server control property is set to true.

ID

The ID number of the blog. This number is assigned by E k t r o n C M S 4 0 0. NE T
and cannot be changed.
Note: ID only appears when viewing the Properties screen. It does not appear
while editing.
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Field

Description

Tagline

A line of additional information that describes the blog. It appears below the
title if the ShowHeader blog server control property is set to true.
For example, the title of a blog is “John’s Blog Page.” The tag line could be “A
place to learn about John's past, present, future, and his current state of mind!”

# Posts Visible

The number of posts visible on the blog page. If the number of posts exceeds
this number, only this many of the most recent posts appear.
For example, if this property is set to 10 and you add 11 posts, only the ten
most recent posts appear.
This number can be from 1 to 999.
If you leave this field blank, all posts made during the current day are visible.

Comments

Choose how to handle comments by checking the appropriate boxes. For
more information, see ”Controlling Blog Comments” on page 350.

Update Service

Enter a service that notifies a blog search site when blog posts are added to
your blog site. These blog search sites allow Web users to search content
contained in blogs around the world.
To use this feature, check the Notify blog search engines of new posts box
and enter a path to a search site. An example path is: http://
rpc.technorati.com/rpc/ping.

Style sheet
filename for
this folder.

If you want to provide a custom style sheet for the blog, enter the path to it
relative to the site root. For example, WorkArea/csslib/
my_custom_blogs.css.
Leave this field blank to inherit the default style sheet, blogs.css, located in
Workarea/csslib. You can customize the default style sheet but your
modifications will get overwritten when you upgrade Ek tr on CMS 400 .NET .

Page
Templates

Lets you specify one or more templates for content in this folder. For more
information, see the E k t r o n C M S 4 0 0 . N E T Administrator manual section
“Managing HTML Content” > “Creating/Updating Templates.”

Metadata
There is no difference when working with Metadata for blogs or
folders. For more information, see ”Adding or Editing Metadata” on
page 77.

Ektron CMS40 0.NET User Manua l, Version 7.5

321

Blogs

Blog Subjects
Subjects make it easier for site visitors scanning a blog page find
posts that interest them. Here’s how they work.
1. The creator of a blog post assigns one or more subjects to it.
2. When the post is published, a list of subjects assigned to all
posts appears in the right column.
3. A site visitor clicks any subject and see all posts relating to it.
For example, a blog’s subjects are Music, Sports, and Art. A user
creates a new blog post about his favorite band, Ektronica, and
assigns the music subject to the post.
When a site visitor views the blog page, he looks under Subjects
and clicks Music. A list of music-related posts appears, including
the post about Ektronica.

A subject can only be assigned to the blog in which it is created -- it
cannot be used with other blogs. With each new blog, you need to
create new subjects. This gives you the flexibility to tailor unique
subjects to each blog.

Adding Blog Subjects
To add a blog subject, follow these steps.
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NOTE

To add a blog subject from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.
or
From the Web site

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
3. Click the Edit Properties button (

).

4. Click the Subjects tab, then Add New Subject.

5. A text box appears.
6. Enter the subject.
NOTE

Add as many subjects as you need by clicking Add New Subjects.

7. Click Save (

).

Editing Blog Subjects
To edit a blog subject, follow these steps.
NOTE

To edit a blog subject from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.
or
From the Web site

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
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3. Click the Edit Properties button (

).

4. Click the Subjects tab.
5. Change the information in the text box for the subject you want
to edit.
6. Click Save (
NOTE

).

You can edit several subjects before clicking Save.

Removing Blog Subjects
There are two ways to remove blog subjects.

• Remove the last link that was added.
• Remove any link in the list.
Each task is explained below.
Removing the Last Blog Subject
Follow these steps to remove the last blog subject on the page.
NOTE

To remove a blog subject from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.
or
From the Web site

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
3. Click the Edit Properties button (

).

4. Click the Subjects tab.
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5. Click Remove Last Subject.

6. A dialog box appears.
7. Click OK to remove the last subject.
NOTE

You can continue to remove subjects at the end of the list by clicking the Remove
Last Subject link.

8. Click Save (

).

Removing a Blog Subject
NOTE

To remove a blog subject from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.
or
From the Web site

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
3. Click the Edit Properties button (

).

4. Click the Subjects tab.
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5. Click Remove next to the subject to be removed.

6. A confirmation box appears.
7. Click OK if you want to remove the subject.
NOTE

You can continue to remove subjects from the list by clicking the Remove link next
to each subject.

8. Click Save (

).

Web Alerts
Web Alerts notify users when a blog post is published. This feature
is explained in the Administrator Manual Section “Web Alert
Feature” > “Assigning Web Alert Information to Folders and
Content.”

Smart Forms
Use a Smart Form when you want to create structured blogging.
Structured blogging provides a form for the blogger to fill out
instead of free form writing. For example, you create a blog for
book reviews. You want to make sure that, when someone submits
a review, he provides the following information:

• Book title
• Author
• Date of review
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• Review text
For information on working with Smart Forms, see the Ektron
CMS400.NET Administrator Manual section “Managing Content
Folders” > “Smart Forms.”
NOTE

Unlike the Smart Forms you can assign to regular folders, you cannot require the
user to select a Smart Form when creating a new post. It is only an option.

The Blog Roll
The blog roll lets you add a list of Web site links to your blog page.
Think of this as a roll call of blog pages, a list of blogs related to
you or that you want visitors of your blog to also visit. Below is an
example of a blog roll on a Web page.

Adding a Blog Roll Link
Follow these steps to add a blog roll link.
NOTE

To add a blog roll link from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.
or
From the Web site
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- right click the blog.
- click Properties.
2. Click View > Folder Properties.
3. Click the Edit Properties button (

).

4. On the Blog Roll tab, click Add New Roll Link.

5. The Add Blog Roll Link form appears.

6. Fill out the form according to the table below.
Field

Description

Link Name

Describes the link in the blog roll.

URL

The URL of the blog you are adding to the blog roll. It must
begin with http://.

Short Description

Add a short description of the site.
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Field

Description

Relationship

Enter the relationship of the blog roll link to you or to the site. For
example, brother.
Click Edit for a pop up screen that helps you choose the site's
relationship.

The table below explains each relationship type.
Type of
Relationship

Description

URL

Check this box if the address is owned by the same person or
company.

Friendship

What level of friendship do you have with the person who owns
the site? Choose one.

•
•
•
•

Contact
Acquaintance
Friend
None

Physical

Check this box if you have physically met the person who owns
this blog.

Professional

Does the person who owns this site have a work level
relationship with you.? Select all that apply.

•
•
Geographical

Co-worker
Colleague

Select one.

•
•
•

co-resident
neighbor
none
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Type of
Relationship

Description

Family

If the site owner is family, what is the relationship? Select one.

•
•
•
•
•
•
Romantic

Child
Parent
Sibling
Spouse
Kin
None

What are your feelings toward the owner of the site? Check all
that apply.

•
•
•
•

Muse
Crush
Date
Sweetheart

7. Click Close.
NOTE

Add as many links to the blog boll as you would like. Just click Add a New Roll
Link. To remove a blog roll link, see ”Removing a Blog Roll Link” on page 331.

8. Click Save (

).

Editing a Blog Roll
To edit a blog roll link, follow these steps.
NOTE

To edit a blog roll link from the Web site, you must be logged in.

1. In the Workarea, navigate to the blog folder.
or
From the Web site

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
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3. Click the Edit Properties button (

).

4. Click the Blog Roll tab.
5. Find the Blog Roll Link for which the information needs to be
edited.
6. Edit the information.
7. Click Save (
NOTE

).

As with adding a blog roll link, you can edit multiple blog roll links before clicking
Save.

Removing a Blog Roll Link
There are two ways to remove blog roll links.

• Remove the last link that was added.
• Remove any link in the list individually.
The steps to perform each task are documented below.
Removing the Last Blog Roll Link
Using this method to remove the last blog link on the page.
1. In the Workarea,

- navigate to the blog folder.
or
From the Web site
NOTE

To remove a blog roll link from the Web site, you must be logged in.

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
3. Click the Edit Properties button (

).

4. Click the Blog Roll tab.
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5. Click Remove Last Roll Link.

6. A dialog box appears.

7. Click OK if you want to remove the last blog roll link.
You can continue to remove subjects at the end of the list by clicking the Remove
Last Subject link.

8. Click Save (

).

Removing a Blog Roll Link
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To remove any blog roll link on the list, follow these steps.
1. In the Workarea,

- navigate to the blog folder.
or
From the Web site
NOTE

To add a blog subject from the Web site, you must be logged in.

- right click the blog.
- click Properties.
2. Click View > Folder Properties.
3. Click the Edit Properties button (

).

4. Click the Blog Roll tab.
5. Find the blog roll link to be removed.
6. Click Remove Roll Link above the Link Name to be removed.

7. A dialog box appears.
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8. Click OK if you want to remove the blog roll link.
NOTE

Continue to remove subjects by clicking the Remove link.

9. Click Save (

).

Permissions and Approvals
Permissions for blogs work like folder permissions. The same
functionality and features are available. For more information on
working with permissions and approvals, see the Administrator
Manual sections “Setting Permissions” and “Setting Approval
Chains.”

User Blog Permission/ Approval Table

Function

Permissions that affect this
function when performed
from Web Site

Permissions that affect this
function when performed from
Workarea

View

Published blogs are viewable by
any site visitor

Blog properties standard permission
View-Only

Add

Not available

Blog properties advanced permission
Add Folders

Edit

Not available

Blog properties advanced permission
Edit Folders

Delete

Not available

Blog properties advanced permission
Delete Folders

Blog
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Function

Permissions that affect this
function when performed
from Web Site

Permissions that affect this
function when performed from
Workarea

View

Published posts are viewable by
any site visitor

Blog properties standard permission
View-Only

Add

Not available

Blog properties standard permission
Add

Edit

Not available

Blog properties standard permission
Edit

Delete

Not available

Blog properties standard permission
Delete

Approve

Not available

User must be member of blog’s
approval chain

Add

Three blog folder properties
control how comments can be
submitted from Web site. See
”Controlling Blog Comments” on
page 350.

Blog properties standard permission
Add

Edit

Not available

Blog properties standard permission
Read Only

Delete

Not available

Blog properties standard permission
Read Only

Approve

Not available

Blog properties standard permission
Edit

Post

Comment

Membership User Blog Permission Table
Membership users can be given permission to edit and add blog
posts in the blog. Depending on the level of permissions, they can
perform any of these functions:

Ektron CMS40 0.NET User Manua l, Version 7.5

335

Blogs

Permission

Lets membership user

Read Only

Read blog posts.
This box must be checked before you can add Edit and Add
permissions.

Edit

Edit blog posts.

Add

Add blog posts.

Library Read Only

Add items to the library.

Add Images

Upload images to the corresponding library folder.

Add Files

Upload files to the corresponding library folder.

Purge History
Purge History works the same way for blogs as it does for the rest
of the Ektron CMS400.NET. See Also: the Administrator Manual
section “Managing Content” > “Managing Content Folders” >
“Purge History”

Language Support
Language Support for blogs and blog posts work the same way as
it does for folders and content. See the Administrator Manual
section “Multi-Language Support” > “Working with Multi-Language
Content” for an explanation on working with multiple languages.

Deleting a Blog
NOTE

To delete a blog, you must have permission to Delete Folders on the blog’s
Advanced Permissions screen.

Deleting a blog removes the blog and all posts, comments, and
quicklinks for the blog.
WARNING!

After a blog is deleted, you cannot retrieve its posts, comments, or quicklinks.
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The following steps explain how to delete a blog.
1. In the Workarea, navigate to the blog folder.
Or
From the Web site, right click the blog and click Properties.
NOTE

To delete a blog from the Web site, you must be logged in.

2. Click the Delete > This Blog.
3. A dialog box appears.

4. Click OK to delete the blog.

Searching Blogs
Searching blogs works the same as searching HTML content. See
the following topics for an explanation of using the Search feature.

• The Administrator Manual chapter “Searching Content on the
Web Site”

• ”Searching the Library” on page 136

Subscribing/Unsubscribing to a Blog
Logged in Site users and Membership users can subscribe to a
blog or a blog post.
By subscribing to a blog, users receive notification when posts are
added to the blog. By subscribing to a blog post, users are notified
when comments are added to the post. When you do not want to
receive notices, you can unsubscribe.
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The section contains the following topics:

• ”Subscribe to a Blog” on page 338
• ”Unsubscribe to a Blog” on page 339
• ”Subscribe to a Blog Post” on page 340
• ”Unsubscribe to a Blog Post” on page 340

Subscribe to a Blog
To subscribe to a blog, follow these steps.
1. Navigate to the blog on the site.
2. Click the Subscribe icon (

) for the blog.

3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.
5. Click Add Subscription.
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A message states that you are now subscribed to the blog. You are
forwarded to the blog page.

Unsubscribe to a Blog
To unsubscribe to a blog, follow these steps.
1. Navigate to the blog on the site.
2. Click the Subscribe icon (

) for the blog.

3. The Subscribe/Unsubscribe screen appears.
4. Select a Notification Type.
5. Check the Unsubscribe check box.

6. Click Update Subscription.
A message states that you are now unsubscribed to the blog.
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Subscribe to a Blog Post
To subscribe to a blog post, follow these steps.
1. Navigate to the blog post on the site.
2. Click the Subscribe icon (

) for the blog post.

3. The Subscribe/Unsubscribe screen appears.

4. Select the Notification Type.
5. Click Add Subscription.
A message states that you are now subscribed to the blog post.
You are forwarded to the blog post’s page.

Unsubscribe to a Blog Post
To unsubscribe to a blog, follow these steps.
1. Navigate to the blog post on the site.
2. Click the Subscribe icon (

) for the blog.

3. The Subscribe/Unsubscribe screen appears.
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4. Select the Notification Type.
5. Check the Unsubscribe check box.
6. Click Update Subscription.
7. A message states that you are unsubscribed to the blog post.

Blog Posts
For a definition of blog posts, see ”Blogs” on page 312.
From your Web site, only published blog posts are visible. But,
from the Workarea, you can see all blog posts, regardless of
status. Using the Workarea, you can also create, edit, delete, and
archive blog posts the same way you work with content.
This section contains the following subtopics.

• ”Blog Posts on the Site” on page 342
• ”Blog Posts in the Workarea” on page 344
• ”Adding a Blog Post” on page 346
• ”Editing a Blog Post” on page 348
• ”Deleting a Blog Post” on page 349
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Blog Posts on the Site
You can view published blog posts on the Web site. The following
is an example of one.

A blog post has a Title, Content, Comments Link, Post Time, Date,
and Editor Information. Below is a breakdown of a blog post on a
site.
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Item

Description

Title

The headline of the post. Usually what a site
visitor scans through to find a post to read.

Permanent Link

If you click this link, a new screen appears. The
new screen indicates the permanent link to this
blog post. As long as the blog post is active within
E ktron CM S40 0.NET , you can access it via the
URL in the browser’s address bar.
Most blog pages show only recent posts. After a
post is moved off the blog’s front page, it is still
accessible via this link.

Content

The body of the post.

Comments Information

The comments link shows the number in
parentheses of comments for a post . When this
link is clicked, a new page of comments for the
post appears.
Also on the page is a form to add comments about
the post. The comments only appear if a site
visitor has logged in or authentication is not
required for blog comments.
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Item

Description

Editor Information

The person who created or last edited the blog
post.

Post Time and Date

The date and time a blog post was created or last
edited.

Blog Posts in the Workarea
Viewing a blog post in the Workarea is similar to viewing content in
the Workarea. Navigate to the folder that contains the blog. Next,
in the View Posts in Blog screen, click the title of the blog post.
Below is an example of a viewing a blog post in the Workarea.

The View Posts in Blog screen shows the following information
about each blog post.
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See Also: ”Blog Posts” on page 341; ”Blogs” on page 312

Item

Description

Title

The headline of the post. Usually what a site
visitor scans through to find a post to read.

Comments Information

The comments link shows the number in
parentheses of comments for a post . When this
link is clicked, the View Comments for Post screen
appears.
If a red flag (
) appears next to the comments
icon, they are awaiting approval.

Editor Information

The person who created or last edited the blog
post.

Post Time and Date

The date and time the blog post was created or
last edited.

Status

The status of the blog post. For example, if the
blog post is checked in, the status is I.
See Also: ”Appendix A: Content Statuses” on
page 798
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From this screen, you can perform all functions with a blog post
that you can with content. You can give it a summary, add
metadata, associate a task, assign Web Alerts, etc. You must have
Edit permission for the blog to perform these functions.
WARNING!

You can also add a history comment to the blog post by clicking the Comment tab.
This is not the same as adding a comment to a blog post on a site. When you add
a history comment, it has the same properties as a comment associated with
content.

Adding a Blog Post
NOTE

To be able to add a blog post, you must have Add permission on the blog’s
Standard Permissions screen.

Follow these steps to add a blog post.
1. In the Workarea, navigate to the blog folder. Click New > HTML
Post.
Or
From the Web site, right click the blog then choose New Post.
NOTE

To add a blog post from the Web site, you must be logged in.

2. When the Add Content screen appears, use the editor to create
the blog post. You create a blog post the same way you create
content. See Also: ”Adding HTML Content” on page 48.
IMPORTANT!

If you are using subjects or tags, they can be assigned to a blog post by clicking
the Summary tab and choosing a subject. For more information on subjects, see
”Blog Subjects” on page 322. For more information on Tags, see ”Tags on the
Summary Page” on page 347.
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3. If the user creating the post is a member of the blog’s approval
chain, it is published immediately. If not, it is surrounded by a
yellow border, and a member of the approval chain must
approve it before it can appear on the Web site. (For more
information on working with permissions and approvals, see
the Administrator Manual section “Setting Approval Chains.”)

4. Once the post is published, it appears within the blog on the
Web site.

Tags on the Summary Page
You can add tags to a blog post to further define information about
the post for blog search engines. For example, you create a blog
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post about your favorite band, Ektronica, and enter the following
tags: Music, Guitars, Rock & Roll.
When a person visits a blog search site and searches for Rock &
Roll music, your blog post appears. Some blog search sites have a
page specifically for searching blog tags.

Editing a Blog Post
NOTE

To be able to edit a blog post, you must have Edit permission on the blog’s
Standard Permissions screen.

Follow these steps to edit a blog post.
IMPORTANT!

If another editor changes a blog post, the posting information reflects the new
editor, the date, and the time the information was changed. This is important to
remember if you want the original person who posted the blog to get credit for the
post.

1. In the Workarea, navigate to the blog folder.
Or
From the Web site, right click the blog then choose Properties.
Next, choose the post.
NOTE

To add a blog post from the Web site, you must be logged in.

2. Click the blog post title you want to edit.
3. Click the Edit button (

).

4. Change the blog post.
5. When the blog is published, the changes appear in the blog
post on the Web site.

Approving a Blog Post
If someone who is not a member of the blog’s approval chain
creates or edits a blog post, its status is set to Submitted. It will
only appear on the Web site after a member of the chain approves
it. While its status is Submitted, it has yellow border on the View
Posts in blog screen.
To approve a blog post, see ”Approving/Declining Content” on
page 87.
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Deleting a Blog Post
NOTE

To be able to delete a blog post, you must have Delete permission on the blog’s
Standard Permissions screen.

The following steps explain how to delete a blog post.
1. In the Workarea, navigate to the blog folder.
Or
From the Web site, right click the blog then choose Properties.
Next, choose the post.
NOTE

To delete a blog post from the Web site, you must be logged in.

2. From the menu, click the Delete > Posts.
3. The Delete Blog Post screen appears.

4. Click the check box next to each post you want to delete. To
select all posts, click the check box next to Title.
5. Click the Delete Contents button (

).

6. A dialog box appears.
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7. Click OK to delete the selected posts.

Blog Comments
WARNING!

Do not confuse blog comments with history comments. You can add a history
comment to the blog post by clicking the Comment tab. This is not the same as
adding a comment to a blog post on a site. When you add a history comment, it
has the same properties as a comment associated with content.

Blog comments allow site visitors to interact with a blog by adding
their thoughts about a blog post. The blog administrator controls
commenting by deciding who can add comments and if they
require approval for publication.
See Also:

• ”Controlling Blog Comments” on page 350
• ”Comments on the Site” on page 352
• ”Comments in the Workarea” on page 354

Controlling Blog Comments
Ektron CMS400.NET provides three properties for controlling
comments. Use the Blog Properties screen to set them. See Also:
”Blog Properties” on page 318. The following table describes these
properties.

Field

Description

Enable Comments

Allows user in Workarea and site visitor to add blog comments. Also
displays comments on site and in Workarea.
Note: A member of the Administrators group can always add
comments, regardless of how this checkbox is set.

Ektron CMS40 0.NET User Manua l, Version 7.5

350

Blogs

Field

Description

Moderate Comments

Determines if comments must be approved before they appear on
site.
If this field is checked, only users with permission to edit the post can
approve comments (see illustration of this permission below).

If users without this permission add comments, they only appear on
the Web site after being approved by someone with permission to
edit the post.
If someone has edit post permission and authenticates before
submitting a comment, it is approved automatically.
Appearance of Unapproved Comments
On the Workarea’s View Posts in Blog screen, an unapproved
comment is indicated by a red flag .

On the View Comments for Post screen, an unapproved comment is
indicated by a yellow border.
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Field

Description

Require Authentication

Determines if a user must be authenticated (that is, logged in as a
CMS400 user or membership user) to add comments via the Web
site.

Comments by default are fully controlled. This means they are
enabled, must be approved, and a site visitor must be
authenticated to create them.
If comments are enabled but not moderated, any site visitor can
add a comment. If you don’t want censorship, this is the way to go.
WARNING!

While you can delete a comment at any time, if comments are not moderated,
they appear on your site as soon as a site visitor submits them.

However, to make sure comments on your site meet certain
criteria, moderate them.
The following topics are explained in this section.

• ”Comments on the Site” on page 352
• ”Comments in the Workarea” on page 354

Comments on the Site
On the site, comments for a blog post appear when one of the
following blog post items is clicked:

• the Comments link
• the Title of the blog post
The comment page contains the original post, any comments that
have been added, and a form to post new comments. Depending
on how the page is designed, the calendar and blog roll can also
appear.
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The Comment Form
NOTE

See ”Controlling Blog Comments” on page 350 to learn about how an
administrator determines if and by whom comments can be submitted.

Site visitors, regular users, and Membership users can add
comments by filling out the form on the comments page. The form
has five fields.
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Field

Description

Name

The person submitting the comment. This
information is required.
Note: This text box appears only when a site
visitor, who is not a regular user or membership
user, is adding a comment. If a regular user or
membership user adds a comment, their name and
email address is taken from their user profile.

Email

The email address of the person submitting the
comment. This information is required.
Note: This text box appears only when a site
visitor, who is not a regular user or membership
user, is adding a comment. If a regular user or
membership user adds a comment, their name and
email address is taken from their user profile.

Homepage

A URL for the person’s web site.

Comment Section

A text area to insert comments about the post.

Post Comment Button

Post a comment by clicking this button.
Depending on the comment’s settings, it either
posts immediately or is submitted for approval. See
Also: ”Controlling Blog Comments” on page 350

Comments in the Workarea
In the Workarea, you can add, view, approve, edit, and delete
comments for a blog post.
The comment link (illustrated below) indicates the number of
comments. To work with comments, navigate to the blog folder and
click the comment link next to a blog post.
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This leads you to View Comments screen. Here, you can view
approve, edit, delete, and add new comments.
NOTE

To learn about recognizing unapproved comments and approving them, see
”Controlling Blog Comments” on page 350.

See Also:

• ”Adding a Comment” on page 355
• ”Editing a Comment” on page 356
• ”Deleting a Comment” on page 357
• ”Approving a Comment” on page 357
Adding a Comment
NOTE

To be able to add a comment, you must have Add permission on the blog’s
Standard Permissions screen.

To add a blog post comment from the Workarea, follow these
steps.
1. From the Content area, navigate to the blog.
2. Click the Comments icon to the left of the post that you want to
comment on.
3. Click New > Comment.
4. The Add Comment screen appears.
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For a description of the fields on this screen, see ”The Comment
Form” on page 353.
Note that Add Comment screen provides an additional field, State.
This field lets the submitting user set the comment’s state to
approved or pending. Approved comments appear on the site
immediately. Pending comments must be approved before they
appear.
To learn about the approval process for pending comments, see
”Moderate Comments” on page 351.

Editing a Comment
1. From the Content area, navigate to the blog.
2. Click the Comments icon to the left of the post whose comment
you want to edit.
3. Locate the comment you want to edit.
4. Click edit.
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5. The Edit Comment screen appears.
For a description of the fields on this screen, see ”The Comment
Form” on page 353.
Note that Edit Comment screen provides an additional field, State.
This field lets the submitting user set the comment’s state to
approved or pending. Approved comments appear on the site
immediately. Pending comments must be approved before they
appear.
To learn about the approval process for pending comments, see
”Moderate Comments” on page 351.

Deleting a Comment
Once a comment is deleted, you cannot retrieve it.
1. From the Content area, navigate to the blog.
2. Click the Comments icon to the left of the post whose comment
you want to delete.
3. Click delete.
4. A dialog box appears:

5. Click OK to delete the comment.

Approving a Comment
Comments can require approval if

• they are submitted from the Web site and Moderate
Comments is checked in the blog’s folder properties
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• a user submits the comment from the Workarea set its state to
Pending
Only users with permission to edit content (posts) within the blog
folder can approve comments. To learn about the approval process
for pending comments, see ”Moderate Comments” on page 351.
To approve a comment, follow these steps.
1. From the Content area, navigate to the blog.
2. Click the Comments icon to the left of the post whose comment
you want to approve. (Unapproved comments are indicated by
a red flag (

).

3. Click approve.
4. The comment’s status changes to approved.

Adding or Editing Blog posts with Windows Live
Writer
Ektron CMS400.NET authors and membership users can use
Windows LiveTM Writer to add and edit blog posts to your site. If
users have the proper permissions, they upload images and attach
files from their system. See Also: ”Permissions and Approvals” on
page 334.
For additional Windows Live Writer help from Microsoft, click here.
Follow these steps to set up Windows Live Writer to work with your
Ektron CMS400.NET Blog. If you have previously set up Windows
Live Writer, click Weblog > Edit Weblog Settings. Then, skip to
step four.
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Step
1.

Windows Live Writer Setup Screen

Download and Start
Windows Live
Writer.
When the Welcome
window appears,
click the Next
button. Do not
create a Windows
Live Spaces
account.

2.

In the Choose Blog
Type window, select
the Another
weblog service
radio button.
Click Next.
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Step
3.

In the Weblog
Homepage and
Login window, enter
the following
information:

•

Weblog Homepage URL - this is the
page that contains
the blog. For example, http://<your

Windows Live Writer Setup Screen

site>/CMS400Min/
blogs.aspx.

•

Username - your
username to log on
to the Ektron
CMS400.NET site.

•

Password - your
password to log on
to the Ektron
CMS400.NET site.

•

Edit Proxy Settings... - edit the
proxy settings as
needed.
Click Next.
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Step
4.

In the Select
Provider widow,
choose Custom
(Metaweblog API)
from the Type of
weblog that you
are using dropdown
box.

5.

In the Remote
posting URL for
your weblog
textbox, add a link to
the xmlrpc.aspx file
for the site. The
default location for
the file in the demo
site is http://

Windows Live Writer Setup Screen

<your site>/
CMS400Min/
Workarea/Blogs/
xmlrpc.aspx.

Click Next.
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Step
6.

Windows Live Writer Setup Screen

When the Weblog
Configuration
Complete window
appears, Add a blog
name in the Weblog
Name field.
Click Finish.
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The Personalization feature lets a signed-in (typically membership)
user determine a page’s layout and content. The user can
customize the page, displaying whatever interests him in an
arrangement of his own design.
Examples of content that might appear on a personalized page are
frequently-updated information, such as news stories, sports
scores, a calendar, and stock market data.
A user gets his personalized view of the customized page after
logging into any computer. The customization is tied to the user,
not a specific computer.
IMPORTANT!

The Personalization feature requires Internet Explorer 5 or higher. You cannot use
other browsers.

The following topics explain personalization in more detail.

• ”Types of Content that Can Be Personalized” on page 363
• ”Which Web Pages Can be Personalized” on page 364
• ”Personalization and Permissions” on page 364
• ”Layout of a Personalization Page” on page 364
• ”Personalizing a Web Page” on page 365
• ”The Personalization Menu” on page 366
• ”Editing Sequence” on page 367

Types of Content that Can Be Personalized
• Content
• Calendars
• Collections
• Blogs
• HTML Forms
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• List Summary
• Contentlist
• Discussion Forum
NOTE

Assets cannot be personalized.

Which Web Pages Can be Personalized
Your administrator will tell which Web pages you can personalize.
Personalization can be enabled on any number of pages.
In the sample Web site provided with Ektron CMS400.NET, the
and http://localhost/
siteroot/mypageadvance.aspx pages demonstrate how
personalization may be implemented.
http://localhost/siteroot/mypage.aspx

Personalization and Permissions
To learn about how permissions affect your ability to personalize,
see the Ektron CMS400.NET Administrator Manual section
“Personalization Feature” >””Permissions that Affect
Personalization” .

Layout of a Personalization Page
A Personalization page consists of one or more Web Part Zones.
Each zone can contain one or more content items. You select the
content you wants to see in each zone.
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Personalizing a Web Page
Your system administrator gives you permission to personalize a
Web page. Several permission levels are available (listed below).
You may have any combination of these permissions.

• moving content among zones
• editing a content item
• adding new content
• globally changing the page. So, anyone visiting the page sees
your content and arrangement.
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NOTE

While the first three permissions affect your ability to personalize a page, the last
one lets you design a page that anyone browsing to it will see.

If you have any permission, you can also perform these actions on
a personalization page.

• remove content from a zone temporarily (close)
• remove content from a zone permanently (delete)
• suppress content from a zone (minimize)
These tasks are explained in more detail below.

The Personalization Menu
The top right corner of any content item contains a menu of options
you can perform on it (circled below).

The options change depending your permissions, your mode (for
example, Add Content mode), and the current state of the content.
Also, each content item has its own menu. So, if a Web part zone
contains three items, you see three menus, one in the top right
corner of each item.
The following table describes Personalization menu options.
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Button

Name

Description

For more information, see

Minimize

In personalization mode, only display the
content title.

”Minimizing a Content Item” on
page 373

To a site visitor, suppress the content.
Restore

Undo minimize.

”Minimizing a Content Item” on
page 373

Close

Removes content item from its zone and
places it in the page catalog. From the
page catalog, the content item can be
moved to any Web Part Zone.

”To remove a content item from its
zone, click the close button (circled
below).” on page 368

See Also: ”The Page Catalog” on
page 375
Delete

Remove content item from its Web part
zone.

”Deleting Content” on page 373

Only appears for content you added.
Edit

•

replace with other content of the
same type

•

move content item to different Web
part zone

•

change its width and height

”Editing Content” on page 369

Editing Sequence
1. Access the Web page that lets you personalize. Your system
administrator tells you how to access this.
2. If you have permission to change the page for unauthenticated
users, the Personalization For box appears.
Otherwise, skip to Step 3.
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Use this box to decide if your page customization applies to
just yourself (Current User) or all site visitors who do not sign
in (Public Users).
3. Click Personalize.
4. The page refreshes, and you see its Web part zones.

• If you have permission to move content, you can do that now.
• If you have permission to edit content, you can do that now.
• If you have permission to add content, click Add Content. The
screen refreshes, and a new area appears that lets you add
content.

• You can delete any content item that you added. See ”Deleting
Content” on page 373.

• To suppress the display of a content item but leave it in its
zone, click its minimize button. To restore the content item,
click the restore button.

• To remove a content item from its zone, click the close button
(circled below).

A closed item is placed in the Page Catalog. If your Web
administrator places the Page Catalog on a personalization
page, you can later move the content from the Page Catalog to
any zone. See Also: ”The Page Catalog” on page 375

• At any time, you can restore the page to the original layout and
content using Reset To Default.

Moving Content
You can move content to an empty zone or one with content. If you
do the latter, the new content appears at the top of the zone, and
existing content in the zone is pushed down.
To move content, follow these steps.
1. Go to the personalization Web page. Your system administrator
will tell you how to find it.
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In the sample database provided with Ektron CMS400.NET, the
page is http://localhost/siteroot/mypage.aspx.
2. Click Personalize to enter personalization mode.
3. Move the cursor to the left of a content item’s personalization
menu (illustrated below).

4. The cursor changes to a four-headed arrow.
5. Drag the content to a different Web part zone.

Editing Content
Editing allows you to do the following to a content item.

• replace it with another item of the same type
• move it to a different Web part zone
• change its width and height
Editing does not allow you to change the content of any item.
To edit content, follow these steps.
1. Go to the personalization Web page. Your system administrator
will tell you how to find it.
In the sample database provided with Ektron CMS400.NET, the
page is http://localhost/siteroot/mypage.aspx.
2. Click Personalize to enter personalization mode.
3. The screen refreshes. If you have edit permission, edit
appears on each content item’s personalization menu (circled
below).
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4. Click edit next to any content item.
5. The editor zone appears. Your system administrator
determines its location on the page.
The fields in the editor zone vary depending on the type of
content you are working with.

6. You can replace the content item with another of the same
type. In the above illustration, you can replace the content
block “Home.”
To do so, click the button to the right of the title. When you do, a
popup window prompts you to select a different item of the
same type.
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NOTE

You cannot select another type of item. If needed, you can delete this content item
and add a different type of item in its place.

7. If a Zone dropdown list appears in the Editor Zone, you can
use it to move the selected item to another zone.

Adding Content
When you enter Add Content mode, a new screen zone appears,
displaying content you can add to the page. Your system
administrator determines which content items appear.
To add content, follow these steps.
1. Go to the personalization Web page. Your system administrator
tells you how to find it.
In the sample database provided with Ektron CMS400.NET, the
page is http://localhost/siteroot/mypage.aspx.
2. Click Personalize to enter personalization mode.
3. The screen refreshes. If you have add permission, Add
Content appears below the Personalization Manager (see
below).
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4. An add content zone appears. Your system administrator
determines its location on the page.
Below is the add content zone on the sample page.

In this example, the administrator provided three categories of
content, and each category has several items. When you
select a category, its items appear below.
5. Select the items you want to display.
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6. Select the zone in which you want to place them.
7. Click the Add button.
8. When you do not need to add more content, click Done Add
Content.

Deleting Content
You can only delete content that you added. (See ”Adding Content”
on page 371) When you delete content, you remove a version of it
from its Web part zone. But, if it exists in another location on the
same page or on any other page, it remains there. And, you can
still add it to any Web part zone.
To delete content, follow these steps.
1. Go to the personalization Web page. Your system administrator
will instruct you on how to find it.
In the sample database provided with Ektron CMS400.NET, the
page is http://localhost/siteroot/mypage.aspx.
2. Click Personalize to enter personalization mode.
3. A delete button appears on the personalization menu for any
content item you added to the page. See illustration below.

4. To remove that item from that Web part zone, click the delete
button.
5. A warning message appears. Click OK.

Minimizing a Content Item
There are two reasons for minimizing content:
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• You want to reduce the clutter while working on a page in
personalization mode. When you minimize, only the title and
menu appear in the zone.

In this case, you would restore content to full size when you
finish.

• You want to suppress the content for anyone visiting the page.
For example, you are customizing a page for all site visitors,
and want to temporarily hide a content item.
To minimize a content item, click the minimize button on the
personalization menu (circled below).
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After you minimize, the button changes to a restore button (circled
below). Click it to restore the content.

The Page Catalog
If your Webmaster has placed a Page Catalog on your
personalization page, it only appears after you enter Add Content
mode (click Personalize > Add Content). The Page Catalog looks
something like the following.
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You can do two things from the catalog area.

• Add to any Web Part Zone items that have been deleted from
other Web Part Zones.

• Add a type of content to any Web part zone. As you can see
from the illustration above, you can add content, a calendar, a
collection, a blog, etc.
After you add the content type, click Done Add Content. Then,
within that content area, click edit. A new screen area appears.
Use that area to define the content.
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My Wo rkspace

A community is a group of people who network with each other to
share information, ideas, likes and dislikes. Typically, people or
members in the community are connected to each other by a
relationship. For example, they work for the same company, went
to the same school, share the same values or have a friendship.
When a person initially visits a community site, they can explore to
see what type of information, people and groups are on the site.
While the person can see some information on the site, they often
need to become a member of the site to see exclusive information.
When a person signs up to be member, they define information
about themselves. This is known as their member profile. As a
Ektron CMS400.NET user, you already have a member profile on
the site.
The Community Platform in CMS400 is a set of features that allow
users to network socially on the site. Access to the community
platform is available from both the Web site and the Workarea.
Only Ektron CMS400.NET users and administrators can access
their information via the Workarea. Membership Users, Ektron
CMS400.NET users and administrators can access their profile
pages via the Web site.
My Workspace is a component of the Community Platform. This
area allows you to manage your community information from the
Workarea.
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The following features are included in My Workspace:

• Documents - see ”Documents” on page 379
• Community Groups - see ”Community Groups” on page 412
• Favorites - see ”Favorites” on page 415
• Colleagues - see ”Colleagues” on page 400
• Journal - a Journal is a personal blog for a user. See ”Blogs”
on page 312
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• Message Board - see ”Message Board” on page 397
• Messaging - see ”Messaging” on page 390
• Photos - see ”Photos” on page 417

Documents
The Documents area of My Workspace allows you to add assets
and HTML content to Ektron CMS400.NET and associate it with
your profile. You can create subfolders to separate content by
category.
Folders and files in the Documents area are separate from the
Content folder structure and its files. Assets and HTML content in
this list have the same properties and actions available to those
found in the Content folder structure. For example, you view, edit,
delete and copy content and assets.
From the Documents area, you can:

• add a folder - see ”Adding Folders to My Workspace >>
Documents” on page 380

• edit a folder’s name - see ”Edit a Folder Name in My
Workspace >> Documents” on page 381

• delete a folder - see ”Deleting a Folder in My Workspace >>
Documents” on page 383

• drag and drop an asset - see ”Adding Assets to My Workspace
>> Documents” on page 384

• create an HTML file - see ”Creating HTML Content in My
Workspace >> Documents” on page 385

• move a content item to another folder - see ”Moving and
Copying Content in My Workspace >> Documents” on
page 387

• select whether to share the folder with the Public, Colleagues,
Selected Colleagues or keep the folder private. - see ”Sharing
Content in My Workspace >> Documents” on page 389
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HTML Content and Assets can be displayed on the site when a
developer adds the CommunityDocuments server control to a
Community Web site. For additional information on the
CommunityDocuments server control, see the Developer Manual
section “Introduction to Ektron CMS400.NET Server Controls” >
“Community Platform Server Controls” > “CommunityDocuments
Server Control.”

Adding Folders to My Workspace >> Documents
You can add subfolders in the Documents area to help you sort
assets and content into categories. The subfolders represent a
taxonomy of the items contained in the documents area.
To add subfolders, follow these steps.
1. In the Workarea, navigate to My Workspace >> Documents.
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2. Click the Manage Folder Button (

).

3. The Add Folder box appears.

4. Enter a Name for the folder.
5. Click the Add button (

).

6. When the page refreshes, it opens to the newly added folder.

Edit a Folder Name in My Workspace >> Documents
Sometimes, it is necessary to change the name of folder in the My
Workspace >> Documents area. To accomplish this, follow these
steps.
1. In the Workarea, navigate to My Workspace >> Documents.
2. Click the folder’s Edit button (
left of the folder’s title.
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3. The Edit Folder box appears.

4. Change the name of the folder.
5. Click the Save button (

).

6. When the page refreshes, it opens to the folder with changed
name.
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Deleting a Folder in My Workspace >> Documents
You can delete obsolete folders from My Workspace >>
Documents. To delete a folder, follow these steps.
NOTE
CAUTION!

You can not delete the top-level folder, Workspace.
Deleting a folder permanently deletes all assets and HTML content, as well as its
subfolders.

1. In the Workarea, navigate to My Workspace >> Documents.
2. Click the folder’s Edit button (
left of the folder’s title.

). This button is located to the

3. The Edit Folder box appears.

4. Click the Delete button (

).

5. A dialog box appears asking you to confirm deleting the folder.
6. Click OK.
7. The page refreshes and the folder is removed.
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Adding Assets to My Workspace >> Documents
Assets are files that are not HTML content, such as Office
documents and PDFs. To add an asset to My Workspace >>
Documents, follow these steps.
1. In the Workarea, navigate to My Workspace >> Documents.
2. Select a folder where the asset will be added. If you want to
create a new folder, see ”Adding Folders to My Workspace >>
Documents” on page 380.
3. Click the Add Asset button (

).

4. The Add Asset box appears.

5. Drag and drop an asset in the Add Asset box.
6. A status box appears and shows the files being uploaded.
7. Once the upload is complete, the page refreshes and the asset
appears in the file list.
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Creating HTML Content in My Workspace >> Documents
To create HTML content in My Workspace >> Documents, follow
these steps.
1. In the Workarea, navigate to My Workspace >> Documents.
2. Select a folder where the content will be added. If you want to
create a new folder, see ”Adding Folders to My Workspace >>
Documents” on page 380
3. Click the Add HTML Content button (

).

4. The Add HTML Content window appears.

Ektron CMS40 0.NET User Manua l, Version 7.5

385

My Workspace

5. Add a title and content. See ”Adding HTML Content” on
page 48 for an explanation of the buttons and tabs in this
window.
6. Click the Publish button (

) to publish the content.

7. The page refreshes and the HTML content appears in the file
list.
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Moving and Copying Content in My Workspace >> Documents
You can change the folder where assets and HTML content are
stored in My Workspace >> Documents by moving the content
from one folder to another. In addition to moving files, you can copy
files to another folder. To accomplish either of these actions, follow
these steps.
1. In the Workarea, navigate to My Workspace >> Documents.
2. Select the folder from which to move or copy the content.
3. Click the triangle to the right of the content title (circled below).

4. From the drop down list, select Copy.
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5. Navigate to the my Workspace > Documents folder into which
you want to copy the content.
6. Click the Manage link.
NOTE

The Manage link only appears after you copy a document but have not pasted it.

7. Click the Move Items (
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8. A dialog box appears asking you to confirm the move or copy
action.
9. Click OK.
10. The page refreshes and the moved or copied content appears
in the folder.

Sharing Content in My Workspace >> Documents
The Documents area of My Workspace allows you to add and edit
content you want share with your colleagues. You can share
content with the Public, Colleagues, Selected Colleagues or keep
the content private. You apply sharing options to folders not to
individual content. To share a folder, follow these steps.
1. In the Workarea, navigate to My Workspace >> Documents.
2. Click the Manage Folder Button (

).

3. The Add Folder box appears.

4. Click the Share Folder button (

).

5. The Share Workspace box appears.
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6. Select with whom to share your folders. The table below
describes each option.

Viewer Type

Description

Public

All people viewing your profile page can view your
documents.

Colleagues

Only people who are your colleagues can view your
documents. See Also: ”Colleagues” on page 400.

Selected Colleagues

Only colleagues who are marked as selected colleagues
can view your documents.

Private

You are the only one who can view your documents.

7. Click the Share button (

).

8. Documents in the folder are now available for viewing by the
selected viewer type.

Messaging
The messaging system allows you to send messages to other
CMS400 and membership users. Messages are similar to email.
The difference is, messages are sent and received within CMS400
Web site or the Workarea. When sending a message, users can
send it to multiple recipients. The recipients can then read, reply or
forward the message.
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In the Workarea, Messages links are located in two places. The
first, a link in the left side panel of the Smart Desktop. The second,
a link under the My Workspace folder button. Messages are stored
in two areas, the Inbox and Sent Messages.
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See Also:

• ”Messaging Inbox” on page 392
• ”Messaging Sent Messages Box” on page 393

Messaging Inbox
In the Inbox, you see a list of messages that have been sent to
you. You can see who the message is from, the subject, and the
date the message was sent.
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From the Inbox, you can:

• view a message’s details. See ”Viewing a Message” on
page 393.

• compose a new message. See ”Compose a New Message in
the Workarea” on page 394.

• delete a message. See ”Delete a Message” on page 396.

Messaging Sent Messages Box
Sent Messages provides a list messages you’ve sent. You can see
to whom the message was sent, the subject and date it was sent.

From the Sent Messages list, you can:

• view a message’s details. See ”Viewing a Message” on
page 393

• delete a sent message. See ”Delete a Message” on page 396
Viewing a Message
To view a message’s details, click the message’s subject link. The
details of a message include who the message is from, to whom it
was sent, the subject, date sent, and body of the message.
Actions you can take from the message details screen include:

• compose a new message. See ”Compose a New Message in
the Workarea” on page 394
Ektron CMS40 0.NET User Manua l, Version 7.5

393

My Workspace

• reply to a message. See ”Reply to a Message” on page 394.
• forward a message. See ”Forward a Message” on page 395.
• Moving to the Next or Previous message. See ”Moving to the
Next or Previous Message” on page 395

• print a message. See ”Print a Message in the Workarea” on
page 396.

• delete the message. See ”Delete a Message” on page 396.
Compose a New Message in the Workarea
Clicking the Compose a Message launches the Send a Message
screen. To compose a message, follow these steps:
1. In the Workarea, click My Workspace or expand the
Messaging folder on the Smart Desktop.
2. Select either Inbox or Sent Items.
3. Click the Compose a Message button (

).

4. The Send a Message screen appears.
5. Click the Browse Users link.
6. Select the people to which you want to send the message.
7. Add a subject to the Subject field.
8. Add text to the body of the message in the editor.
9. Click the Send button (

).

Reply to a Message
When replying to a message, you reply only to the person who
sent you the original message. A reply contains the details of the
original message. The details of the original message can be
edited or removed from the new message.
To reply to a message, follow these steps:
1. In the Workarea, click My Workspace > Messaging or expand
the Messaging folder on the Smart Desktop.
2. Select either Inbox or Sent Items.
3. Find the message to which you want to reply and click the
subject.
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4. Click the Reply button (

).

5. The message editor screen appears with the original
message’s details in the body of the message.
6. Add your reply.
7. Click the Send button (

).

8. The message is sent.

Forward a Message
When forwarding a message, you can select to whom the
message is sent. A forwarded message contains the details of the
original message. The details of the original message can be
edited or removed from the new message.
To forward a message, follow these steps:
1. In the Workarea, click My Workspace or expand the
Messaging folder on the Smart Desktop.
2. Select either Inbox or Sent Items.
3. Find the message you want to forward and click the subject.
4. Click the Forward button (

).

5. The message editor screen appears with the original
message’s details in the body of the message.
6. Add any additional information to the message.
7. Click the Send button (

).

8. The message is sent.

Moving to the Next or Previous Message
Users in the Workarea can navigate through their messages by
clicking the Next or Previous button (

) located in the header

of a message. Clicking the Next button (

) opens the next

newest message in the list. Clicking the Previous link (
) opens
the next oldest message in the list. Once you have reached the
end of the list, that option’s link is unavailable. For example, when
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a user reaches the newest message in the list, the Next link is
greyed out (

) and cannot be clicked.

Print a Message in the Workarea
To print a message, follow these steps:
1. In the Workarea, click My Workspace or expand the
Messaging folder on the Smart Desktop.
2. Select either Inbox or Sent Items.
3. Find the message you want to print and click the subject.
4. Click the Print button (

).

5. The Print dialog box appears.
6. Select a printer.
7. Click the Print button.

Delete a Message
Deleting a message permanently deletes it from Ektron
CMS400.NET.
To delete a message, follow these steps:
1. In the Workarea, click My Workspace or expand the
Messaging folder on the Smart Desktop.
2. Select either Inbox or Sent Items.
3. Find the message you want to delete and click the subject.
or
Find the message you want to delete and fill in the check box.
4. Click the Delete button (

).

5. The message is deleted and you are returned to the Inbox or
Sent Messages.
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Message Board
The Message Board allows site visitors to leave a short message
or comment on the site.

Message Board in My Workspace
The Message Board located in My Workspace allows a user to
manage the comments on their board. From this area, a user can

• view comments - see ”Viewing Your Message Board
Comments” on page 398- See ”Viewing Your Message Board
Comments” on page 398

• add comments - see ”Add a Comment to Your Message Board
in the Workarea” on page 399- See ”Add a Comment to Your
Message Board in the Workarea” on page 399

• delete comments - see ”Delete Comments on Your Message
Board in the Workarea” on page 399- ”Delete Comments on
Your Message Board in the Workarea” on page 399
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Viewing Your Message Board Comments
To view comments for a Message Board in the Workarea, click the
My Workspace folder button. Then, click the Message Board link. A
list of comments and a dialog that allows you to add a comment
appear.
Each comment contains the following information:

• Comment Text - the message text that’s been posted to the
Message Board.

• Delete Link - click this link to delete the comment from the
Message Board.
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• Avatar - an image representing the user who made the
comment.

• Display Name - the display name of the user who made the
comment.

• Date/Time - The post date and time of the comment.
Add a Comment to Your Message Board in the Workarea
To add a comment to your Message Board in the Workarea, follow
these steps.

1. In the Workarea, click My Workspace > Message Board.
2. In the text box, enter a comment.
3. Click the Add Comment button.
4. The comment appears in the list of comments.

Delete Comments on Your Message Board in the Workarea
To delete a comment on your Message Board in the Workarea,
follow these steps:
1. Click My Workspace > Message Board.
2. Click the Delete link next to comment you want to remove.
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3. A dialog box asks if you are sure you want to delete the
comment.
4. Click OK.
5. The comment is removed from the list.

Colleagues
You can associate yourself with other people in the community by
adding them as colleagues. This allows you to create a network of
colleagues and share information with them. Once a colleague is
added, you can visit their profile page and see all their details
including their colleagues. You can then search through their
colleagues list to find people you know and add them to your own
colleagues list. Thus, growing your social network and facilitating
additional information sharing.

• Ektron CMS400.NET users can manage colleagues from the
Workarea or the Web site. Membership users can only manage
colleagues through the Web site.”Managing Existing
Colleagues” on page 401

• ”View Pending Colleagues” on page 410
• ”Viewing Sent Colleague Requests in the Workarea” on
page 411

Colleagues in the Workarea
You can manage your colleagues in the Workarea by clicking the
My Workspace folder button and expanding the Colleagues
items. From this area you can work with:

• Colleagues - your colleagues. See Also: ”Managing Existing
Colleagues” on page 401

• Pending Colleagues - users who have sent you a colleague
request. See Also: ”View Pending Colleagues” on page 410

• Sent Colleagues Requests - colleagues’ requests you’ve sent
that have not been accepted. See Also: ”Viewing Sent
Colleague Requests in the Workarea” on page 411
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Managing Existing Colleagues
To manage existing colleagues in the Workarea, click My
Workspace > Colleagues > Colleagues.
From the Colleagues link, users can:

• view a list of colleagues - see ”Viewing the Existing Colleagues
List” on page 402
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• invite non-site user to join to the site and become a colleague see ”Inviting Non-Site Users to Become Colleagues and Join
the Site” on page 402

• search for users - see ”Searching for Ektron CMS400.NET
Users and Members” on page 403

• send a colleague request - see ”Send a Colleague Request” on
page 408

• remove colleagues - see ”Removing Colleagues” on page 409
• choose whether a colleague is a Selected Colleague. see ”Selected Colleagues” on page 410

Viewing the Existing Colleagues List
The Colleagues list provides a quick and easy way to view your
colleagues in the Workarea. This list contains the following
information.
Field

Description

Avatar

An image representing the user.

Display Name

The user’s display name as it appears in blogs, forums
posts and message board comments.

First Name

The user’s first name.

Last Name

The user’s last name.

Inviting Non-Site Users to Become Colleagues and Join the Site
IMPORTANT!

The default From email address used to send all invitations is
invitation@example.com. Ektron, Inc. strongly recommends that your site
administrator change this address for use with your site. See Also: The Setup
Manual section “Managing the web.config File” > “Settings in the web.config File”
> “ek_InvitationFromEmail”

You can invite people who are not part of CMS400 community to
become your colleagues and members of the site.
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To invite a non-site user to become your colleague, follow these
steps.
1. In the Workarea, navigate to My Workspace > Colleagues.
2. Click on the Colleagues link.
3. Click the Invite button (

).

4. The Invite New Colleagues screen appears.
5. In the Recipient email addresses box, enter emails for the
people you wish to invite. Separate addresses using either
commas, spaces, semicolons or new lines.
6. Enter a message to include with the invite in the Optional
message box.
7. Click the Send Invitations button.
A confirmation appears stating that the invitation was sent. The
person is added to your Sent Colleagues Request. See Also:
”Viewing Sent Colleague Requests in the Workarea” on page 411.

Searching for Ektron CMS400.NET Users and Members
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This Search lets you find users or community groups registered on
the Web site. After seeing the search results, you can add a
colleague or join a community group.
When you hover over a user or community group name link, profile
information appears. How much information appears depends on
your status and the profile settings of the user or group returned in
the results. For an explanation of when additional information
appears, see the Developer Manual section > “Community
Platform server controls” > “CommunitySearch server control” >
“Using Community Search Results” > “When is a User’s Profile
Accessible in Search Results”
The Community Search provides two types of searches:

• Directory - filter users by a letter in the alphabet. A user can
select whether to sort by first or last name. See

• Basic Search - Searches for users and groups on the site. See
”Performing a Basic User Search” on page 405

• Advanced Search - Searches based on individual or multiple
criteria, such as Tags, Display Name or Email. See ”Advanced
User Searching” on page 406
Performing a Directory Search

The Directory tab in a Community Search allows a user to filter the
list of users based on the selection of a letter in the alphabet. For
example, John wants to find all users whose first name begin with
the letter S. John navigates to the CommunitySearch control on his
site, clicks the Directory tab and selects First Name from the Sort
By list. Then, he selects the letter S from list of letters. Next, the
control displays a list of users who name begins with the letter S.
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A Basic search is the easiest to perform and returns the widest
array of results.

A Basic search is based on the following criteria:

• Email
• Display Name
• First Name
• Last Name
• Custom User Properties - these properties define information
about a user beyond the standard Ektron CMS400.NET user
properties. See Also: The Administrator Manual section >
“Custom User Properties”

• Personal Tags - tags are keywords that are associated with a
user or community group in CMS400. See Also: The
Administrator Manual section > “Community Management” >
“Tags”

• Group Name
• Group Description
• Group Tags - tags are keywords that are associated with a
user or community group in CMS400. See Also: The Developer
Manual section > “Community Management” > “Tags”
To use the basic search, enter a name, email, group name or tag
into the text box. Then, click the Search button. Any matches
appear in the results. See Also: ”Using Community Search
Results” on page 408
You can also perform wildcard searches, but the wildcard must
appear after the first letter in the search. For example, you can
search for J*, but not *J. J* returns all users and community
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groups that start with the letter J, or have a word that starts with the
letter J in their email, tags or description.

Advanced User Searching

The Advanced tab lets you filter search results for users and
community groups based on selected criteria. The filters to select
from are the same criteria as a basic search. But with advanced
searching, you select which filters you apply to the search results.
For example, you can select the Tag filter and the Display Name
filter and you will only see results that have Tag and Display Name
information that match the given criteria.
See Also: ”Performing a Basic User Search” on page 405

If you apply several filters, they work in an “and” fashion, where
results must match each filter. For example, if you select the Tags
filter and the Display Name filter, results must match the criteria in
both to appear in the results box. If a user or community group
matches only one filter, it does not appear in the results. Here is a
detailed example:
John is searching for another member named Jane who has
tagged herself as a writer. John decides to add Jane as colleague
and searches for her by selecting the Tags filter and First Name
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filter. In the tags filter, John enters “Writer.” In the First Name filter,
John enters “Jane.” When the search is complete, Jane appears in
the search results. If Jane did not match the criteria in both filters,
she would not show up in the search results.
In addition to the criteria listed in a Basic Search, you can perform
an advanced search based on a taxonomy category. If you do not
see the Category filter in the drop down list, ask your administrator
if your site has a taxonomy for its users. To use categories to find a
user, select Category from the Users filter and place a check mark
in the appropriate User Categories check boxes. Next, click the
search button. Any users assigned to the categories appear.

To search using the Advanced tab, follow these steps.
1. In the Workarea, navigate to My Workspace > Colleagues >
Colleagues.
2. Click the Search button (

).

3. Click the Advanced Search tab.
4. Select the criteria by which to filter the search results.
5. Click Add Filter to add additional filters.
6. Enter text in one of the text boxes.
7. Click the Search button.
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Using Community Search Results

After you click the Search button, all users and groups who match
the search term appear. This list shows an avatar, display name,
and status for each user or group.

The Status column indicates whether the user is already a
colleague or if you can add them as a colleague. It also lets you
join a Community Group if you are not already a member.
Click the Add as Colleague link to send the colleague request, or
the Join this Group link to join the community group.

Send a Colleague Request
To send a colleague request to another user in the Workarea,
follow these steps.
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1. Search for a user as described in ”Searching for Ektron
CMS400.NET Users and Members” on page 403.
2. Click the Add as Colleagues link.
3. A colleague request is sent to the user.
4. You are added to Pending Colleagues list of the user to whom
the request was sent. See Also: ”View Pending Colleagues” on
page 410.
Until the user accepts the colleague request, he appears on
your Sent Colleagues Request List. See Also: ”Viewing Sent
Colleague Requests in the Workarea” on page 411.
5. Once a user accepts the colleague request, he is added to your
colleagues list, and you are added to his Colleagues list.

Removing Colleagues
If you would like to end your association with another user, you can
remove the colleague. To do that in the Workarea, follow these
steps.
1. Navigate to My Workspace > Colleagues > Colleagues.
2. Click in the check box to the far left of each colleague you want
to remove. Selecting the check box in the title row selects all
colleagues.

3. Click the Remove button (

).

4. A dialog box asks you to confirm that the colleague is to be
removed.
5. Click OK.
The page refreshes, and the user is removed from your colleagues
list.
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Selected Colleagues
You can designate any user as a Selected Colleague. This means
he can view documents in your favorites that regular colleagues
cannot view.
To make someone a Selected Colleague, follow these steps.
1. Navigate to My Workspace > Colleagues > Colleagues.
2. Place a check mark next to any user you want to make
Selected.

3. Click the Update Selected Colleagues button (

).

View Pending Colleagues
Pending Colleagues are users that have sent you a colleague
request which you haven’t accepted yet. To view pending
colleagues in the Workarea, navigate to My Workspace >
Colleagues > Pending Colleagues. From this area, you can
accept and decline colleague requests. See ”Accepting a Pending
Colleague Request” on page 410 and ”Declining a Pending
Colleagues Request” on page 411

Accepting a Pending Colleague Request
Accepting a colleagues request adds the user to your colleagues
list. This allows you to access additional information on their profile
page. To accept a pending colleague request, follow these steps.
1. Navigate to My Workspace > Colleagues > Pending
Colleagues.
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2. Place a check mark in the check box next to each colleague
whose request you want to accept.
3. Click the Approve New Colleague button (

).

The page refreshes and the users are removed from the Pending
Colleagues list and added to the Colleagues list. See Also:
”Viewing the Existing Colleagues List” on page 402

Declining a Pending Colleagues Request
Declining a colleague request allows you cancel another users
colleague request. Once you decline the request, it is removed
from your Pending Colleagues list and the requester’s Sent
Colleagues Request list. See Also: ”View Pending Colleagues” on
page 410 and ”Viewing Sent Colleague Requests in the Workarea”
on page 411. To decline a colleague request, follow these steps.
1. Navigate to My Workspace > Colleagues > Pending
Colleagues.
2. Place a check mark in the check box next to each colleague
whose request you want to decline.
3. Click the Decline New Colleagues button (

).

4. A dialog box appears asking you to confirm that you are
declining the colleague.
5. Click OK.
The page refreshes and the users are removed from the Pending
Colleagues list and requester’s Sent Colleagues Request list.

Viewing Sent Colleague Requests in the Workarea
The Sent Colleague Requests list allows you to view a list of users
to whom you’ve sent colleague requests. From this screen, you
can also delete requests that have yet to be accepted. See Also:
”Canceling a Colleague Request” on page 412
If a request goes stale and has not been acted upon the by the
recipient, you can resend the invite and add another optional
message. See ”Resending an Invitation” on page 412
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To view sent colleague requests, navigate to My Workspace >
Colleagues > Sent Colleague Requests.

Canceling a Colleague Request
If you want to cancel a colleague request, follow these steps.
1. Navigate to My Workspace > Colleagues > Sent Colleague
Requests.
2. Place a check mark in the checkbox next to each colleague
whose request you want to cancel.
3. Click the Cancel Colleague Requests button (

).

4. A dialog box appears asking you to confirm that you are
canceling the colleague requests.
5. Click OK.

Resending an Invitation
To resend an invitation, follow these steps.
1. Navigate to My Workspace > Colleagues > Sent Colleague
Requests.
2. If necessary, add a message to the Optional Message box.
3. Place a check mark in the boxes next to the users that you
want to re-send an invitation.
4. Click the Resend Invitation button.
The pages refreshes and returns to the My Sent Invites screen.

Community Groups
Another aspect of a community site is the concept of Community
Groups. Being a part of a group allows you meet people with a
similar interest, for example, car racing.
You can access your community group information in My
Workspace > Community Groups. This area allows you to:
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• view community groups to which you belong - see ”Viewing
Your Community Groups” on page 413.

• remove yourself from a community group - see ”Remove
Yourself from a Community Group” on page 413.

• view the different community groups to which you have asked
to join, but have yet to be accepted - see ”Working with
Pending Community Groups” on page 414.

• view and accept invitations for any groups you have been
invited to join - see ”Working with Community Group Invites” on
page 414

Viewing Your Community Groups
You can see a list of community groups you belong to by
navigating to My Workspace > Community Groups > My Groups
in the Workarea. From this area, you can remove yourself from a
community group.

Remove Yourself from a Community Group
To remove yourself from a community group in the Workarea,
follow these steps:
1. In the Workarea, navigate to My Workspace > Community
Groups > My Groups.
2. Place a check in the box next to the group from which you want
to be removed. To remove yourself from all groups, place a
check in the Select All box.
IMPORTANT!

If you are the leader of a community group, a check box does not appear next the
title of the group. You cannot remove yourself from community groups which you
lead. You must either select a new leader for the community group and then
remove yourself or remove the community group from the system. For the steps
to select a new leader, see the Administrator Manual section “Community Groups”
> “Community Groups in the Workarea” > “Managing Community Groups” > “Edit
a Community Group’s Information”

3. Click the Leave Group button (

).

The screen refreshes and the group is removed.
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Working with Pending Community Groups
Pending Groups show a list of groups which you have asked to
join, but have yet to be accepted. To view this list, navigate to the
Workarea > My Workspace > Community Groups > Pending
Groups.

Deleting a Pending Community Group
If a community group has not accepted your request to join, you
might want to delete the request. Follow these steps to delete a
pending community group request.
1. In the Workarea, navigate to My Workspace > Community
Groups > Pending Groups.
2. Place a check mark in the check box next to a community
group.
3. Click the Cancel Request button (

).

4. A dialog box appears asking you to confirm the cancellation of
the pending request.
5. Click OK.
The page refreshes and the pending community group is removed
from the list.

Working with Community Group Invites
Members of a community group can invite people to join the group.
The Workarea allows you to view, accept and decline pending
group invites. To view pending community group invites, navigate
to the Workarea > My Workspace > Community Groups >
Group Invites.

Accepting a Community Group Invite
To accept an invitation to a community group, follow these steps.
1. In the Workarea, navigate to My Workspace > Community
Groups > Group Invites.
2. Place a check mark in the check box next to a community
group.
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3. Click the Accept Community Group Invite button (

).

4. A dialog box appears asking you to confirm that you are
accepting the invitation.
5. Click OK.
The page refreshes and community group is removed from the
Group Invites page and now appears in My Groups. See Also:
”Viewing Your Community Groups” on page 413.

Declining a Community Group Invite
To decline an invitation to a community group, follow these steps.
1. In the Workarea, navigate to My Workspace > Community
Groups > Group Invites.
2. Place a check mark in the check box next to a community
group.
3. Click the Decline Invitation button (

).

4. A dialog box appears asking you to confirm that you are
declining the invitation.
5. Click OK.
The page refreshes and community group is removed from the
Group Invites page.

Favorites
The Favorites area in My Workspace allows you to manage
content you have designated as your favorite content. From this
area you can:

• Add a Folder - see ”Adding a Favorites Folder” on page 416.
• Remove Favorites - see ”Remove Favorites” on page 416.
• Move a favorite from one folder to another. ”Moving Favorites
to a Folder” on page 416
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Adding a Favorites Folder
To add a favorites folder, follow these steps.
1. In the Workarea, navigate to My Workspace > Favorites.
2. Click the Add Folder button (

).

3. Enter a Name and Description for the folder in the provided text
boxes.
4. Click the Add link to add the folder.
The folder appears in the list of Favorites.

Remove Favorites
To remove a favorite, follow these steps.
1. In the Workarea, navigate to My Workspace > Favorites.
2. Place a check in the box next to the content you wish to
remove.
3. Click the Remove button (

).

Moving Favorites to a Folder
Moving favorite content to a folder allows you to group you
favorites by a common theme. For example, you might group all
content created by a certain author under a folder with that
author’s name.
To move a Favorite to a folder, follow these steps.
1. In the Workarea, navigate to My Workspace > Favorites.
2. Mark a favorite item(s) to be moved.
3. Click the Move button (

).

4. Select the folder where the content will be moved.
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5. Click OK to move the favorites to the new folder.
6. The page refreshes and the content can now be found in the
new folder.

Photos
The Photos area of My Workspace allows you to add images to
CMS400 and associate them with your profile. You can create
subfolders to separate images by category.
Images in the Photos area are separate from the Content folder
structure and its files. Images in this list have the same properties
and actions available to those found in the Content folder structure.
For example, you view, edit, delete and copy Photos.
From the Photos area, you can:

• add a folder - see ”Adding Folders to My Workspace >>
Photos” on page 418

• edit a folder’s name - see ”Edit a Folder Name in My
Workspace >> Photos” on page 418

• delete a folder - see ”Deleting a Folder in My Workspace >>
Photos” on page 419

• drag and drop an asset - see ”Adding Assets to My Workspace
>> Photos” on page 420

• move a content item to another folder - see ”Moving and
Copying Content in My Workspace >> Photos” on page 422
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• select whether to share the folder with the Public, Colleagues,
Selected Colleagues or keep the folder private. - see ”Sharing
Content in My Workspace >> Photos” on page 422
Photos can be displayed on the site when a developer adds the
PhotoGallery server control to a Community Web site. For
additional information on the PhotoGallery server control, see the
Developer Manual section “Introduction to Ektron CMS400.NET
Server Controls” > “Community Platform Server Controls” >
“PhotoGallery Server Control.”

Adding Folders to My Workspace >> Photos
You can add subfolders in the Photos area to help you sort images
into categories. The subfolders represent a taxonomy of the items
contained in the Photos area. To add subfolders, follow these
steps.
1. In the Workarea, navigate to My Workspace > Photos.
2. Click the Manage Folder Button (

).

3. The Add Folder box appears.

4. Enter a Name for the folder.
5. Click the Add button (

).

6. When the page refreshes, it opens to the newly added folder.

Edit a Folder Name in My Workspace >> Photos
Sometimes it becomes necessary to change the name of folder in
the My Workspace >> Photos area. To accomplish this, follow
these steps.
1. In the Workarea, navigate to My Workspace >> Photos.
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2. Click the folder’s Edit button (
left of the folder’s title.

). This button is located to the

3. The Edit Folder box appears.

4. Change the name of the folder.
5. Click the Save button (

).

6. When the page refreshes, it opens to the folder with changed
name.

Deleting a Folder in My Workspace >> Photos
You can delete obsolete folders from My Workspace >> Photos. To
delete a folder, follow these steps.
NOTE
CAUTION!

You can not delete the top-level folder, albums.
Deleting a folder permanently deletes all images, as well as its subfolders.

1. In the Workarea, navigate to My Workspace >> Photos.
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2. Click the folder’s Edit button (
left of the folder’s title.

). This button is located to the

3. The Edit Folder box appears.

4. Click the Delete button (

).

5. A dialog box appears asking you to confirm deleting the folder.
6. Click OK.
7. The page refreshes and the folder is removed.

Adding Assets to My Workspace >> Photos
To add an image to My Workspace >> Photos, follow these steps.
1. In the Workarea, navigate to My Workspace >> Photos.
2. Select a folder where the image will be added. If you want to
create a new folder, see ”Adding Folders to My Workspace >>
Photos” on page 418
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3. Click the Add Image button (

).

4. The Add Asset Photo Data box appears.

5. Fill in the description of the image (optional).
6. Select a Maximum Width. Choices are: 250, 800, 1000, 1400
or 1600 pixels.
7. Enter a map address associated with image. For example, 542
Amherst Street, Nashua, NH 03036.
8. Click Next.
9. The Drag and drop upload box appears.

10. Drag and drop an image in the box.
11. A status box appears and shows the file being uploaded.
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12. Once the upload is complete, the page refreshes and the asset
appears in the file list.

Moving and Copying Content in My Workspace >> Photos
You can change the folder where images are stored in My
Workspace >> Photos by moving the content from one folder to
another. In addition to moving images, you can copy them to
another folder. To accomplish either of these actions, follow these
steps.
1. In the Workarea, navigate to My Workspace >> Photos.
2. Select the folder from which to move or copy the images.
3. Click the drop down triangle to the right of the image title.
4. From the drop down list, select Copy to Buffer.
5. Select the folder to which the content will be moved.
6. Click the Manage link.
7. Click the Move Items (

) or Copy button (

).

8. A dialog box appears asking you to confirm the move or copy
action.
9. Click OK.
10. The page refreshes and the moved or copied image appears in
the new folder.

Sharing Content in My Workspace >> Photos
The Photos area of My Workspace allows you to add and remove
images you want share with your colleagues. You can share
content with the Public, Colleagues, Selected Colleagues or keep
the content private. You apply sharing options to folders not to
individual content. To share a folder, follow these steps.
1. In the Workarea, navigate to My Workspace >> Photos.
2. Click the Manage Folder Button (

).

3. The Add Folder box appears.
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4. Click the Share Folder button (

).

5. The Share Workspace box appears.

6. Select with whom to share your folders. The table below
describes each option.

Viewer Type

Description

Public

All people viewing your profile page can view your photos.

Colleagues

Only people who are your colleagues can view your
photos. See Also: ”Colleagues” on page 400.

Selected Colleagues

Only colleagues who are marked as selected colleagues
can view your photos.

Private

You are the only one who can view your photos.

7. Click the Share button (

).

Images in the folder are now available for viewing by the selected
viewer type.
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Working with Collections

A collection is a list of content links offered to the readers of a Web
page. The following illustration shows a collection on a Web page.

You can also use a collection to display listings such as job
postings, press releases, and knowledge base articles. The
following graphic illustrates a collection on the landing page of
Ektron’s Knowledge Base.

This section explains how to create collections. Your system
administrator then creates or updates a Web page to display the
collections using the Collection server control or ecmCollection
function.
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NOTE

Your system administrator must assign to you permission to work with collections.
For details, see the Collections chapter of the Ektron CMS400.NET Administrator
Manual .

This section explains how to find, create, and manage collections
through the following subtopics.

• ”Finding Collections” on page 425
• ”Viewing a Collection” on page 428
• ”Creating a Collection” on page 430
• ”Editing Content in a Collection” on page 438
• ”Reordering Collections List” on page 439
• ”Editing Collection Information” on page 439
• ”Deleting a Collection” on page 440
• ”Working with Collections in a Multi-Language System” on
page 440

• ”Comparison of Collections, Menus, Taxonomy, and the List
Summary Features” on page 442

Finding Collections
Every collection is assigned to a folder. To find the collections
assigned to any folder, navigate to it and click the Collection button
( ). For more information, see ”Finding a Collection by
Navigating to its Content Folder” on page 425.
Since collections can be assigned to any content folder, the
Modules folder provides a central Collections folder, which displays
all collections, regardless of their content folder. For more
information, see ”Finding a Collection Using the Collections Folder”
on page 426.

Finding a Collection by Navigating to its Content Folder
To access collections for a content folder, follow these steps.
1. Click the content folder that contains the collection.
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2. If you are using Ektron CMS400.NET’s multi-language support
features, select the language by clicking View > Language.
See Also: ”Working with Collections in a Multi-Language
System” on page 440
3. Click View > Collection.
4. The View Collections screen appears.

The screen displays each collection created for the folder. The
following table explains each column.
Column

Description

Title

The title assigned to the collection by the creator.

ID

The ID assigned to the collection by Ektron
CMS400.NET. This number is used to store and retrieve
the data to/from the database.

Date
Modified

When the collection was last edited.

URL

The default template used to display the content.

To learn more about a collection and perform tasks on it, proceed
to ”Viewing a Collection” on page 428.

Finding a Collection Using the Collections Folder
To view all collections in all content folders, follow these steps.
1. From the Workarea, click Modules > Collections.
2. The Collections Report screen appears.
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NOTE

The ek_PageSize setting in the web.config file determines the maximum number
of collections that appear on a page before it “breaks.” When a page breaks,
additional collections appear on another screen, and the following appears at the
bottom of the list:
Page 1 of 2
[First Page] [Previous Page] [Next Page] [Last Page]

NOTE

If you have a large number of collections, use the Search box to help find one.

3. The screen has four columns, described below.
Column Title

Description

Title

Title given to collection by user who created, or last edited, it.

ID

ID number assigned by Ektron CMS400.NET. (Developers use this number to
reference the collection in ecmCollection custom function.)

Description

Description given to collection by user who created, or last edited, it.

Path

Folder location of the collection.

You can click any collection to view information about it and
perform tasks on it. See ”Viewing a Collection” on page 428.
You can also add a new collection. See ”Creating a Collection” on
page 430.
And, if you have a large number of collections, you can use the
Search box to help find collections of interest.
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Viewing a Collection
To view a collection, follow these steps.
1. Select a collection using the procedure described in ”Finding a
Collection by Navigating to its Content Folder” on page 425 or
”Finding a Collection Using the Collections Folder” on
page 426.
2. The View Collection screen appears.
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The screen displays each item in the collection. To learn more
about a collection, click More Info. When you do, the lower section
of the screen displays the following information about the
collection.

• title
• description
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• ID number
• template
• last user who edited it
• last date when it was edited
• date it was created
• whether or not the content folder’s subfolders can be included
• for each content item in the collection
- a link to the content (click this to view and edit the content)
- ID number
- quicklink

Collections Toolbar
The following table describes the collection toolbar buttons.
Button

Name

Description

More Information

Add

Add new collection or add items to a
collection.

”Creating a Collection”
on page 430

Remove

Remove items from a collection.

”Removing Content from
the Collection” on
page 438

Reorder

Reorder items in a collection.

”Reordering Collections
List” on page 439

Edit

Edit collection information.

”Editing Collection
Information” on page 439

Delete

Delete a collection.

”Deleting a Collection” on
page 440

Back

Return to previous screen.

Creating a Collection
Creating a collection involves two steps:
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• ”Adding a Collection” on page 431
• ”Assigning Content to the Collection” on page 434
The following sections explain each step.
Note

This section explains creating a collection in a site that does not support multiple
languages. If you want to create collections in several languages, see ”Working
with Collections in a Multi-Language System” on page 440.

See Also: ”Working with Collections” on page 424

Adding a Collection
To add a new collection, follow these steps.
1. Navigate to the content folder in which you want to create the
collection.
2. If you are using Ektron CMS400.NET’s multi-language support
features, select the language. See Also: ”Working with
Collections in a Multi-Language System” on page 440
3. Click New > Collection.
NOTE

If you access the collection via the Collections folder, you cannot choose the
collection’s folder. It is automatically placed in the root folder.

4. The Add Collection screen appears.

5. Complete the screen using the following table.
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Field

Description

Title

Assign a unique title to the collection.

Template

Enter the default template for the collection. This template is used to
display the content of the links generated if no template is assigned in the
custom function.
If left blank, the links use their respective Quicklinks.
See Also: ”Default Template vs. Quicklinks” on page 432

Description

Add a more detailed description for the collection.

Include Subfolders

Check if you want to add to the collection content in subfolders of the
content folder.

Approval is Required

See the Ek tron CM S40 0.NET Administrator Manual section “Web Site
Navigation Aids” > “Collections” > “Setting up Approval for Collections”

6. Click the Save button (

).

You can now assign content to the collection. See ”Assigning
Content to the Collection” on page 434.

Default Template vs. Quicklinks
You can specify a template that determines the screen display for a
collection when it is published on a Web page. (See your system
administrator for information about Ektron CMS400.NET templates.)
Or, you can disable the template and, instead, use Quicklinks to
determine the page template. (See Also: ”Quicklinks and Forms”
on page 153)
If you specify a template, all content in the collection uses the
same screen elements other than the specific content. For
example, the page header, footer and information in the right frame
of the screen are all the same. On the other hand, if you use
Quicklinks, every page in the collection uses its original template.
As a result, the surrounding information may change for every
content item in the collection.
Here is an example of links using Quicklinks. Notice that content
uses several templates. As a result, when a user clicks content in
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the collection, the screen information around the content changes
according to its template.

Here is an example of links when using a template named
index.asp. In this case, all pages have the same information
surrounding the content.

NOTE

If a collection item is a form, ekfrm is used instead of id to denote form block .

To toggle between a default template and Quicklinks, follow these
steps.
1. Access the Edit Collection screen for the collection you want to
edit.
2. Modify the Template field.
3. Click the Save (
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Assigning Content to the Collection
After a collection is created, your next step is to assign content to
it. To do so, follow these steps.
NOTE

When viewing a Collection on the Web site, the last published version of content
appears. If the content has never been published, nothing appears.

1. Access the collections screen for the content folder in which
you want to add the collection, as described in ”Finding a
Collection by Navigating to its Content Folder” on page 425.
2. Access the View Collection Screen, as described in ”Viewing a
Collection” on page 428.
3. Click the collection to which you want to assign content.

4. The View Collection screen appears.
5. Accept or change the language.

6. Click the Add button (

).

7. The Add Items to Collection screen appears, displaying

• all subfolders within the selected folder (Subfolders are
available if the Include subfolders checkbox was checked for
the collection.)
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• content in the selected folder that is not part of the collection.
Note that the file types selection remembers your most recent
choice and can filter which files appear. You can change the
selection if desired.

8. Check boxes next to content to add to the collection. You can
only add content from the selected folder or its subfolders.
(Subfolders are available if the Include subfolders checkbox
is checked for the collection.)
Click a subfolder to view its content. To return to the parent
folder, click the folder with the up arrow (
NOTE

).

If you select content from a subfolder, click the Add button to add selected content
to the collection. Navigating between subfolders deselects content.

9. Click the Add button (

).

See Also: ”Creating a Collection” on page 430; ”Working with
Collections” on page 424
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Creating New Content for a Collection
You can create new content while adding content links to a
collection. To add content, follow these steps.
1. Access the View Collections screen for the content folder in
which you want to add the collection, as described in ”Finding a
Collection by Navigating to its Content Folder” on page 425.
2. Access the View Collection Screen for a collection, as
described in ”Viewing a Collection” on page 428.
3. If you are using Ektron CMS400.NET’s multi-language support,
select the language of the collection.
4. Click the Add button (

).

5. The Add Items to Collection screen appears.
6. If your collection includes subfolders and you want to add the
content to one of them, navigate to that subfolder. Otherwise,
proceed to the next step.
7. Click the Add Content button (

).

8. The Add Content screen appears. If you are using Ektron
CMS400.NET’s multi-language support, the content’s language
appears next to the title. The language is derived from the
collection’s language and cannot be changed.
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9. Create the content.
NOTE

Refer to ”Adding HTML Content” on page 48 for additional information about
creating new content.

10. Click a workflow option in the Add Content screen.
11. The Add Content screen closes, and the new content link
appears in the list of links available to the collection.
12. Check off the content you created and other content.

13. Click the Add button (
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Editing Content in a Collection
After a collection is created, you can add or remove links to and
from it.

Adding Content to the Collection
For information about adding content links to a collection, see
”Assigning Content to the Collection” on page 434.

Removing Content from the Collection
To remove a content link from a collection, follow these steps.
1. Access the collections screen for the content folder in which
you want to add the collection, as described in ”Finding a
Collection by Navigating to its Content Folder” on page 425.
2. Access the View Collection Screen, as described in ”Viewing a
Collection” on page 428.
3. Click the Remove button (

).

4. The Delete Items from Collection screen appears.
5. Check boxes next to links that you want to delete.

Click Select All to select all boxes.
Click Clear All to remove all check marks.
6. Click the Delete button (
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Reordering Collections List
After a collection is created, and more than one content item is
assigned to it, you can reorder the collections list. To do so, follow
these steps.
1. Access the collections screen for the content folder in which
you want to add the collection, as described in ”Finding a
Collection by Navigating to its Content Folder” on page 425.
2. Access the View Collection Screen, as described in ”Viewing a
Collection” on page 428.
3. Click the Reorder button (

).

4. The Reorder Collection screen appears.

5. Click the content whose order you want to change.
6. Click the up or down arrow to move the content in either
direction.
7. Repeat steps five and six until you set the desired order.
8. Click the Update button (

).

Editing Collection Information
To edit information about a collection, follow these steps.
1. Access the collections screen for the content folder in which
you want to add the collection, as described in ”Finding a
Collection by Navigating to its Content Folder” on page 425.
2. Access the View Collection Screen, as described in ”Viewing a
Collection” on page 428.
3. Click the collection whose information you want to change.
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4. Change any of the field values. For documentation of the fields,
see ”Complete the screen using the following table.” on
page 431.

Deleting a Collection
When you no longer want a collection, you can delete it. To delete
a collection, follow these steps.
1. Access the collections screen for the content folder in which
you want to add the collection, as described in ”Finding a
Collection by Navigating to its Content Folder” on page 425.
2. Access the View Collection Screen, as described in ”Viewing a
Collection” on page 428.
3. Click the Delete button (

).

4. A confirmation message appears.
5. Click OK to proceed.

Working with Collections in a Multi-Language
System
In a multi-language Ektron CMS400.NET system, you can create a
language-specific edition of each collection. For example, prior to
the 4.7 Release, the RC International sample site’s products page
had a collection in the default application language (English unless
you change it). From 4.7 on, you can create an edition of a
collection in every enabled language.
When a visitor to your site selects a language then navigates to a
page with a collection, Ektron CMS400.NET displays the collection
in the selected language if available. If not, Ektron CMS400.NET
displays nothing.
NOTE

Note the contrast between the collections and content: if a collection is not
available in the selected language, nothing appears. But if content is not available
in the selected language, content in the default language appears.

When creating a collection for a foreign language, decide if you
want to create
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• a foreign edition of an existing collection, or
• a new collection in a foreign language
For example, if you want to provide several versions of a single
page that change depending on the language selected by the user,
see ”Creating a Language-Specific Collection if Another Edition
Exists” on page 441.
On the other hand, if you are creating a collection to appear only
on a foreign language page, and no other edition of the collection
will appear on your site, see ”Creating a Language-Specific
Collection if Another Edition Does Not Exist” on page 441.
You can only add content in the language of a collection. So,
create the content first, then create the collection that links to them.

Creating a Language-Specific Collection if Another Edition
Exists
1. Click the content folder in which your collection exists. The
folder’s contents are displayed.
2. Click View > Collection.
3. The View Collections screen is displayed.
4. Select the collection that you want to translate.
5. From the Add drop-down list, select the language of the new
collection.
6. Using the Add button ( ), select the content to add to the
collection. Navigate through the folders to the content you want
to add. You can only add content in the selected language.

Creating a Language-Specific Collection if Another Edition
Does Not Exist
1. Navigate to the folder in which you will create the collection.
2. Click View > Collections. The View Collections screen is
displayed.
3. Click the Add button ( ) and enter basic information about
the collection. (This screen is described in ”Creating a
Collection” on page 430.)
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4. The View Collections in Folder screen appears. Click the
collection you just created.
5. From the Add drop-down list, select the language of the new
collection.
6. Using the Add button ( ), select the content to add to the
collection. Navigate through the folders to the content you want
to add. You can only add content in the selected language.

Comparison of Collections, Menus, Taxonomy, and
the List Summary Features
A menu, a collection, a taxonomy, and the ListSummary function
are similar in that they let you add a list of links to a Web page. The
following table compares these features to help you understand
which one is best suited to your needs.
NOTE

To implement these features, the assistance of a developer is required.

Collection

Display all content in a folder.
As folder’s content changes,
display changes.

Menu

List
Summary

Taxonomy

X

X

X

(folder items
appear on a
menu)

X

Can display all content in a
folder’s subfolders
Display selected content

X

X

X

Display external hyperlinks &
library assets
Display content summary
(optional)

X

X
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Collection

Display additional content
information:

•
•
•
•
•
•
•

Menu

List
Summary

Taxonomy

X

comment
last modified date
start date
end date
user who last edited it
ID number
path relative to your site’s
root

X

Can be multi-leveled
Main purpose is navigation

X

Main purpose is classification

X

X
X
X

For a detailed guide to Ektron CMS400.NET navigation, see the
“Best Practice – Navigation for your Web site pamphlet,” available
from http://dev.ektron.com/uploadedFiles/Resources/
navigation%20best%20practice.pdf.
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Working with Menus

Ektron CMS400.NET’s Menu feature lets users create and maintain

a dropdown menu system for your Web site. The menu options can
link to content, library assets, external hyperlinks, and submenus.
Below is a sample menu.

In this example (delivered with Ektron CMS400.NET), the menu
appears when a site visitor moves the cursor over About Us on
the home page.
However, if a content contributor with permission to edit menus
signs in to Ektron CMS400.NET then views the menu, it has
additional options for editing the menu or adding content.
IMPORTANT!

If you chooses to hide the border that appears around content when you are
logged in, the Add and Edit options are also hidden. This allows you to view the
page as it appears when you are not logged in. See Also: ”Hiding and Showing
the Content Border” on page 5. If the page is set to show borders and you still do
not see the Add and Edit buttons, the feature may be turned off. Ask your
Administrator or Web site Developer for additional information.
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NOTE

For more information on adding content, see ”Adding HTML Content” on page 48.
To learn more about Menu permissions, see the Ektron CMS400.NET
Administrator Manual section “Web Site Navigation Aids” > “Menu Feature.”

This chapter describes the following aspects of managing menus:

• what they are
• how they can be used
• how to the add, edit, view and delete them

What’s In This Chapter
The following topics explain Menus.

• ”The Structure of Menus and Menu Items” on page 446
• ”Access to the Menus Feature” on page 446
• ”Adding a New Menu” on page 448
• ”Adding a Menu Item” on page 453
• ”Editing a Menu” on page 462
• ”Editing a Menu Item” on page 464
• ”Viewing a Menu” on page 467
• ”Reordering Menu Items” on page 470
• ”Deleting a Menu” on page 471
• ”Deleting a Menu Item” on page 472
• ”Working with Menus in a Multi-Language System” on
page 473
Ektron CMS400.NET Administrator Manual sections
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• Menu Feature > Permission to Use the Menus Feature
• Menu Feature > Implementation of the Menus Feature

The Structure of Menus and Menu Items
Menus have the following structure:

• menu - top level structure that is a placeholder for menu items
and submenus. It is assigned to a content folder.
A menu identifies a page template used to display menu
options that are content.

• menu item - the individual options on a menu; can be any of
the following

- content of any type
- library asset
- external hyperlink (link to a page outside your Web site)
- submenu (a link to another menu. In the illustration below,
the menu on the right is a submenu. It appears when the
user hovers the cursor over Company Profile. The right
arrow indicates a submenu is available.)

Access to the Menus Feature
There are three ways to access the Menus feature:

• the Workarea, by choosing the associated content folder then
clicking View > Menus
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• the Workarea, by choosing Modules > Menus
• the Edit Menu option on the sample menu displayed above
If you choose the first or second option, you select a specific menu.
Then, it appears on the View Menu screen. For the third option, the
selected menu appears on the View Menu screen.
From the View Menu screen, you can perform the following actions
on a menu.

• Create a new menu
• Edit its information (for example, the URL and template link)
• Translate it
• Delete it
• Add or remove items
• Change the sequence of menu items
• Edit menu items
• For submenus
- add /remove items
- change sequence of menu items
- edit menu information
- edit menu items

Managing Menus
Ektron CMS400.NET gives you the flexibility to add, edit, view and
delete a menu. The following sections explain how to do that.

• ”Adding a New Menu” on page 448
• ”Adding a Menu Item” on page 453
• ”Adding New Content to a Menu via Navigation Link on a Web
Page” on page 461

• ”Editing a Menu” on page 462
• ”Editing a Menu Item” on page 464
• ”Viewing a Menu” on page 467
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• ”Reordering Menu Items” on page 470
• ”Deleting a Menu” on page 471
• ”Deleting a Menu Item” on page 472
• ”Working with Menus in a Multi-Language System” on
page 473

Adding a New Menu
You can create a menu by navigating to a folder or by choosing
Modules > Menus from the left frame of the Workarea. If you
choose Modules > Menus, you cannot select the menu’s folder -it is automatically assigned to the root folder. In contrast, if you
create a menu after choosing a content folder, it is assigned to the
selected folder.

Adding a Menu via Content Folder
1. Navigate to a content folder.
2. The current language appears as a flag next to the screen title.
To create the menu in this language, proceed to the next step.
To change the language of the new menu, click View >
Language and select the new language.
3. Click New > Menu.
4. The Add Menu screen appears.

5. At minimum, a menu requires a title. If you want to add more
information, click Advance Settings. When you do, the lower
section of the screen appears as shown below.
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6. Using the following table, complete the fields on the Add Menu
screen.

Fields on the Add/Edit Menu Screen

Field

Description

Title

The name given to the menu by the creator. It appears on the Web page to indicate the
kind of information on the menu.
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Field

Description

Image Link

You can have an image appear next to or instead of the menu title. For example:

To do this, follow these steps.
Note: Before beginning these steps, the image must reside in the library. if it does not,
add it before proceeding. For more information, see ”Copying Files to the Library” on
page 141.
1.

Click the image icon (

).

2.

The library window opens.

3.

Navigate to the folder that contains the image you want to use.

4.

Click the Insert button (

) to insert it.

Using Image to Replace Title Text
Alternatively, you can have the image replace the menu text, so that only the image
appears to indicate the kind of information on the menu. To do this, check the Use
image instead of a title checkbox.
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Field

Description

URL Link

After you create a menu, your developer links it to text or an image on a Web page by
modifying a page template. When a site visitor reading that Web page moves the
cursor over the text or image, the menu appears. In the illustration below, the menu
appears when the site visitor moves the cursor over Products.

You can also assign a URL link to a menu, using this field. If you do, and the user clicks
the link text or image, he jumps to the specified page.
For example, in this field you assign the product landing page, siteroot/
products.aspx. In the illustration above, if the user moves the cursor over Products,
the assigned menu appears. However, if the user clicks Products (as indicated by the
hand), he jumps to siteroot/products.aspx.
Entering the Path to the Landing Page
This path is relative to the site root. For example: siteroot/jobs.aspx
This URL path can be a static template path (like the one mentioned above) or a
dynamic path, such as
wellness.aspx?id=40&wellness=Hemophilia
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Field
Template Link

Description
Note: This field applies to content only. It has no effect on other types of menu items
(such as images). Also, this field only affects content that dynamically references a
content block, such as /CMS400Min/therapies.aspx?id=84. If the menu option is a
template that includes content (for example, /CMS400Min/news.aspx), the template
you identify here is ignored.
If you want to apply a template to this menu, enter the template here. If you do, all
content on this menu uses this template when selected from the menu.
If you do not enter a template here, content on this menu uses the template specified in
its Quicklink.
Overriding the Template Link
You can override the menu template for any content item on this menu and, instead,
use the template specified in its Quicklink. To do so, follow these steps.
1.

Add all items to the menu. (See ”Adding a Menu Item” on page 453)

2.

Go to the View Menus option.

3.

Click More Info.

4.

Click the menu item you want to change.

5.

At the Link field, change the value from Menu Template to Quicklink.

Important! If you created menus prior to upgrading to this version of E k tro n
C M S 4 0 0 . N E T , those menu items are assigned as Quicklinks. You cannot change
them to template links simply by entering a template link here. Instead, you must go to
each menu item and change the Link field value from QuickLink to Menu Template
(as illustrated above).
Description

Add a more detailed description for the menu.

Folder
Associations

Seethe E k t r o n C M S 4 0 0 . N E T Administrator Manual section “Menu Feature“ >
“Implementation of the Menus Feature“> “Effect of Assigning a Folder to a Menu”

Template
Associations

Seethe E k t r o n C M S 4 0 0 . N E T Administrator Manual section “Menu Feature“ >
“Implementation of the Menus Feature“> “Effect of Assigning a Template to a Menu”

6. Click the Save button (

).

With the menu added, you may assign menu items to it. See
”Adding a Menu Item” on page 453.
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Adding a Menu via the Menus Module
1. From the left frame of the Workarea, click Modules > Menus.
2. Click the Add Menu button (

).

3. The Add Menu screen appears.

4. To complete the fields on the Add Menu screen, see ”Fields on
the Add/Edit Menu Screen” on page 449.
With the menu added, you may assign menu items to it. See
”Adding a Menu Item” on page 453.

Adding a Menu Item
Similar to being able to add, edit, view or delete a menu, Ektron
CMS400.NET also allows you to add, edit, view and delete a menu
items. See Also: ”The Structure of Menus and Menu Items” on
page 446

Adding a Menu Item via Content Folder
To add a menu item via a content folder, follow these steps.
1. Navigate to the content folder that contains the menu to which
you want to add items.
2. Click View > Menus.
3. Click the menu that you want to add items to.
4. In the View Language dropdown list, select the language of the
menu. See Also: ”Working with Menus in a Multi-Language
System” on page 473
5. The View Menu screen opens, displaying the items already on
the menu. Submenus look like a folder with a plus sign to the
left (
).
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6. To add a new item to the selected menu or any submenus on it,
move the cursor over the menu item and click Add from the
popup menu.

NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

7. The Add New Item screen appears. Use the table below to
select a type of menu item and follow the steps to add it.

Assign this type of content to
the menu

For details, see

Content

”Adding Content as a Menu Item” on
page 456

Any library asset: images, files,
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu
Item” on page 458

External hyperlink

”Adding an External Hyperlink as a
Menu Item” on page 458

Submenu to the main menu

”Adding a Submenu as a Menu Item”
on page 459

Adding a Menu Item via Menus Module
To add a menu item via the Menus module, follow these steps.
1. From the left frame of the Workarea, click Modules > Menus.
2. Click the menu that you want to add a menu item to.
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3. In the View Language dropdown list, select the language of the
menu.
4. To add a new item to the selected menu or any submenus on it,
move the cursor over the menu item and click Add from the
popup menu.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

5. The Add New Item screen displays a list of items that you can
add to the menu. Use to the table below to select the type of
menu item and follow the steps to add it.
Menu item type

For more information, see

Content

”Adding Content as a Menu Item” on
page 456

Any library assets: images, files,
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu Item”
on page 458

External hyperlinks

”Adding an External Hyperlink as a Menu
Item” on page 458

Submenu to the main menu

”Adding a Submenu as a Menu Item” on
page 459

Adding a Menu Item via Navigation Link on a Web Page
1. Log in.
2. Access the Web page that contains the link to display the
menu.
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3. Place the cursor on the hyperlink that causes the menu to
appear.
4. The menu appears.

5. Click Add.
6. The Add Menu screen displays a list of items you can add to
the menu.
7. Use the table below to select the type of menu item and follow
the steps to add that menu item.

Assign this type of content to
the menu

For details, see

Content

”Adding Content as a Menu Item” on
page 456

Any library assets: images, files,
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu
Item” on page 458

External hyperlinks

”Adding an External Hyperlink as a
Menu Item” on page 458

Submenu to the main menu

”Adding a Submenu as a Menu Item”
on page 459

Adding Content as a Menu Item
To add content as a menu item, follow these steps.
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1. Follow the directions in ”Adding a Menu Item via Content
Folder” on page 453, ”Adding a Menu Item via Menus Module”
on page 454, or ”Adding a Menu Item via Navigation Link on a
Web Page” on page 455.
NOTE

You can only add content that resides in the menu’s content folder or its
subfolders.

2. Click the radio button next to Content Block.
3. Click the Next... button.
4. The Add New item screen appears, listing all content in the
folder (and its subfolders) in which you created the menu.
5. By default, all content is available. To limit your selection to a
type of content (for example, Word documents), click the
content types dropdown and select a type.

6. Content items in the selected folder appear below any
subfolders. You can click any subfolder to display its content.
7. Check all content you want to add from any single screen to the
menu.
WARNING!

If you check items on a screen then proceed to another screen before clicking the
Add button, the items on the first screen are not added to the menu.

8. Click the Add button (

).

9. The View Menu screen reappears, showing the new content.
10. To access the Edit Menu Item screen for the new content,
hover the cursor over the item, then click Edit from the popup
menu.
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NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

11. The Edit Menu Item screen lets you assign additional
information to the menu item, such as the target window. See
”Fields on the Add/Edit Menu Screen” on page 449.
12. Continue to add new items to the menu as needed.

Adding a Library Asset as a Menu Item
To add a library asset as a menu item via a content folder or menus
module, follow these steps.
1. Follow the directions in ”Adding a Menu Item via Content
Folder” on page 453, ”Adding a Menu Item via Menus Module”
on page 454, or ”Adding a Menu Item via Navigation Link on a
Web Page” on page 455.
2. Click the radio button next to Library Asset.
3. Click the Next button.
4. The Add New Item screen appears. Enter a title for the library
asset that will be on the menu.
5. Click Browse Library.
6. The library screen opens.
7. In the right frame, select the type of asset to insert (image,
hyperlink, etc.).
NOTE

To insert assets, the menu’s folder must contain library assets. However, you can
insert library assets from other folders for which you have permission.

8. Select a library asset and click the Insert button (

).

9. The Add New Item screen reappears.
10. Click the Save button (

).

Adding an External Hyperlink as a Menu Item
To add an external hyperlink as a menu item via a content folder or
the Menus module, follow these steps.
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1. Follow the directions in ”Adding a Menu Item via Content
Folder” on page 453, ”Adding a Menu Item via Menus Module”
on page 454, or ”Adding a Menu Item via Navigation Link on a
Web Page” on page 455.
2. Click the circle next to External Hyperlink.
3. Click the Next button.
4. The Add New Item screen is displayed.
5. Complete the fields as needed.
Field

Description

Title

Title of the new external hyperlink menu item.

URL Link

The URL of the external hyperlink. For example,
www.example.com.

6. Click the Save button (
NOTE

).

When adding an External Hyperlink menu item, the URL does not get added to
the library nor is an ID assigned to it. So, when you save the menu item, it is not
added to the CMS database nor can it be retrieved for future use.

Adding a Submenu as a Menu Item
To add a submenu as a menu item via content folder or menus
module, follow these steps.
1. Follow the directions in ”Adding a Menu Item via Content
Folder” on page 453, ”Adding a Menu Item via Menus Module”
on page 454, or ”Adding a Menu Item via Navigation Link on a
Web Page” on page 455.
2. Click the radio button next to Submenu.
3. The Add Menu screen is displayed.
4. Complete the fields using ”Fields on the Add/Edit Menu
Screen” on page 449 as a reference.
5. Click the Save button (
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Adding an Item to a Submenu
1. From the left frame of the Workarea, click Modules > Menus.
2. Select the menu.
3. Find the submenu to which you want to add items. (Submenus
have a folder icon (
) next to them.)

4. Move the cursor over the submenu and click Add from the
popup menu.

NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

5. The Add New Item screen opens, displaying items you can
add.
6. Refer to the table below for selecting a menu item and follow
the steps to add it.
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Assign this type of content to
the menu

For details, see

Content

”Adding Content as a Menu Item” on
page 456

Any library asset: images, files,
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu
Item” on page 458

External hyperlink

”Adding an External Hyperlink as a
Menu Item” on page 458

Submenu to the main menu

”Adding a Submenu as a Menu Item”
on page 459

Adding New Content to a Menu via Navigation Link on a Web Page
NOTE

You can only use this feature after your Web developer has modified a page
template to display the menu. This procedure is described in the Ektron
CMS400.NET Developer Manual section “Custom ASP Functions” > “Menus.”

To add new content to a menu via a navigation link on a Web page,
follow these steps.
1. Access the Web page that contains the link to display the
menu.
2. Place the mouse on the hyperlink that causes the menu to
appear.
3. The menu appears.
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4. Click (

) Add.

5. The Add Menu screen opens, displaying items you can add.
6. Refer to the table below for selecting a menu item and follow
the steps to add it.

Assign this type of content to
the menu

For details, see

Content

”Adding Content as a Menu Item” on
page 456

Any library asset: images, files,
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu
Item” on page 458

External hyperlink

”Adding an External Hyperlink as a
Menu Item” on page 458

Submenu to the main menu

”Adding a Submenu as a Menu Item”
on page 459

Editing a Menu
You can edit a menu via:

• its content folder
• menus module
• navigation link on a Web page
This section describes each option.

Editing a Menu via its Content Folder
To edit a menu from a content folder, follow these steps.
1. Access the Workarea and navigate to the content folder that
contains the menu.
2. Click View > Menus.
3. Click the menu you want to edit.
4. Move the cursor over the menu that you want to edit.
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5. Click Edit from the popup menu.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

6. The Edit Menu screen is displayed.
7. Change the fields in Edit Menu screen by referencing ”Fields
on the Add/Edit Menu Screen” on page 449.
8. Click the Save button (

).

Editing a Menu via Menus Module
To edit a menu via the Menus Module, follow these steps.
1. From the left frame of the Workarea, click Modules > Menus.
2. Click the menu you want to edit.
3. Move the cursor over the menu that you want to edit.
4. Click Edit from the popup menu.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

5. The Edit Menu screen is displayed.
6. As necessary, update the fields in Edit Menu screen by
referencing ”Fields on the Add/Edit Menu Screen” on
page 449.
7. Click the Save button (

).

Editing a Menu via Navigation Link on a Web Page
To edit a menu via a navigation link on a Web page, follow these
steps.
1. Navigate to the Web page that contains the link to display the
menu.
2. Click the menu link.
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3. The menu appears.

4. Click Edit Menu.
5. The View Menu screen for the menu appears.
6. Move the cursor over the menu that you want to edit.
7. Click Edit from the popup menu.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

8. The Edit Menu screen is displayed.
9. Update the fields by referencing ”Fields on the Add/Edit Menu
Screen” on page 449.
10. Click the Save button (

).

Editing a Menu Item
This section explains how to edit the following types of menu
items:

• content on your Web site
• library asset
• link to an external Web site
• submenu
You can edit a menu item via:

• its content folder
• menus module
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• navigation link on a Web page
See Also: ”Working with Menus” on page 444

Editing a Menu Item via its Content Folder
To edit a menu item from its content folder, follow these steps.
1. Access the Workarea and navigate to the content folder that
contains the menu.
2. Click View > Menus.
3. Click the menu you want to edit.
4. The View Menu screen for that menu appears, listing all menu
items.

5. Move the cursor over the item you want to edit.
6. Click Edit from the popup menu.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

7. To learn about the fields on the screen, see ”Fields on the Add/
Edit Menu Screen” on page 449.
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Editing a Menu Item via Menus Module
To edit a menu via the Menus module, follow these steps.
1. Access the Menu Report screen, as described in ”Viewing a
Menu via the Menus Module” on page 468.
2. Click the menu you want to edit.
3. The View Menu screen for that menu appears, listing all items
on the menu.

4. Move the cursor over the item you want to edit, and click Edit
from the popup menu.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

5. To learn about the fields on the screen, see ”Fields on the Add/
Edit Menu Screen” on page 449.

Editing a Menu Item via Navigation Link on a Web Page
To edit a menu via navigation link on a Web page, follow these
steps.
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1. Access the template where you inserted the link to display the
menu.
2. Click the Menu Navigation link title on the Web page.
3. A menu is displayed along with all menu items on the menu.

4. Click Edit Menu.
5. The View Menu screen appears.
6. Move the cursor over the item you want to edit, and click Edit
from the popup menu.
7. To learn about the fields on the screen, see ”Fields on the Add/
Edit Menu Screen” on page 449.

Viewing a Menu
Just like editing a menu, you can view a menu via

• its content folder
• menus module
• navigation link on a Web page
When viewing a menu via the content or menu folder, you get an
internal view of information entered by menu creator. When
viewing via a navigation link on a Web page, you get an external
view of the menu, as seen by anyone navigating Web site.

View a Menu via its Content Folder
To access a menu via its content folder, follow these steps.
1. Access the Workarea and navigate to the content folder that
contains the menu.
2. Click View > Menus.
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3. The View All Menus screen displays all menus in the folder.

4. Click the menu you want to view.
5. The menu’s options appear.

Viewing a Menu via the Menus Module
To access the menu via the Modules folder, follow these steps.
1. From the left frame of the Workarea, click Modules > Menus.
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2. The Menus Report screen displays all menus.

3. Click the menu you want to view.
4. The menu’s options appear.

View Menus via Navigation Link on a Web Page
To access the menu via a navigation link on a Web page, follow
these steps.
1. Access the Web page on which your Web developer inserted
the link to display the menu.
2. Click the link that launches the menu on the Web page.
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3. A menu is displayed.

For information on how to display a menu on a Web page, refer to
the section on menus in the Developers and Administrator
Manuals.

Reordering Menu Items
To rearrange the items on a menu, follow these steps.
1. Navigate to the View Menu screen for the menu that you want
to rearrange. See ”Viewing a Menu” on page 467.
2. Move the cursor over the menu, and click Reorder.
3. The Reorder Items screen appears.

4. Click the item you want to move.
5. Click the up arrow to move it up, or the down arrow to move it
down.
6. When finished, click Save (
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Deleting a Menu
Similar to editing and viewing a menu, you can delete a menu via

• its content folder
• menus module
You cannot delete a menu from the navigation link on a Web page.

Deleting a Menu via Content Folder
To delete a menu via its content folder, follow these steps.
1. Access the View Menu screen, as described in ”View a Menu
via its Content Folder” on page 467.
2. Move the cursor over the menu, and click Delete.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

3. A confirmation message is displayed.
4. Click OK to delete the menu.
NOTE

Deleting a menu automatically deletes all menu items associated with it. Do not
confuse the menu link with the item itself. For example, deleting a menu deletes
its links to content but has no effect on the content.

Deleting a Menu via Menus Module
To delete a menu via its menus module, follow these steps.
1. Access the View Menu screen, as described in ”Viewing a
Menu via the Menus Module” on page 468.
2. Move the cursor over the menu, and click Delete.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

3. A confirmation message is displayed.
4. Click OK.
Ektron CMS40 0.NET User Manua l, Version 7.5

471

Working with Menus

NOTE

Deleting a menu automatically deletes all menu items associated with it. Do not
confuse the menu link with the item itself. For example, deleting a menu deletes
its links to content but has no effect on the content.

Deleting a Submenu
1. Access the View Menu page, as described in ”Viewing a Menu
via the Menus Module” on page 468.
2. Select the submenu.
3. Move the cursor over the menu, and click Delete.

Deleting a Menu Item
Similar to editing and viewing a menu, you can remove a menu
item from a menu via

• its content folder
• its menu folder
Removing a Menu Item via its Content Folder
1. Access the View Menu screen, as described in ”View a Menu
via its Content Folder” on page 467.
2. Move the cursor over the item.
NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

3. Click Delete.

Removing a Menu Item via Menus Module
1. Access the View Menu screen, as described in ”View a Menu
via its Content Folder” on page 467.
2. Move the cursor over the item.
3. Click Delete.
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NOTE

When moving the cursor to the popup menu, avoid moving across other menus or
options. When you move across another menu or option, it may become selected
instead of the item you want to work with.

Working with Menus in a Multi-Language System
NOTE

For background information about supporting multiple languages on your Web
site, see the Ektron CMS400.NET Administrator manual section “MultiLanguage Support” > “Additional Multi-Language Topics“ > “Working with Menus
in a Multi-Language System.”

You can create an edition of any menu in every supported
language. When a site visitor selects a language, navigates to a
page that has a menu and clicks the menu link, Ektron
CMS400.NET displays the menu in the selected language if it is
available. If a menu in that language is not available, nothing
appears.
Before creating or translating a menu, it’s a good idea to create or
translate all content that will be on the menu. In this way, you can
link this content to the new menu. However, after creating a menu,
you can add new items to it.

Translating a Menu
To translate a menu into any supported language, follow these
steps. You can navigate to the menu via the Web site or from the
Workarea. Each procedure is described below.
By Navigating the Site
1. Sign on to Ektron CMS400.NET
2. Select the menu’s current language.
3. Navigate to the page that has the menu you want to translate.
4. Click the menu and the Edit Menu option.
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5. The View Menu screen appears for the selected menu.
6. From the Add drop-down list, select the language into which
you want to translate the menu.

7. The Add Menu screen appears. Complete the screen for the
menu in the selected language. See ”Fields on the Add/Edit
Menu Screen” on page 449.
8. Click the Save button (

).

9. The View Menu screen reappears. Now, the View In dropdown list displays the menu’s new language.

10. Add items to the menu. See ”Adding a Menu Item” on
page 453. If adding content, you can only insert an item in the
selected language.
11. Later, you can add more menu items, edit them, delete them,
view them, etc.
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These capabilities are described in this chapter.

By Accessing the Menus Report Screen
1. From the Workarea screen, click Modules > Menus.
2. Click the menu you want to translate.
3. The View Menu screen appears for the selected menu.
4. From the Add drop-down list, select the language into which
you want to translate the menu.

5. The Add Menu screen appears. Complete the screen for the
menu in the selected language. See ”Fields on the Add/Edit
Menu Screen” on page 449.
6. Click the Save button (

).

7. The View Menu screen reappears. Now, the View In dropdown list displays the menu’s new language.

8. Add items to the menu. See ”Adding a Menu Item” on
page 453. If adding content, you can only insert an item in the
selected language.
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Later, you can add more menu items, edit them, delete them, view
them, etc.

Creating a Menu in Any Language
To create a menu in any language, follow these steps.
1. Form the Workarea screen, click Modules > Menus.
2. From the language drop-down list, select the new menu’s
language.

3. Create the menu. See ”Adding a Menu via the Menus Module”
on page 453.
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Management

Updating Your User Profile

When a new user is added to an Ektron CMS400.NET Web site,
the administrator sets up a personal profile for him. It contains
information such as password and email address. You can update
some personal profile information when needed. This section
explains how to modify your personal profile.

Viewing Your Profile
Before changing your personal profile, you must view it. To do so,
follow these steps.
1. Access your Workarea.
2. From the lower left frame, click Settings > User Profile.
3. Your user profile appears.
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4. Click the Edit button (

) in the top left corner.

5. The Edit User Information screen appears.
The following table explains fields you can edit.
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Field

Description

Display Name

The name that is used to identify you on the Web site. This can be different
from your Username, which is the name you use to log into the Ektron
CMS400.NET Web site.
Important: This name needs to be unique inside Ektron CMS400.NET
and it cannot be blank.

Password

If desired, enter a new password into this field.
If you change your password, you do not need to log out then log back in.
However, the next time you log in, you must use the new password.

Confirm Pwd

Confirm your new password by retyping it into this field.

User Language

Select a language in which to view Ektron CMS400.NET. Click the black
down arrow on the right (circled below) to see a list of choices.

Email Address

Enter a new valid email address. Notification email is sent to this address
unless the Disable E-mail Notification field is checked.
To understand how email notification operates within the content workflow,
see ”Example of an Approval Chain” on page 91.
Also, this address identifies the user sending Instant email. See
”Sending Instant Email” on page 25

Forum Editor

Also:

Determines which editor will be used when this user replies to a
Discussion Board.
See Also: E k t r o n C M S 4 0 0 . N E T Administrator Manual section
“Discussion Boards” > “Using Discussion Boards on your Web Site”
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Field

Description

Avatar

An image or icon to represent you on the Web site.
Type in a web path to image. For example: http://www.example.com/
smileyface.gif

Address

The address used to find your location when a user is performing a search
based on location.

Latitude

The latitude used to find your location when a user is performing a search
based on location.
Google maps provides a service that takes the address of user and returns
its latitude and longitude.
Note: You don’t need to use Google’s automatic retrieval of latitude and
longitude. Instead, you can enter the values manually.

Longitude

The longitude used to find your location when a user is performing a
search based on location.
Google maps provides a service that takes the address of content and
returns its latitude and longitude.
Note: You don’t need to use Google’s automatic retrieval of latitude and
longitude. Instead, you can enter the values manually.
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Field

Description

Forum Signature

Adds a signature to your posts in the forum. You do not see the signature
in the editor. It is added after you click the Post button.

Tags

Select from a predefined list of Tags that describe yourself. Or, create a
new tag by clicking the Click To Add A New Tag link. Placing a check
mark in the check box next to a tag activates it for your profile.

Disable Email
Notification

Check this box if you do not want to receive notification email.

Work Page Size
Your system administrator may let you change the work page values. If he does, the following fields
are editable. Otherwise, you can only view the fields.
Width

If desired, change the width of the screen in which E k t r o n C M S 4 0 0 . N E T
appears. The width in pixels must be between 400 and 2400.
This field accommodates users who have larger monitors and/or prefer a
smaller resolution, such as 1280 x 1024.

Height

If desired, you can change the height of the screen in which E k t r o n
C MS4 00. NE T appears. The height in pixels must be between 300 and
1800.
This field accommodates users who have larger monitors and/or prefer a
smaller resolution, such as 1280 x 1024.
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Field

Description

Display button text in
the title bar

Check this box if you want any button’s caption text to appear in the screen
title’s bar whenever a user moves the mouse over the button. Note the
word Update, describing the button, in the illustration below.

If you do not check this box, the screen’s title remains in the title bar when
the user moves the mouse over the button, as illustrated below.

Landing Page after
login

If you want one page in your Web site to appear after sign in, enter the
URL to that page. You might select a page that leads to a group of pages
that you maintain.
If you don’t know the URL, navigate to the page, go to the browser address
bar and select the text following the directory in which E kt ro n
C MS4 00. NE T resides. For example, if the browser address bar says
http://www.example.com/customers.aspx?id=945, you would enter
customers.aspx?id=945 here.

Set smart desktop as
the start location in the
Workarea

If you want the Smart Desktop to appear as soon as you enter the
Workarea, click inside this check box.

See Also: ”Understanding the Smart Desktop” on page 17
If you leave this check box blank, when you enter the Workarea, you go to
the folder of the content specified at the Landing Page after login field.

Inherit Task
Permissions From
User Groups

User Properties

This area indicates your task permissions and whether you inherit them
from user groups to which you belong.
For more information, see the E ktron CM S40 0. NET Administrator
Manual chapter “Managing Tasks,” section “Task Permissions.”
See “Custom User Properties” in the E k t r o n C M S 4 0 0 . N E T Administrator
Manual.
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Online Help

Online help provides access to important and useful information
about using Ektron CMS400.NET. Help is provided in two formats:

• online help - accessible from most screens by clicking the help
button ( ), it provides information about the screen you are
currently viewing. Online help is in HTML format, so it opens in
the browser you use to surf the internet.
After viewing a help topic, you can browse to related topics as
well as access a table of contents, index, and search to expand
your quest for information. See Also: ”Accessing Online Help”
on page 483

• online manuals - can be viewed, searched, and printed like a
paper manual. Online manuals are in a PDF format, which
makes it easy to navigate online and print. See Also:
”Accessing Online Manuals” on page 484
Both formats provide the same information. Choose the format that
best suits your needs.

Accessing Online Help
To access online help for any screen, click the help icon (illustrated
below).

When you do, an online help screen appears.

Ektron CMS40 0.NET User Manua l, Version 7.5

483

Online Help

The following table describes the buttons available on every help
screen.

Button

Description
Moves to prior topic in the help. This refers to the topic
sequence arranged by the help’s author.
Moves to next topic in the help. This refers to the topic
sequence arranged by the help’s author.
Divides the help into two panels.

•

The left panel displays the table of contents. It also
provides buttons for accessing the index and fulltext search.

•

The right panel continues to display help topics.

Highlight the current help topic’s location within the table
of contents.
Prints current topic

Accessing Online Manuals
To access the help folder, follow these steps.
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1. Access the Workarea.
2. From the lower left frame, click Settings.
3. From the top left frame, click Help.

4. The help screen appears in the right frame.

5. Click any link to open the documentation or Web page.
NOTE

Your computer requires an internet connection to access the help page on
Ektron.com.
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Introduction to Ektron
CMS400.NET Editors

Ektron CMS400.NET has two choices for a main content editor,

depending on your computer’s operating system.

TECHNICAL NOTES

Operating
System

Possible editors

Windows

• e We b E d i t P r o + X M L
• eWebEdit400

Macintosh

• eWebEdit400

eWebEdit400 does not require installation of an ActiveX control to each client
computer.
But, even if you choose eWebEdit400, if a user begins to create or edit an XML
Smart Form configuration, the client computer installs eWebEditPro+XML. Ektron
CMS400.NET requires that editor to create XML Smart Forms.

Each editor’s toolbar is illustrated below.
eWebEdit400 Toolbar

Ektron CMS40 0.NET User Manua l, Version 7.5

486

Introduction to Ektron CMS400.NET Editors

eWebEditPro+XML Toolbar

NOTE

Your choice of editors only affects the main HTML content editor. It does not affect
other screens which use eWebEdit400, such as the Task Description.

Setting the Editor for Ektron CMS400.NET Users
Each Web server that hosts Ektron CMS400.NET has two editor
options: one for clients that run Windows and another for clients
using MacIntosh. Your system administrator determines the editor
options in the site’s web.config file, using the following settings.
<appSettings>
.
.
<!-- EditControlWin may be either "ContentDesigner" or "eWebEditPro" -->
<add key="ek_EditControlWin" value="eWebEditPro"/>
<add key="ek_EditControlMac" value="ContentDesigner"/>
</appSettings>

The table below contains information about both editors.

Operating
System

Web.Config file key

Possible editor key values

Windows

ek_EditControlWin

•
•

eWebEditPro
ContentDesigner (use to load

eWebEdit400)

•

ContentDesigner (use to load

eWebEdit400)

Macintosh

ek_EditControlMac

The following sections explain how to use the eWebEditPro+XML
and eWebEdit400 editors.
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eWebEdit400 is a browser-based, Web content editor designed for
dynamic Web sites. It lets you create and publish your own Web
content in any language supported by the operating system and
your Web site.

NOTE

To learn how to enable eWebEdit400 for all clients that connect to your server,
see ”Setting the Editor for Ektron CMS400.NET Users” on page 487.

More specifically, eWebEdit400 lets you perform Web page editing
functions, such as

• copy content from any Windows-based application
• cut, copy, and paste
• find and replace text
• check spelling
• change font style, size, attributes (bold, italics, underline), and
color

• begin lines with bullets or numbers
• adjust indentation
• right, center, or left justify text and images
• add a bookmark, hyperlink, image, or table
• view your text as WYSIWYG or HTML code
• insert or clean HTML source code
You gain access to these functions from the toolbar at the top of
the editor, or from a menu that appears when you right click the
mouse inside the editor.
Also, if you create and maintain HTML forms, this chapter
describes how to do that using eWebEdit400.
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Using eWebEdit400
eWebEdit400 is like many other word processing applications. You
type text and then use toolbar buttons (illustrated below) and menu
options to change the text’s appearance or perform functions on it,
such as spell checking.

To learn more about using eWebEdit400, see these topics.

• ”Toolbar Buttons” on page 490
• ”Copying from Other Applications” on page 497
• ”Finding and Replacing Text” on page 498
• ”Checking Spelling” on page 503
• ”Working with Images” on page 506
• ”Using Bookmarks” on page 517
• ”Using Hyperlinks” on page 521
• ”Inserting email Links” on page 527
• ”Working with HTML” on page 529
• ”Working with Tables” on page 531
• ”Working with HTML Forms” on page 574
NOTE

You cannot use eWebEdit400 to create or edit Smart Form configurations. If
you try to, Ektron CMS400.NET begins to install eWebEditPro+XML. If you
complete the installation, you will use eWebEditPro+XML to create and edit Smart
Form configurations, but use eWebEdit400 to perform other editing.
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This section explains how to use the buttons and drop-down lists
on the toolbar. (The toolbar is the row of buttons across the top of
the editor window, illustrated below.)

The buttons let you perform functions such as cutting and pasting
text, inserting images, and creating tables.
All buttons may not appear. Your Webmaster determines which
buttons appear on your toolbar.
TECHNICAL NOTE

The following Ektron Knowledge Base article explains how a Webmaster adds a
custom toolbar button to eWebEdit400: http://dev.ektron.com/
kb_article.aspx?id=16550.

See Also:

• ”Selecting Text” on page 632
• ”Applying Formatting Attributes to Text” on page 633
• ”Table of Toolbar Buttons” on page 490
• ”Form Elements Toolbar” on page 496

Table of Toolbar Buttons
eWebEdit400’s toolbar buttons are explained below.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Select All
Cut

Ctrl+A

Select all content

Ctrl+X

Remove selected text and graphics.
Place that data into temporary memory,
also known as the “clipboard.”
(If you later cut or copy more information
onto the clipboard, the new information
overwrites the original information.)

Copy

Ctrl+C

Copy selected text and graphics into
temporary memory. Leave selected data
where it is.

”Copying from Other
Applications” on
page 497

(If you later cut or copy more information
into memory, the original information is
lost.)
Ctrl+V
Paste

Launch the Search and Replace dialog
box. The dialog searches for (and lets
you optionally replace) text that you
specify.

Find and Replace

Print

Undo

Redo

Spell Check

Anchor Tag

Insert the most recently cut or copied text
and graphics at the current cursor
location.

Ctrl+P

Print the editor content.

Ctrl+Z

Reverse the most recent action, as if it
never occurred. You can undo as many
actions as you wish.

Ctrl+Y

Reverse the undo action.

”Finding and
Replacing Text” on
page 498

Begin spell checker.

”Checking Spelling”
on page 503

Insert a bookmark anchor.

”Using Bookmarks”
on page 517
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Button

Equivalent
Keystroke

Function

For more
information, see

Change information about a hyperlink.

”Using Hyperlinks”
on page 521

Remove a hyperlink.

“Removing a
Hyperlink” on
page 525

Insert a library file.

”Adding a Library
File to Content” on
page 148

Create a wiki link.

”Using Ektron
CMS400.NET’s Wiki
Feature” on
page 778

Translate content into another language

”Translating Content
to Another
Language” on
page 55

(Internet
Explorer only)

Add/edit Hyperlink

Remove Hyperlink

Library

Add Wiki Link

Translate

Insert a horizontal line.
Horizontal Line
Insert symbols and special characters.
Insert Symbol
Apply CSS Class

Display a list of style sheet classes.
Users can select from the list to apply a
class to selected text. The list can
change depending on the selected text.
Your Webmaster determines which styles
are available.

Paragraph Style

Display a list of paragraph styles. Users
can select from the list to apply a style to
selected text. The list can change
depending on the selected text.
Your Webmaster determines which styles
are available.

Bold

Ctrl+B

Make selected text bold.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Italic
Underscore

Ctrl+I

Make selected text italic.

Ctrl+U

Make selected text underlined.

Strikethrough

Apply strikethrough to selected text. For
example: Here is some text

Superscript

Make selected text appear smaller and
above text line.

Subscript

Make selected text appear smaller and
below text line.

Relative Font Size

Change the relative font size. Your
Webmaster determines which relative
font sizes are available.
Change the font style. Your Webmaster
determines which fonts are available.

Font Style

Note: If more than one font appears in a
selection, the browser on the reader’s PC
tries to display text using the first font. If
the browser cannot find that font, it tries
to use the second, etc.

Font Size

Font Color
Background
Color

Change the font size in points. Your
Webmaster determines which font sizes
in points are available.
Change the font color.

Change the background color of the
selected content.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Number

Begin the line on which the cursor rests
with a number. If the line above this line
is

•
•

not numbered, assign this line 1
numbered, assign a number one
more than the line above

Note: The Number toolbar button applies
a number to each paragraph. If you want
to switch to regular (that is, nonnumbered) paragraphs, click the button a
second time.

Bullet

Begin the line on which the cursor rests
(or all selected lines) with a bullet ( ).
Note: The Bullet toolbar button applies a
bullet to each paragraph. If you want to
switch to regular (that is, non-bulleted)
paragraphs, click the button a second
time.

Indent

Increase or decrease the current line’s
distance from the left margin.
Align paragraph so that it is arranged

•
Left, Center, and Right
Justify

evenly on the left side (uneven on
the right)

•in the center of each line
•evenly on the right side (uneven on
the left)

•

evenly on right and left side

Use the last button to remove
justification.
Insert table

Insert a table.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Insert row above

Insert row below

Insert a new row above current one (that
is, the one in which the cursor currently
resides).
Insert a new row below current one (that
is, the one in which the cursor currently
resides).

Insert column left

Insert a new column to the left of the
current one.

Insert column right

Insert a new column to the right of the
current one.

Delete row

Delete column

Delete cell

Merge cells
horizontally

Merge cells
vertically

Split cell

Table properties

Cell properties

Delete current row.

Delete current column.

Delete current cell.

”Deleting a Cell” on
page 559

Merge current cell with cell to its right.

”Merging Two Cells”
on page 566

Merge current cell with cell below it.

”Merging Two Cells”
on page 566

Divide a cell into two. After you split, each
cell occupies one half the size of the
original cell.

”Splitting a Cell” on
page 565

Adjust a table’s properties

”Modifying Table
Properties” on
page 535

Adjust properties of current cell

”Working with Table
Cells” on page 556
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Button

Equivalent
Keystroke

Function

For more
information, see

Display/suppress internal table border

”Setting Table
Borders” on
page 551

(Internet
Explorer only)

Show/hide border

Form Elements Toolbar
These toolbar options appear when you are working with an HTML
form, poll, or survey.

See ”The Form Toolbar Options” on page 587.
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Copying from Other
Applications

You can copy information from most other Windows
applications into eWebEdit400 and retain most or all of the
original application’s formatting. In general, copying from
another application involves these steps.
1. Sign on to the application that contains the information.
2. Select the text to be copied.
3. Press <Ctrl>+<C>.
4. Go to eWebEdit400.
5. Press <Ctrl>+<V> to paste the selected information.
Note that you can only copy content, not background
information that generates content. So, for example, you can
copy the values in a spreadsheet but not the formulas used to
generate them. Also, copying dynamic fields from Microsoft
Word retrieves the current value of the fields but not the
variables that generate the values.
It’s a good idea to experiment with copying from different
sources to test the results.
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To find (and optionally replace) text on your Web page, click the
Find and Replace button ( ). When you do, the Find and
Replace dialog box appears.

You can use this dialog to simply find text, or to find text then
replace it with other text. Each option is explained below.
TIP!

You can also use this dialog to delete text that appears repeatedly. To do so,
follow the directions in ”Finding and Replacing Text” on page 499 and enter
nothing in the Replace With field.

See Also:

• “Finding Text” on page 499
• “Finding and Replacing Text” on page 499
• “Additional Options on the Dialog Box” on page 499
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Finding Text
1. In the Find field, type the text you want to find.
2. Set dialog box options (see ”Additional Options on the Dialog
Box” on page 499).
3. Click Find Next to find the next occurrence of the “find” text.

Finding and Replacing Text
1. In the Find field, type the text you want to find.
2. Click the Replace tab.
3. In the Replace With field, type the text to replace the “find”
text.
4. Set dialog box options (see ”Additional Options on the Dialog
Box” on page 499).
5. If you want to

- replace all occurrences of the “find” text with the “replace”
text, click Replace All.
NOTE

You can undo replacements one at a time using the Undo button (

).

- replace only the highlighted term with the “replace” text, click
Replace.

- find the next occurrence of the “find” text (and optionally
replace it with the “replace” text), click Find Next.

- change the highlighted term using the editor, exit the Find
and Replace dialog, move to the term and edit as needed.
To restart the search, press the Find button ( ).
6. Continue to find and optionally replace or edit until you reach
the end of the text.

Additional Options on the Dialog Box
The dialog box also lets you do the following.

• ”Specifying a Search Direction” on page 500
• ”Considering the Case of a Search Term” on page 501
• ”Whole Word Match” on page 501
• ”Searching Selected Text” on page 500
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Searching Selected Text
You can search and replace text in a selected portion of content. To
do so, follow these steps.
1. Select text that you want to search and replace by dragging the
cursor over it.
2. Click the Find and Replace button (

).

3. In the Find & Replace dialog, enter the search string.
4. If desired, click the Replace tab and enter a replacement
string.
5. Under Search, click Selection only.

6. Click Find Next.
7. The search runs but is limited to text you selected in Step 1.

Specifying a Search Direction
The search begins where the cursor is when you click Find Next.
To make sure you find every occurrence of a term, place the cursor
at the top of the content before beginning the search.
If you begin the search somewhere other than the top of the page,
use the Direction field to search from the current location to the
top or bottom of the content.
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To search from the
cursor location to the

Click this option in the
Direction field

end of the page

Down

top of the page

Up

Considering the Case of a Search Term
By default, the search ignores the case (upper or lower) of a
search term. In other words, if you enter Bob in the Find field, the
search finds bob, Bob, BOB, etc.
If you want the search to be case sensitive, use the Match case
check box. If you enter Bob in the Find field and place a check in
the Match case box, the search only stops at Bob, not bob or
BOB.

Whole Word Match
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By default, the search finds any occurrence of the text that you
type into the Find field. For example, if you enter the, the search
finds the word the, as well as those letters embedded in other
words, such as others and theater.
If you want the search to find only whole word occurrences of the
text in the Find field, click the Match whole words only box.
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NOTE

This section describes the spell check software installed with eWebEdit400. If you
use the FireFox browser, it has its own spell check software. To eliminate
confusion between eWebEdit400’s and Firefox’s spell checker, Ektron suggests
disabling Firefox’s. This is set on Firefox’s Tools > Options dialog > General Tab >
Check my spelling as I type check box.

To begin spell checking, click the spell check button (

).

When you do, eWebEdit400 underscores in red each word that’s
not in the dictionary. Then, it stops at the first misspelled word and
displays your options for fixing the problem.

The Spelling Options
Option

Use this option if you want to...

One or more similar,
correctly-spelled words

Replace highlighted word with one from the list. To do this, click the
correct word.

Ignore, Ignore All

Don’t want to change the highlighted word, nor do you want to add it
to the dictionary.
If the word appears repeatedly in the content, Ignore All also
appears. Use this to skip all occurrences of the word in this spell
check session.
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Option

Use this option if you want to...

Change Manually

Retype the highlighted word.
If the word appears repeatedly in the content, the following message
asks if you want to change all occurrences to the fixed version.
This word occurs more than once in the text. Would you like to
replace all instances?

Add to Dictionary

Add the selected word to the “dictionary.” Do this if it is correctly
spelled, and you expect to use the word in the future.
Once you add a word to the dictionary, it will no longer be highlighted
by the spell checker. The word can also now appear on the correctlyspelled words list.
Technical note: Words added using this option are placed in a .txt file
located in the host server’s site root/Workarea/Foundation/
RadControls/Spell/TDF folder. The file’s name begins with the
selected language, and ends with custom.txt. For example, if the
language is U.S. English, the file is en-US-custom.txt.

Using the Spell Checker
• As soon as you select an option, the spell checker moves to
the next misspelled word and displays its options.

• If you finish spell checking all words, you return to edit mode.
• Instead of stopping at every misspelled word, you can place
the cursor on any highlighted word. When you do, its spelling
options appear.

• If you are done before fixing every misspelled word, click
Finish spell checking from the toolbar (circled below). If you
do, your changes are saved, and you return to edit mode.
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• If you want to exit the spell checker and ignore all changes you
have made since beginning it, click Cancel (circled above) at
any time.
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eWebEdit400 makes it easy to insert images in to your content.

First, you import the image into library or as a Ektron CMS400.NET
asset. Then, add it to the content. Next, you can edit its properties,
such as border width and color, spacing, width and height, etc.
For more information, see

• ”Inserting an Image” on page 506
• ”Inserting an Image Thumbnail” on page 508
• ”Editing an Image’s Properties” on page 508
• ”Deleting an Image from Content” on page 516

Inserting an Image
Prerequisite
Before you can insert an image into eWebEdit400, it must be either
uploaded to the Library or imported as an asset.

• ”Copying Files to the Library” on page 141 explains how to
upload an image to the Library

• ”Importing Managed Files” on page 255 explains how to import
an asset

Procedure for Inserting an Image
To insert an image into the editor, follow these steps.
1. Place the cursor where you want the image to appear
2. Click the library button (

).

3. Make sure Images is selected in the content type dropdown
(circled below).
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4. From the folder display in the left panel, select the folder that
contains the image you want to insert.

If you don’t know the image’s folder, use the search button (
to find the image by title, description, or internal file name.

)

5. Select the image you want to insert.
6. Click the insert button (

).

7. The image is inserted into the content.
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Inserting an Image Thumbnail
As an alternative to inserting an image, you can insert a thumbnail,
a miniature version of the image. When the thumbnail appears on
a Web page, a site visitor can click it to see a full-sized version of
the image. See an example of both below.

To insert an image thumbnail, follow the steps in ”Procedure for
Inserting an Image” on page 506, but when you get to Step 5, click
the image’s thumbnail button (

).

Editing an Image’s Properties
After an image in inserted, you can adjust the following properties
for it.
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• border width
• border color
• alt text
• description
• alignment
• the image itself
• horizontal and vertical spacing
• width and height

To access the Image Properties dialog, follow these steps.
1. Select the image.
2. Right click the mouse.
3. Click Set Image Properties.
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NOTE

You can also view and adjust some image properties at the bottom of the Edit
Content screen, as shown below.

The following explains the fields on the Image Properties dialog.

Field

Description

Border Width

Set the width of the image’s border in pixels. See Also: “Setting a
Border” on page 513
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Field

Description

Border Color

To set the color of the image’s border, click the X circled below.
When you do, a palette of colors appears. Click the border color from
the palette.

If a color has already been assigned, it appears next to this field
label. To change it, click down arrow next to the color to display the
color palette.
Image Alt Text

The image’s title is used as the default alt text. Change if desired.
The alt text appears in place of the image on the Web page if the
image does not display. Examples of when an image does not
display include:

•
•

a speech browser (for example, a visually impaired person)

•

a graphical browser with images turned off

a text-only browser (for example, browsing from a mobile
phone)

Image Alignment

The alignment of the image relative to adjacent text and images. If
you choose left or right alignment, the text wraps around the image.
For more information, see “Aligning the Picture” on page 514

Image Src

The path to the image.
If you want to change the image, click the ellipsis (
) button to
open the library. From there, select a replacement image.

Horizontal Spacing,
Vertical Spacing

The amount of horizontal and vertical space around the picture. See
Also: ”Adding Space around the Picture” on page 515

Width

The width of the picture in pixels. See Also: ”Pixels” on page 512

Height

The height of the picture in pixels. See Also: ”Pixels” on page 512
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Field

Description

Constrain

The constrain feature lets you determine if an image’s height and
width can be adjusted independently. Typically, you want Constrain
on, as shown below.

In this state, if one dimension is adjusted, the other is automatically
adjusted in proportion to it. For example, if you change the height
from 100 to 200, the width is also doubled.
To turn Constrain off, click it. When you do, it looks like this.

When Constrain is off, the adjusted picture can be disproportionate,
as shown below.

WARNING!

If you substantially adjust the picture’s height and/or width, the picture may be
distorted when users view your Web page.

Pixels
A pixel is a single point in a graphic image.
Computer monitors display pictures by dividing the screen into
thousands of pixels, arranged in rows and columns. The pixels are
so close together that they appear connected.
Below is an image shown at regular size and then enlarged so you
can see the pixels that make up the picture.
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regular size

enlarged to show pixels

Setting a Border
To add a border around a picture, enter the border’s thickness in
pixels in the Border Width field on the Image Properties dialog.
See Also: ”Pixels” on page 512

Here is a picture with a 1 pixel border.

Here is the same picture with a 10 pixel border.
If the picture is not a hyperlink, its border is black. If the picture is
also a hyperlink, the border is the same color as a hyperlink (for
example, blue or purple if visited).
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Aligning the Picture
To align a picture, use the Image Alignment field on the Image
Properties dialog.

The following table lists your alignment choices.

To align

Click this
Alignment
option

Illustration

The picture on the left margin,
allowing subsequent text to
wrap around it

The picture on the right margin,
allowing subsequent text to
wrap around it

The top of the picture with the
first line of text
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To align

Click this
Alignment
option

Illustration

The vertical center of the picture
with the first line of text

The bottom of the picture with
the first line of text

Adding Space around the Picture
On the Image Properties dialog box, you can use the Spacing
fields (Horizontal and Vertical) to add space around the picture.
You enter a number of pixels to determine spacing value.
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The following graphic illustrates the effect of adding spacing to a
picture.

Deleting an Image from Content
If you want to delete a picture, follow these steps.
1. Move the cursor over the picture.
2. Click the mouse to select the picture.
3. Click the Cut button (
NOTE

).

If you want to remove an image from content created from an XML Smart Form
and eWebEdit400 is your editor, click the image icon (
), open the Image
Properties dialog, and delete the image path (circled below).
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Use a bookmark to let a user “jump” from any word or phrase to
another place in the same content block. On your Web page, text
appears in a different color to indicate the bookmark.
Bookmarks are particularly helpful if your page is very long. For
example, if your Web page contains minutes from several
meetings, the top of the page could list the meeting dates. You
could then assign a hyperlink to each date and a bookmark to each
set of minutes. The user sees that a date is in a different color, so
clicks it to “jump” (using the bookmark) to the correct minutes.
“Creating a Bookmark” on page 517 describes how to set up a
bookmark within a file. You can also set up hyperlink to

• another Web page. This procedure is described in “Using
Hyperlinks” on page 768.

• a bookmark within another Web page. This procedure is
described in “Creating a Hyperlink to a Location Within a Web
Page” on page 771.

Creating a Bookmark
When creating a bookmark, you must specify a

• source, the text a user clicks to move to the bookmark
• bookmark, the destination to which the cursor jumps when a
user clicks the source
To continue with the above example, a meeting date is the source,
and the meeting minutes are the bookmark.
To create a bookmark, follow these steps.
1. Select the bookmark text.
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2. Click the Insert Anchor button (

).

3. The Hyperlink Manager dialog appears with the Anchor tab
selected.

4. Enter a name for the bookmark.
5. Click OK.
6. The editor screen redisplays. (The bookmark does not appear
on the page.)
7. Select the source text.
8. Click the Hyperlink Manager button (

).

9. The Hyperlink Manager dialog appears with the Hyperlink tab
selected.
10. Click the down arrow below the Existing Anchor field and click
the bookmark you created in Step 4.

11. If desired, use the Target dropdown to change the destination
text ‘s window. For details, see “Changing the Destination
Window” on page 519.
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If you leave the Target Frame field blank, the new window
replaces the current window.
12. Click OK.

Changing the Destination Window
Use the Target Frame field on the Hyperlink Manager dialog to
change the window that displays the destination page.

The values you can enter into the Target Frame field are explained
below.

If you want the destination page to appear

Click this in the Target Frame
field

In a new browser window, on top of the current
browser.

New Window
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If you want the destination page to appear

Click this in the Target Frame
field

In the same position within the browser window.
The new window replaces the current one.

Same Window

If your page contains frames, in the frame that
contains the frame with the hyperlink.

Parent Window

If your page contains frames, in the full display
area, replacing the frames.

Browser Window
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Use hyperlinks to let a user “jump” from any word or phrase to
another Web page. The page can be within your network (that is,
on an intranet) or anywhere on the internet.
NOTE

If you want to create jumps within a content block, see ”Using Bookmarks” on
page 517.

For example, if your Web page should include a link to the Ektron
Web site, you would enter the text to indicate the jump (for
example Ektron Web Site), then create a hyperlink to
www.ektron.com. When users see Ektron Web Site in a different
color, they can click the text to “jump” to the site.
Although most jumps go to the top of another Web page, you can
also jump to a bookmark within a Web page.
This section explains

• ”Creating a Hyperlink” on page 521
• ”Testing a Hyperlink” on page 523
• ”Creating a Hyperlink to a Location Within a Web Page” on
page 524

• ”Editing a Hyperlink” on page 525
• ”Removing a Hyperlink” on page 525
• ”Preventing a URL from Becoming a Hyperlink” on page 526

Creating a Hyperlink
When creating a hyperlink, you must specify a

• source, the text the user clicks to move to the destination
• destination, the Web page that appears when someone clicks
the source
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To continue with the above example, Ektron Web Site is the
source, and www.ektron.com is the destination.

Entering a Hyperlink
To create a hyperlink, follow these steps.
1. Select the source text.
2. Click the Hyperlink Manager button (
appears.

). The Hyperlink dialog

3. Click in the URL field after http://. Then, enter the address of
the destination Web page. For example, www.ektron.com.
If your version of Ektron CMS400.NET has URLs that have been
entered into the library as hyperlinks, click the ellipsis button
(
) to browse the library and insert a hyperlink. See Also:
”Hyperlinks” on page 150

Ektron CMS40 0.NET User Manua l, Version 7.5

522

Using Hyperlinks

4. If desired, use the Target Frame field to change the window in
which the destination text appears. For details, see “Changing
the Destination Window” on page 767.
If you leave the Target Frame field blank, the new window
replaces the current window.
5. You can enter text to appear in a small window when someone
hovers his cursor over this link. For example:

To add such text, use the Tooltip field.
6. The style of this hyperlink is normally determined by the style
sheet assigned to the content’s page template. However, if you
want to apply a special style sheet class to this link, select it
from the CSS Class dropdown.
7. Click OK.

Testing a Hyperlink
To test a hyperlink, save the content. Then, under the View
screen’s Content tab, click the link to verify that it opens the
correct Web page.
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Creating a Hyperlink to a Location Within a Web
Page
Sometimes, the destination Web page contains bookmarks, and
you want to jump from your page to a bookmark on another page.
(Bookmarks are described in ”Using Bookmarks” on page 517.)
To create a hyperlink that jumps to another page’s bookmark,
follow these steps.
1. Open a browser and your Web site.
2. Go to the Web page that contains the bookmark link.
3. Click the bookmark that you want to jump to. For example, on
the illustration below, the text Benefits to Partners jumps to a
bookmark further down the page.
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4. When you click the bookmark, its full address appears in the
browser address bar. This bookmark’s address looks like this.
http://www.example.com/single.aspx?id=35#Benefits2

5. Click the address bar. The address is selected.
6. Press <Ctrl>+<C> to copy the address into the Windows
clipboard.
7. Go to eWebEdit400.
8. Select the text or image from which you want to jump to the
bookmark.
9. Click the Hyperlink button (
appears.

). The hyperlink dialog box

10. Move the cursor to the Link field.
11. Press <Ctrl>+<V> to paste the address you copied in Step 4
into the Link field.
12. Click OK.

Editing a Hyperlink
If you need to change a hyperlink’s destination Web page or target
frame, follow these steps.
1. Select the hyperlinked text.
2. Right click your mouse.
3. Click Set Link Properties.
4. The Hyperlink Manager dialog appears.
5. Edit the fields as needed. Several fields are explained in
”Entering a Hyperlink” on page 522
6. Press OK.

Removing a Hyperlink
If you want to remove a hyperlink from text, select the text and
press the Remove Link button (
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Preventing a URL from Becoming a Hyperlink
If you enter a URL or an email address into eWeb Ed it 40 0 , it
automatically becomes a hyperlink. To avoid this, select the text
and click the Remove Link toolbar button ( ).
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You can easily insert email links into your content. Such links
provide an easy way for your site visitors to communicate with your
organization.
An email link resembles a hyperlink. But, when a site visitor clicks
the link, instead of opening a different Web page, his email
application is launched.

The address and subject are retrieved from the mail link and
inserted into the user’s email screen, as shown above.
To insert an email link, follow these steps.
1. Within eWeb Ed it 4 00 content, insert text that a site visitor will
click to open the email link. For example: Contact us today!
If the text does not exist yet, insert it.
2. Select the text.
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3. Click the Hyperlink Manager button (
appears.

). The Hyperlink dialog

4. Click the E-mail tab.

5. Note that the selected text appears in the Link Text field.
6. In the Address field, enter the email address to which the
message will be sent.
7. In the Subject field, enter default text for the email’s Subject
line if desired. The user sending the mail can edit this text if
desired.
8. Press OK.
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eWebEdit400 creates pages for display on the internet or an
intranet. These pages use HTML (hypertext markup language) to
format text and images for display in a browser. You do not need to
know HTML to use eWebEdit400.

However, if you know HTML, you can view, insert or edit your Web
page’s HTML code.

Viewing and Editing HTML
To view your page’s HTML, follow these steps.
1. Scroll to the bottom of the screen.
2. Click the HTML button (circled below).

3. The HTML code appears, as shown below.
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4. You can edit the HTML using functions like Cut, Copy, Paste
and Delete. To access these functions, right click the mouse.
5. To return to normal view, click the Design button (circled
below).
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Sometimes, the information on your Web page looks better when
displayed on a table. Here is an example.

City

Baseball Team

Hockey Team

Boston

Red Sox

Bruins

New York

Yankees / Mets

Rangers

Chicago

White Sox / Cubs

Black Hawks

This chapter explains everything you need to about working with
tables. It explains

• ”Creating a Table” on page 531
• ”Deleting a Table” on page 537
• ”Inserting a Table within a Table” on page 537
• ”Modifying Table Properties” on page 535
• ”Working with Table Cells” on page 556
• “Section 508 Tables” on page 570

Creating a Table
When creating a table, you need to specify a number of rows and
columns. A row is a horizontal series of cells, while a column is a
vertical series.
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If you know how many rows and columns the table will be, enter
those numbers. If you don’t know the exact number when you
create the table, estimate how many you need. You can easily add
or remove rows and columns later.
There are two ways to create a table. If your table will be six rows
by six columns or less, use the Table Builder. See Also: ”Creating a
Table Using the Table Builder” on page 532
If it will exceed 6 x 6, use the Table Wizard. See Also: ”Creating a
Table Using the Table Wizard” on page 533
Either way, once the table is created, you use the features
described in ”Modifying Table Properties” on page 535 to add
borders, background color, set width and height, etc.

Creating a Table Using the Table Builder
To create a table, follow these steps.
1. Click the table button (

).

2. Drag the cursor over rows and column to indicate the size of
the table.
The following example shows a table that is 4 rows by 5 columns.
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3. Click the mouse.
At this point, the table looks like this.

4. Begin entering text and images into the table cells. To further
modify the table, see ”Modifying Table Properties” on
page 535.
You can also select the table and drag its right border to the right
and/or down to enlarge it for ease of use.

Creating a Table Using the Table Wizard
1. Click the table button (

).

2. Click Table Wizard (circled below).
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3. The Table Wizard dialog appears.

4. To change the number of columns or rows, click the plus or
minus signs (+ -) next to Columns and Rows.
5. The image adjusts to show the number of rows and columns.
6. Press OK.
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7. Begin entering text and images into the table cells. To further
modify the table, see ”Modifying Table Properties” on
page 535.

Modifying Table Properties
To modify a table’s properties, follow these steps.
1. Click inside the table.
2. Right click the mouse.
3. Click Set Table Properties.
4. The Table Wizard dialog appears.

The dialog has four tabs, described below.
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Tab

Description

For more information, see

Table Design

Lets you

“Choosing the Number of Rows
and Columns” on page 538

Table Properties

Cell Properties

•

adjust the number or row and columns

•

span rows or columns (that is, two or
more adjacent cells are merged)

Lets you set the table’s

•

width

•
•
•
•
•
•
•
•

height

”Specifying Table Width” on
page 540
”Table Backgrounds” on
page 546

background color

”Specifying Horizontal
Alignment” on page 544

background image
alignment

”Setting Cell Padding and
Spacing” on page 568

cell spacing and padding

”Setting Table Borders” on
page 551

Id
css class
border

Lets you set the selected cells’

•
•
•
•
•
•
•
•

”Spanning Rows or Columns”
on page 562

alignment

”Aligning Text Within a Cell” on
page 564

background color

”Specifying a Cell’s Background
Color” on page 560

background image

”Specifying a Background
Image for a Cell” on page 561

height and width
ID

”Specifying a Cell’s Background
Color” on page 560

css class

“Spanning More than One Row
or Column” on page 563

abbreviation
categories
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Tab

Description

For more information, see

Accessibility

Lets you assign accessibility information
for the table.

”Section 508 Tables” on
page 570

•
•
•
•
•

heading rows caption
heading columns caption
caption alignment
caption
summary

Deleting a Table
To delete a table, follow these steps
1. Move the cursor over the table until the cursor becomes a fourheaded arrow (

).

2. Click the mouse button. The table becomes selected (small
squares appear around it).

3. Press <Delete>.

Inserting a Table within a Table
You can insert a table within a table. You might want to do this to
arrange text in columns.
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NOTE

HTML does not let you use tabs or spaces to align text in columns. You must use
a table to align columns. You can remove the table’s border, so that no lines
appear between the columns and rows.

To insert a table within a table, follow these steps.
1. Place the cursor in the cell into which you want to insert a table.
2. Click the Insert Table button (

).

3. Drag the cursor over rows and column to indicate the size of
the table.
4. Click the mouse.

Choosing the Number of Rows and Columns
Use the Table Design tab of the Table Properties box to change
the number of rows or columns in a table.

Ektron CMS40 0.NET User Manua l, Version 7.5

538

Working with Tables

Alternatively, place the cursor within the table then add or remove
columns relative to that cell. See ”Adding or Removing Rows and
Columns” on page 539.

Adding or Removing Rows and Columns
To add or remove table rows and columns, follow these steps.
NOTE

You can also adjust the number of rows and columns using the Table Wizard. See
Also: ”Creating a Table Using the Table Wizard” on page 533.

1. Place the cursor in the cell from which you want to add or
delete rows or columns.
2. Right click the mouse. A menu appears.
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Menu options relating to adding/removing rows or columns are
highlighted below.

3. Click the appropriate menu option. For example, to add a row
above the current cursor location, click Insert Row Above.
NOTE

These options are also available on the toolbar.

Specifying Table Width
After you create a table, you can set its width by specifying one of
the following:

• percentage of the window: the table’s width varies as a user
adjusts the browser size

• fixed number of pixels, the table’s width stays the same as a
user adjusts the browser size
You can also not set a width but instead let information you enter
into the table’s cells determine its width.
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NOTE

To set the width of a column, adjust the width of one of the cells within the column
(as described in ”Specifying the Height and Width of a Cell” on page 558). Usually,
this change affects the other cells in the column.

Specifying Table Width by Percentage
Specify table width and height by percentage if you want the table
to be resized as the user resizes the browser.
NOTE

In order for the table to resize with the browser, the Word Wrap attribute must be
turned on in all table cells. For details, see “Word Wrap” on page 567.

For example, if you specify that a table is 100% wide and high, and
your browser displays 14 inches across when it is maximized, the
table fills the screen (except for the browser border).

If you resize the browser to half the screen, the table will be about
7” wide. You still see both columns, but some of the data is moved
down.
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Setting Table Width or Height by Percentage
To specify table width by percentage, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
5. In the Dimensions section of the Table Properties tab, specify
the percentage at the Width or Height field. Follow the number
with the percent sign (%), as shown below.
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Specifying Table Width or Height by Pixels
Specify table width or height by pixels if you want the table size to
remain the same when a user resizes the browser.
For example, if you specify that a table is 610 pixels wide, and the
user’s browser is set to low resolution (640 x 480 pixels), the table
occupies the full width of the browser when it is maximized.
If the user resizes the browser so that it only occupies the left half
of the screen, only the left half of the table appears. A scroll bar
appears at the bottom of the browser. The user must move the
scroll bar to see the rest of the table.

Setting Table Width by Pixels
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To specify table width or height by pixels, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
5. In the Dimensions section of the Table Properties tab, enter
the number of pixels at the Width or Height field.

Specifying Horizontal Alignment
You can specify your table’s horizontal alignment (left, right, or
center) within the browser.

Alignment

Example

left

right
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Alignment

Example

center

If you specify right or left justify, you can wrap text around the table.
To do this, move the cursor to the right or left of the table and begin
typing.

To specify table alignment, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
5. Specify table alignment at the Alignment field.
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Table Backgrounds
You can specify a background color or image for your table.

• ”Deleting a Table’s Background Color” on page 548
• ”Specifying a Table’s Background Image” on page 549

Specifying a Table’s Background Color
You can assign a background color to a table to give it more visual
appeal. Here is an example.

To assign a background color to your table, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
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3. Select Set Table Properties.
4. Click the Table Properties tab.
5. Click the Background dropdown list.

6. A selection of colors appears. Click a color for the table’s
background.
From the dropdown, you can add custom colors by selecting a
color patch or entering a color’s hex value. Follow these steps to
get help on how to use the color box.
1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor.
3. Drag the question mark to the area of the dialog box that you
want to learn about.
4. Click the mouse button. A box appears with instructions for that
area.

Deleting a Table’s Background Color
To delete a table’s background color, click the Background
dropdown list on the Table Properties tab of the Table Wizard.
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Then, click the top left choice (circled above).

Specifying a Table’s Background Image
You can specify a background image for your table. Here is an
example.

Note that when you apply a background image to a table

• if the table is larger than the image, the image repeats until it
fills the table.

• if the image is larger than the table, the top left corner of the
image aligns with the top left corner of the table. The rest of the
image fills as much of the table as possible.

• you can also apply an image to individual cells (see “Specifying
a Background Image for a Cell” on page 752).

• make sure the image does not obscure the table’s legibility
See Steps for Inserting a Table’s Background Image
To insert a table background image, follow these steps.
1. Place the cursor within the table.
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2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
5. In the Background Image field, click the ellipsis button (
)
to open the Library. From there, select an image for the table’s
background. See Also: ”Library Folder” on page 131

6. Click Update.

Deleting a Background Image
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
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5. Select the value in the Background Image field.
6. Press <Delete>.
7. Click OK.

Setting Table Borders
A table border consists of the lines that separate a table’s cells
form each other, and the table from the rest of your Web page.
There are two types of table borders.

Border
type

Used by this
type of user

internal

content author

external

site visitor

Illustration

Assigning an Internal Table Border
A table’s internal border is either on or off. You cannot specify other
attributes.
To turn a table’s internal border off or on, follow these steps.

NOTE

If the table’s border is on, these steps turn it off. If it is off, they turn it on.

1. Place the cursor inside the table.
2. Right click the mouse.
3. Click Show/Hide border.

Assigning External Table Border Attributes
You can modify these external border attributes
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• color - see ”Assigning Table Border Color” on page 552
• size (thickness) - see ”Assigning Border Size” on page 553
• line selection - see ”Determining Which Table Border Lines
Appear” on page 554

Assigning Table Border Color
This section explains how to change the color of a table’s border
(see example below).

To assign the color of your table’s border, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
5. Click the Border Color drop down (circled below).

6. A color selection box appears. Click a color to apply to the
table’s border.
Follow these steps to get help on how to use the color box.
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1. Click the question mark in the top right corner.

2. A large question mark appears next to your cursor.
3. Drag the question mark to the area of the dialog box that you
want to learn about.
4. Click the mouse button. A box appears with instructions for that
area.

Assigning Border Size
You can also adjust the size of a table border. Size is measured in
pixels.
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The border size only adjusts a table’s exterior border - it has no
effect on the border between cells.
To assign a border size to your table, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.
5. Enter a number of pixels into the Border field (circled below).

If you set a table’s border size to zero (0) but wish to view
boundary lines while editing, see ”Assigning an Internal Table
Border” on page 551.

Determining Which Table Border Lines Appear
You may want to suppress some table borders. For example, the
table below only shows horizontal lines.

To modify which border lines appear, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Table Properties.
4. Click the Table Properties tab.

Ektron CMS40 0.NET User Manua l, Version 7.5

554

Working with Tables

5. Use the icons within the Border area to indicate which border
lines should appear. Each icon has tooltip text that explains its
function.
NOTE

In order to view the selected borders on the dialog, a border color must be
assigned. See ”Assigning Table Border Color” on page 552.

Note that if a table already has border lines but you want to start
“fresh,” it is a good idea to remove all borders using the icons
indicated below. Then, you can begin adding new ones.
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Working with Ta ble Cells

Along with functions for managing tables (described in
“Introduction to Tables” on page 719 and “Manipulating Your
Table’s Format” on page 730), eWebEdit400 also lets you perform
actions on individual cells within a table.
You can perform the following actions on individual table cells.

• ”Specifying the Height and Width of a Cell” on page 558
• ”Deleting a Cell” on page 559
• ”Specifying a Cell’s Background Color” on page 560
• ”Specifying a Background Image for a Cell” on page 561
• ”Spanning Rows or Columns” on page 562
• ”Aligning Text Within a Cell” on page 564
• ”Splitting a Cell” on page 565
• ”Merging Two Cells” on page 566
• ”Word Wrap” on page 567
• ”Setting Cell Padding and Spacing” on page 568
• “Setting Abbreviation and Category Attributes” on page 572
NOTE

HTML does not allow you to adjust the width of a cell’s border.

You can also select several cells or a row of cells and change them
as described above. However, you cannot select and change a
column of cells.

Selecting Cells to Modify
• ”Modifying a Single Cell” on page 557
• ”Modifying Several Cells” on page 557
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Modifying a Single Cell
If you want to make any of the modifications described in this
section to a single cell, follow these steps.
1. Place the cursor in that cell.
2. Right click the mouse.
3. Select Set Cell Properties from the menu.
4. Make the changes on the Cell Properties dialog.
5. Click Update.

Modifying Several Cells
If you want to make any of the modifications described in this
section to several cells, follow these steps.
NOTE

Most procedures in this section tell you to select Cell Properties from the right
click menu. To perform an action on several cells, select Set Table Properties
from the right click menu, then click the Cell Properties tab.

1. Place the cursor anywhere in the table.
2. Right click the mouse.
3. Select Set Table Properties from the menu.
4. Click the Cell Properties tab.
5. Select the cells that you want to change. Hold down the <Ctrl>
key while selecting.
As you select a cell, its color changes from light to dark gray.
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6. Make changes to fields on the lower part of the Cell Properties
tab. The fields are described later in this section.
7. Click OK.

Specifying the Height and Width of a Cell
As described in “Specifying Table Width” on page 732, there are
several ways to set the width of a table. Within a table, you can
also specify the height and width of an individual cell.
When you set a cell width, there is no guarantee that the cell will
occupy that width when displayed in a browser. This is because the
cell is part of a column, and changes to other cells in the column
can affect the cell whose width you set. Setting cell width only
guarantees that the cell will not be less than the width you specify.
If you want to ensure that a cell’s size does not change, set all cells
in a column to that width.
To specify a cell’s height and width, follow these steps.
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1. Place the cursor in the cell whose height or width you want to
set.
2. Right click the mouse.
3. Click Set Cell Properties from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog appears.

6. Enter the cell width and height in the fields circled above. You
can enter the width in pixels or percentage. These choices are
explained in “Specifying Table Width” on page 540.
7. Click Update.

Deleting a Cell
To delete one or more cells, follow these steps.
1. Move the cursor to the cell you want to delete.
2. Right click the mouse.
3. Click Delete Cell from the menu.
Cells to the right of the deleted cell shift left to occupy the vacant
space. In this example, the cursor was in cell “b” when the user
clicked on Delete Cells.
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Before

After

Specifying a Cell’s Background Color
“Specifying a Table’s Background Color” on page 739 explains how
to apply a background color to a table. You can also apply a
background color to a cell.
To apply a background color to a cell, follow these steps.
1. Move the cursor to the cell.
2. Right click the mouse.
3. Click Set Cell Properties.
4. Click the Background dropdown.
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5. A color selection box appears.
6. Click a color to apply to the cell’s background.

Deleting a Cell’s Background Color
To delete a cell’s background color, click the square in the top left
corner of the Background area (circled below).

Specifying a Background Image for a Cell
“Specifying a Table’s Background Image” on page 549 explains
how to apply a background image to a table. You can also apply a
background image to a cell.
To insert an image into a cell, follow these steps.
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Cell Properties.
4. In the Background Image field, click the ellipsis button (
)
to open the Library. From there, select an image for the cell’s
background. See Also: ”Library Folder” on page 131
5. Click Update.
Note that when you apply a background image to a cell

• If the cell is larger than the image, the image repeats until it fills
the cell.

• If the cell is smaller than the image, the top left corner of the
image appears in the top left corner of the cell. The rest of the
image fills as much of the cell as possible.

• Make sure the image does not obscure a user’s ability to read
the cell text (if any exists).
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Deleting a Background Image
1. Place the cursor within the table.
2. Right click the mouse.
3. Select Set Cell Properties.
4. Delete the value in the Background Image field.
5. Click Update.

Spanning Rows or Columns
You can create a table cell that stretches across more than one
row or column. In the following table, notice how the “Sports
Teams” row spans three columns.

Sports Teams
City

Baseball Team

Hockey Team

Boston

Red Sox

Bruins

New York

Yankees

Rangers

Chicago

White Sox

Black Hawks

You can also create a column that spans several rows, as
illustrated below. Notice that Boston spans three rows.

Colleges
City

Name

Boston

Boston College
Northeastern University
Boston University
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Colleges
City

Name

New York

Columbia University

Spanning More than One Row or Column
To have a table cell span more than one row or column, follow
these steps.
1. Place the cursor in the cell that will span rows or columns.
2. Right click the mouse.
3. Click Merge Cells Horizontally or Merge Cells Vertically
from the menu.

• Merge Cells Horizontally merges the cell in which the cursor
resides with the cell to its right.

• Merge Cells Vertically merges the cell in which the cursor
resides with the cell below.
NOTE

You can also merge cells on the Table Design tab of the Table Wizard.
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Effect of Spanning a Cell
When you set a cell to span rows or columns, eWebEdit400 does
not remove the cells that are in the way. Instead, it moves those
cells across or down to the next available position.
For example, the following table has two rows and two columns.

If you set cell A to span two rows, note that cell C moves across to
make room for cell A. This action pushes cell D to the next column.

Aligning Text Within a Cell
Within a cell, you can specify how your text aligns horizontally and
vertically.
You have nine choices for specifying the horizontal and vertical
alignment of a cell, illustrated below.
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To set cell alignment, follow these steps.
1. Place the cursor in the cell that you want to edit.
2. Right click the mouse.
3. Click Set Cell Properties.
4. The Cell Properties dialog appears.
5. Click the down arrow to the right of Content Alignment.

6. Click your alignment choice.
7. Click Update.

Splitting a Cell
You can divide a cell into two. If you split a cell, each cell occupies
one half the size of the original cell.
Row before split

Row after split
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To split a table cell into two cells, follow these steps.
1. Place the cursor in the cell that you want to split.
2. Right click the mouse.
3. Click Split Cell from the menu.

4. Two cells now appear where only one appeared before.

Merging Two Cells
You can merge two cells into one. If you merge two cells, the new
cell contains all of the information from both. The new cell’s width
or height equals the sum of the two cells that were merged.
Cells Before Merge

Cell After Merge
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The above example shows a horizontal merge. You can also
merge cells vertically.
To merge two or more cells, follow these steps.
1. Place the cursor in the left or upper cell.
2. Right click the mouse.
3. Click Merge Cells Horizontally or Merge Cells Vertically.

Word Wrap
Word Wrap is a text formatting feature of cells. It causes text to
move down to the next line when the width of the characters on a
line equals the column width. For example, if you set column width
to 50%, with word wrap turned on, a table looks like this.

If you turn Word Wrap off for the same table, you get this result.

If Word Wrap is turned off, text stays on one line until the user
entering table text presses <Enter>. That keystroke causes text to
move down to the next line.
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By default, all cells have the Word Wrap feature turned on.

Turning Word Wrap On and Off
To turn Word Wrap on or off for a cell, follow these steps.
1. Place the cursor in the cell that you want to edit.
2. Right click the mouse.
3. Click Set Cell Properties.
4. The Cell Properties dialog box appears.
5. To turn off Word Wrap, click the No Wrapping checkbox.

6. Click Update.

Setting Cell Padding and Spacing
Cell padding is the space between a cell’s data and its border.

Cell spacing is the space between a cell and surrounding cells.
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Assigning Cell Padding and Spacing
To assign cell padding and spacing to your table, follow these
steps.
1. Place the cursor in the table.
2. Right click the mouse.
3. Click Set Table Properties.
4. The Table Properties dialog appears.
5. Click the Table Properties tab.
6. In the Cell Padding and Cell Spacing fields, enter the number
of pixels.

7. Click Update.
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Section 508 Tables
You can apply the following information to any table to make it 508
compliant. Narrative software uses the information from the
Accessibility table fields (heading rows, columns, caption
alignment and summary) to produce a Tooltip message for each
table cell. Users with impaired vision can see those Tooltips as
they hover over the cells.

Information

Where applied

For more information, see

Heading Rows

Accessibility dialog

”Accessibility Dialog” on
page 571

Heading Columns

Accessibility dialog

”Accessibility Dialog” on
page 571

Summary

Accessibility dialog

”Accessibility Dialog” on
page 571

Caption

Accessibility dialog

”Accessibility Dialog” on
page 571

Horizontal Caption
Alignment

Accessibility dialog

”Accessibility Dialog” on
page 571

Vertical Caption
Alignment

Accessibility dialog

”Accessibility Dialog” on
page 571

Abbreviation

Cell properties dialog

”Accessibility Fields on Cell
Properties Dialog” on page 573

Categories

Cell properties dialog

”Accessibility Fields on Cell
Properties Dialog” on page 573

To create a 508 compliant table, follow these steps.
1. Create a new table or edit an existing one, as explained in
“Creating a Table” on page 531.
2. Place the cursor inside the table.
3. Right click the mouse.
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4. Click Set Table Properties.
5. The Table Properties dialog appears.
6. Click the Accessibility tab.

• ”Accessibility Dialog” on page 571
• ”Setting Abbreviation and Category Attributes” on page 572

Accessibility Dialog
The fields on the tab are described below.

Field

Description

Heading
Rows

If you want your table to have a horizontal header, enter the number
of rows that it should occupy. The number cannot exceed five.
Beginning with the top, all cells in the specified number of rows are
designated as table headers.
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Field

Description

Heading
Columns

If you want your table to have a header, enter the number of columns
that it should occupy. The number cannot exceed three.
Beginning with the left column, all cells in the specified number of
columns are designated as table headers.

Caption
Alignment

To choose the caption’s alignment, click the down arrow next to this
field as shown below.

Select the box that represents the alignment style you want.
Caption

If desired, enter the table caption. The caption appears below the
table when viewed.

Summary

If desired, enter the table summary. Non-visual browsers use the
summary to explain the table’s contents.
From http://www.w3.org/TR/WCAG10-HTML-TECHS/#data-tables
“A summary of the relationships among cells is especially important
for tables with nested headings, cells that span multiple columns or
rows, or other relationships that may not be obvious from analyzing
the structure of the table but that may be apparent in a visual
rendering of the table. A summary may also describe how the table
fits into the context of the current document. If no caption is provided,
it is even more critical to provide a summary.”

Associate
Cells with
Headers

Check this box if you want to associate the table’s data cells with the
appropriate headers. See Also: http://www.w3.org/TR/WCAG20TECHS/H43.html

After you complete the Table Properties dialog, click OK to make
the table Section 508 compliant.

Setting Abbreviation and Category Attributes
You can modify abbreviation (ABBR) and category (AXIS)
attributes within a table. To do so, follow these steps.
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1. Select one or more cells.
2. RIght click the mouse.
3. Select Set Cell Properties.
4. The Cell Properties dialog appears. It includes the
Abbreviation and Categories fields (see illustration below).

The following explains how to respond to these fields.

Accessibility Fields on Cell Properties Dialog

Field

Description

Abbreviation

Sets or retrieves abbreviated text for the content in the tag. Can be
used to render non-visual media, such as speech or Braille.
For more information, see http://msdn2.microsoft.com/en-us/

library/ms533058.aspx
Categories

Sets or retrieves a comma-delimited list of conceptual categories
associated with that tag. Can be used to render non-visual media,
such as speech or Braille.
For more information, see http://msdn2.microsoft.com/en-us/library/
ms533489.aspx
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NOTE

This section explains how to create/edit HTML forms using eWebEdit400. If your
editor is eWebEditPro+XML, see ”Working with HTML Forms” on page 156.

Ektron CMS400.NET provides powerful online form capabilities,

allowing you to create an online dialog with visitors. Now anyone in
your organization – not just a developer or Webmaster– can create
and deploy Web forms to capture visitor information. Support
marketing strategies by getting feedback on their needs. Follow up
on their interest in your products and services. Register people for
events.
Form capabilities include

• Creating a form and its postback message
• Creating polls and surveys
• Adding validation criteria to form fields
• Automatically assigning tasks for follow-up activities to form
submissions

• Reporting on form information
• Exporting results to Microsoft Excel
A sample form appears below. Toolbar buttons for working with
forms are circled.
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This chapter explains how to perform all form actions through the
following topics.

• ”Overview of Form Processing” on page 576
• ”The Structure of Form Data” on page 576
• ”Creating a New Form” on page 576
• ”Creating a Form’s Content” on page 585
• ”Form Validation” on page 590
• ”Form Fields” on page 590
• ”Implementing a Form on a Web Page” on page 615
• ”Assigning a Task to a Form” on page 615
• ”Viewing Form Reports” on page 618
• ”Viewing Form Information” on page 618
• ”Editing a Form” on page 618
• ”Deleting a Form” on page 618
• ”View Form Toolbar” on page 618
• ”Creating Polls and Surveys” on page 618
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Overview of Form Processing
Step

For more information, see

1.

Create a form

”Creating a New Form” on page 576

2.

Assign it to a Web page

”Implementing a Form on a Web Page” on page 615

3.

Site visitor goes to your Web site
and completes form. Form is mailed
to an email address, saved to a
database, or both.

4.

View submitted form data and
download it to a spreadsheet.

”Viewing Form Reports” on page 618

The Structure of Form Data
A form has the following components.

• Form (title, ID number, whether the form data is sent as email,
and/or saved to a database, etc.)

• Content information (title, start and/or end date, status,
postback message, etc.)

• Form fields (text field, password field, text area, hidden text,
choices, checkbox, select list, calendar, submit button, etc.)

Creating a New Form
The screen you use to create a form follows five simple steps. After
completing the steps, you have a new form that’s ready to collect
the information you need. To make the task easier, Ektron
CMS400.NET provides sample forms that you can start with then
customize.
As explained in ”Mailto or Database Form” on page 211, form data
can be emailed and/or saved to a database. Forms created using
the procedure described below are saved to a database by default,
but not emailed. To change either setting, use the Edit Properties
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screen. See ”Viewing and Editing a Form’s Properties” on
page 205.
To create a new form, follow these steps.
NOTE

You can also create a new edition of a form in another language by copying an
existing form and translating it. For more information, see ”Translating Content”
on page 818.

NOTE

For the steps to create a new poll, see ”Working With Polls” on page 619. For the
steps to create a new survey, see ”Creating a Survey” on page 624.

1. Consult with your Ektron CMS400.NET administrator about the
folders in which you should create forms. See Also: Ektron
CMS400.NET Administrator Manual section “Managing HTML
Forms” > “Forms Must Use Template with FormBlock Server
Control”
2. From the View menu, click Language, and select the language
in which to create the form.
3. Click the New menu > HTML Form/Survey.
4. The New Form screen appears.

NOTE

When you choose Standard Poll or Blank Survey, the number of steps in the
Forms Wizard changes from five to four. This happens because the Assign Tasks
step is removed. See Also: ”Working With Polls” on page 619 and ”Creating a
Survey” on page 624.
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5. Choose the form that you want to begin with. You can click the
preview icon ( ) next to any sample form to see it before
choosing it.
Select a sample that most closely matches the form you want
to create. After you create it, you can add fields, remove fields,
modify possible responses, etc.
6. Click Next.
7. Enter or edit the form’s Title and Description.

•Title - used to reference the form within the Workarea
(required)

•Description - an extended description of the form
8. The next screen lets you assign a task to a user or user group.
If you do, a task will be created every time a site visitor submits
this form. See Also: ”Assigning a Task to a Form” on page 615
9. A new screen lets you determine what happens after the site
visitor completes the form. The choices are:

•Display a message - See ”Composing the Postback
Message” on page 579

•Redirect to a file or page - Identify a file or a page on your
Web site that is launched when the visitor completes the
form.

- An example of a file is a white paper (a common file
format is .PDF) that a visitor requested

- An example of a page is one that prompts the visitor to
download your product

•Redirect to form data to an action page - See ”Redirect to
an Action Page and Forwarding Form Data” on page 580

•Report on the form - See ”Making Form Results Available to
Site Users” on page 582
10. Now that you have completed information about the form, you
can enter the form’s content. This procedure is described in
”Creating a Form’s Content” on page 585.
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Composing the Postback Message
The postback message can contain text or graphics, just like any
other HTML content. Typically, it acknowledges a site visitor’s
completion of the form.
For most sample forms provided, sample text appears in the editor.
Modify it as you wish, using Ektron CMS400.NET’s editor to change
the style sheet class, insert library items, etc.

Inserting Fields into the Postback Message
You can also insert fields into the Postback Message that retrieve
form information.For example, your postback message may be
Thank you «Full Name» for completing the «[Form Title]».

When the postback message appears, it looks like this.
Thank you Jay Kohler for completing the breakroom survey.

When you click the Post back message tab and select Display a
message, the Merge Field button ( ) appears on the toolbar.

When you click that button, a dialog like the one below appears.

Ektron CMS40 0.NET User Manua l, Version 7.5

579

Working with HTML Forms

All form fields appear on the list. In addition, the list includes the
following fields, which can retrieve form information into the
postback message.

• Form title
• Form description
• Date submitted

Redirect to an Action Page and Forwarding Form Data
The following section of the Ektron CMS400.NET Administrator
Manual explains how your administrator sets up the action page:
“Working with HTML Forms“> “Redirecting Submitted Form Data”.
After your administrator follows that procedure, he identifies a
folder and hyperlink that you use to select an action page.
WARNING!

You must have the folder and hyperlink name from your administrator to complete
this procedure.

To redirect submitted form data to an action page, follow these
steps.
1. Go to the page on which you determine the form’s response. If
this is a new form, it is page 3 of the Forms Wizard.
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To modify an existing form, select the form’s folder, then the
form. Next, select Edit and click the Post back message tab.
2. Select Redirect form data to an action page.

3. Click the icon next to File or page.
4. The Hyperlink Manager dialog appears. Click the URL button.
5. The library appears. In the left panel, select the folder that
contains the hyperlink.
6. In the right panel, select Hyperlinks from the file type
dropdown.
7. Select the hyperlink whose name was given to you by your
system administrator.
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8. Click the insert button (

).

Making Form Results Available to Site Users
When you create polls and surveys, you can choose to display the
results after a site visitors completes the form. The results can
display in the same window or a new window. In addition, you can
choose how to chart the data. For a description of chart types, see
”Chart Types” on page 584.
To show site visitors poll/survey results, follow these steps.
1. Go to the page on which you determine the form’s response. If
this is a new form, it is page 4 of the Forms Wizard.
To modify an existing form, select the form’s folder, then the
form. Next, select Edit and click the Post Back Message tab.
2. Select Report on the form.
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3. Choose whether you want the results to appear in the Same
Window or a New Window.
4. Choose the style of the report.
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Chart Types
The following table describes the types of charts available.
Chart Type

Description

Data Table

The poll or survey
answers are
displayed with the
percentage of users
who responded to
each item.

Bar Chart

The poll or survey
answers are
displayed with a bar
graph. Use this chart
type when you want
a quick visual
representation of the
responses.

Pie Chart

Displays a standard
pie chart. Poll or
survey answers are
color coded, and the
percentage of
people who chose
each answer is
shown.

Sample
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Chart Type

Description

Combined

Combines the Data
Table and the Bar
Chart.

IMPORTANT!

Sample

You cannot chart data entered into a text box. For example, if one choice in a poll
is Other, and the survey has a text box for site users to enter additional
information, the text in the box is not charted. However, the fact that a user chose
Other is charted.

Creating a Form’s Content
Here is an example of form content that you can create.
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Note that some fields are required, and some provide a dropdown
list of choices. You can learn how to create such a form by
following the directions below.
The following topics explain how to create a form.

• ”The Form Toolbar Options” on page 587
• ”Form Validation” on page 590
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The Form Toolbar Options
Creating form content is similar to creating standard content. (See
”Adding HTML Content” on page 74). The big difference is a form
toolbar (illustrated below), which lets you insert form elements.

When using the form toolbar, place the cursor where you want
field. Then, click the appropriate toolbar button.

Adding a Field to the Screen
The final screen of the Forms setup lets you arrange a form that
collects exactly the information you want. To create the form, insert
fields that prompt a site visitor to enter information. Then, add a
button that enables the user to submit data.
If you chose a sample form at the beginning of the Forms Wizard,
the form includes fields. If you did not, the screen has only a
Submit button.
TIP!

In addition to inserting fields, you can add explanatory text, lines, images, etc. to
the form. To lay out fields in columns, insert a table and place the fields within
table cells.

The table below explains each field type you can enter.

Button

Inserts this
kind of field

Description

For more information, see

Checkbox

User’s response is either checked or
unchecked

”Inserting a Checkbox Field” on
page 591

Text

Free text field; user cannot format
text

”Inserting a Text Field” on page 592

Choices

Several choices appear on screen.
User checks any number of
appropriate responses.

”Inserting a Choices Field” on
page 605

Calendar

Lets user insert a date by clicking a
calendar

”Inserting a Calendar Field” on
page 609
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Button

Inserts this
kind of field

Description

For more information, see

Insert Button

Button with no text. You can easily
add text to it.

”Inserting or Editing Buttons on the
Form” on page 612

When a site visitor completing the
form presses this button, the data on
the screen is submitted to your Web
server.
Insert Reset

Button with Reset as its text. When a
site visitor completing the form
presses this button, the form’s field
values are set to their state when the
form first loaded.

”Inserting or Editing Buttons on the
Form” on page 612

Insert Submit

Button with Submit as its text.

”Inserting or Editing Buttons on the
Form” on page 612

When a site visitor completing the
form presses this button, the data on
this screen is submitted to your Web
server.

After you complete the form, you have the following options.
Button or Tab

Description

Postback Message

See ”Composing the Postback Message” on page 579

Metadata

Edit the metadata for the form. See Also: ”Adding or Editing
Metadata” on page 77

Schedule

Assign start or end dates, or both, for when the form is published
to Web site See Also: ”Scheduling Content to Begin and End” on
page 65

Comment

Enter history comment to indicate changes made to the form

Templates

The template assigned to the form.
Technical note: HTML forms must reside in a folder whose
template uses the FormBlock server control.
See Also: Ek tr on CMS 400 .NET Administrator Manual section
“Creating/Updating Templates”
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Button or Tab

Description

Category

Any taxonomy categories assigned to the content. See Also:
Ek tron CM S40 0.NET Administrator Manual section “Taxonomy”

Web Alerts

Assign or update Web Alert information for the form. See the
Ek tron CM S40 0.NET Administrator Manual chapter “Web Alert
Feature””Web Alert Feature” on page 931.
Submit content into approval process.

Submit
Publish content to Web site.
Publish

Note: If the content has any active tasks, a comments window
pops up. You can insert comments to describe how approving or
declining the content affects the task.
Note: Only the last approver in the approval chain sees this button.

Check In

Save and check-in content. This button does not submit the
content into the approval process, but rather lets other users
change it.
Save the content without submitting it into the approval process.

Save

Decline

If a user clicks save and then closes the editor, other users cannot
edit the content.
This button appears if you are the next approver in the approval
list. Click it to decline the changes made to the content.
Note: If content has any active tasks, a comments window pops
up. You can insert comments to describe how approving or
declining the content affects the task.
Close the editor without saving changes.

Cancel

Next, click the Save and Submit or Publish button (
only appears on your Web site after it is published.

). The form

After you complete and save the form, it may need to go through
the approval process. When that is complete, add it to the site by
assigning it to a page template. See ”Implementing a Form on a
Web Page” on page 615.
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Form Validation
You can apply validation rules to text or calendar field types.
Validation rules ensure that the information entered by site visitors
meets your criteria. For example, a validation rule specifies that a
response to the Telephone field is 10 digits. If the response does
not conform, an error message indicates the problem. The input
must conform before the form can be submitted.
For a list of validation rule types, see ”Validation Options” on
page 596.

When Validation Rules are Applied
Validation rules are applied when a site visitor submits an entire
form, not when the input is entered. If an invalid response is found,
the error message that you define appears.
The site visitor must change his response to conform to the
validation rule. When he does, the next field is checked and, if that
is invalid, its error message appears, etc.
TIP!

If you apply validation rules to more than one field, include the field name in the
error message. For example, enter The name field only allows text.
This is good practice because error messages only appear after a form is
submitted. If the message does not identify the field, the user may not know which
field needs correction.

Form Fields
You can insert the following types of fields onto an HTML form.

• ”Inserting a Checkbox Field” on page 591
• ”Inserting a Text Field” on page 592
• ”Inserting a Choices Field” on page 605
• ”Inserting a Calendar Field” on page 609
See Also: ”Inserting or Editing Buttons on the Form” on page 612
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Inserting a Checkbox Field
A Checkbox field is one character wide and accepts one of two
possible values: checked or unchecked. For example

To insert a checkbox field, follow these steps.
1. Place the cursor where you want the check box field to appear.
2. Click the Checkbox field button (

).

3. The following dialog appears.

Fields on the Checkbox Dialog

Field

Description

Descriptive
Name

Enter a descriptive name for this checkbox.
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Field

Description

Field Name

Enter a name for this checkbox. This text identifies the field in the
database and in email (if the form is mailed).
Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are
replaced by underscores.

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this
field (circled in red below).

Default
value

If you want this field to be checked when the screen first appears,
click True. Otherwise, click False.
A site visitor can change the default value while completing the
screen.

Caption

Enter text to guide the user’s response to this field. The caption
appears on the screen to the right of the checkbox.
To continue the above example, the caption would be Check if you
are over 65.

Inserting a Text Field
Use a text field when you want the user to enter a free text
response, or to display text on the screen. There are many
variations you can apply to such a field, such as

• a default value
• text can be read-only or hidden
• the field can expand to accommodate user input
• validation, requiring user input to meet criteria such as a nonnegative whole number or a zip code
To insert a text field, follow these steps.
1. Enter a field label. For example, Name.
2. Place the cursor where you want the text field to appear.
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3. Click the Text field button (

).

4. The following dialog appears.

Fields on the Text Field Dialog - General Tab
NOTE

If you are using FireFox, you cannot enter text into a text field while creating or
editing the form. If you need to prefill a text field with text, use the field’s Default
Value property.

Field

Description

Descriptive Name

Enter a description of the field. This text describes the field on form
reports. See ”Viewing Form Reports” on page 618.

Field Name

Enter a name for this field. This text identifies the field in the
database and in email if the form is mailed.
Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are
replaced by underscores.
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Field

Description

Tool Tip Text

Enter text that appears if a site visitor hovers the cursor over this field
(circled in red below).

Default value

If you want to set a default value for this field, enter it here. For
example, if this field collects a city, and most users enter New York,
enter New York as the value.
A site visitor can change the default value while completing the
screen.

Allow multiple lines

Check this box if you want this field to scroll vertically to allow the
person completing the form to enter as much text as needed.
Note: This setting cannot be applied if this is a Password field.

Cannot be changed

Check this box to prevent the person completing this field from
changing its content. For example, you want to display a license
agreement.
Below this field, you might place a check box prompting the site
visitor to check it to indicate he has read the agreement.
As another example, you could provide instructions for completing
the screen.

Invisible

Check to make this field hidden. This option lets you store unseen
information in each document. An example might be putting a
version number on the form.
If you apply this property to a form, the Allow multiple lines and
Cannot be changed fields are automatically checked and cannot be
unchecked. Also, the Validation tab is disabled.

Password field

Use a password field when you want the user to enter a password. A
password is like a text field but the user’s entry is disguised. This
prevents an onlooker from seeing the password.

Passwords cannot exceed 18 characters.

Learn About Fields on the Text Field Dialog - Validation Tab
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Fields on the Text Field Dialog - Validation Tab

Field

Description

Validation

Select the kind of validation to apply to this field. See ”Validation
Options” on page 596
Your system administrator determines whether a user can save an
invalid document.

Message

Enter text that appears on the screen if a site visitor‘s response
violates the validation criterion. For example, if the validation
criterion is telephone number, the error message could be Please
enter 7 or 10 digits. It would appear if the user entered, for
example, S061882.
By default, the error message matches the selected validation
criterion. Use this field to customize the text.
Note: You can only enter double-byte characters if your Windows
settings include that language. If you enter characters that are not in
a language defined in your Windows settings, question marks (?)
appear instead of the characters.
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Field

Description

Custom
Validation

See ”Custom Validation” on page 599

Validation Options
NOTE

Your Web developer can customize validation options. For details, see the
Ektron CMS400.NET Developer’s Guide section “Customizing Validation.”
However, the file that maintains custom validation is different for HTML forms: it is
siteroot/workarea/ContentDesigner/ValidateSpace.xml.

Option

Characteristics of Valid Response

No validation

Response is not checked.

Cannot be blank

Response is required. The format of the response
is not checked.

Allow Maximum of
1000 characters

Response cannot exceed 1000 characters. (Only
available if text field is set to Allow Multiple
lines.)

Minimum of 8
characters with at
least one digit

Site visitor’s entry must be at least 8 characters
and include one digit. (Only available if text field is
set to Password field.)

Non-negative
whole number or
blank

A positive whole number or no response.

Non-negative
whole number
(required)

A positive whole number must be entered.
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Option

Characteristics of Valid Response

Decimal number
or blank

A decimal number (for example, 12.345 or 12) or
blank. A leading minus sign “-” is allowed. The
decimal point must be a period (.), even in locales
that normally use a comma (,).

Used with
text field

Used with
calendar
field

Note: Decimal numbers include whole numbers
because the decimal point is implied. That is, 12 is
12.0000.
Decimal number
required

A decimal number (it cannot be blank) of none,
one, or two decimal places.
A leading minus sign “-” is allowed. The decimal
point must be period (.), even in locales that
normally use a comma (,).
Note: Decimal numbers include whole numbers
because the decimal point is implied. That is, 12 is
12.0000.

Percent: (0-100)
required

A whole number from 0 to 100. A response is
required.

email address

a@a, where a is one or more characters.

email address
required

a@a, where a is one or more characters. A
response is required.

email address list

Several email addresses. Each address’s format
is a@a, where a is one or more characters. The
user must separate each address with a
semicolon (;).

email address list
required

Several email addresses. Each address’s format
is a@a, where a is one or more characters. The
user must separate each address with a
semicolon (;). A response is required.

Zip code (US)

5 (nnnnn) or 9 digits. If 9, a dash appears after the
fifth (nnnnn-nnnn).

Zip code (US)
required

5 (nnnnn) or 9 digits. If 9, a dash appears after the
fifth (nnnnn-nnnn). A response is required.
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Option

Characteristics of Valid Response

Social Security
(US)

Nine digits in this pattern: nnn-nn-nnnn.

Social Security
(US) required

Nine digits in this pattern: nnn-nn-nnnn. A
response is required.

Postal Code
(Canada)

ana nan, where a is an alphabetic character and n
is numeric.

Postal Code
(Canada) (required)

ana nan, where a is an alphabetic character and n
is numeric. A response is required.

Social Insurance
Number (Canada)

A nine digit number in the format: nnnnnnnnn.

Social Insurance
Number (Canada)
Required

A nine digit number in the format: nnnnnnnnn. A
response is required.

Telephone
number (US and
Canada)

A seven or 10 digit number in the format nnnnnnn
or nnnnnnnnnn.

Telephone
number (US and
Canada)
(required)

A seven or 10 digit number in the format nnnnnnn
or nnnnnnnnnn.

Used with
text field

Used with
calendar
field

The site visitor can insert separator characters,
such as dashes (-), between numbers.

The site visitor can insert separator characters,
such as dashes (-), between numbers.
A response is required.

URL

A web site address.
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Option

Characteristics of Valid Response

ISBN

The International Standard Book Number (ISBN)
is a 10-digit number that uniquely identifies books
and book-like products published internationally.
Every ISBN consists of ten digits. When printed,
the ISBN number is preceded by the letters ISBN.
The ten-digit number is divided into four parts of
variable length, each part separated by a hyphen.

Used with
text field

Used with
calendar
field

The four parts of an ISBN are:

•

Group or country identifier - identifies a
national or geographic grouping of publishers

•

Publisher identifier - identifies a particular
publisher within a group

•

Title identifier - identifies a particular title or
edition of a title

•

Check digit - the single digit at the end of the
ISBN which validates it

(Above copied from www.isbn.org.)
ISSN

The ISSN (International Standard Serial Number)
is an eight-digit number which identifies periodical
publications as such, including electronic serials.
The ISSN takes the form of the acronym ISSN
followed by two groups of four digits, separated by
a hyphen. The eighth character is a control digit
calculated according to a modulo 11 algorithm on
the basis of the 7 preceding digits; this eighth
control character may be an “X” if the result of the
computing is equal to “10”, in order to avoid
ambiguity.
(Above copied from www.issn.org.)

Custom Validation
The Text and Calendar field dialog’s Validation tab features a
validation area (illustrated below).
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The validation feature can ensure the following aspects user input.

• The data type - the default types are
- text
- URL
- whole number
- decimal number
- floating point number (Floating point includes scientific
notation, so is appropriate for scientific numbers. Decimals
usually suffice for business numbers.)

- date (calendars only)
• The field value has one of the following relationships with
another field, a number, or an expression. The default
expressions are

- between two values (either another field or a number that
you specify)

- less than
- equal to
- not equal to
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- maximum length (usually for text responses)
NOTE

Your Web developer can customize validation options. For details, see the Ektron
CMS400.NET Developer’s Guide section “Customizing Validation.” However, the
file that maintains custom validation is different for HTML forms: it is siteroot/
workarea/ContentDesigner/ValidateSpace.xml.

Your system administrator determines if a user can save the invalid
data.
When the Custom Validation option is selected from the
Validation field, the Custom Validation screen area becomes
active.

• The Data Type field is the value’s basic type, for example, text,
number, or URL.

• The Condition field displays the validation logic.
• The Examples drop-down list shows validation expressions
that you can apply to the field.

Example of Creating Custom Validation
As an example of custom validation, assume that a field collects
telephone numbers, and you want to make sure the user enters 10
digits. To accomplish this, follow these steps.
1. Insert a Text Field.
2. Complete the Text Field dialog’s General tab.
3. Click the Validation tab.
4. In the Validation dropdown list, select (Custom).
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5. In the Data Type field, select Whole Number from the drop
down list. This ensures that the user can only enter digits.

6. Click the down arrow to the right of the Examples field to see
sample logic.
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7. Click Maximum text length... . This option lets you specify the
length of the user’s response.
8. string-length(.) <= {X} appears in the Condition field.
9. Since you want the user’s input to equal 10, remove the less
than sign (<) from the calculation. Now it looks like this: stringlength(.) = {X}.

10. Replace the {X} with 10. Now, it looks like this: stringlength(.) = 10.

11. Move the cursor up to the Message field and compose a
relevant error message. For example: must be 10 digits.
12. Your screen should look like this.
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13. Press OK.

Fields on the Text Field Dialog - Data Style Tab
Click the Data Style tab to apply formatting to a field that accepts
user input. When you do, the following tab appears.
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Use the tab to assign the following formatting attributes to a
response field.

• Font style and size
• Bold and italic
• Text alignment (especially helpful for formatting dollar amounts
in a plain text field)

• Underline or strikethrough
• Font color and/or background color

Inserting a Choices Field
Use a Choices field when you want a site visitor to select from a
predetermined list. You can allow a site visitor to select only one or
more than one choice. You can also determine the list’s items and
appearance.
To insert a choices field, follow these steps.
1. Enter a field label. For example, Country.
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2. Click the Choices field button
the Screen” on page 587

. See Also: ”Adding a Field to

3. The following dialog appears.

Fields on the Choices Dialog

Field

Description

Descriptive
Name

Enter a description of the field.

Field Name

Enter a name for this field. This text identifies the field in the database and in
email if the form is mailed.

This text describes the field on form reports. See ”Viewing Form Reports” on
page 618.

Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are replaced by
underscores.
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Field

Description

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this field
(circled in red below).

List

Custom - You create your own set of choices. Use the Item List area to do
this. See Also: ”Item List” on page 609
Languages - A standard list of languages
Countries - A standard list of countries
U.S States and Territories - A standard list of United States of America
states and territories
Canadian Provinces - A standard list of Canadian provinces
Age Ranges - A standard list of age ranges
Numeric Ranges - A standard list of numeric ranges
Years - A standard list of years
Gender - Male or female
Marital Status - A standard list marital statuses

Allow
Selection

Click More than one to let a site visitor select more than one item for this
field. Otherwise, click Only one to limit the user to one choice.
A selection is required - Check this box if the user must select at least one
item.
First item is not a valid selection - You can use the first list item to prompt
the user to make a selection instead of being a valid response. For example,
the first item may say Select from the list. To do so, check this box.
If you do, the site visitor must choose any selection except the first item. If he
tries to file the screen without choosing a different item, this error message
appears: First item is not a valid selection.
Note: This option is only available if Appearance is set to Drop List.
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Field

Description

Appearance

Click Vertical List to arrange the choices vertically.

Click Horizontal List to arrange the choices horizontally.

Click List Box to display all choices in a box. If more than four choices are
available, the user scrolls to see additional options.

Click Drop List to display all choices in a dropdown list. When the user clicks
the down arrow, all entries appear.
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Field

Description

Item List

This section of the screen displays the list items. It is only editable if the list
type is Custom.
The Context-Sensitive Menu
Buttons to the left of each item (circled below) display a menu. The menu lets
you remove items, rearrange them, and insert additional items anywhere on
the list.

The Selected Box
Place a check in the box of any item to be checked by default on the data
entry screen. If you do, the user can accept the default or uncheck the item by
clicking in the checkbox. Note that if Only One is selected under Allow
selection (above), only one item can be selected.
If the Appearance is set to Drop-Down list, this value is ignored.
Display Text
Enter text to describe this item on the data entry screen.
Value
Enter the value that is collected when the site visitor selects this item.
For example, if Interests appears in the Name field, and you want music to be
collected when the data entry user selects this item and saves the page, enter
music here.
The Disabled Checkbox
Check the box next to any selection that you want to disable. If you do, the
option appears on the form but the user cannot select it.
Option
Click this button to add a row to the bottom of the list.

Inserting a Calendar Field
To insert a field that lets a site visitor select a date, use a Calendar
Field. To do that, follow these steps.
1. Enter a field label. For example, Expiration Date.
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2. Click the Calendar field button (
to the Screen” on page 587

). See Also: ”Adding a Field

3. The following dialog appears.

Respond to the fields on the screen.
See Also:

• ”Fields on the Calendar Field Dialog - General Tab” on
page 610

• ”Fields on the Calendar Field Dialog - Validation Tab” on
page 611

• ”Fields on the Calendar Field Dialog - Data Style Tab” on
page 612

Fields on the Calendar Field Dialog - General Tab

Field

Description

Descriptive
Name

Enter a description of the field.
This text describes the field on form reports. See ”Viewing Form Reports” on
page 618.
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Field

Description

Field Name

Enter a name for this field. This text identifies the field in the database and in
email if the form is mailed.
Note: You cannot enter spaces nor most special characters
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field. If you do, they are replaced by
underscores.

Tool Tip Text

Enter text that appears when a site visitor hovers the cursor over this field
(circled in red below).

Default
value

If you want to set a default date, enter it here. The site visitor can change the
default value while completing the screen.

Validation

Select the kind of validation to apply to this field. The choices are:

Error
Message

•
•

No validation - response is not checked

•

Custom - See ”Custom Validation” on page 599

Cannot be blank - Response is required. The format of the response is
not checked. If you assign Cannot be blank, the field is surrounded by
red dashes when it appears on your Web site.

Enter text that appears if a site visitor‘s response does not satisfy the
validation criterion. For example, if the validation criterion is Cannot be blank,
the error message could be Please enter a response.
By default, the error message is the same as the validation criterion. Use this
field to customize its text.
Note: You can only enter double-byte characters if your Windows settings
include that language. If you enter characters that are not in a language
defined in your Windows settings, question marks (?) appear instead of the
characters.

Fields on the Calendar Field Dialog - Validation Tab
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Field

Description

Descriptive
Name

Enter a description of the field.

Validation

Select the kind of validation to apply to this field. The choices are:

Message

This text describes the field on form reports. See ”Viewing Form Reports” on
page 618.

•
•

No validation - response is not checked

•

Custom - See ”Custom Validation” on page 599

Cannot be blank - Response is required. The format of the response is
not checked. If you assign Cannot be blank, the field is surrounded by
red dashes when it appears on your Web site.

Enter text that appears on the screen if the site visitor‘s response does not
satisfy the validation criterion. For example, if the validation criterion is
Cannot be blank, the error message could be Please enter a response.
By default, the error message is the same as the validation criterion. Use this
field to customize it.
Note: You can only enter double-byte characters if your Windows settings
include that language. If you enter characters that are not in a language
defined in your Windows settings, question marks (?) appear instead of the
characters.

Fields on the Calendar Field Dialog - Data Style Tab
See ”Fields on the Text Field Dialog - Data Style Tab” on page 604

Inserting or Editing Buttons on the Form
A form typically includes one or more buttons, which let a site
visitor submit a completed form.
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eWebEdit400’s form toolbar has three buttons that you can place
on a form (circled below.) The buttons are described below.

Toolbar

Name

Description

Insert

Submits form information to your Web server. By
default, it has no text. To learn how to add button text,
see ”Editing a Button’s Properties” on page 614.

Button

Ektron CMS40 0.NET User Manua l, Version 7.5

613

Working with HTML Forms

Toolbar

Name

Description

Reset

Changes a form’s field values back to their state when
the form first loaded.

Submit

Submits form information to your Web server. Its default
text is Submit.

Button

Editing a Button’s Properties
After you insert a button, you may want to enter or change its
properties, such as its text, height, and width. To edit a button’s
properties, follow these steps.
1. Click the button so that it is selected. A selected button is
surrounded by small squares, as shown below.
2. Below the editor screen, several fields appear, as shown
below.

3. Update the button fields as needed.

Field

Description

Name

Give the button a unique name.

Id

If needed, give the button a unique ID.

Width

Enter or change the button’s width in pixels.

Height

Enter or change the button’s height in pixels.

Value

Enter or change the button text.

Ektron CMS40 0.NET User Manua l, Version 7.5

614

Working with HTML Forms

Field

Description

Tooltip

Enter or change the button’s tooltip (that is, text that
appears in a small window when someone hovers the
mouse over the button).

Classname

Enter or change the style sheet class assigned to the
button.

Implementing a Form on a Web Page
After you create the form, you need to link it to another page on
your Web site. You would insert the link as you would any form link.
See ”Adding a Library File to Content” on page 148
Next, open your Web Site, navigate to the host page, and click the
hyperlink to access the form. Now, you can test the form and make
sure it works as you expected. If needed, you can return to edit
mode, change the form, and test it again until you are happy with it.

Assigning a Task to a Form
While tasks typically help Ektron CMS400.NET users track content
activities, you can also assign a task to users or user groups
whenever a form is submitted.
For example, your Web site offers a free product demonstration to
anyone who completes a form. Whenever a site visitor submits the
form, a task is assigned to your sales department’s administrative
assistant. He uses the information on the form to schedule a
demonstration. The sales manager can review the task history to
audit sales leads and ensure demonstration requests are being
handled in a timely manner.
To set up a task that it is assigned to users or groups whenever a
site visitor completes the form, follow these steps.
Note

You should be familiar with tasks before beginning this procedure. See Also:
”Managing Tasks” on page 286

1. If you are creating a new form, assign the task at Step 3 of the
Forms Wizard.
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If you are editing a form, assign the task on the form’s Edit
Properties screen.
In both cases, you identify only users and groups to whom the
task will be assigned whenever a site visitor completes the
form. Ektron CMS400.NET assigns the remaining task
information.
2. You complete the form and make it available on your Web site.
3. A visitor to your site fills out and submits the form.
4. A task is created and assigned to users and groups you
identified in Step 1.
5. Any Ektron CMS400.NET user can view all tasks created via
form submission in the Smart Desktop. See illustration below.
See Also: ”Understanding the Smart Desktop” on page 17

Ektron CMS400.NET users and administrators can also view and

update tasks assigned to them via the Task screens on the Smart
Desktop. See ”Viewing a Task” on page 300 and ”Viewing a Task’s
History” on page 310.
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Task Information
The task created upon form submission has the following
information.

Field

Value

Title

Form title, as entered by the author

Assigned to

As set up by the user who created or edited the form

Assigned by

User who created or last edited form

Priority

Normal

Task
Category

Form Submission Task Category

Task type

Form Submission Task

Created by

User who created or last edited form

State

Not started

Due date

Not specified

Start date

Not specified

Description

Data from form “form name” was received on date time.
form description
Name of every field on the form: value submitted by
user into that field

email Automatically Generated Upon Form Submission
An email is automatically sent to every user named in Step 1 above
who has a valid email address in the User Information Screen. The
email’s subject line is the form name. The body of the email
contains the following information for each field on the form.
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• name
• value submitted by user

Viewing Form Reports
See ”Viewing Form Reports” on page 197

Viewing Form Information
See ”Viewing Form Information” on page 204

Editing a Form
See ”Editing a Form” on page 210

Deleting a Form
See ”Deleting a Form” on page 212

View Form Toolbar
See ”View Form Toolbar” on page 212

Creating Polls and Surveys
Polls and surveys are a type of form. All of the same functionality is
available and applies.
WARNING!

For complete understanding of forms, polls, and surveys, you should read the
entire chapter ”Working with HTML Forms” on page 574.

• A poll is generally one question and appears on a site for a
very short time: an hour or a day.

• A survey is usually multiple questions and appears on your site
for a longer time than a poll.
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NOTE

For information on scheduling when your polls and surveys appear on the site,
see ”Scheduling Content to Begin and End” on page 65.

With polls and surveys, you can show ongoing results to site
visitors after they submit their answers.
The following sections provide information about creating a poll or
survey beyond the normal form information.

• ”Working With Polls” on page 619
• ”Creating a Survey” on page 624
• ”Making Form Results Available to Site Users” on page 582
• ”Viewing Form Information” on page 618
For information on how to display a poll or survey on a Web site,
see the Developer Reference Manual section “Introduction to
Ektron CMS400.NET Server Controls” > “Poll Server Control”.

Working With Polls
Below is an example of a poll. Note that when a site visitor hovers
over the poll, the question also appears as ToolTip text.

This subsection contains the following:

• ”Creating a New Poll in the Workarea” on page 620
• ”Replacing a Poll from the Web Site” on page 621
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• ”Editing a Poll from the Web Site” on page 623
Creating a New Poll in the Workarea
To create a new poll, follow these steps.
NOTE

You can also create a new edition of a poll in another language by copying an
existing poll and translating it. For more information, see ”Translating Content” on
page 818.

NOTE

For the steps to create a new form, see ”Creating a New Form” on page 576. For
the steps to create a new survey, see ”Creating a Survey” on page 624.

1. From the View menu, click Language, and select the language
in which to create the poll.
2. Click New > HTML Form/Survey.
3. The New Form screen appears.

NOTE

If you choose Standard Poll or Blank Survey, the number of steps in the Forms
Wizard changes from five to four. This happens because the Assign Tasks step is
removed.

4. Choose Standard Poll. You can click the preview icon (
next to any sample form to preview it before choosing it.

)

5. Click the Next button.
6. Enter or edit the form’s Title and Description.
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•Title - used to reference the poll within the Workarea
(required)

•Description - an extended description of the poll.
7. Click the Next button.
8. This screen lets you add a poll question and possible replies.
NOTE

This screen allows you to add up to eight replies. If you have more than eight
replies, you can add them in the forms editor after clicking the Done button.

9. Click the Next button.
10. This screen indicates that you have entered the basic poll
information and should click the Done button to further edit and
view the form’s fields.
11. After clicking the Done button, the form editor launches so you
can edit existing fields and properties. In addition, you can set
post back and schedule information, add metadata and
comments, change the title, and submit the poll for publication.
NOTE

From this screen, you can add more replies to your poll by right clicking on the
choices field and clicking properties. See Also: ”Inserting a Choices Field” on
page 605.

Replacing a Poll from the Web Site
When logged into Ektron CMS400.NET, you can right click on a poll
and choose New Poll to replace the current one. The title of the
poll, its ID, and properties stay the same. Only the questions and
answers change.
To replace a poll, follow these steps.
1. Log into Ektron CMS400.NET.
2. Navigate to the Web page that hosts the poll.
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3. Right click the poll and choose New Poll.

4. The Workarea opens, indicating you are at step three of the
Poll Wizard.

5. Add a new question to the Question text box.
6. Add possible responses to the Choices text boxes.
7. Click Next.
8. Click Done.
9. The form editor launches, allowing you to edit the fields and
properties. In addition, you can set post back and schedule
information, add metadata and comments, change the title and
submit the poll for publication.
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10. Once published, the updated poll appears on the site.

Editing a Poll from the Web Site
To edit an poll on a Web site, follow these steps.
WARNING!

If you are logged into the site and create a new poll by right clicking on a poll
selecting New, the existing poll is replaced by the new one.

1. Log on to the Ektron CMS400.NET Web site.
2. Right click the poll you want to change and click Edit.

3. Make changes to the poll using the Forms editor.
4. Submit the poll to the Approval Process.
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Creating a Survey
To create a new survey, follow these steps.
NOTE

You can also create a new edition of a survey in another language by copying an
existing form and translating it. For more information, see ”Translating Content”
on page 818.

NOTE

For the steps to create a new poll, see ”Working With Polls” on page 619. For the
steps to create a new form, see ”Creating a New Form” on page 576.

1. Consult with your Ektron CMS400.NET administrator about the
folders in which you should create polls. See Also: Ektron
CMS400.NET Administrator Manual section “Managing HTML
Forms” > “Forms Must Use Template with FormBlock Server
Control”
2. From the View menu, click Language, and select the language
in which to create the form.
3. Click the New > HTML Form/Survey.
4. The New Form screen appears.
.

NOTE

When you choose Standard Poll or Blank Survey, the number of steps in the
Forms Wizard changes from five steps to four steps. This happens because the
Assign Tasks step is removed.
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5. Choose Blank Survey. You can click the preview icon (
next to any sample form to preview it before choosing it.

)

6. Click the Next button.
7. Enter or edit the form’s Title and Description.

•Title - used to reference the survey within the Workarea
(required)

•Description - an extended description of the survey.
8. Click the Next button.
9. This screen lets you determine what happens after the site
visitor completes the survey. The choices are:

•Display a message - See ”Composing the Postback
Message” on page 579

•Redirect to a file or page - Use the Library Identify a file or
a page on your Web site that is launched when the visitor
completes the form

- An example of a file is a white paper (a common file
format is .PDF) that the visitor requested

- An example of a page is one that lets the visitor
download your product

•Redirect to an action page and forward form data - See
”Redirect to an Action Page and Forwarding Form Data” on
page 580

•Report on the form - See ”Making Form Results Available to
Site Users” on page 582
10. Click the Next button.
11. A screen indicates that you have entered basic information
about the survey and should click the Done button to enter the
survey’s content. This procedure is described in ”Creating a
Form’s Content” on page 585.
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eWebEditPro+XML is a browser-based, Web content editor
designed for dynamic Web sites. It lets you create and publish your
own Web content in any language supported by the operating
system and your Web site.
More specifically, eWebEditPro+XML lets you perform Web page
editing functions, such as

• copy content from any Windows-based application
• use Microsoft Word to edit Web content
• cut, copy, and paste
• find and replace text
• check spelling
• edit an image
• change font style, size, attributes (bold, italics, underline), and
color

• begin lines with bullets or numbers
• adjust indentation
• right, center, or left justify text and images
• add a bookmark, hyperlink, image, or table
• view your text as WYSIWYG or HTML code
• insert or clean HTML source code
You gain access to these functions either from the toolbar at the
top of the editor window or from a menu that appears when you
right click the mouse inside the editor.
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Using eWebEditPro+XML
eWebEditPro+XML is like many other word processing
applications. You type text and then use toolbar buttons (illustrated
below) and menu options to change the text’s appearance or
perform functions on it, such as spell checking.

To learn more about using eWebEditPro+XML, see these topics.

• ”Creating a Simple Web Page” on page 628
• ”Toolbar Buttons” on page 632
• ”Customizing Your Toolbar” on page 645
• ”The Context Sensitive Menu” on page 654
• ”Using eWebEditPro+XML’s Advanced Features” on page 657
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This section walks you through the process of creating a simple
Web page, using only a few of the many features available. Later
sections explain all of the features and how to use them.

Your Finished Web Page
When you finish this exercise, your simple Web page will look like
this.

Notice that this page has the following elements.

• The second sentence includes bold, italic and underlined text.
• The third sentence includes a hyperlink, text that will jump to
another Web page when the user clicks on it.

• The fourth sentence begins with a bullet.
• The last sentence has some very large (18 point) text.
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Creating a Sample Web Page
To create this page, follow these steps.

Enter the First Two Sentences
1. Open eWebEditPro+XML. (Your Webmaster installs
eWebEditPro+XML on your computer and determines which
fonts and sizes are available. Your system may not match the
example below.)
2. Type the first two sentences.
This is some sample content. You can make text bold,
italic and underlined with the push of a button.
3. Double click the word “bold” to select it. Then, click the Bold
button ( ) to apply bold to the word.
4. Double click the word “italic.” Then, click the Italic button (
apply italic to the word.

) to

5. Double click the word “underlined.” Then, click the underline
button ( ) to underline the word.

Create a Hyperlink
1. Type You can also easily add hyperlinks.
2. Double click the word hyperlinks so that it becomes selected.
3. Click the Hyperlink button (

).

4. The hyperlink dialog box appears.
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5. In the Link field, after http://, enter www.ektron.com.
6. Click OK.
Notice that the word hyperlink now appears in a different color.
When you save this Web page and a user views it, if the user clicks
hyperlink, a new Web page will display Ektron’s home page.
NOTE

If your computer has an internet connection, you can double click the hyperlink to
test it.

Applying a Bullet to a Line of Text
1. Press <Enter> to move the cursor down to the next line.
2. Type You can begin a line with bullets.
3. Click the bullet button (

).

4. Notice that the line is indented and now begins with a bullet.
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Changing the Size of Text
1. Press <Enter> to move the cursor down to the next line.
2. Type Finally, you can change the font to a large size.
3. Select the words large size.
4. Click the down arrow to the right of the font size list. When you
do, the list of available fonts appears.

5. Click 5 (18 pt).
6. Notice that large size is now much larger than the other text.
Congratulations! You have just created your first Web page with
eWebEditPro+XML. You have learned how to apply bold, italic, and
underlining, create a hyperlink, add a bullet to a line, and change
the size of the text.
This sample used only a few of the many features available. The
following sections explain the rest of the details about using the
product.
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This section explains how to use the buttons and drop-down lists
on the toolbar. (The toolbar is the row of buttons across the top of
the editor window, illustrated below.)

The buttons let you perform functions such as cutting and pasting
text, inserting images, and creating tables.
All buttons may not appear. Your Webmaster determines which
buttons appear on your toolbar. Also, you can customize your
toolbar so that it contains only the buttons you use (See
“Customizing Your Toolbar” on page 645).
This section explains

• ”Selecting Text” on page 632
• ”Applying Formatting Attributes to Text” on page 633
• ”Table of Toolbar Buttons and Drop-Down Lists” on page 633

Selecting Text
You select text before performing an action on it, such as copying
it.

• To select all information on a page, press Ctrl+A.
• To select a portion of the information on a page, you have two
choices.

- Hold down the left mouse button and drag the cursor across
the data you want to select.

- Hold down the Shift key and the right arrow key (

) until

the desired data is selected.
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• To select a single word, place the cursor on the word and
double click the mouse.
Selected text has different background and foreground colors, as
illustrated below.

Applying Formatting Attributes to Text
Several buttons apply formatting attributes to text, such as bold
and italics. There are two ways to apply these attributes.

• Enter the text. Then, select the text and press the toolbar
button. The button is now in a “pressed in” condition, and the
text has the formatting attribute.

• Press the toolbar button. Then, begin typing the text. As you
type, the formatting is applied.
To stop applying the formatting, press the button again. This action
changes the button to a “pressed out” condition and terminates the
formatting.

Table of Toolbar Buttons and Drop-Down Lists
The toolbar buttons and drop-down lists on the default toolbar are
explained below.
Five optional toolbars are also available. To display one, place the
cursor on the standard toolbar, right click the mouse, and select it.
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The optional toolbars are explained in these sections.

• ”Form Elements Toolbar” on page 641
• ”Table Elements Toolbar” on page 642
• ”Position Objects Options” on page 640
• ”Text Direction Options” on page 641
• ”Miscellaneous Toolbar” on page 643

Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Cut

Ctrl+X

Remove selected text and graphics.
Place that data into temporary memory,
also known as the “clipboard.”
(If you later cut or copy more information
onto the clipboard, the new information
overwrites the original information.)
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Button

Equivalent
Keystroke

Function

For more
information, see

Copy selected text and graphics into
temporary memory. Leave selected data
where it is.

“Copying from Other
Applications” on
page 658

(Internet
Explorer only)

Copy

Ctrl+C

(If you later cut or copy more information
into memory, the original information is
lost.)

Paste

Ctrl+V

Insert the most recently cut or copied text
and graphics at the current cursor
location.
Paste the contents of the clipboard as
plain text. That is, all HTML tags
(including images) are not pasted.

Paste Text

This button is helpful when you want to
eliminate the HTML formatting of the text
being copied.
Replace

Launches the Search and Replace dialog
box. The dialog searches for (and lets
you optionally replace) text that you
specify.

“Finding and
Replacing Text” on
page 659

Find Next

Find next occurrence of the string
entered into the Find What field of the
Search and Replace dialog box.

“Finding and
Replacing Text” on
page 659

Undo

Redo

Spell Check
(manual)

Spell Check
(automatic)

Ctrl+Z

Reverse the most recent action, as if it
never occurred. You can undo as many
actions as you wish.

Ctrl+Y

Reverse the undo action.

Begin spell checker.

“Checking Spelling
Upon Demand” on
page 664

Turn on or off spell check as-you-type
feature.

“Checking Spelling
as You Type” on
page 663
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Button

Equivalent
Keystroke

Function

For more
information, see

Change information about a hyperlink.

“Using Hyperlinks”
on page 768

Remove a hyperlink.

“Removing a
Hyperlink” on
page 773

Insert a library file

”Adding a Library
File to Content” on
page 148

Upload any external files (such as
images) to the server.

”Moving an Image to
the Server” on
page 685

Translate content into another language

Ek tr on
C MS4 00. NE T

(Internet
Explorer only)

Edit Hyperlink

Remove Hyperlink

Library

Upload Files

Translate

Administrator
Manual section
“Multi-Language
Support” > “Working
with Multi-Language
Content” >
“Translating Content”
> “Using Machine
Translation”
Add Comment

Picture

Image Editor

Table

Edit in Microsoft
Word

Insert a comment into the content

”Adding Comments
to Content” on
page 795

Insert a picture.

“Inserting Images”
on page 671

Edit an image.

”Editing Images” on
page 687

Insert or edit a table.

“Introduction to
Tables” on page 719

Edit content in Microsoft Word.

“Editing in Microsoft
Word” on page 668
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Button

Equivalent
Keystroke

Function

For more
information, see

Switches to Data Design Mode.

Ek tr on
C MS4 00. NE T

(Internet
Explorer only)

Data Design Mode

Button only appears when
eWeb Ed i tP ro+ XML configuration
enables the Data Designer feature.

Data Entry Mode

Switches to Data Entry Mode.
Button only appears when
eWeb Ed i tP ro+ XML configuration
enables the Data Designer feature.

View as
WYSIWYG

View as HTML
nbsp

Administrator
Manual section
“Using the Data
Designer”
Ek tr on
C MS4 00. NE T

Administrator
Manual section
“Using the Data
Designer”

Display the page content as WYSIWYG
(What You See Is What You Get).
WYSIWYG is the ability to see in the
editor what will appear when user views
the Web page.
Display the page content as HTML.

“Viewing and Editing
HTML” on page 774

Insert a blank space character.
Although you can add spaces in the
editor using the <space> bar on the
keyboard, those spaces are ignored
when the content is displayed by a
browser.
Insert copyright symbol.

Copyright
Insert registered trademark symbol.
Registered
Trademark
TM

Insert trademark symbol.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Insert special characters (such as
and
Special Characters

Remove Style

) from a drop down list.
To view the list, click the black down
arrow.
Remove all style information applied to
selected text. (You apply styles using the
Style dropdown list.) For example
Before
<P class=note>This is initial
content. </P>

After
<P>This is initial content.</P>

Style

Display a list of styles. Users can select
from the list to apply a style to selected
text.
Note that the list can change depending
on the formatting of the selected line.
Your Webmaster determines which styles
are available.

Heading Size

Change the heading size. Your
Webmaster determines which heading
sizes are available.
Change the font style. Your Webmaster
determines which fonts are available.

Font Style

Note: If more than one font appears in a
selection, the browser on the reader’s PC
tries to display text using the first font. If
the browser cannot find that font, it tries
to use the second, etc.

Font
Size

Font Color

Change the font size. Your Webmaster
determines which font sizes are
available.
Change the font color.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Change the background color of the text.

Background Color

Note: To remove background color from
selected text, click the Normal button
( ).

Bold

Italic
Strikethrough

Normal

Ctrl+B

Make the text bold.

Ctrl+I

Make the text italic.

Apply strikethrough to selected text. For
example: Here is some text
Remove all formatting from selected text.

Superscript

Make selected text appear smaller and
above text line

Subscript

Make selected text appear smaller and
below text line

Number

Begin the line on which the cursor rests
with a number. If the line above this line
is

•
•

Bullet

Indent

not numbered, assign this line 1
numbered, assign a number one
more than the line above

Begin the line on which the cursor rests
(or all selected lines) with a bullet ( ).
Increase or decrease the current line’s
distance from the left margin.
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Button

Equivalent
Keystroke

Function

For more
information, see

(Internet
Explorer only)

Align paragraph so that it is arranged

•
Left, Center, and Right
Justify

evenly on the left side (uneven on
the right)

•in the center of each line
•evenly on the right side (uneven on
the left)

•

evenly on right and left side

Display a dialog box that shows your
version of eWe bE di tP ro + XML and your
license keys.

About
eWeb Ed it Pr o+X ML

Position Objects Options
These buttons let you absolutely position elements (pictures,
tables, etc.) anywhere on a page.
WARNING!

Button

Some older browsers (for example, Netscape 4) do not display absolutely
positioned elements. Absolute position uses the style attribute. If you use this
feature, the content is not compatible with all browsers.

Function

Position

Lets you move selected table or image anywhere on the screen.

Lock

“Locks” selected table or image at its current screen position. Nothing can move
a locked object.
To move the object, unlock it by clicking this button again.

Move to Front

If two or more images overlay each other, moves the selected image in front of
the others.

Move to Back

If two or more images overlay each other, moves the selected image behind the
others.

Above Text

If text overlays an image, move the image in front of the text.
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Button
Below Text

Function
If an image overlays text, move the text in front of the image.

Text Direction Options
The text direction menu options (
) allow bidirectional editing of text, which is useful for Arabic, Farsi and
Hebrew. The client computer must also support the language.
The text buttons determine the editing direction, while the edit
buttons determine the side of the editor that displays the scroll bar.
For right-to left languages, such as Arabic, Farsi and Hebrew, the
text editing would be “right to left”, and the scroll bar would be on
the left side.
For western European languages, the text editing would be “left to
right”, and the scroll bar would be on the right side.

Button
Left-Right Text

Right-Left Text

Function
Text is entered left to right.

Text is entered right to left.

Left-Right Edit

The vertical scroll bar appears on the
right side of the window.

Right-Left Edit

The vertical scroll bar appears on the left
side of the window.

Form Elements Toolbar
See “Inserting Form Fields” on page 169
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Table Elements Toolbar

Toolbar
button

Description

For more information, see

Insert table

”Introduction to Tables” on page 719

Add row

Inserts a new row below the last one

Add column

Inserts a new column to the right or the right
column

Insert row

Inserts a new row above the current one

Insert column

Inserts a new column to the left of the current one

Insert new cell

Inserts a new cell to the left of the current one

Delete row

Deletes current row

Delete column

Deletes current column

Delete cells

”Deleting a Cell” on page 748

Merge cells

”Merging Two Cells” on page 760

Split cell

”Splitting a Cell” on page 759

Table properties

”Manipulating Your Table’s Format” on page 730

Cell properties

”Working with Table Cells” on page 746
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Miscellaneous Toolbar

Button

Equivalent
Keystroke

Function

(Internet
Explorer only)

Open local file and copy it into CMS content.

Open File

While you can open any file type, Ek tr on CMS 400 .NET ’s
editor only works with .htm and .xml files.
When you open a file into a content block, the new file
replaces any content currently in the block.
Save CMS content as file on your computer or network.

Save File

Since E k t r o n C M S 4 0 0 . N E T ’s editor only works with .htm
and .xml files, you should save the file using one of those
extensions.
Display/hide
Borders

Display or suppress table and cell borders

Display/hide
Invisible Elements

Display or suppress formatting characters that do not
appear when content is published

View Preferences

Display a dialog that lets you change the appearance of the
HTML source code

About

Display a dialog box that shows your version of
e We b E d i t P r o + X M L and your license keys.

e We bE di t Pro + XML

Delete selected content

Delete
Underline

Ctrl+U

Make the text underlined

Remove alignment

Remove alignment settings applied to selected content

Bookmark

Create a bookmark. See Also: “Using Bookmarks” on
page 764

Horizontal Line

Insert a horizontal line.
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Button

Equivalent
Keystroke

Function

(Internet
Explorer only)

Print

Select All

Select None

Ctrl+P

Print the editor content.

Ctrl+A

Select all content

Deselect all selected content
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Customizing Your Toolbar

The eWebEditPro+XML toolbar consists of one or more menus.
Each menu has one or more buttons.
You can recognize the beginning of a menu by the double vertical
bars (circled in the illustration).

This sample toolbar has four menus.
Your Webmaster determines

• which menus are available to you
• which buttons appear on each menu, and the sequence in
which they appear initially

• whether or not you are authorized to customize your toolbar. If
you are not authorized, your edits are not saved when you
leave the eWebEditPro+XML screen.
If you are authorized to customize your toolbar, there are several
ways to do so.

• ”Removing Or Adding Menus” on page 646
• ”Removing or Adding Menu Items” on page 647
• ”Restoring Toolbars” on page 650
• ”Rearranging the Menus on a Toolbar” on page 650
• ”Creating a New Menu” on page 650
• ”Moving a Menu Off the Toolbar” on page 652
• ”Changing the Menu’s Orientation” on page 653
Each procedure is explained below.
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Removing Or Adding Menus
To remove or add a menu, follow these steps.
1. Place the cursor on the toolbar.
2. Right click the mouse.
3. A dropdown list appears. It displays all menus available to you
and the Customize option.

NOTE

If Customize does not appear on the menu, you are not authorized to customize
the toolbar.

Menus that are checked appear on your toolbar.
In the above example, the Special Characters, View As,
Format, and Paragraph Format menus appear. The Table,
Position Objects and Text Directions menus, which are not
checked, are available but do not currently appear on the
toolbar.
4. To add a menu to your toolbar that appears on the list but is not
currently checked, place the cursor on the menu name and
click the mouse. A check mark appears, and the menu appears
on the toolbar.
To remove a menu from your toolbar, place the cursor on the
menu name and click the mouse. The check mark disappears,
and the menu no longer appears on the toolbar.
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Removing or Adding Menu Items
1. Place the cursor on the toolbar.
2. Right click the mouse.
3. A dropdown list appears. Click Customize.

NOTE

If Customize does not appear on the menu, you are not authorized to customize
the toolbar.

4. The Toolbar Customization dialog box appears.
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5. Click the menu that you want to edit.
6. Click the Commands tab. A new screen appears.
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Using the Customize Toolbar Dialog Box
The left half of the Commands screen lists the buttons in the
sequence in which they appear on the menu.
The right half of the screen lists available buttons that do not
currently appear on the menu.
To add a button to the toolbar, drag it from the right side of the
screen to the location on the left side where you want it to appear.
(You can also click a button then click <--Add. This action places
the button at the bottom of the list.)
To remove a button from the toolbar, drag it from the left side of the
screen to the right. (You can also click a button then click Remove->.)
The Move Up and Move Down buttons let you to move any button
up or down one slot within the list of buttons.
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Rearranging the Items on a Menu
1. Click the button you want to move
2. Click Move Up and Move Down to move the button up or
down one slot for each click.

Restoring Toolbars
If you remove all toolbars from your menu, and then want to
restore the menus but do not have the Customize menu option,
follow these steps.
1. Place the cursor in the editor.
2. Right click the mouse.
3. A menu appears with a Redisplay toolbars option.
4. Click this option to restore all menus.

Rearranging the Menus on a Toolbar
To move a menu to a different toolbar location, follow these steps.
1. Place the cursor on the double vertical bars that indicate the
beginning of the menu.
2. Click the mouse.
3. Hold down the mouse button and drag the menu to the new
location. You can move the menu anywhere else on the
toolbar.
Note that your Webmaster can define a menu so that it cannot
reside on the same row with another menu. If you move such a
menu, it will not remain on a row with another menu. Instead, it
will move down to the next row.
4. After you place the menu where you want it, release the mouse
button.

Creating a New Menu
1. Place the cursor on the toolbar.
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2. Right click the mouse.
3. A dropdown list appears. Click Customize.

4. The Toolbar Customization dialog box appears.

5. Click New.
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6. A new menu appears on the left side of the window, above the
existing menus. The default name of the new menu is Custom
0.

7. To rename the menu, place the cursor in the field that displays
the new menu and enter the new name.
NOTE

If you click outside the toolbar name field, you cannot later change the menu’s
name.

8. To have the menu appear on your toolbar, click in the small box
to the left of the menu name.
9. Click the Commands tab.
10. Add buttons to the menu, following the procedure described in
“Using the Customize Toolbar Dialog Box” on page 649.

Moving a Menu Off the Toolbar
You can move a menu from the toolbar to anywhere else on the
screen, even if eWebEditPro+XML does not occupy the entire
screen.
You can also change the orientation of a menu that is not on the
toolbar from a horizontal to vertical.
To move a menu, follow these steps.
1. Place the cursor on the double vertical bars that indicate the
beginning of the menu.
2. Click the mouse.
3. Hold down the mouse button and drag the menu to the new
location. You can move the menu anywhere on the screen.
4. After you place the menu where you want it, release the mouse
button.
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Changing the Menu’s Orientation
To change the menu’s orientation, follow these steps.
1. Drag the menu from the toolbar.
2. Move the cursor to the bottom of the menu until it becomes a
double-headed arrow (illustrated below).

3. Drag the cursor to the lower left. As you do, the menu’s
orientation changes from horizontal to vertical (illustrated
below).
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The Context Sensitive Menu

This section explains the functions available on the menu that
appears when you right click the mouse within the
eWebEditPro+XML editor. You can also access this menu by
pressing the application key (

).

Because this menu can change depending on what you are doing,
it is called a context-sensitive menu.

NOTE

A different context-sensitive menu is available when your cursor is within a table.
That menu is described in “The Table Context Sensitive Menu” on page 728.

The following table lists the menu options and where to get more
information on each.
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Menu Option

Lets you

For more information,
see

Menus

View all toolbar menus.

“Using eWebEditPro+XML
without a Mouse” on
page 785

Cut

Remove selected text and graphics.
Place that data into temporary memory.
If you later cut or copy more information
into memory, the information in memory
is lost.

Copy

Copy selected text and graphics into
temporary memory. Leave selected data
where it is. (If you later cut or copy more
information into memory, the original
information is lost.)

Paste

Insert the most recently cut or copied text
and graphics at the current cursor
location.

Paste Text

Paste the contents of the clipboard as
plain text. That is, all HTML tags
(including images) are not pasted.

“Copying from Other
Applications” on page 658

This button is helpful when you want to
eliminate the HTML formatting of the text
being copied.
Select All

Select all information on your page. After
you select it, you can cut it, copy it, etc.

Clean Source

Remove unnecessary HTML tags

“Cleaning Source Code” on
page 776

Hyperlink

Create a link to another Web page or a
spot within the current page

“Using Hyperlinks” on
page 768

Edit Source

Edit your page’s HTML source

“Editing a Section of a
Page” on page 775

Insert Source

Insert HTML source onto the page at the
cursor location.

“Inserting Source” on
page 775
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Menu Option

Lets you

For more information,
see

Check Spelling

Compare words in the editor to Microsoft
WORD spelling list.

“Checking Spelling” on
page 663

View as WYSIWYG/HTML

View and edit your page’s HTML

“Viewing and Editing HTML”
on page 774

Picture

Insert a picture

“Inserting Images” on
page 671
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Using eWebEditPro+XML’s
Advanced Features

Most of eWebEditPro+XML’s features are easy to learn. For
example, to make your text bold, you select the text, and click the
bold button ( ).
However, some of eWebEditPro+XML’s features are more complex.
For example, when creating a table, you must make several
decisions: the number of rows and columns, the size of the border,
the spacing between cells, etc. The following sections explain
eWebEditPro+XML’s more advanced features.
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Copying from Other
Applications

You can copy information from most other Windows
applications into eWebEditPro+XML and retain the formatting
from the original application. In general, copying from another
application involves these steps.
1. Sign on to the application in which the information resides.
2. Select the information to be copied.
3. Press <Ctrl>+<C>.
4. Go to eWebEditPro+XML.
5. Press <Ctrl>+<V> to paste the selected information.
Note that you can only copy content, not background
information that generates content.
So, for example, you can copy the values in a spreadsheet but
not the formulas used to generate those values. Also, copying
dynamic fields from Microsoft WORD would retrieve the current
value of the fields but not the variables that generate those
values.
It’s a good idea to experiment with copying from different
sources to test the results.
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To find (and optionally replace) text on your Web page, click the
Replace button ( ). When you do, the Find and Replace
dialog box appears.

You can use this dialog box to simply find text, or to find text
and replace it with other text. Each option is explained below.
NOTE

You can also use this dialog to delete text that appears repeatedly. To do so,
follow the directions in ”Finding and Replacing Text” on page 660 and enter
nothing in the Replace With field.

See Also:

• “Finding Text” on page 659
• “Finding and Replacing Text” on page 660
• “Additional Options on the Dialog Box” on page 660

Finding Text
1. In the Find What field, type the text that you want to find in
the content.
2. Set dialog box options (see ”Additional Options on the
Dialog Box” on page 660).
3. Click Find Next to find the next occurrence of the “find”
text.
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Finding and Replacing Text
1. In the Find What field, type the text that you want to find.
2. In the Replace With field, type the text to replace the “find”
text.
3. Set dialog box options (see ”Additional Options on the Dialog
Box” on page 660).
4. If you want to

- replace all occurrences of the “find” text with the “replace”
text, click Replace All.
NOTE

You can undo replacements one at a time using the Undo button (

).

- replace only the highlighted term with the “replace” text, click
Replace.

- find the next occurrence of the “find” text (and optionally
replace it with the “replace” text), click Find Next.

- change the highlighted term using the editor, exit the Find
and Replace dialog, move to the term and edit as needed.
To restart the search, press the Find Next button (

).

5. Continue to find and optionally replace or edit until you reach
the end of the text.

Additional Options on the Dialog Box
The dialog box also lets you do the following.

• ”Specifying a Search Direction” on page 660
• ”Considering the Case of a Search Term” on page 661
• ”Whole Word Match” on page 662
Specifying a Search Direction
The search begins where the cursor is when you click Find Next.
To make sure you locate every occurrence of a term, place the
cursor at the top of the content before beginning the search.
If you begin the search from somewhere other than the top of the
page, use the Direction field to search from the current location to
the top or bottom of the file.
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To search from the
cursor location to the

Click this option in the
Direction field

end of the page

Down

top of the page

Up

Considering the Case of a Search Term
By default, the search ignores the case (upper or lower) of a
search term. In other words, if you enter Bob in the Find What
field, the search finds bob, Bob, BOB, etc.
If you want the search to be case sensitive, use the Match case
check box on the Find window. If you enter Bob in the Find What
field and place a check in the Match case box, the search only
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stops at Bob, not bob or BOB.

Whole Word Match
By default, the search finds any occurrence of the text that you
type into the Find what field. For example, if you enter the, the
search finds the word the, as well as those letters embedded in
other words, such as others and theater.
If you want the search to find only whole word occurrences of the
text you type into the Find what field, click the Match whole
words only box in the Find dialog box.
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Checking Sp elling

The eWebEditPro+XML editor can check your spelling as you type
or whenever you want to check it.
The rest of this section explains

• ”Disabling Script Blocking” on page 663
• ”Checking Spelling as You Type” on page 663
• ”Checking Spelling Upon Demand” on page 664
• ”Spell Checking Selected Text” on page 665
• ”Setting Spell Check Options” on page 666

Disabling Script Blocking
If Norton Antivirus TM 2001 is installed on your computer, you need
to disable script blocking in order to use the spell checker. If you do
not disable script blocking, an error message will appear whenever
you check spelling.
To do this, follow these steps.
1. Launch Norton Antivirus TM 2001.
2. From the first window, click Options.
3. On the next window, click Script Blocking.
4. On the script blocking window, uncheck Enable Script
Blocking.
5. Press OK.

Checking Spelling as You Type
You can have the editor check spelling as you type. To turn on the
spell-check-as-you-type feature, click the automatic spell check
button(

).
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When you click the button, the spell checker reviews every word in
the file. A wavy red line (
) appears under any word whose
spelling is not found in the system’s dictionary.
The spell checker continues to review each word as you type it,
marking any words not in the dictionary.
NOTE

Depending on the speed of your computer, there may be a short delay between
the time you type an incorrect word and when the wavy red line appears. Also, the
spell check does not check a word until you enter a space character after the
word.

Fixing Spelling Errors
There are two ways to fix a spelling error (indicated by a wavy red
line).

• Click the misspelled word and then right click. A menu displays
words that are similar to the misspelled word. Click the correct
word.

• If you know the correct spelling, type the correction.

Checking Spelling Upon Demand
If you do not want to use the spell-check-as-you-type feature, you
can begin spell checking whenever you wish. To do this, click the
spell check button ( ).
When you do, the system checks each word in the file. If the spell
check finds a word in none of the dictionaries, it displays the
Spelling dialog box.
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The Spelling Dialog Box
The Spelling dialog box displays

• the word not in the dictionary (in the Not in Dictionary field).
• suggested spellings for the word (in the Suggestions field).
The most likely replacement is selected at the top of the list.

• buttons that let you ignore the word, change the word, or exit.

If you want to

Do this

Replace the word with one of the suggestions and continue
spell checking the page.

1.

Click the suggested word.

2.

Click Change.

Replace every occurrence of the word with one of the
suggestions and continue spell checking the page.

1.

Click the suggested word.

2.

Click Change All.

Correct the spelling of the word by typing it and continue
spell checking the page.

1.

Click in the Not In Dictionary
field.

2.

Correct the spelling.

3.

Click Change.

Leave the word as is; continue spell checking the page.

Click Ignore.

You would normally do this if a word (such as a company
name) is spelled correctly even though it is not in the
dictionary.
Leave the word as is; continue spell checking the page,
ignoring all other occurrences of the word.

Click Ignore All.

Stop spell checking.

Click Cancel.

Spell Checking Selected Text
To check the spelling for a single word or a group of words, follow
these steps.
1. Select the text that you want to spell check.
2. Press the manual spell check button (
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3. The spell checker reviews the words in the selected text and
stops at any word not in the dictionary. For documentation of
options when a misspelled word is found, see “The Spelling
Dialog Box” on page 665.
4. When the spell checker finishes reviewing the words in the
selected text, it displays the following message
Finished checking selection. Do you want to check the rest of the
document?

Click Yes to spell check the rest of the document (including text
above the selected text).
Click No to stop the spell checker.

Setting Spell Check Options
eWebEditPro+XML can use Microsoft Word’s spell checking feature

(your Webmaster makes this decision).
If your installation uses Word, Word’s Spelling & Grammar window
(available from the Tools - > Options menu) has settings that
affect the operation of the spell check.
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Specifically, you can set the spell check feature to check or ignore

• words in UPPERCASE (for example, XYLOGIC)
• words with numbers (for example, mp3)
• Internet and file addresses (for example,

http://

www.example.com/)

As an example, if you check the box to the left of Ignore Words in
UPPERCASE, eWebEditPro+XML’s spell check does not consider
words in all uppercase characters.
You also use the custom dictionary section of the screen to identify
custom dictionaries for the spell check to reference.
The spell check feature does not use the other fields on this
screen.
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If your computer has Microsoft Word 2000 or greater, you can edit
content within Word. You may prefer to do this because of
familiarity with Word’s user interface, and to use additional
functionality available in Word.
See Also: ”Working with Microsoft Office Documents” on page 227
NOTE

Some Word formatting may not be compatible with HTML and, as a result, not be
transferred to eWebEditPro+XML.

To edit with Word, follow these steps.
1. Open eWebEditPro+XML.
2. Press the Word toolbar button (

).

3. The following dialog may appear, warning you that some Word
formatting may not be transferred back to eWebEditPro+XML.
Press Yes if you still want to edit in Word.

4. Microsoft Word opens. Any content that was in
eWebEditPro+XML when you pressed the Word button is
copied to Word.
5. Edit content as desired.
6. Press File -> Close.
7. Another warning like the one in Step 3 may appear. Press Yes
to copy the edited content back to eWebEditPro+XML.
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8. When done, return to eWebEditPro+XML and press the Word
toolbar button again.
9. If you change your mind and decide to restore the content to
the way it was before you edited it in Word, press the undo
button ( ).
If you want to restore the Word changes after pressing Undo,
press the redo button ( ).

Uploading an Image in a Microsoft Word Document
If you insert an image into the Word content and then paste that
content or save it, the following dialog box appears. The box lists
all images in the content and asks if you want to copy them from
your computer to your organization’s Web server.

If you are ready to publish your Web content and want to display
the image, click Update Now. If you plan to add more content later,
you can click Upload Later and upload all images at that time.

Editing XML Documents
If your organization has implemented eWebEditPro+XML, you
cannot edit XML documents using Microsoft Word. This is because
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Word does not support XML editing. If a full XML document is
loaded, the Word button (

) is disabled.

If a Word document includes some custom/XML tags, the following
dialog appears, warning you about the problem.

You can proceed and edit using Word or decide not to edit using
Word.
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To insert a picture into the editor, place the cursor where you want
the image to appear and click the Insert Picture button ( ). When
you click the button, one of the two Picture Properties dialog boxes
illustrated below appears, depending on how your Webmaster has
set up your system.
The dialog boxes are very similar, with the only difference being
that the Select Server File button only appears on the second
dialog box.
The Select Server File button appears if your upload mechanism
is set to FTP. It does not appear if the mechanism is HTTP. For
more information, see the eWebEditPro+XML Administrator Manual
section “Managing Image Selection” > “Examples of Implementing
Image Selection” > “Selecting Files from the Server.”
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You can also access this dialog box to modify a picture after you
insert it. To do this, follow these steps.
1. Click the picture.
2. Right click the mouse.
3. Click Picture from the menu.
If you see the first dialog box, proceed to “Using the First Picture
Properties Dialog Box” on page 673. If you see the second dialog
box, proceed to “Using the Second Media Selection Dialog Box” on
page 677.

Using the First Picture Properties Dialog Box
When the first Picture Properties dialog box appears, click the
Select New File button. When you do, the Insert Media Item dialog
box appears.
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This box and lets you insert a picture from your computer (and any
network folder available to your computer), or from the Web server
to which your computer is connected. Both choices are described
below.

Inserting a Picture from the Server
The top left corner of the dialog box (Illustrated below) lists the
pictures on the Web server.
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Pictures that you previously inserted appear on this list, as do
pictures inserted by other users connected to that server.
To insert a picture from the server, follow these steps.
1. Click the picture from the To Select an Existing File field that
you want to insert.
2. Information about the picture’s file size, width and height
appears in the upper right corner of the dialog box.
3. If you want to view a picture before inserting it, click Preview
(on the right side of the dialog box).
4. Click OK.
5. The Picture Properties dialog box reappears. Here, you can
change the properties of the picture. For more information, see

•“Adjusting a Picture” on page 679
•“Setting a Border” on page 680
•“Aligning the Picture” on page 681
•“Adding Space around the Picture” on page 683
6. Click OK to insert the picture into the editor.

Deleting a Picture from the Server
To delete a picture from the server, select the picture and click the
Delete button.
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Inserting a Picture from Your Computer
Use the lower left corner of the dialog box to insert pictures from
your computer (and any network folder available to your computer)
into the editor.

NOTE

You can only select files in the To Select a Local File: field if your computer has
permission to upload files to the server.

To insert a picture from your computer, follow these steps.
1. Click the Browse button.
2. Navigate to the file that you want to insert and press Open to
insert it.
Your Webmaster can set a maximum size (in kilobytes) for
images. If you select an image that exceeds the maximum, an
error message appears and you cannot insert it.
Your Webmaster can also restrict the type of image file you can
insert. For example, if your Webmaster does not authorize you
to insert bitmap (.bmp) files and you try to do so, an error
message lists valid file extensions, and you cannot insert the
image.
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3. Click in the Enter a description for the file field. Enter a title
to describe the file.
4. After you insert the picture, the title appears in the dialog box’s
top left corner to identify the picture to you and all users
connected to the same Web server.
NOTE

The title is also the alt text for the image. The alt text appears in place of the
image on the Web page if the image itself cannot display for any reason.

5. Information about the picture’s file size, width and height
appears in the upper right corner of the dialog box.
6. If you want to view a picture before inserting it, click Preview
(on the right side of the dialog box).
7. Click OK.
8. The Picture Properties dialog box reappears. Here, you can
change the picture’s properties. For more information, see

•“Adjusting a Picture” on page 679
•“Setting a Border” on page 680
•“Aligning the Picture” on page 681
• “Adding Space around the Picture” on page 683
• “Editing the Picture’s Title” on page 684
9. Click OK to insert the picture into the editor.

Using the Second Media Selection Dialog Box
When using the second Media Selection dialog box, you can insert
a picture from any folder available to your computer (whether the
folder is on your computer or a remote computer) or from the Web
server. Your Webmaster determines which pictures are available
on the Web server.
To insert a picture from

• a folder available to your computer, click Select New File,
navigate to the file of interest, and click OK.

• the Web server, click the Select Server File button.You are
prompted to enter a User Name and Password. Your
Webmaster assigns these codes to you, which are needed to
copy the file to the Web server.
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Next, the Image Explorer dialog appears (illustrated below).
Navigate through the folder structure until you find the image.
Then click OK to insert the image into eWebEditPro+XML.

See Also:

• ”The Picture Properties Dialog Box” on page 678
• ”Adjusting a Picture” on page 679
• ”Pixels” on page 680
• ”Setting a Border” on page 680
• ”Aligning the Picture” on page 681
• ”Resetting Width, Height, Border Thickness, and Alignment” on
page 683

• ”Adding Space around the Picture” on page 683
• ”Editing the Picture’s Title” on page 684
• ”The Options Button” on page 684
The Picture Properties Dialog Box
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You can also use the Picture Properties dialog box to

• adjust the picture’s width, height, border thickness, and
alignment

• reset the image’s properties width, height, border thickness,
and alignment to their original specifications

• set spacing between the picture and surrounding information
on the page

• enter or edit the picture’s title
• view technical information about your connection
Adjusting a Picture
The layout area of the Picture Properties dialog box lets you adjust
a picture’s width, height, border thickness, and alignment.

You can use the following fields to adjust the picture before
inserting it into the editor.

To make this change

Use this field

The width of the picture, in pixels

Width

The height of the picture, in pixels

Height

Add a border around the picture

Border Thickness
For more information, see “Setting a Border” on
page 680
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To make this change

Use this field

Adjust the alignment of the picture

Alignment
For more information, see “Aligning the Picture” on
page 681

WARNING!

If you substantially adjust the picture’s height and/or width, the picture may be
distorted when users view your Web page.

Pixels
A pixel is a single point in a graphic image.
Computer monitors display pictures by dividing the screen into
thousands of pixels, arranged in rows and columns. The pixels are
so close together that they appear connected.
Below is an image shown at regular size and then enlarged so you
can see the pixels that make up the picture.

regular size

enlarged to show pixels

Setting a Border
To add a border around a picture, enter the border’s thickness in
pixels in the Border Thickness field on the Picture Properties
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dialog box.

Here is a picture with a 1 pixel border.

Here is the same picture with a 10 pixel border.
If the picture is not a hyperlink, its border is black. If the picture is
also a hyperlink, the border is the same color as a hyperlink (for
example, blue or purple if visited).

Aligning the Picture
To align a picture, use the Alignment field on the Picture
Properties dialog box.

When deciding how to align a picture, you need to become familiar
with these terms.
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• baseline of text - the imaginary line on which the text lies.
Some letters (such as g, p and y) have descenders, segments
of letters that extend below the baseline

• bottom of text - the lowest section of a line to which a
descender extends

• top of text - the highest spot of a line to which any segment of a
letter extends

• vertical center - the midpoint between the top and bottom of the
line

The following table lists your alignment choices.

To align

Click this in the
Alignment field

The picture on the left margin, allowing
subsequent text to wrap around it

Left

The picture on the right margin, allowing
subsequent text to wrap around it

Right

The top of the picture with the top of the
text

Text Top, Top

The vertical center of the picture with the
baseline of the text

Middle

The vertical center of the picture with the
vertical center of the text

AbsMiddle
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To align

Click this in the
Alignment field

The bottom of the picture with the
baseline of the text (This is the default
alignment)

Bottom, Baseline

The bottom of the picture with the bottom
of the text

AbsBottom

Illustration

Resetting Width, Height, Border Thickness, and Alignment
If you adjust the picture’s width, height, border thickness, and/or
alignment and later want to restore all of those settings to their
original values, click the Reset button.

Note that you cannot selectively restore some settings -- the Reset
button automatically restores all of them.

Adding Space around the Picture
On the Picture Properties dialog box, you can use the Spacing
fields (Horizontal and Vertical) to add space around the picture.
You enter a number of pixels to determine spacing value.
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The following graphic illustrates the effect of adding spacing to a
picture.

Editing the Picture’s Title
The title that you entered in the Insert Media Item dialog box
defaults into the Title field of the Media Selection dialog box. You
can edit the title in this field if desired.
NOTE

The title is also the alt text for the image. The alt text appears in place of the
image on the Web page if the image itself cannot display for any reason.

The Options Button
When you click the Options button on the File Properties dialog
box, the options dialog box appears. The box displays information
about your connection to the Web server.
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For information about these settings, see “Uploading Images” in
the eWebEditPro+XML Developer’s Reference Guide.

Moving an Image to the Server
If you insert an image from your computer into eWebEditPro+XML
content, that image must be moved to the server when you save
the content. The image can only appear on Web pages that display
it after you move it to the server.
When you save content that includes an image you inserted, the
following dialog appears.
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All inserted files appear in the dialog, which also estimates how
long it will take to move the files to your server. If you do not want
to wait that long to upload the files, click Upload Later. If you do
this, the images will not appear on the published Web content until
you move them to the server.
You can also enter a Title for the image near the bottom of the
screen. If you do, this text appears when the user reading the Web
pages moves the cursor over the image.

Deleting a Picture
If you want to delete a picture, follow these steps.
1. Move the cursor over the picture.
2. Click the mouse to select the picture.
3. Click the Cut button (
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WebImageFX lets you select an image from the content, edit that
image, and then insert the updated image into the content. Editing
consists of several functions available on the toolbar, such as

• brightening
• rotating
• changing the color depth
• inserting text
This section explains WebImageFX.
NOTE

WebImageFX is an external, add-on product available from Ektron.

Using WebImageFX
Choosing the Image
If you double click an image, it appears within WebImageFX. You
can also right click the mouse and choose Image Editor from the
menu that appears.
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WebImageFX looks similar to eWebEditPro+XML but has different
menu and toolbar buttons.

If the Image Edit button ( ) appears on your toolbar, you can click
it to open WebImageFX. If no image is selected when you press
the button or click the menu command, a blank editor appears, and
you can use the File -> Open command to choose an image.
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Once the image is in WebImageFX, you can use the buttons and
menu options to edit it. The rest of this chapter describes those
buttons and menu options.

Saving the Image
When you finish editing the image, you can insert it into the content
by pressing the Exit button (

). Alternatively, you can save the

image to a local or network folder using the Save button (

).

When you insert the image into the content, WebImageFX checks
the file extension. If the image is a .gif file, it is saved as a .png file
in your temporary directory. For example test.gif is saved as
C:\Documents and Settings\your user name\Local
Settings\Temp\test.png.

Any other file type is saved in your temporary directory without
changing the file extension, unless you use the Save As option.
For example, you save test.jpg as test.png.

Assigning a Name to a New Image
If you create an image in WebImageFX, and then exit
WebImageFX and return to eWebEditPro+XML, the system assigns
the image a random name, such as WIF50A.jpg.
If you want to assign a different name and/or folder to the image,
use the Save as command.
See Also: ”Save As” on page 712

Toolbar Buttons and Menu Commands
The following tables list each toolbar button and menu command.
They are followed by a more detailed description of each function.
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File Menu Options

Toolbar
Button

Command

Brief Description

For more
information, see

Create New

Creates a new image.

”Create New” on
page 699

Open

Selects an image to edit.

”Open” on page 705

Save

Saves changes to an image.

”Save” on page 711

Save As

Saves the current image under a
different name or format.

”Save As” on page 712

Performs a single page scan.

”Twain Acquire” on
page 716

Twain Acquire

Before scanning, you must select a
source using the Twain Source
command.
Twain Source

Allows the user to select a source for
acquiring an image, such as a
scanner or digital camera.

”Twain Source” on
page 716

Exit

Save changes and return to
eWe bE di tP ro + XML .

”Exit” on page 701

Exit without save

Ignore changes; return to
eWe bE di tP ro + XML .

”Exit without Save” on
page 702

Command

Brief Description

For more
information, see

copy

Copies a selected area of an image.

”Copy” on page 699

Edit Menu Options

Toolbar
Button
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Toolbar
Button

Command

Brief Description

For more
information, see

paste as new
image

Inserts copied image or area into a
new file.

”Paste as New Image”
on page 707

undo

Reverses the most recent action.

”Undo” on page 717

redo

Reapplies the changes from the
command that occurred before you
pressed Undo.

”Redo” on page 710

select

Selects an area of an image. You
can then perform actions on the
area, such as blur and delete.

”Select” on page 713

crop

Removes everything outside of
selected area of an image.

”Crop” on page 699

delete

Deletes selected area of an image.

”Delete” on page 700

Command

Brief Description

For more
information, see

reset zoom ratio

Displays image at full size.

”Reset Zoom Ratio” on
page 710

zoom in

Increases an image’s magnification.

”Zoom In” on page 717

zoom out

Decreases an image’s magnification.

”Zoom Out” on
page 718

View Menu Options

Toolbar
Button
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Image Menu Options

Toolbar
Button

Command

Brief Description

For more
information, see

image info

Displays information about an
image.

”Image Info” on
page 703

dimensions

Modifies an image’s width and
height.

”Dimensions” on
page 700

color depth

Changes the number of colors
available to an image.

”Color Depth” on
page 697

blur

Blurs or softens an image.

”Blur” on page 693

sharpen

Sharpens edges within an image.

”Sharpen” on page 713

brightness

Changes an image’s brightness.

”Brightness” on
page 694

contrast

Changes the difference between
light and dark areas of an image.

”Contrast” on page 698

horizontal flip

Reverses an image horizontally left
to right.

”Horizontal Flip” on
page 703

vertical flip

Flips an image vertically top to
bottom.

”Vertical Flip” on
page 717

rotate

Turns an image a specified number
of degrees.

”Rotate” on page 711
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Annotation Menu Options

Toolbar
Button

Command

Brief Description

For more
information, see

pointer selection

Click an annotation to select it.

”Pointer Selection” on
page 707

choose color

Sets the color for an annotation
before you insert it.

”Choose Color” on
page 695

choose font

Sets the color of text before you
insert it.

”Choose Font” on
page 696

freehand

Draws a line in any shape that you
want.

”Freehand” on
page 702

line

Draws a straight line.

”Line” on page 704

oval

Draws an oval.

”Oval” on page 706

polygon

Draws a polygon (a closed figure
surrounded by straight lines).

”Polygon” on page 708

rectangle

Draws a rectangle.

”Rectangle” on
page 709

text

Inserts text.

”Text” on page 714

Blur
Standard Toolbar Button

Description
Blurs or softens an image. You can select a level of blur, from 0
through 4.
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If you select an area of the image, the command only changes that
area.

Dialog Box

Brightness
Standard Toolbar Button

Description
Increases or decreases an image’s brightness. You can select a
brightness level from 32 (brightest) through -32 (darkest).
If you select an area of the image, the command only changes that
area.
NOTE

You cannot adjust brightness if the image’s bit depth is 8 or fewer. See
”Specifying Color Depth” on page 718

Also:

Dialog Box
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Choose Color
Standard Toolbar Button

Description
Lets you choose the color of an annotation before you insert it.
To change an annotation’s color after inserting it, place the cursor
on the annotation and press the right mouse button to display the
Attributes menu.

Dialog Box
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Choose Font
Standard Toolbar Button

Description
Lets you choose the color of annotation text before you insert it.
To change an annotation’s color after inserting it, place the cursor
on the annotation and press the right mouse button to display the
Attributes menu.

Dialog Box
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Color Depth
Standard Toolbar Button

Description
Changes an image’s color depth.
See Also: “Specifying Color Depth” on page 718

Dialog Box
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Contrast
Standard Toolbar Button

Description
Increases or decreases an image’s contrast (that is, the difference
between light and dark areas of an image). You can select a
contrast level, from 10 through -10.
If you select an area of the image, the command only changes that
area.

Dialog Box

Ektron CMS40 0.NET User Manua l, Version 7.5

698

Editing Images

Copy
Standard Toolbar Button

Description
Copies a selected area of an image. After you copy an image, you
can paste it using the paste command. See Also: ”Paste as New
Image” on page 707
To select an area of an image, use the Select command. See Also:
”Select” on page 713
If you do not select an area, the entire image is copied.

Create New
Standard Toolbar Button

Description
Lets you create a new image. If you are editing an image when you
press this command, you are asked if you want to save changes to
it first.
By default, a new image’s bit depth is 24, but you can change it if
desired using the color depth command.
See Also: ”Color Depth” on page 697

Crop
Standard Toolbar Button

Description
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Keeps selected area of an image; removes everything outside that
area.
To use the Crop command, follow these steps.
1. Select an area of an image that you want to keep.
2. Press the Crop button (

).

3. Everything outside the selected area is removed.

Delete
Standard Toolbar Button

Description
Removes a selected area of an image. You must select an area
before you delete it.
The deleted area is not saved for later pasting. In contrast, if you
use the Cut command, you can later paste the cut area.

Dimensions
Standard Toolbar Button

Description
Lest you change an image’s width and/or height, which are defined
in pixels.
Maintaining Aspect Ratio
Use this check box to change an image’s size while maintaining its
aspect ratio.
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Aspect ratio is the ratio of an image’s width to height. For example,
if a graphic has an aspect ratio of 2:1, its width is twice as large as
its height.
If you check the Maintain Aspect Ratio box, just specify a new
width -- the height is calculated automatically.

Dialog Box

Exit
Standard Toolbar Button

Description
Save the change in the WebImageFX and return to
eWebEditPro+XML, where the updated image appears.
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Exit without Save
Standard Toolbar Button

Description
Ignore changes made to the image in WebImageFX. Return to
eWebEditPro+XML.

Freehand
Standard Toolbar Button

Description
Lets you draw a line in any shape that you want, similar to using a
pen on paper.
To use this command, click the freehand command, drag the line,
and release the mouse. To change the line’s size or color, place
the cursor on the line and press the right mouse button to display
the Attributes menu.

Dialog Box
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Horizontal Flip
Standard Toolbar Button

Description
Reverses an image horizontally left to right.
Click this command again to reverse the image horizontally right to
left.

Image before horizontal flip

Image after horizontal flip

Image Info
Standard Toolbar Button
Ektron CMS40 0.NET User Manua l, Version 7.5

703

Editing Images

Description
Displays information about an image:

• image name
• height and width in pixels
• bit depth (See Also: ”Specifying Color Depth” on page 718)
• file format

Line
Standard Toolbar Button

Description
Draw a straight line. To change a line’s size or color, right click it
after drawing it.
To use this command, click the line command, drag the line, and
release the mouse. To change the line’s size or color, place the
cursor on the line and press the right mouse button to display the
Attributes menu.

Dialog Box
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Open
Standard Toolbar Button

Description
Select an image for editing. The image can be on your computer or
a local area network.

Dialog Box
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To change the type of file that appears in the window, click the
down arrow (circled above) to the right of the Files of type field.
Your system administrator determines which types of files you can
edit.

Oval
Standard Toolbar Button

Description
Draws an oval.
To use this command, click the oval command, drag the line, and
release the mouse. To change the oval’s line size or color, place
the cursor on the line and press the right mouse button to display
the Attributes menu.
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Dialog Box

Paste as New Image
Standard Toolbar Button

Description
After you copy or cut an image or an area of an image, use paste
as new image to insert it into a new file.
Before creating a new file, WebImageFX asks if you want to save
changes to current file.

Pointer Selection
Standard Toolbar Button

Description
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Click an annotation to select it. After you select an annotation, you
can perform functions on it, such as delete it.
This command is a toggle, which means the first time you click it, it
is on, and the next time you click it, it is off.

Polygon
Standard Toolbar Button

Description
Draws a polygon (that is, a closed figure surrounded by straight
lines).
To use this command, follow these steps.
1. Click the polygon command.
2. Drag the line in one direction as far as you want.
3. Drag the line in the other directions to complete the polygon.
4. Double click the mouse to terminate the polygon.
5. To change the polygon’s line size or color, place the cursor on
the line and press the right mouse button to display the
Attributes menu.

Dialog Box
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Rectangle
Standard Toolbar Button

Description
Draws a rectangle.
To use this command, click the rectangle command, drag a
rectangle, and release the mouse. To change the rectangle’s line
size or color, place the cursor on the line and press the right mouse
button to display the Attributes menu.

Dialog Box

Ektron CMS40 0.NET User Manua l, Version 7.5

709

Editing Images

Redo
Standard Toolbar Button

Description
If you use the Undo command and then decide that it was a
mistake, use this command. It re-applies the changes from the
command that occurred before you pressed Undo.
See Also: ”Undo” on page 717

Reset Zoom Ratio
Standard Toolbar Button

Description
Displays image at full size.
See Also: ”Zoom In” on page 717; ”Zoom Out” on page 718
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Rotate
Standard Toolbar Button

Description
Turns an image a specified number of degrees. Note that the
dialog box lets you rotate the image

• left or right
• 90, 180, or 270 degrees
• any number of degrees between 1 and 359
Dialog Box

Save
Standard Toolbar Button

Description
Save changes to an image. If required information is missing, such
as the image name, you are prompted for this information.
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Dialog Box

NOTE

The dialog box only appears the first time you save the image. If you later want to
save it to a different folder, or under a different name or file type, use the Save As
command.

Save As
Standard Toolbar Button

Description
Save the current image under a different name or format. For
example, you might save mypicture.gif as mypicture.jpg.
Your system administrator determines which file formats are
available.
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Dialog Box
See ”Save” on page 711

Select
Standard Toolbar Button

Description
Selects an area of an image. You can then execute other
commands on the selected area, such as blur, sharpen, cut, and
delete.
NOTE

Once you press the Select command, it remains selected and continues to be
active until you press it a second time.

Sharpen
Standard Toolbar Button

Description
Sharpens edges within an image. You can select a level of
sharpness, from 1 through 5.
Sharpening brings an image into better focus and increases the
detail.
If you select an area of the image, the command only changes that
area.

Dialog Box
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Text
Standard Toolbar Button

Description
Places text on an image. You can also change the text’s size, font,
color, and attributes (bold, italic, etc.).
To use the Text command, follow these steps.
1. Click the Text button (

).

2. Move the cursor to where you want to place the text.
3. Click the mouse button and drag a rectangle in which to insert
the text.
NOTE

Make sure the rectangle is large enough to accommodate your text. The rectangle
disappears after you enter text.

4. Type the text.
5. Click outside the rectangle to close it.
6. To change the text or its font, size, style, color, etc., place the
cursor over the text and right click the mouse. The text
attributes dialog appears.

Dialog Box
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The following table lists functions you can perform with this dialog.

To change this

Use this tab/field

font

Font Attributes/Font

font size

Font Attributes/Size

font style (bold, italic, etc.)

Font Attributes/Style

underlining

Font Attributes/Underline

strikeout (for example, sample)

Font Attributes/Strikethrough

font color

Color Attributes/Primary
Color

text

Text Attributes/white box

if text wraps when it reaches the
end of a line

Text Attributes/ Wrap
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Twain Acquire
Standard Toolbar Button

Description
Perform a single page scan from a previously selected source.
See Also: ”Twain Source” on page 716
Importing Scanned Images
WebImageFX lets you acquire images from a scanner or digital
camera that supports the Twain standard. You select the source
(using Twain Source) and do a quick acquire from that source
(using Twain Acquire).
Limitations

• You can only acquire one page at a time
• Few digital cameras support twain. Usually, digital cameras
resemble a hard drive or use proprietary software to extract
images. Ektron does not support an interface to proprietary
software.

• Not all scanners support the twain standard

Twain Source
Standard Toolbar Button

Description
Lest you select a source for acquiring an image, such as a scanner
or digital camera.
See Also: ”Twain Acquire” on page 716
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Undo
Standard Toolbar Button

Description
Reverses the most recent commands within the current editing
session.
You can undo several commands at once by pressing the undo
command repeatedly. The first time you press the command, the
most recently completed command is “undone.” The next time, the
second most recently completed command is “undone”, etc.
See Also: ”Redo” on page 710

Vertical Flip
Standard Toolbar Button

Description
Flips an image vertically top to bottom.
Click this command again to reverse the image vertically bottom to
top.

Image before vertical flip

Image after vertical flip

Zoom In
Standard Toolbar Button
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Description
Increases an image’s magnification.
You can press this command several times to continue to increase
magnification.
See Also: ”Zoom Out” on page 718; ”Reset Zoom Ratio” on
page 710

Zoom Out
Standard Toolbar Button
Decrease an image’s magnification.
You can press this command several times to continue to decrease
magnification.
See Also: ”Zoom In” on page 717; ”Reset Zoom Ratio” on
page 710

Specifying Color Depth
To specify an image’s color depth (that is, the number of colors
available to an image), specify a bit depth. The color depth is
derived from the bit depth. Here are the bit depth values.
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Bit depth

Color depth

1

2 colors

4

16 colors

8

256 colors

24

16M colors
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Sometimes, the information on your Web page looks better when
displayed on a table. Here is an example.

City

Baseball Team

Hockey Team

Boston

Red Sox

Bruins

New York

Yankees / Mets

Rangers

Chicago

White Sox / Cubs

Black Hawks

This section explains

• ”Creating a Table” on page 720
• ”Deleting a Table” on page 721
• ”Inserting a Table within a Table” on page 722
See Also:

• “Table Dialog Boxes and Menus” on page 723
• “Manipulating Your Table’s Format” on page 730
• “Working with Table Cells” on page 746
• ”Section 508 Tables” on page 787
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Creating a Table
To create a table, click the table button ( ) then click Insert Table
from the menu. When you do, the Insert Table dialog box appears.

You can also access this dialog box after you insert it. You would
do this if you wanted to edit any of the information entered in the
dialog.
To access this dialog after insertion, follow these steps.
1. Click the table.
2. Right click the mouse.
3. Click Table Properties from the menu.
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When creating a table, you can specify the

• number of rows and columns
• width
• horizontal alignment on the page
• background color or background picture
• border size and color
For more information about managing tables, see “Manipulating
Your Table’s Format” on page 730.
For more information about managing individual cells within a
table, see “Working with Table Cells” on page 746.

Deleting a Table
To delete a table, follow these steps
1. Move the cursor over the table until the cursor becomes a fourheaded arrow (

).

2. Click the mouse button. The table becomes selected (small
squares appear around it).

3. Press <Delete>.
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Inserting a Table within a Table
You can insert a table within a table. You might want to do this to
arrange text in columns.

NOTE

HTML does not let you use tabs or spaces to align text in columns. You must use
a table to align columns. You can remove the table’s border, so that no lines
appear between the columns and rows.

To insert a table within a table, follow these steps.
1. Place the cursor in the cell into which you want to insert a table.
2. Click the Insert Table button (

).

3. Click Insert Table from the menu.

4. The Insert Table dialog box appears.
5. Edit the fields in the dialog box as needed. Then, click OK.
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This section explains the menu options and dialog boxes you use
to manipulate tables and cells. In most cases, you are referred to
another section that describes the feature in more detail.
This section explains

• ”The Insert Table Menu” on page 723
• ”The Table Properties Dialog Box” on page 725
• ”The Cell Properties Dialog Box” on page 727
• ”The Table Context Sensitive Menu” on page 728

The Insert Table Menu
You access the Insert Table menu by clicking on the Insert Table
button (
NOTE

) while the cursor is inside a table.

Before you click the button, make sure the table is not selected (that is, the table
is not surrounded by small boxes).

When you do, the following menu appears.
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The following table lists the menu options and where to get more
information on each.

Menu Option

Description

For more information, see

Insert Table

Inserts a new table where the
cursor is currently resting

“Creating a Table” on page 720

Insert Row

Creates a new table row above the
row in which the cursor is currently
resting

“Adding or Removing Rows and
Columns” on page 731

Insert Column

Creates a new table column next to
the column in which the cursor is
currently resting

“Adding or Removing Rows and
Columns” on page 731

Insert Cell

Inserts a cell to the left of the cursor
in a table

Delete Rows

Deletes table row in which the
cursor is currently resting

“Adding or Removing Rows and
Columns” on page 731

Delete Column

Deletes table column in which the
cursor is currently resting

“Adding or Removing Rows and
Columns” on page 731

Delete Cells

Deletes the selected cells

Merge Cells

Combines the contents of two or
more selected cells into one

“Merging Two Cells” on page 760

Split Cell

Divides a cell into two. Each cell
occupies one half the size of the
original cell.

“Splitting a Cell” on page 759

Table Properties

Displays and lets you edit table
properties, such as the number of
rows and columns, cell padding,
and borders.

“The Table Properties Dialog Box” on
page 725

Cell Properties

Displays and lets you edit cell
properties, such as width and
alignment

“The Cell Properties Dialog Box” on
page 727
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The Table Properties Dialog Box
The Insert Table dialog box lets you manipulate most elements of a
table‘s appearance.

The following table lists the fields on this dialog box and refers you
to the section that explains each field.
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Field(s)

Lets you specify

For more
information, see

Size: Rows, Columns

The number of rows and
columns in the table

“Choosing the Number
of Rows and Columns”
on page 730

Layout: Width

Table width

“Specifying Table Width”
on page 732

Layout: Horizontal
Alignment

The table’s alignment
across the Web page

“Setting Horizontal
Alignment” on page 756

Background Color

The background color of
the table

“Specifying a Table’s
Background Color” on
page 739

Background Image

A background image for
the table

“Specifying a
Background Image
for a Table” on
page 741

Borders: Use Default
Color

Whether or not to use
the default color (gray)
for table borders

Border Color

If you do not use the
default, the color of the
table border

“Assigning Border
Color” on page 742

Border Size

The size of the table
border

“Assigning Border Size”
on page 744

Cell Padding

The space (in pixels)
between the cell text
and a cell’s border

“Assigning Cell
Padding” on page 762

Cell Spacing

The space (in pixels)
between a cell and
surrounding cells

“Assigning Cell
Spacing” on page 763
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The Cell Properties Dialog Box
The Cell Properties dialog box lets you manipulate most elements
of a cell‘s appearance.

The following table lists the fields on this dialog box and refers you
to the section that explains each field.
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Field(s)

Lets you specify

For more
information, see

Rows Spanned

If the cell spans two or
more rows

“Spanning Rows or
Columns” on page 754

Columns Spanned

If the cell spans two or
more columns

“Spanning Rows or
Columns” on page 754

Width

The minimum cell width

“Specifying the Width of
a Cell” on page 746

Word Wrap

Whether text moves
down to the next line
when it reaches the
specified width of a cell

“Word Wrap” on
page 761

Horizontal Alignment

The alignment of data
across a cell

“Setting Horizontal
Alignment” on page 756

Vertical Alignment

The alignment of data
up and down within a
cell

“Setting Vertical
Alignment” on page 757

Background Color

The cell’s background
color, if you want it to be
different from the table’s
background color

“Specifying a Cell’s
Background Color” on
page 750

Background Image

A background image for
the cell

“Specifying a
Background Image for a
Cell” on page 752

Use Default Color

Apply the table border
color to this cell border

Border Color

Apply a color other than
the table border color to
this cell border

“Setting a Cell’s Border
Color” on page 749

The Table Context Sensitive Menu
The following menu appears when you right click the mouse while
the cursor is in a table.
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All items on this menu are described in ”The Context Sensitive
Menu” on page 654 except Tables, which is described in ”The
Insert Table Menu” on page 723.
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Format

This section explains how to manipulate your table’s format by
specifying

• a number of rows and columns
• a width
• horizontal alignment
• a background color or image
• border color and size
NOTE

You can also apply most of these properties to individual cells within a table. See
“Working with Table Cells” on page 746 for details.

• ”Choosing the Number of Rows and Columns” on page 730
• ”Specifying Table Width” on page 732
• ”Specifying Horizontal Alignment” on page 737
• ”Table Backgrounds” on page 738
• ”Setting Table Borders” on page 742

Choosing the Number of Rows and Columns
Use the Size section of the Insert Table dialog box to specify the
number of rows and columns in the table.
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A row is a horizontal series of cells, while a column is a vertical
series.

If you know how many rows and columns the table will be, enter
those numbers. If you don’t know the number of rows and columns
you need when you create the table, estimate how many you need.
You can add or remove rows and columns later.

Placement of Inserted Row or Column
If you add a row, it appears above the row in which the cursor was
resting when you pressed Insert Row.
If you add a column, it appears on the left side of the table.

Adding or Removing Rows and Columns
To add or remove rows and columns after you create the table,
follow these steps.
1. Place the cursor in the cell from which you want to add or
delete.
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2. Right click the mouse. A menu appears.

3. Click the appropriate action from the menu. For example to add
a row, click Insert Row.
NOTE

If you are working with nested tables, and you add or remove a column then undo
that action and redo it, you must press the redo button once for each cell in the
row or column.

Specifying Table Width
When you create a table, you can set its width by specifying one of
the following:

• percentage of the window: the table’s width varies as a user
adjusts the browser size

• fixed number of pixels, the table’s width stays the same as a
user adjusts the browser size
You can also not set a width but instead let information you enter
into the table’s cells determine its width.
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NOTE

To set the width of a table column, adjust the width of one of the cells within the
column (as described in “Specifying the Width of a Cell” on page 746). Usually,
this change affects all other cells in the column.

Specifying Table Width by Percentage
Specify table width by percentage if you want the table to be
resized as the user resizes the browser.
NOTE

In order for the table to resize with the browser, the Word Wrap attribute must be
turned on in all of a table’s cells. For details, see “Word Wrap” on page 761.

For example, if you specify that a table is 100% wide, and your
browser displays 14 inches across when it is maximized, the table
fills the screen (except for the browser border).

If you resize the browser to half the screen, the table will be about
7” wide. You still see both columns, but some of the data is moved
down.
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Setting Table Width by Percentage
To specify table width by percentage, choose Percent in the layout
section of the Insert Table dialog box. Then, specify the percentage
at the Width field.
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Specifying Table Width by Pixels
Specify table width by pixels if you want the table to remain the
same size if a user resizes the browser.
For example, if you specify that a table is 610 pixels wide, and the
user’s browser is set to low resolution (640 x 480 pixels), the table
occupies the full width of the browser when it is maximized.
If the user resizes the browser so that it only occupies the left half
of the screen, only the left half of the table appears. A scroll bar
appears at the bottom of the browser. The user must move the
scroll bar to see the rest of the table.
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If you set table width by pixels, do not set it to more than 610
pixels. Otherwise, the table will not fully display on a monitor set to
low resolution (640 x 480).

Setting Table Width by Pixels
To specify table width by pixels, choose Pixels in the layout section
of the Insert Table dialog box. Then, specify the number of pixels at
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the Width field.

Specifying Horizontal Alignment
You can specify your table’s horizontal alignment (left, right, or
center) within the browser.

Alignment

Example

left

right

center
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If you specify right or left justify, you can wrap text around the table.
To do this, move the cursor to the right or left of the table and begin
typing.

Specify the table alignment at the Horizontal Alignment field on
the Layout area of the Insert Table dialog box.

Table Backgrounds
You can specify a background color or image for your table.
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Specifying a Table’s Background Color
You can assign a background color to a table to make it more
pleasing to the eye. Here is an example.

NOTE

If you apply a dark background color to a table, you may want to apply a light
foreground color to the text. Use the font color button (
color.

) to change the text

To assign a background color to your table, click the Background
Color field on the Insert Table dialog box.

When you click that field, a color dialog box appears. Click the
color that you want to apply to the background of the table.
Follow these steps to get help on how to use the color box.
1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor.
3. Drag the question mark to the area of the dialog box that you
want to learn about.
4. Click the mouse button. A box appears with instructions for that
area.

Deleting a Table’s Background Color
To delete a table’s background color, click the Unassigned box in
the Custom Background area of the Insert Table dialog box.

Ektron CMS40 0.NET User Manua l, Version 7.5

740

Manipulating Your Table’s Format

Specifying a Background Image for a Table
If you want a background image to appear in all table cells, use the
Background Image field of the Insert Table dialog box.

Your Webmaster determines which images are available to you.
To insert a background image
1. Click the down arrow to the right of (Select Image). A list of
background images appears.
2. Click the image of your choice.
3. Click OK.
Note that when you apply a background image to a table

• it applies to the entire table, including the borders.
• if the table is larger than the image, the image repeats until it
fills the table.

• if the image is larger than the table, the top left corner of the
image aligns with the top left corner of the table. The rest of the
image fills as much of the table as possible.

• you can also apply an image to individual cells (see “Specifying
a Background Image for a Cell” on page 752).

• make sure that the image does not obscure user’s ability to
read the table text.
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Deleting a Background Image
1. Move the cursor to any cell on the table and right click the
mouse.
2. Click Table Properties from the menu.

3. Select the value in the Background Image field and press
<Backspace>.
4. Click OK.

Setting Table Borders
You can specify a border color or size for your table.

Assigning Border Color
A table border is the line that separates the table from the rest of
your Web page. By default, table borders are gray. You can change
the color of table borders.
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If you want a table’s border to “disappear,” set it to the same color
as the page’s background color. This technique is often used to
format text on a Web page.

Assigning a Cell Border Color
Each cell also has a border that separates it from the other cells
and the table border. By default, a cell’s border color matches the
table border. However, you can individually change a cell border
color (see “Setting a Cell’s Border Color” on page 749).
To assign a color to your table’s border, click the Border Color
field on the Insert Table dialog box.

When you click that field, a color selection box appears. Click the
color that you want to apply to the table’s border. Follow these
steps to get help on how to use the color box.
1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor.
3. Drag the question mark to the area of the dialog box that you
want to learn about.
4. Click the mouse button. A box appears with instructions for that
area.

Assigning Border Size
You can also adjust the size of a table border. Size is measured in
pixels.

To assign a border size to your table, enter a number of pixels into
the Border Size field on the Insert Table dialog box.

Ektron CMS40 0.NET User Manua l, Version 7.5

744

Manipulating Your Table’s Format

If you set a table’s border size to zero (0) but wish to view the
table’s boundary lines while you are editing it, select the table and
click the border button ( ). Boundary lines will appear while you
are editing but disappear when a user views the page.
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Along with functions for managing tables (described in
“Introduction to Tables” on page 719 and “Manipulating Your
Table’s Format” on page 730), eWebEditPro+XML also lets you
perform actions on individual cells within a table.
You can perform the following actions on individual table cells.

• ”Specifying the Width of a Cell” on page 746
• ”Inserting a Cell” on page 747
• ”Deleting a Cell” on page 748
• ”Setting a Cell’s Border Color” on page 749
• ”Specifying a Cell’s Background Color” on page 750
• ”Specifying a Background Image for a Cell” on page 752
• ”Spanning Rows or Columns” on page 754
• ”Aligning Text Within a Cell” on page 756
• ”Splitting a Cell” on page 759
• ”Merging Two Cells” on page 760
• ”Word Wrap” on page 761
• ”Setting Cell Padding and Spacing” on page 762
NOTE

HTML does not allow you to adjust the width of a cell’s border.

You can also select several cells or a row of cells and change them
as described above. However, you cannot select and change a
column of cells.

Specifying the Width of a Cell
As described in “Specifying Table Width” on page 732, there are
several ways to set the width of a table. Within a table, you can
also specify the width of an individual cell.
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When you set a cell width, there is no guarantee that the cell will
occupy that width when displayed in a browser. This is because the
cell is part of a column, and changes to other cells in the column
can affect the cell whose width you set. Setting cell width only
guarantees that the cell will not be less than the width you specify.
If you want to ensure that a cell’s size does not change, set all cells
in a column to that width.
To specify a cell’s width, follow these steps.
1. Place the cursor in the cell whose width you want to set.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears.

6. In the layout section of the dialog box, enter the cell width at
the Width field. You can enter the width in pixels or percentage.
These choices are explained in “Specifying Table Width” on
page 732.
7. Click OK.

Inserting a Cell
To insert a cell, follow these steps.
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1. Move the cursor to the right of where you want the new cell to
appear.
2. Right click the mouse.
3. Click Insert Cell from the menu.
The new cell appears to the left of the cell in which the cursor
resides when you click Insert Cell. The cursor cell and all cells to
its right shift right to make room for the new cell.
In this example, the cursor was in cell “b” when the user clicked
Insert Cell.
Before

After

Deleting a Cell
To delete one or more cells, follow these steps.
1. Move the cursor to the first cell you want to delete.
2. To delete only that cell, proceed to the next step. To delete
several contiguous cells, select them. Contiguous cells can
cross rows.
3. Right click the mouse.
4. Click Delete Cells from the menu.
Any cells to the right of the deleted cells shift left to occupy the
vacant space.
In this example, the cursor was in cell “b” when the user clicked on
Delete Cells.
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Before

After

Setting a Cell’s Border Color
A cell border is the line that separates it from other cells.
By default, the color of a cell’s border matches the color of the
table border. However, you can change the color of any cell border
individually.
NOTE

When viewed in Netscape Navigator, cell borders are gray, regardless of any
change you make on the Cell Properties dialog box.

This example illustrates the effect of different cell border colors
within a table.

If you want a cell’s border to “disappear,” set it to the same color as
the table’s background color.
To change the color of a cell’s border, follow these steps.
1. Move the cursor to the cell and right click the mouse.
2. Click Table from the menu.
3. Click Cell Properties from the menu.
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4. Click the Border Color field on the Cell Properties dialog box.

5. When you click that field, a Windows Color selection box
appears. Click the color that you want to apply to the cell
border.
See Also: “Using the Color Box” on page 753

Specifying a Cell’s Background Color
“Specifying a Table’s Background Color” on page 739 explains how
to apply a background color to a table. You can also apply a
background color to a cell.
To apply a background color to a cell, follow these steps.
1. Move the cursor to the cell and right click the mouse.
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2. Click Table from the menu.
3. Click Cell Properties from the menu.
4. Click the Background Color field on the Cell Properties dialog
box.

5. When you click that field, a Windows Color selection box
appears.
See Also: “Using the Color Box” on page 753

6. Click a color to apply to the background of the cell.

Deleting a Cell’s Background Color
To delete a cell’s background color, click the Unassigned box in
the Custom Background area of the Cell Properties dialog box.
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Specifying a Background Image for a Cell
“Specifying a Background Image for a Table” on page 741 explains
how to apply a background image to a table. You can also apply a
background image to a cell.
Your Webmaster determines which images are available.
To insert an image into a cell, follow these steps.
1. Move the cursor to the cell and right click the mouse.
2. Click Table from the menu.
3. Click Cell Properties from the menu.
4. Move the cursor to the Background Image field of the Cell
Properties dialog box.

5. Click the down arrow to the right of (Select Image). A list of
background images appears.
6. Click the image of your choice.
7. Click OK.
Note that when you apply a background image to a cell

• If the cell is larger than the image, the image repeats until it fills
the cell.
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• If the cell is smaller than the image, the top left corner of the
image appears in the top left corner of the cell. The rest of the
image fills as much of the cell as possible.

• Make sure the image does not obscure a user’s ability to read
the cell text (if any exists).

Deleting a Background Image
1. Move the cursor to the cell and right click the mouse.
2. Click Table from the menu.
3. Click Cell Properties from the menu.
4. Select the value in the Background Image field and press
<Backspace>.

Using the Color Box
Follow these steps to get help on how to use the color box.
1. Click the question mark in the top right corner.

2. A large question mark appears next to your cursor.
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3. Drag the question mark to the area of the dialog box that you
want to learn about.
4. Click the mouse button. A box appears with instructions for that
area.

Spanning Rows or Columns
You can create a table cell that stretches across more than one
row or column. In the following table, notice how the row that
contains “Sports Teams” spans three columns.

Sports Teams
City

Baseball Team

Hockey Team

Boston

Red Sox

Bruins

New York

Yankees

Rangers

Chicago

White Sox

Black Hawks

You can also create a column that spans several rows, as
illustrated below. Notice that Boston spans three rows.

Colleges
City

Name

Boston

Boston College
Northeastern University
Boston University

New York
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Spanning More than One Row or Column
To have a table cell span more than one row or column, follow
these steps.
1. Place the cursor in the cell that will span rows or columns.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. In the Rows Spanned
or Columns Spanned field, enter the number of rows or
columns that you want this cell to span.

6. Click OK.

Effect of Spanning a Cell
When you set a cell to span rows or columns, the editor does not
remove the cells that are in the way. Instead, it moves those cells
across or down to the next available position.
For example, the following table has two rows and two columns.

If you set cell A to span two rows, note that cell C moves across to
make room for cell A. This action pushes cell D to the next column.
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Aligning Text Within a Cell
Within a cell, you can specify how your text aligns horizontally and
vertically.

Setting Horizontal Alignment
In the Cell Properties dialog box, you can specify the horizontal
alignment of a cell. You have set the alignment to left, center, or
right, or

• left
• center
• right
• justify - the text is justified down both left and right edges. Many
books use this alignment style. (This alignment is not
supported by all browsers.)
This example illustrates these choices.

To set horizontal justification of a table cell, follow these steps.
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1. Place the cursor in the cell that you want to edit.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu
5. The Cell Properties dialog box appears. Click the down arrow
to the right of the Horizontal Alignment field.

6. Click your choice from the list and click OK.

Setting Vertical Alignment
In the Cell Properties dialog box, you can specify the vertical
alignment of a cell. You have four choices.

• top
• middle
• bottom
• along the baseline of the first line of text (the term “baseline” is
defined in ”Aligning the Picture” on page 681)
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This example illustrates the choices.

To set vertical justification for a table cell, follow these steps.
1. Place the cursor in the cell that you want to edit.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. Click the down arrow
to the right of the Vertical Alignment field.
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6. Click your choice from the list and click OK.

Splitting a Cell
You can divide a cell into two. If you split a cell, each cell occupies
one half the size of the original cell.
Row before split

Row after split

To split a table cell into two cells, follow these steps.
1. Place the cursor in the cell that you want to split.
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2. Right click the mouse.
3. Click Table.
4. Click Split Cell from the menu.

5. Two cells now appear where only one appeared before.

Merging Two Cells
You can merge two cells into one. If you merge two cells, the new
cell contains all of the information from both. The new cell’s width
equals the sum of the two cells that were merged.
Cells Before Merge

Cell After Merge

To merge two or more cells, follow these steps.
1. Select the cells that you want to merge.
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2. Click the Insert Table button (

).

3. Click Merge Cells from the menu.

Word Wrap
Word Wrap is a text formatting feature of tables. It causes text to
move down to the next line when the width of the characters on a
line equals the column width. For example, if you set column width
to 50%, with word wrap turned on, a table looks like this.

If you turn Word Wrap off for the same table, you get this result.

If Word Wrap is turned off, text stays on one line until the user
entering table text presses <Enter>. That keystroke causes text to
move down to the next line.
By default, all cells have the Word Wrap feature turned on.
To turn Word Wrap on or off for a cell, follow these steps.
1. Place the cursor in the cell that you want to edit.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. Click or off the Word
Wrap checkbox and click OK.
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Setting Cell Padding and Spacing
Cell padding is the space between a cell’s data and its border.

Cell spacing is the space between a cell and surrounding cells.

Assigning Cell Padding
To assign cell padding to your table, click the Cell Padding field on
the Insert Table dialog box. Enter the number of pixels.
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Assigning Cell Spacing
To assign cell spacing to your table, click the Cell Spacing field on
the Insert Table dialog box. Enter the number of pixels.
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Use a bookmark to let a user “jump” from any word, phrase, or
image to another place in the content. On your Web page, text
appears in a different color to indicate that additional information is
available at the bookmark’s location.
For example, if your Web page includes meeting minutes, the top
of the page could list the meeting dates. You could then assign a
hyperlink to each date and a bookmark to each set of minutes.
The user sees that a date is in a different color, so clicks the date to
“jump” to the bookmark that marks the location of the meeting
minutes.
“Creating a Bookmark” on page 764 describes how to set up a
hyperlink to a bookmark within a file. You can also set up hyperlink
to

• another Web page. This procedure is described in “Using
Hyperlinks” on page 768.

• a bookmark within another Web page. This procedure is
described in “Creating a Hyperlink to a Location Within a Web
Page” on page 771.

Creating a Bookmark
When creating a bookmark, you must specify a

• source, the text or image that the user clicks to move to the
bookmark

• bookmark, the place to which the cursor jumps when the user
clicks the source
To continue with the above example, a meeting date is the source,
and the meeting minutes are the bookmark.
To create a bookmark, follow these steps.
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1. Select the bookmark text or image.
2. Click the Bookmark button (

).

3. The Bookmark dialog box appears. Enter the name of the
bookmark. The bookmark can include the following nonalphabetic characters: ; / ? : @ & = + $ , - _ . ! ~ * ' ( ).

4. Click Add.
5. The editor screen returns. (The bookmark does not appear on
the page.) Select the source text or image.
6. Click the Hyperlink button (

).

7. The Hyperlink dialog box appears.
8. Click the down arrow to the right of the Quicklink field and
click the bookmark you created in Step 3.
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9. If desired, you can use the Target Frame field to change the
window in which the destination text appears. For details, see
“Changing the Destination Window” on page 767.
If you leave the Target Frame field blank, the new window
replaces the current window.
10. Click OK.
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Changing the Destination Window
While defining hypertext, you can use the Target Frame field on
the Hyperlink dialog box to change the window in which the
destination page appears.

The possible values that you can enter into the Target Frame field
are explained below.

If you want the destination page to appear

Click this in the Target Frame
field

In a new browser window, on top of the current
browser.

New Window(_blank)

In the same position within the browser window.
The new window replaces the current one.

Same Window(_self)

If your page contains frames, in the frame that
contains the frame with the hyperlink.

Parent Window(_parent)

If your page contains frames, in the full display
area, replacing the frames.

Browser Window(_top)

If your page contains frames, in the frame with the
specified name.

Enter the name of the frame.
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Use hyperlinks to let a user “jump” from any word, phrase or image
to another Web page. The page can be within your network (that is,
on an intranet) or anywhere on the internet.
NOTE

If you want to create jumps within a file, see “Using Bookmarks” on page 764.

For example, if your Web page includes a jump to the Ektron Web
site, you would enter the text to indicate the jump (for example
Ektron Web Site), then create a hyperlink to www.ektron.com. When
users see Ektron Web Site in a different color, they can click the
text to “jump” to the site.
Although most jumps go to the top of another Web page, you can
also jump to a bookmark within a Web page.
This section explains

• ”Creating a Hyperlink” on page 768
• ”Testing a Hyperlink” on page 771
• ”Creating a Hyperlink to a Location Within a Web Page” on
page 771

• ”Editing a Hyperlink” on page 772
• ”Removing a Hyperlink” on page 773
• ”Preventing a URL from Becoming a Hyperlink” on page 773

Creating a Hyperlink
When creating a hyperlink, you must specify a

• source, the text or image the user clicks to move to the
destination

• destination, the Web page the browser displays when the
person viewing the page clicks the source
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To continue with the above example, Ektron Web Site is the
source, and the Web page available at www.ektron.com is the
destination.
To create a hyperlink, click the Hyperlink button ( ). When you
do, the Hyperlink dialog box appears. From there, you can select
from a list of Web pages (also known as Quicklinks). Or, if the page
you are jumping to is not on the list, enter the URL address of the
destination Web page.
Each choice is described below.

Using a Quicklink
Your Web master can add to the Hyperlink dialog box any number
of Quicklinks, that is, Web addresses that you can link to simply by
selecting an item from a drop down menu.

Quicklinks are “quick” because you do not need to enter or know
the URL of the destination Web page -- your Web master has
already stored that information for you.
To apply a Quicklink, follow these steps.
1. Select the source text or image.
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2. Click the Hyperlink button (
appears.

). The Hyperlink dialog box

3. Click the down arrow to the right of the Quicklink field. A list of
Web pages that your Web master has pre-loaded appears.
4. Click an item from the list to select it.
5. If desired, you can use the Target Frame field to change the
window in which the destination text appears. For details, see
“Changing the Destination Window” on page 767.
If you leave the Target Frame field blank, the new window
replaces the current window
6. Click OK.

Entering a Hyperlink Manually
To create a hyperlink, follow these steps.
1. Select the source text or image.
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2. Click the New Hyperlink button (
appears.

). The Hyperlink dialog box

3. Click in the Link field after http://. Then, enter the address of
the destination Web page. For example, to enter a hyperlink to
the ektron Web site, enter www.ektron.com.
4. If desired, you can use the Target Frame field to change the
window in which the destination text appears. For details, see
“Changing the Destination Window” on page 767.
If you leave the Target Frame field blank, the new window
replaces the current window
5. Click OK.

Testing a Hyperlink
Within the eWebEditPro+XML editor, you can test a hyperlink. To do
this, select the hyperlink then double click it. That action launches
the Web page assigned to the hyperlink.

Creating a Hyperlink to a Location Within a Web Page
Sometimes, the destination Web page contains bookmarks, and
you want to jump from your page to a bookmark on another page.
(Bookmarks are described in “Using Bookmarks” on page 764.)
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To create a hyperlink that jumps to another page’s bookmark,
follow these steps.
1. Go to the destination Web page.
2. Click the bookmark that you want to jump to. For example, on
the illustration below, the text Benefits to Partners jumps to a
bookmark further down on the page.

3. When you click the bookmark, its full address appears in your
browser’s address bar. This bookmark’s address looks like this.
http://www.example.com/single.cfm?doc_id=35#Benefits2

4. Click the address bar. The address is selected. Press
<Ctrl>+<C> to copy the address into the Windows clipboard.
5. Go to eWebEditPro+XML.
6. Select the text or image from which you want to jump to the
bookmark.
7. Click the Hyperlink button (
appears.

). The hyperlink dialog box

8. Move the cursor to the Link field.
9. Press <Ctrl>+<V> to paste the address you copied in Step 4
into the Link field.
10. Click OK.

Editing a Hyperlink
If you need to change a hyperlink’s destination Web page or target
frame, follow these steps.
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1. Click the Hyperlink button (
appears.

). The hyperlink dialog box

2. Edit the Link or Target Frame field as needed.
3. Press OK.

Removing a Hyperlink
If you want to remove the hyperlink from text or an image, select
the text or image and press the Remove Hyperlink button (

).

Preventing a URL from Becoming a Hyperlink
If you enter a URL or an email address into eWebEditPro+XML, it
automatically becomes a hyperlink. To prevent this, enter an extra
space in the URL or address.
For example, instead of entering sales@ektron.com, enter
sales<blank>@ektron.com.
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eWebEditPro+XML creates pages for display on the World Wide

Web or an intranet. These pages use HTML (hypertext markup
language) to format text and images for display in a browser. You
do not need to know HTML to use eWebEditPro+XML.
However, if you know HTML, you can view, insert or edit your Web
page’s HTML code.
This section explains

• ”Viewing and Editing HTML” on page 774
• ”Inserting Source” on page 775
• ”Cleaning Source Code” on page 776
• ”Inserting Content from MS Office” on page 777

Viewing and Editing HTML
When you choose to view your page as HTML, the editor cleans
the content using a method determined by your Webmaster. (For
more information, see “Cleaning HTML” in the eWebEditPro+XML
Developer’s Reference Guide.)
To view your page’s HTML, follow these steps.
1. Click the View as HTML button ( ), or right click the mouse
and click View as HTML from the menu.
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2. The HTML code appears. While viewing the code, you can edit
it using editor functions such as Cut, Copy, Paste and Replace.
To select all content, press <Ctrl>+<A>.
You can also set default values for the style, size and color in
which the HTML appears. To do this, right click the mouse and
click Preferences. When you do, a dialog box appears in which
you can enter formatting information about the HTML code.

These settings will be used whenever you view as HTML.
The settings are ignored when you view the page in WYSIWYG
mode and when the user views the page.
3. To return to normal view, click the View as WYSIWYG button
( ) or right click the mouse and click View WYSIWYG.

Editing a Section of a Page
If you want to edit only a section of the HTML on your Web page,
follow these steps.
1. Select the portion of your Web page that you want to edit.
2. Right click the mouse.
3. Click Edit Source from the menu. The HTML code appears.
4. Edit the HTML code as desired.
5. Click OK.

Inserting Source
If you want to insert HTML source code into your Web page, follow
these steps.
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1. Place the cursor at the spot on the page where you want to
insert the HTML.
2. Right click the mouse.
3. Click Insert Source from the menu.
4. The Insert Source dialog box appears. Paste or type your
HTML code.
5. Click OK.

Cleaning Source Code
eWebEditPro+XML lets you “clean” the HTML source code for your

Web page. You would typically use this feature after entering
HTML text or pasting HTML code into eWebEditPro+XML from
another application.
The Clean Source option removes unnecessary HTML tags,
ensures that all tags begin and end properly, and maximizes the
page for efficiency. As a result, the page should be error-free and
load more quickly in a browser. Also, the appearance of clean
HTML is more consistent when viewed in different browsers.
To clean your HTML, follow these steps.
1. Right click the mouse.
2. Click Clean Source from the menu.
3. eWebEditPro+XML cleans your Web page’s HTML content.
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Inserting Content from MS Office
If you paste text into eWebEditPro+XML from a Microsoft Office
2000 (or higher) application, such as Microsoft Word, the following
window appears.

For best results, click Yes.
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The Wiki feature lets registered site visitors (that is, membership
users) and CMS users insert hyperlinks to other content. The
hyperlinks can connect to existing content or to content that
doesn’t exist yet. If the hyperlink’s destination does not yet exist,
the wiki creates both the hyperlink and the new content item to
which it jumps.
This collaborative authoring style is used in wiki sites such as
Wikipedia (http://en.wikipedia.org), where any author can
contribute new content and articles.

Creating a Wiki
To create a wiki hyperlink, the user needs permission to add
content to the folder that contains the content being edited.
There are two ways to create a wiki link. They are contrasted
below.
Method

Advantages

For more
information, see

Surround text with square
brackets ([[ ]])

Quick

”Creating a Wiki Link
Using Square Brackets”
on page 782
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Method

Use the wiki button (

)

Advantages

For more
information, see

•

Can link to existing content or create new
content

”Using the Wiki Button”
on page 779

•

Can choose new content’s folder

Note: Membership users cannot choose a
folder. The new content is created in the same
folder as the content being edited.

•
•

Can change title of new content
Can select new window’s target frame

Using the Wiki Button
To create a wiki link using the wiki button, follow these steps.
1. Begin editing a content item. (For CMS users, this is explained
in ”Editing HTML Content” on page 52. For membership users,
this is explained in the Ektron CMS400.NET Administrator
manual section “Managing Content Folders” > “Community
Folders.”.)
2. Select the text to which you want to assign a wiki hyperlink. It
can be one or several words.
3. Click the Wiki button (
NOTE

).

The Wiki button only appears if you have permission to add content to the folder
that contains the current content.

4. The Add/Edit Wiki Link screen appears. It has two tabs.
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• Use the New Content tab to create a new content item into
which you will add information later. The new content item will
appear when a site visitor clicks the link text.
If you want to place the new content item in the folder that
contains the text you are editing, do nothing. To place new
content in a different folder, click Change and navigate to that
folder.
NOTE

Membership users do not have an option to assign a folder. The new content is
saved to the folder that contains the content to which the wiki is assigned.

You can also edit the Title and the Target Frame. To learn
about target frames, see ”Changing the Destination Window”
on page 767.

• Use the Related Content tab to link to an existing content item.
If you click this tab, Ektron CMS400.NET uses the selected text
to search the Web site.
All content with that text then appears on the screen. Each
content item’s title appears followed by its summary. Click the
radio button next to the content you want to link to.
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5. To indicate that a wiki to new content has been applied, the text
color changes to blue and bold, and small dots appear under
the wiki text.
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If you applied a link to related content, a regular hyperlink
appears.

Creating a Wiki Link Using Square Brackets
To create a wiki link using square brackets, follow these steps.
1. Begin editing a content item. (For CMS users, this is explained
in ”Editing HTML Content” on page 52. For membership users,
this is explained in the Ektron CMS400.NET Administrator
manual section “Managing Content Folders” > “Community
Folders.”)
2. Move the cursor to the left of the text to which you want to
assign a wiki hyperlink. It can be one or several words.
3. Insert two open square brackets ([[).
4. Move the cursor to the end of the text to which you want to
assign a wiki hyperlink.
5. Insert two close square brackets (]]).
6. Save the content.

Effect of Linking to Existing Content
If you link to existing content, the link is the same as quicklink. See
”Using a Quicklink” on page 769

Effect of Linking to New Content
If you are creating new content, Ektron CMS400.NET assigns a
<span> tag to the selected text. See example below.
<Span class = "makelink">selected text here</span>

When the content is published, Ektron CMS400.NET
1. detects the <span

class = "makelink">

tag

2. finds text surrounded by the <span> tag
3. creates a new content block in the selected folder
NOTE

Membership users cannot select a folder. The new content is created in the folder
that contains the source content.

Ektron CMS40 0.NET User Manua l, Version 7.5

782

Using Ektron CMS400.NET’s Wiki Feature

- its name is typically the selected text. However, if the user
used the wiki button, he can modify the new content block’s
title on the Add/Edit Wiki Link screen.

- its initial text is New Content: content for selected text.
(Fill in the topic text as you or other collaborators have
time.)
4. gets the quicklink for the newly-created content block
5. opens the original content and replaces the <span> tag with the
quicklink to newly-created content
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IMPORTANT!

This section explains how eWebEditPro+XML complies with Section 508 of the
Rehabilitation Act. To learn about how the alternative editor, eWebEdit400,
complies with Section 508, see ”Section 508 Tables” on page 570.

This section explains how eWebEditPro+XML complies with
Section 508 of the Rehabilitation Act (a law enacted by the United
States government that requires Federal agencies to make their
electronic and information technology accessible to people with
disabilities).
Specifically, this section explains the following topics.

• ”Moving the Cursor into eWebEditPro+XML” on page 784
• ”Using eWebEditPro+XML without a Mouse” on page 785
• ”Section 508 Tables” on page 787

Moving the Cursor into eWebEditPro+XML
Using Internet Explorer
If the eWebEditPro+XML editor is one of several fields on a page,
and your browser is Internet Explorer, move to eWebEditPro+XML
by pressing <Tab> until the cursor lands in the editor.
To move from the editor to the next field, press <Ctrl>+<Tab>.

Using Netscape
If the eWebEditPro+XML editor is one of several fields on a page,
and your browser is Netscape, your Webmaster needs to create
custom toolbar buttons that let you move into and out of the editor.
(This procedure is described in the eWebEditPro+XML
Developer’s Reference Guide.)
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Using eWebEditPro+XML without a Mouse
As explained in ”Customizing Your Toolbar” on page 645, the
eWebEditPro+XML toolbar consists of one or more toolbar
menus. Menus have buttons that you click with the mouse to
perform actions, such as copying text.
This section explains how to perform those actions without using
the mouse.
1. With the cursor in the eWebEditPro+XML editor, press the
application key (

).

2. A menu appears.

3. Press the down arrow key ( ) to select Menus. Menus
becomes highlighted.

4. Press <Enter>. A new menu lists all toolbar menus available to
you.
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If your Webmaster has given you access to all standard toolbar
menus, the menu looks like this.

5. Press the down arrow key ( ) to select the toolbar menu that
has a button that you want to use.
6. A new menu appears, listing all options on the selected menu.
The following menu displays what might appear if you select
the Edit Menu. (Your Webmaster determines which menu
options are available).
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7. Press the down arrow key ( ) until the desired option is
highlighted. Then, click the option to perform the action.

Section 508 Tables
You can apply the following information to any table to make it 508
compliant.

Information

Where applied

For more information, see

Heading Rows

Accessibility dialog

”Accessibility Dialog” on
page 790

Heading Columns

Accessibility dialog

”Accessibility Dialog” on
page 790
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Information

Where applied

For more information, see

Summary

Accessibility dialog

”Accessibility Dialog” on
page 790

Caption

Accessibility dialog

”Accessibility Dialog” on
page 790

Horizontal Caption
Alignment

Accessibility dialog

”Accessibility Dialog” on
page 790

Vertical Caption
Alignment

Accessibility dialog

”Accessibility Dialog” on
page 790

Abbreviation

Cell properties dialog

”Accessibility Fields on Cell
Properties Dialog” on page 792

Categories

Cell properties dialog

”Accessibility Fields on Cell
Properties Dialog” on page 792

WARNING!

The Section 508 Table Properties dialog only works if Internet Explorer version
6.0 or higher is installed. Once that is installed, any browser can be used
(Netscape, FireFox, IE, etc.).

WARNING!

Even if you change no values on the screen, you must open the Accessibility
dialog whenever you modify a table (for example, add a new row). The table’s
properties, required for Section 508, are generated when you click OK to close
the dialog box.

To create a 508 compliant table, follow these steps.
1. Create a new table or edit an existing one, as explained in
”Introduction to Tables” on page 719.
2. Select the table by moving the cursor to a table border until you
see a four headed arrow (illustrated below). When a table is
selected, small squares surround it.
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3. Click the Tables button (

).

4. Click Table Properties.
5. The Table Properties dialog appears.
6. Click the Accessibility button.
NOTE

Your system administrator can add or remove the Accessibility button from the
Insert Table dialog.

7. The Accessibility dialog appears.
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Accessibility Dialog
Respond to the fields in the dialog. They are described below.

Field

Description

Heading
Rows

If you want your table to have a horizontal header, enter
the number of rows that it should occupy.
Beginning with the top, all cells in the specified number
of rows are designated as table headers.

Heading
Columns

If you want your table to have a header, enter the
number of columns that it should occupy.
Beginning with the left column, all cells in the specified
number of columns are designated as table headers.

Summary

If desired, enter the table summary. Non-visual browsers
can use the summary to explain the contents of the
table.
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Field

Description

Caption

If desired, enter the table caption. The caption appears
centered below the table when viewed.

Horizontal
Caption
Alignment

If desired, enter the caption’s horizontal alignment:

Vertical
Caption
Alignment

•
•
•

center
left
right

If desired, enter the caption’s vertical alignment:

•
•

bottom
top

After you complete the Table Properties dialog, click OK to make
the table comply with Section 508.

Setting Abbreviation and Category Attributes
You can modify abbreviation (ABBR) and category (AXIS)
attributes within a table. To do so, follow these steps.
1. Select one or more cells.
2. RIght click the mouse.
3. Select Table > Cell Properties.
4. Access the Cell Properties dialog.
The Cell Properties dialog includes fields that let you adjust the
Abbreviation and Category Attribute field values (see illustration
below).
NOTE

Your system administrator can add or remove the Accessibility fields from the
Cell Properties dialog.
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The following explains how to respond to these fields.

Accessibility Fields on Cell Properties Dialog

Field

Description

Abbreviation

Sets or retrieves abbreviated text for the content in the
tag. Can be used to render non-visual media, such as
speech or Braille.
For more information, see http://msdn.microsoft.com/

library/default.asp?url=/workshop/author/dhtml/
reference/properties/abbr.asp
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Field

Description

Categories

Sets or retrieves a comma-delimited list of conceptual
categories associated with that tag. Can be used to
render non-visual media, such as speech or Braille.
For more information, see http://msdn.microsoft.com/
workshop/author/dhtml/reference/properties/axis.asp
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Content

While editing Ektron CMS400.NET content, you can insert
comments to the content. Comments might be an author’s note to
himself or other authors about the content. For example, you could
insert a comment explaining why you are using a certain style
class.
Comments are only visible during editing -- they do not appear
when the content is published on your Web site.
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Other users can add comments to your comments. This feature is
know as “Content Collaboration.”
Similar to other word processing programs, comments can be
added, updated, and tracked to audit changes being made.
This section explains the content collaboration feature.
WARNING!

Do not confuse these comments, which are inserted within the content, with
history comments, which are inserted outside the content and used to indicate
what changed during an editing session.

Adding Comments to Content
To add a comment to content, follow these steps.
1. Create new content or edit existing content. See Also: ”Adding
HTML Content” on page 48
2. In the editor, place the cursor where you want to insert the
comment.
3. On the editor toolbar, click the Insert Comment button (

).

4. The Ektron CMS Comment window opens.
5. Insert a comment. Use the toolbar to format the text if desired.
6. Click the Insert button.
7. The comment is saved.
8. Click the Close button.
9. The comment window closes, and a comment icon is placed
where the comment was added to the content.
.
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Each comment appears in the table at the top of the window. From
this window, you can add another comment and update an existing
one. See the next section for more details.

Viewing a Comment
After a comment is inserted into content, it can be viewed by any
user who can edit the content. To view a comment, follow these
steps.
1. Edit the content that contains the comment.
2. Within the content, double-click the comment icon.

3. The Comments window opens.

Adding Another Comment
To comment on an existing comment, follow these steps.
1. Access the View Comment window for the comment, as
described in ”Viewing a Comment” on page 796.
2. Insert the comment.
3. Click the Insert button.
4. The comment is saved and added to the top row of the
comment table.
5. Click the Close button.

Updating a Comment
You can change a comment if needed. To update a comment,
follow these steps.
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1. Access the View Comments window for the comment that
needs to be updated.
2. Click the Date/Time link of the comment you want to edit.

3. The comment editor opens with the selected comment in it.
4. Update the comment.
5. Click the Update button to save the changes.
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Appendix A: Content Statuses

The table below describes all possible content statuses. The rest
of this appendix explains each status in more detail.

Letter

Border
Color

Meaning

Content state

More Information

A

green

Approved

Through the workflow and
published on the Web site.

”Approved Content”
on page 799

O

red

Checked Out

Currently being edited. Has
not been checked in.

”Checked Out
Content” on
page 802

I

green

Checked In

Checked in for other users
to edit.

”Checked-In
Content” on
page 800

S

yellow

Submitted for
Approval

Saved and submitted into
the approval chain.

”Submitted Content”
on page 803

See Also: ”Approving/
Declining Content” on
page 87

M

yellow

Marked for Deletion

Requested for deletion.

”Marked for Deletion
Content” on
page 804

P

grey

Pending Go Live
Date

Approved but the Go Live
date hasn’t occurred yet.

”Pending Start Date
Content” on
page 805

Awaiting Completion
of Associated Tasks

Task(s) assigned to content
are not complete

T
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Letter

Border
Color

D

Meaning

Content state

More Information

Pending Deletion

Content was created with a
future start date then
checked in and deleted.
This status only remains
until the start date is
reached. At that point, the
content is deleted.

Approved Content
If content has a green border, it is live on the Web site.

When content is approved, you can perform the following actions
on it, depending on your permissions.
.
Button

Dropdown
Menu Option

Description

For more information, see

Check out and
Save as

Check content out and save on
your computer

”Checking Out, Saving, and
Replacing an Office Document”
on page 247

Save as

Save copy of file to your
computer

”Saving an Office Document” on
page 249

Edit or Edit in
Office

Check out the content to
change it

•

”Editing HTML Content” on
page 52

•

”Editing a Managed File” on
page 256

•

”Editing an Office Document” on page 244
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Button

Dropdown
Menu Option

Description

For more information, see

Edit Properties

Edit content’s summary,
metadata, schedule, comment,
etc.

View, View in
Office, or View
Properties

View all information about
content

”Viewing Content from the
Workarea” on page 41

Delete

Submit a request to delete the
content. If you are the last or
only approver, the content is
immediately deleted.

”Deleting Content” on page 57

See Also: ”Example of an
Approval Chain” on page 91

Checked-In Content
If content has a green border, it could mean that the content is
checked in. A checked-in content item is one to which changes
were made, after which it was checked in instead of being
submitted or published. When content is checked in, it is
accessible to all users who have permissions to edit it. They can
check it out and change it.
Keep in mind that the content seen on the template is not the same
as the content in the editor view.

See Also: ”Example of an Approval Chain” on page 91
Each option you may perform on checked-in content is described
below.
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Button

Name

Description

For more information, see

Check out and
Save as

Check content out and save on
your computer

”Checking Out, Saving, and
Replacing an Office Document”
on page 247

Save as

Save copy of file to your
computer

”Saving an Office Document” on
page 249

Edit or Edit in Office

Check out the content to
change it.

•

”Editing HTML Content” on
page 52

•

”Editing a Managed File” on
page 256

•

”Editing an Office Document” on page 244

Edit Properties

Edit content’s summary,
metadata, schedule, comment,
etc.

View, View in
Office, or View
Properties

View all information about
content

”Viewing Content from the
Workarea” on page 41

Delete

Submit a request to delete the
content. If you are the last or
only approver, the content is
immediately deleted.

”Deleting Content” on page 57

See Also: ”Example of an
Approval Chain” on page 91
Submit/Publish

Submit content into approval
chain.

”Asset Workflow” on page 258

If you are last approver in the
approval chain, the publish
button/option appears. If you
click it, the content is
immediately posted to Web site.
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Checked Out Content
If content has a red border, it was checked out by a user other than
you. (If you checked it out, the border is green.) While in this
status, other users are prevented from editing it.

The content remains checked out until it is checked in by the user
who checked it out or a system administrator. Only the user who
checked out the content can edit it.
Each option you may perform on checked-out content is described
below.

Button

Name

Description

Check In

Check in content. Only appears
to user who checked content
out.

Force Check In

Only appears if user is a
member of the Administrator
group and content is checked
out.

For more information, see

Allows the admin to check in
content even though he is not
the one who checked it out.
Request Check In

Allows any user to send an
email to the user who checked
out content. The email asks the
check-out user to check in the
content.

Save as

Save copy of file to your
computer
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Button

Name

Description

For more information, see

Edit or Edit in Office

Check out content to change it.
(Only available to user who
checked content out.)

•

”Editing HTML Content” on
page 52

•

”Editing a Managed File” on
page 256

•

”Editing an Office Document” on page 244

Edit Properties

Edit content’s summary,
metadata, schedule, comment,
etc.

View, View in
Office, or View
Properties

View all information about
content

”Viewing Content from the
Workarea” on page 41

Submitted Content
A yellow border shows that a user submitted the content into the
approval chain. The border remains yellow until the content is
published or declined. While the content is in the approval chain,
no user can check it out.

See Also: ”Example of an Approval Chain” on page 91
Each toolbar button is described below.
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Button

Name

Description

Approve

Approve and publish the content to the Web site.
Note: Only the last approver in the chain has this option.

See Also: ”Example of an Approval Chain” on page 91
Decline

Refuse to publish the submitted content, and change its status
to checked-in.
Note: Only members of the approval chain have this option.
This button rejects the changes and keeps the current version
live on Web site. The approver is prompted to enter a reason for
the decline. After the decline option is completed

•
•

The author who made the change is notified by email
The content is removed from the Approval Chain

If an author updated content then submitted it for approval, the
updated content remains in the file. If you do not want it to
remain, choose the Edit option.
Approvers are prompted to publish or decline content changes
as well as requests to delete content.
Edit

Check out the content and edit it. Only the user who submitted
the content has this option.
Note: If you edit the content, you need to resubmit it to the
approval chain.

View, View in
Office, or View
Properties

View all information about content

Marked for Deletion Content
Content that is marked for deletion has been requested to be
removed from the Web site by a user. When content is marked for
deletion, it passes through the approval chain like content that is
submitted for publishing. When the content completes the approval
chain, it is deleted from the Web site.
See Also: ”Example of an Approval Chain” on page 91
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The table below describes the toolbar buttons.

Button

Name

Description

Delete

Approve the deletion request.
Note: If you are the last user in the approval chain, the content is
deleted when you click this.

Decline

Refuse the deletion request. This sends the content back into a
checked-in status.

Save As...

Save copy of file to your computer. See Also: ”Saving an Office
Document” on page 249

(for assets
only)
View

View information about content

Pending Start Date Content
Content that is pending a Go Live date has been approved, but its
start date and time have not occurred yet.

Button

Name

Description

Edit

Check out the content and edit it. Only the user who submitted
the content has this option.
Note: If you edit the content, you need to resubmit it to the
approval chain.

View, View in
Office, or View
Properties

View all information about content
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Staged Content
A staged version of content is one that is not published. It can be
content that is checked in, or content that is approved with a
pending a start date.
Staging lets you make changes to content, while keeping it from
the Web site until you are ready to publish it.
See Also: ”After you select the content, you have the following
options.” on page 43; ”Appendix A: Content Statuses” on
page 798; ”Workflow in Ektron CMS400.NET” on page 8
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Index
Note: All eWebEdit400 entries are
listed under eWebEdit400.

definition 69
options 69
restoring archived content 71
assets
supported types 223
assign task button, floating toolbar 4
auto hide, feature of Smart Desktop 24
avatar, assigning 480

508 compliance 784

B
A
about eWebEditPro box 640, 643
absolute positioning of objects 640
add
button
calendar event 60
library items 61
task 61
workarea toolbar 60
column
toolbar button 642
content 48
block button 60
folder button 60
row
toolbar button 642
add content screen
buttons 50
responding to fields 50
tabs 51
address, email, user, editing 479
AddSubMenu 460
alignment
cell 756
image 681
table 737
text 640
text, remove, toolbar button 643
approval chain, example 91
approvals toolbar button 61
approve
all, toolbar button 61
button
floating toolbar 4
workarea toolbar 61
content 87
one content item 89
several content blocks 90
approving file
document management
feature 259
archived content, toolbar button 61
archiving

background color
applying to text 639
cell
applying 750
deleting 751
removing from text 639
table
applying 739
deleting 740
background image
cell
deleting 753
inserting 752
table
deleting 742
inserting 741
bidirectional editing 641
blogs
adding 316
categories 322
adding 322
editing 323
removing 324
comments
in the Workarea 354
on the site 352
overview 350
deleting 336
overview 312
posts
adding 346
deleting 349
editing 348
made from the Web site 342
made from the Workarea 344
overview 341
properties 318
roll 327
assigning link 327
editing 330
link, removing 331
searching 337
setting style sheet 321
smart forms used with 326
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tagline 321
update service 321
visibility setting 317
workflow 315
blur, WebImageFX command 693
bold, toolbar option 639
bookmarks 764
border
image
color 681
thickness 680
border color
cell 749
content block, meaning 798
table 742
border size
cell 746
table 744
brightness, WebImageFX command 694
broken links, finding 59
browser requirements
document management
feature 224
bullet, toolbar option 639
buttons
adding to menu 647
rearranging on menu 650
removing from menu 647
text, displaying in title bar 482

C
calendars
add event button 60
authorization for creating 263
button to display in Workarea 63
definition 261
event types 277
events
adding 273
assigning event types 277
button for viewing 63
deleting 284
display times 276, 279
editing 282
end time 275, 279
insert hyperlink 276
location 275
recurring, adding 277
start date 275, 278
start time 275, 279
viewing 280
screen, information on 265
viewing 269
cell properties

i

toolbar button 642
cells
background color 750
background image
deleting 753
inserting 752
border
color 749
invisible 749
deleting 748
inserting 747
merging 760
padding 762
spacing 762
splitting 759
text alignment 756
width 746
check in, toolbar button 61
checked in content
definition 800
checked out content
definition 802
choose color, WebImageFX
command 695
choose font, WebImageFX
command 696
cleaning HTML 776
collaboration, content 794
collections
adding content 434
changing sequence of links 63
compared with menu and List
Summary 442
creating 430
creating new content for 436
default template 432
definition 424
deleting 440
editing content blocks 438
finding 425
folder, using to find collection 426
information, editing 439
multi-language 440
removing content 438
reordering content blocks 439
toolbar button 61, 62
toolbar buttons 430
using default template or
quicklinks 432
viewing 428
color
background
cell
applying 750
deleting 751
table
applying 739

deleting 740
cell border 749
default 728
content block border,
meaning 798
depth, specifying 718
font, changing 638
picture border 681
table border 742
default 726
columns
eWebEdit400
table
deleting columns 539
table
adding 731
deleting 731
spanning 754
specifying 730
comments
adding another 796
adding to a task 306
inserting into content 794
updating 796
viewing 796
Compare source code field,
eWebDiff 105
Compare visual aspect field,
eWebDiff 105
comparing content 98, 100
content area explained 106
Diff tab 106
how status affects
comparison 102
published tab 107
setup window 104
staged tab 107
toolbar 103
view tabs 106
when available 100, 101
window explanation 102
content
see also content block
active, definition 799
adding 48
adding as menu option 456
adding to collection 434
approval process 91
archived, toolbar button 61
archiving see archiving
area, expanding 46
awaiting approval 18
border
hiding and showing 5
checked in, definition 800
checked out, definition 802
collaboration 794
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comparing, see comparing content
creating 48
currently checked out 18
declining 90
declining, see declining content
deleting 57
difference
view, button, floating toolbar 5
viewing 98, 100
editing 52
editing, toolbar button 62
end date, setting 68
folders, see folders
history
accessing from Web page 53, 109
accessing via Workarea 54, 109
marked for deletion, definition 804
metadata, see searchable properties
pending start date 805
previous version, viewing 108
properties 45
publish see publish
restoring previous version 108
scheduling 65
start date, setting 66
statuses 798
approved 798
submitted, definition 803
summary see summary
translating 55
types 7
viewing 40
Workarea search 114
workflow reports see reports
content block
see also content
add button 60
definition 1
deleting
several at once 62
editing
overview 9
finding 9
lifecycle 10
contrast, WebImageFX command 698
copy
information from other
applications 658
toolbar and menu option 635
WebImageFX command 699
copyright character, inserting 637
create new, WebImageFX
command 699
creating

ii

document, document management feature 255
crop, WebImageFX command 699
custom validation, data designer 599
customizing toolbar 645
cut, toolbar and menu option 634

D
data designer
custom validation 599
decline
content
from publishing 90
one content item 89
several content blocks 90
delete
button, floating toolbar 4
content, toolbar button 62
folder, toolbar button 62
toolbar button 62
WebImageFX command 700
delete cell
toolbar button 642
delete column
toolbar button 642
delete row
toolbar button 642
deleting
cell 748
content 57
folders 40
table 721
Detect All field, eWebDiff 105
difference
content
view, toolbar button 5
dimensions, WebImageFX
command 700
display borders
toolbar button 643
DMS Document Option 232
Do not apply XSLT button 62
document
creating, document management
feature 255
importing into DMS 230
document management feature
adding documents to
collections 259
adding documents to menus 259
approving file 259
browser requirements 224
creating managed file 255
document types 223
file types 223
importing document 230
introduction 222

managed files 253
Office document, editing 244
overview 222
reports 259
reports of document by status 259
security 224
software requirements 224
workflow 258
Document Management System
Firefox plugin 225
documentation, online, accessing 483
drag and drop
DMS documents 235

E
edit button, floating toolbar 4
editing
content block, overview 9
content, toolbar button 62
HTML 775
editors
introduction 486
email
address, user, editing 479
instant
modifying 27
requirements 26
sending 25
where available 26
notification, disabling 481
end date, setting for content 68
end time, calendar event 275, 279
eWebDiff window 104
eWebEdit400
alignment toolbar buttons 494
anchor tag toolbar button 491
bold toolbar button 492
bookmarks 517
bullet toolbar button 494
cells
background color 560
background color, deleting 561
background image, deleting 562
background image, inserting 561
border size 556
deleting 559
merging 566
padding and spacing 568
splitting 565
text alignment 564
width 558
copy
information from other
applications 497
toolbar button 491
cut toolbar button 491
email links 527
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finding text 498
font
background color toolbar
button 493
color toolbar button 493
relative size toolbar button 493
size, absolute, toolbar button 493
style toolbar button 493
form elements toolbar 496
horizontal line toolbar button 492
HTML
viewing 529
hyperlink toolbar button 492
hyperlinks 521
creating 521
editing 525
entering manually 522
preventing 526
removing 525
testing 523
to a bookmark in another web
page 524
images
deleting 516
inserting 506
indent toolbar button 494
insert symbol toolbar button 492
introduction 488
italic toolbar option 493
library toolbar button 492
number toolbar button 494
paragraph style toolbar button 492
paste toolbar button 491
print toolbar button 491
redo toolbar button 491
remove hyperlink toolbar
button 492
replace toolbar button 491
replacing text 498
search 498
considering case of search
term 501
direction 500
whole word match 501
select all toolbar button 491
spell check toolbar button 491
spelling 503
strikethrough toolbar button 493
style class toolbar button 492
subscript toolbar button 493
superscript toolbar button 493
table
add row above toolbar button 495
add row below toolbar button 495
adding columns 539
adding rows 539
alignment 544

iii

background color 546
background color,deleting 548
background image 549
background image,deleting 550
border color 552
border size 553
cell properties toolbar button 495
columns, specifying 538
creating 531
delete cell toolbar button 495
delete column toolbar button 495
delete row toolbar button 495
deleting 537, 539
insert column left toolbar
button 495
insert column right toolbar
button 495
insert toolbar button 494
inserting within a table 537
merge cell horizontally toolbar
button 495
merge cell vertically toolbar
button 495
properties toolbar button 495
rows,specifying 538
section 508 570
show/hide border toolbar
button 496
span rows and columns 562
split cell toolbar button 495
width,setting by percentage 541
width,setting by pixels 543
word wrap 567
text, searching 498
text,aligning in columns 538
toolbar buttons 490
translate toolbar button 492
underscore toolbar button 493
undo toolbar option 491
wiki toolbar button 492
exit without save, WebImageFX
command 702
exit, WebImageFX command 701
extensions
file, allowed in library 135
image, allowed in library 135

F
file
open
toolbar button 643
save to local computer
toolbar button 643
files
copying to library 140
extensions, library, setting 135
library

inserting into content 148
overwriting 145
viewing 143
library, editing title 145
find next
toolbar and menu option 635
finding
content block 9
text 659
FireFox plugin for DMS
installing 225
folders
add button 60
button for deleting 62
deleting 40
information available when
viewing 31
screen display 28
view history, restore 111
viewing 30
fonts
background color 639
color 638
heading size 638
size 638
style 638
form elements toolbar 641
forms
adding to content 153
HTML
assigning task 195, 615
creating 159, 576
creating content block 166, 585
database 212
deleting 212, 618
editing
content block 211
introduction 210, 618
summary 211
field validation options 178, 596
implementing on Web page 194,
615
inserting fields 169
calendar field 192, 609
checkbox 173, 591
choices 185, 605
hidden text 175
password 180
select list 189
text 176, 592
text area 182
introduction 156, 574
mailto 212
processing overview 158, 576
reports, exporting 203
reports, viewing 197, 618
structure of data 158, 576
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toolbar 212, 618
toolbar options 168, 587
validation 172, 590
viewing 204, 618
properties 204
viewing 153
forum
signature, defining 481
freehand, WebImageFX command 702

G
gray, content border color, meaning 798
green, content border color,
meaning 798

H
height, work page, customizing for
user 481
help, online, accessing 483
hide borders
toolbar button 643
history
button, view, floating toolbar 5
content
accessing from Web page 53, 109
accessing via Workarea 54, 109
viewing 63
window 109
horizontal flip, WebImageFX
command 703
horizontal line, inserting, toolbar
button 643
HTML
cleaning 776
editing 775
inserting 775
saving Office document as 249
view as, toolbar and menu
option 637
viewing 774
hyperlink
edit, toolbar and menu option 636
remove, toolbar and menu
option 636
hyperlinks 768
adding as menu option 458
creating 768
definition 131
editing 772
entering manually 770
library
adding 151
adding to content 151
editing 151
viewing 151
preventing 773

iv

removing 773
testing 771
to a bookmark in another web
page 771
to content block, finding 62
using a Quicklink 769

italic, toolbar option 639

J
jumps, see bookmarks and hyperlinks
justify, toolbar option 640

I

L

Ignore All field, eWebDiff 105
Ignore Case field, eWebDiff 105
Ignore Format Attributes field,
eWebDiff 105
image extensions, library, setting 135
image info, WebImageFX command 703
image upload
from Microsoft Word
document 669
inserting picture from
computer 676
media file selection 673
images
adding space around 683
aligning 681
background
cell, inserting 752
table, inserting 741
border
color 681
thickness 680
deleting 686
deleting from server 675
editing 687
inserting 671
from server into editor 674
inserting from your computer 676
library
adding to content 152
editing titles 152
overwriting 152
uploading 151
viewing 152
locking in position 640
moving to server 685
scanning 716
specifying color depth 718
indent, toolbar option 639
insert
column, toolbar button 642
library item, toolbar button 62
new cell, toolbar button 642
row, toolbar button 642
table, toolbar button 723
inserting
cells 747
HTML 775
instant email, see email, instant
Internet addresses, spell checking 666

landing page after login, customizing for
user 482
language, user, editing 479
library
accessing 132
add items button 61
asset, adding as menu item 458
copying files to 140
definition 131
file extensions 135
files
deleting 148
editing 145
inserting into content 148
overwriting 145
viewing 143
folder properties 134
forms
adding to content 153
viewing 153
hyperlinks
adding 151
adding to content 151
editing 151
viewing 151
images
adding to content 152
editing titles 152
extensions 135
overwriting 152
uploading 151
viewing 152
quicklinks
adding to content 153
viewing 153
search results
include images 127, 140
text only 128, 140
searching 136
license keys, viewing 640, 643
lifecycle, content block 10
line, WebImageFX command 704
link check button 62
link search button 59
links, broken, finding 59
ListSummary, compared with collection
and menu 442
lock table or image in position 640
log in 11
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log out 13
button, floating toolbar 4

M
managed files 253
creating 255
editing 256
importing one 255
manuals, online, accessing 483
mapped network folder
adding Office documents 238
drag and drop assets 241
editing Office document 245
language restrictions 239
removing 243
setting up 239
viewing files 242
marked for deletion content 804
menus
accessing 446
add new content block via navigation link 461
adding new
via content folder 448
via Menus module 453
adding to toolbar 646
appearance
to content contributor 444
to site visitor 444
changing orientation 653
compared with collection and List
Summary 442
creating 650
in any language 476
definition 444
deleting 471
editing 462
via content folder 462
via menus module 463
via navigation link 463
items
adding
content block as 456
external hyperlink as 458
library asset as 458
submenu 459
to submenu 460
via content folder 453
via modules folder 454
via navigation link on Web
page 455
definition 446
deleting
via content folder 472
via menus module 472
editing
via content folder 465

v

via menus module 466
via navigation link 466
rearranging 470
moving from toolbar 652
multi-language issues 473
rearranging on toolbar 650
removing from toolbar 646
structure 446
submenu, definition 446
template link field 452
translating 473
URL link field 451
viewing
via content folder 467
via menus module 468
via navigation link 469
merge cell
toolbar button 642
merging cells 760
metadata
definition 77
Microsoft Office
documents
importing 230
Microsoft Office document
checking out, saving and
replacing 247
deleting 246
saving 249
saving in html format 249
Microsoft Office Documents
adding via drag and drop 235
adding via mapped network
folder 238
adding via Multiple DMS Documents option 233
Microsoft Office documents
adding via DMS Document
Option 232
edit in mapped network folder 245
editing in Office 244
imported
how named 231
Microsoft Word
editing in 668
editing XML documents 669
inserting content from 777
uploading image from 669
multi-language menus 473
Multiple DMS Documents option 233

N
network folder
mapped
adding Office documents 238
number, toolbar option 639
numbers in words, spell checking 666

O
objects, absolute positioning 640
Office 2000, inserting content from 777
open file, toolbar button 643
open, WebImageFX command 705
oval, WebImageFX command 706
overwrite button 62

P
padding, cell 762
password, changing 479
paste
toolbar and menu option 635
paste as new image, WebImageFX
command 707
paste text
toolbar and menu option 635
pending start date content 805
pictures
inserting see image upload
properties, image upload 673
pixels 680
pointer selection, WebImageFX
command 707
polls
creating 214, 618
creating in Workarea 215, 620
editing from Web site 219, 623
polygon, WebImageFX command 708
position objects menu 640
prerequisites 11
preview
button 62
floating toolbar 4
feature 13
print editor content, toolbar button 644
profile
users
updating 477
viewing 477
properties
button, floating toolbar 4
content 45
publish
button 63
content to web site 89
published
content block, viewing 63

Q
quicklinks 769
adding to content 153
broken, finding 59
definition 132
using for a collection 432
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viewing 153

R
rectangle, WebImageFX command 709
red, content border color, meaning 798
redisplay toolbars 650
redo
toolbar and menu option 635
WebImageFX command 710
registered trademark character,
inserting 637
remove alignment, toolbar button 643
remove button 63
remove XSLT from XML content
block 111
reorder button 63
replace
toolbar and menu option 635
replacing text 659
reports
content
workflow 130
restore, toolbar button 63
restoring content 111
right to left editing 641
rotate, WebImageFX command 711
rows
table
adding 731
deleting 731
spanning 754
specifying 730

S
save
file to local computer, toolbar
button 643
to database, toolbar button 63
WebImageFX command 711
save as, WebImageFX command 712
scanning an image 716
scheduling content 65
search 659
considering case of search
term 661
content folder 114
direction 660
library 136
toolbar button 63
whole word match 662
search screen
noise files 123
specifying
kind of content to search 122
match criteria 123
word or phrase 122

vi

searchable properties
creating 79
editing 79
section 508
compliance 784
tables 787
select all
menu option 655
toolbar button 644
select none, toolbar button 644
select, WebImageFX command 713
selecting text 632
server, moving picture to 685
sharpen, WebImageFX command 713
shortcuts, keyboard 633
show calendar, toolbar button 63
Smart Desktop
definition 17
hiding left panel 23
modifying folder display 21
navigating 20
set as start location for user 482
Smart Detect field, eWebDiff 105
space character, inserting 637
spacing, cell 762
spanning
table columns 754
table rows 754
special characters, inserting 638
spell check
automatic, toolbar and menu
option 635
manual, toolbar and menu
option 635
spelling
check a single word 665
check as you type 663
check on demand 664
check selected text 665
checking file addresses 666
checking Internet addresses 666
checking uppercase words 666
checking words with numbers 666
fix errors 664
split cell
toolbar button 642
splitting a cell 759
staged content block, viewing 64
start date
content block, setting 66
setting, results 67
start time, event calendar 275, 279
Strikethrough, toolbar and menu
option 639
style class, assigning to text 638
submenus
adding as menu item 459

adding items 460
definition 446
deleting 472
submit, toolbar button 63
submitted content, definition 803
Subscript, toolbar and menu option 639
summary
adding 73
content
creating for existing content
block 75
creating for new content block 74
editing 76
Superscript, toolbar and menu
option 639
surveys
creating 214, 220, 618, 624

T
table
insert, toolbar button 642
table properties
toolbar button 642
tables
alignment 737
background color
applying 739
deleting 740
background image
deleting 742
inserting 741
border
color 742
invisible 743
size 744
columns
adding 731
deleting 731
spanning 754
specifying 730
creating 720
deleting 721
inserting within a table 722
locking in position 640
rows
adding 731
deleting 731
spanning 754
specifying 730
section 508 787
width
setting by percentage 733
setting by pixels 735
tasks
add button 61
assign button, floating toolbar 4
assigning
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to content block 289
to HTML form 195, 615
to user 289
comments
adding 306
updating 308
creating
via content block 299
via task folder 288
definition 286
deleting 309
due date 291
editing 305
priority, assigning 289
redirecting to another user 289
relationship to content blocks 286
start date 291
state, assigning 290
toolbar buttons 311
viewing 300
options 301
sorting options 304
template link
field on Add/Edit Menu screen 452
text
aligning 640
in columns 722
within a cell 756
direction menu 641
indenting 639
remove formatting 639
replacing 659
searching 659
selecting 632
WebImageFX command 714
title bar, displaying button text 482
toolbars
buttons 60, 633
collections 430
customizing 645
eWebEdit400 490
floating
buttons 3
redisplay 650
restore 650
trademark
character, inserting 637
toolbar and menu option 637
translate
toolbar and menu option 636
twain acquire, WebImageFX
command 716
twain source, WebImageFX
command 716

U
underline, toolbar option 643

vii

undo
toolbar option 635
WebImageFX command 717
uppercase words, spell checking 666
URL link
field on Add/Edit Menu screen 451
users
email address, editing 479
language, editing 479
profile
customizing work page height 481
customizing work page size 481
customizing work page width 481
landing page after login 482
see profile
set Smart Desktop as start
location 482

V
validation
HTML form 172, 590
version number, viewing 640, 643
vertical flip, WebImageFX command 717
view content difference 98, 100
button, floating toolbar 5
screen, first use 107
view date, toolbar button 63
view difference, toolbar button 63
view history
button, floating toolbar 5
toolbar button 63
view preferences toolbar button 643
view published, toolbar button 63
view staged, toolbar button 64
ViewAllMenus 444
viewing HTML 774

W
WebImageFX
assigning new name to image 689
choosing image 687
commands
blur 693
brightness 694
choose color 695
choose font 696
contrast 698
copy 699
create new 699
crop 699

delete 700
dimensions 700
exit 701
exit without save 702
freehand 702
horizontal flip 703
image info 703
line 704
open 705
oval 706
paste as new image 707
pointer selection 707
polygon 708
rectangle 709
redo 710
rotate 711
save 711
save as 712
select 713
sharpen 713
text 714
twain acquire 716
twain source 716
undo 717
vertical flip 717
zoom in 717
zoom out 718
introduction 687
menu commands 689
saving image 689
specifying color depth 718
toolbar buttons 689
whole word match 662
width, table
setting by percentage 733
setting by pixels 735
width, work page, customizing for
user 481
wiki
creating 778
overview 778
word wrap 761
work page size, customizing for user 481
workarea
accessing 15
button, floating toolbar 5
definition 15
hiding left panel 23
toolbar buttons 60
add 60
add calendar event 60
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add content block 60
add content folder 60
add library items 61
add task 61
approvals 61
approve 61
approve all 61
archived content 61
calendar 61
check in 61
collections 61, 62
delete 62
delete content 62
delete folder 62
do not apply XSLT 62
edit 62
insert library item 62
link check 62
overwrite 62
preview 62
publish 63
remove 63
reorder 63
restore 63
save to database 63
search 63
show calendar 63
submit 63
view date 63
view difference 63
view history 63
view published 63
view staged 64
WYSIWYG, view as, toolbar and menu
option 637

X
XSLT, removing from XML content
block 111

Y
yellow, content border color,
meaning 798

Z
zoom in, WebImageFX command 717
zoom out, WebImageFX command 718

viii

